


ATX™UserGuidefor2017

©2018 Universal Tax Systems, Inc. and its affiliates and/or licensors. All rights reserved.

Audit Shield, MAX, InterviewPLUS, TaxWise, Universal Tax Systems Inc. are registered trademarks and/or registered service marks
of Universal Tax Systems, Inc.. ATX, Client Accounting Suite, Fixed Asset Manager, PaperlessPLUS, Protection Plus, and Trial
Balance are trademarks and/or service marks of Universal Tax Systems, Inc.. CCH and IntelliConnect are registered trademarks of
CCH Incorporated. CCH iFirm is a registered trademark of CCH Incorporated.

Excel, Internet Explorer, Outlook, Microsoft, and Windows are either registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.

Other company and product names referenced in this manuscript may be the trademarks or service marks of their respective
companies.

No part of this manuscript may be copied, photocopied, reproduced, modified or distributed in any form or by any means without
permission in writing from Universal Tax Systems, Inc. d/b/a CCH Small Firm Services. Information in this manuscript is subject to
change without notice. Any software or service described in this manuscript is furnished under a license agreement and may be
used or copied only in accordance with the terms of the license agreement.

CCH Small Firm Services is not engaged in rendering legal, technical, or other professional services. Use of this manuscript or the
information in this publication does not relieve the user of complete responsibility for the operation and functionality of its computers
and/or network, for the maintenance and backup of all user data, or for the preparation, content, accuracy, and review of all forms.

Any mention herein of third party products is for informational purposes only and does not constitute an endorsement by CCH Small
Firm Services. CCH Small Firm Services assumes not responsibility with regard to the performance or use of third party products.

THIS MANUSCRIPT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTIES, EXPRESSED OR IMPLIED, INCLUDINGWARRANTIES
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

February 2018

Version 17.3



Table of Contents
System Requirements 11

System Analysis Tool 11

Installation and Activation 15
Locate Activation Code(s) 15

Downloading Products 15
ATX Installation and Activation Instructions 16

For Payroll Forms, a Separate Install isRequired 16

ATXUser Guide for TaxYear 2017 16

Review Your ATX Purchase 16

Downloading ATX 18

What Install Type Do I Need? 20
Standalone 20

Network 20

Stand-Alone Installation 22
Stand-Alone Computer Activation 26

Network Server Installation 29
Installing ATXon the NetworkServer 29

Network Workstations Installation 34
Workstation Activation 39

Finding Your NetworkServer 41

Adding a Server 42

Workstation and Server Installation 44
NetworkServer andWorkstation Activation 49

Activation Codes Dialog Box 52
If ATXDVD Doesn't Start Automatically 53

Using ATXon a Network 53

NetworkTroubleshooting Tips 54

Uninstalling ATX 54
Part 1: Uninstalling the ATX2017 Program 55

Part 2: Uninstalling the ATXServer 2017 55

W2-1099 or Payroll Compliance 55
Installing from theWebsite 55

Installing from aDVD 59

RunningW-2/1099 or PayrollCompliance on a Network 60

Contact Us 61
Fax 61

Phone Support 62
Information YouMayNeed 62

Community Forums - Talk to Us, Talk to Each Other 62

Online Support 63

Even More Online Resources 63

MyATX Solution Center 63

Using the ATX Knowledge Base 63

Searching the Knowledge Base 64

ATX Communities 64
Getting Started 64

Support Web Sites 66
Checking the IRSRefund Status 66

Customer Service Utilities 66
Refreshing Application Configurations 67

Sending a Return to Customer Service 67

Send Diagnostics to Customer Service 68

Send E-file Log to Customer Service 69

Synchronizing E-filesWith the EFC 69

Administrative Tasks 71
Setting Up the Admin User 72

Changing User Access and Passwords 72

Changing File and Backup Locations 72

Manual Backups and Copying Backups to Local Stor-
age 72

Initial Login and Setting Update Preferences 72
Subsequent Login and Update 74

Adding Users to the System 74

Creating a New Security Group 75

Resetting the Admin Password 76

Resetting a Locked User Account 77

Editing Return Passwords 79

Removing a Return Lock 79

Admin Console 80
What can you do in Admin Console? 80

Accessing the Admin Console 80

ATXServer and the Stand-Alone Environment 82

Changing Your Backup Location 83

Changing Your File Storage Location 85

ManuallyMoving Files to a New Location 87

User Interface 89
Manager View 90

Manager Tabs 90

Menus 90

Toolbar 90

Manager-Specific Tabs 90

Filters 91

Manager Pane and Pagination Controls 91

Scroll bar 91

E-file Information Pane 91

Open Return View 91
Form, Schedule andWorksheets tabs 91

PagesandWorksheet tabs 91



Diagnostics Pane 92

Easy View 92

Main Managers 93
ReturnManager 93

Rollover Manager 93

E-file Manager 93

BankManager 93

Setup Managers 93

Manager Pane 94

Filters 97
Find filter 98

Clear Filters button 98

Toolbars 98
ReturnManager Toolbar 98

Rollover Manager Toolbar 99

E-file Manager Toolbar 100

BankManager Toolbar 101

OpenReturnsToolbar 101

Notifications 103

Open Return Interface 103
Forms, Schedules, and Spreadsheets 104

Pages&Worksheet Tabsand Button 104

Progress and Results Dialog Boxes 105
ProgressDialog Box 105

ResultsDialog Box 106

Zooming In and Out 106
Enlarge/Reduce 106

ZoomSlider 107

Messages and Warnings 107
InformationalMessages 107

WarningMessages 107

Refund Meter 108

Getting Started 109
Setup Checklist 110

Display Settings 111

Government Instructions 111
FromOutside a Return 111

From Inside the Return 112

Internet Connection 113
Connection Speed 113

Connection Type 113

Firewalls 113

Activating Other Products From Within ATX 114

Login and Password Requirements 114
Password Requirements 115

Initial Login and Setting Update Preferences 115

Logging In 117

Updating ATX 119
FormsUpdates 120

ProgramUpdates 120

Getting ProgramUpdates from Inside the Application 120

Getting ProgramUpdates from theWeb 121

Help and Support 122

Education Library 122

ATX Managers 123
Main Managers 124

OpenReturn(s) Tabs 124

Setup Information Managers 124

Functional Managers 125

Customizing Managers 125
Rearranging and Resizing Columns 125

Changing Data inManager Views 126

Return Manager 126
ReturnsTab 127

E-file Information Pane 127

AccountsReceivable Tab 127

TaxWarehouse Tab 127

ReturnManager Menus 127

ReturnManager Filters 133

ReturnsTab 134

AccountsReceivable Tab 135

TaxWarehouse Tab 135

Sorting the Return List 136

E-file Information 136

Customizing Fields 137

Marking ReturnsComplete 138

Importing Returns 139

Importing Converted Returns 141

Exporting Returns 141

Export AllReturns 143

ExportingMarked Client List 144

Rollover Manager 144
Rollover Manager Tabs 145

Rollover Manager Menus 145

Rollover Manager Filters 148

Rollover Returns from Last Year 149

Rollover Other Data 154

Rollover Returns from Last Month/Quarter 156

E-file Manager 158
E-file Manager Menus 158

E-file Manager Filters 161

Bank Manager 162



BankManager Menus 163

BankManager Filters 166

BankProductsTab 168

DisbursementsTab 170

BankProducts 171

FeeCollect™ 172

FeeCollect PSPackage 174

Protection Plus 174

BankProduct Fees 175

UnpostablesReport 176

Enrollment Manager 176

Adding BankProducts to Returns 180

BankStatus/Acknowledgements 181

Viewing Disbursement Details 182

Re-Creating BankApplications 183

Preparer/EROManager 185
Preparer/EROManager Tabs 186

Adding Preparer/ERO Information 186

Entering an EROEFIN 188

Deleting Preparer/ERO Information 189

Inserting Preparer/ERO Information 190

Removing Preparer and ERO Information 190

Exporting Preparer/ERO Information 190

Company Manager 191
Adding Companies 192

Inserting Company Information 193

Deleting Companies 193

Exporting Companies 194

Payer Manager 194
Adding Payers to the System 195

UsingQuickEntry to Select Payers 196

Deleting Payers 197

Exporting Payers 198

Security Manager 198
UsersTab 199

GroupsTab 199

SecurityManager Terminology 199

User Passwordsare Required 200

Default User NamesandGroups 200

SecurityManager Available Actions 201

Adding Users to the System 202

Creating a New SecurityGroup 207

Restricted AccessMessage 211

Billing Manager 212
Form and Schedule Rates 212

Setting Up Form and Schedule Rates 214

Setting UpHourlyRates 215

Changing FormRates 216

Exporting Billing Rates 218

Modifying Billing Rates in a .csvFile 219

Importing Billing Rates 220

Adding a Billing Invoice to a Return 222

Completing the Billing Invoice 223

Billing a Flat Fee 223

Client Communication Manager 224
Client CommunicationManager Menus 225

Client Communication Toolbar 226

Edit Mode vsPreview Mode 228

Client Letter Templates 229

Using Variables in the Client Letter 231

AddingGraphics 234

Deleting a Client Letter 235

Inserting a Table in a Client Letter 236

Attaching Custom Letters 237

Importing Client Letters 238

Exporting Client Letters 239

Printing the Client Letter 240

Preferences 243
Preferences Dialog Box 244

All Managers Preferences 244
Show Popup Tooltips in allManagers and Dialogs 245

Hide ReturnsMarked Complete 245

Return Manager Preferences 246
Reset to Default Sorting On Startup 246

Show E-file Status Information for Selected Return 246

iTransact Merchant ServicesClient ID 246

CCH iFirm 247

TaxResearch Login Credentials 247

Rollover Manager Preferences 247
Delete Sold Assets 247

Rollover Itemized, Text and Custom Lists 248

Enter Current Year Default Preparer on Rolled-Over
Returns 248

Enter Current Year Default EROonRolled-Over Returns248

AlwaysCheck for FormUpdatesWhenOpening Rolled
Returns 248

OptimizeMemoryUsage During Rollover 248

Preparer Manager Preferences 249
Enter Preparer on AllNew Returns 249

Enter EROon AllNew Returns 249

E-file Manager Preferences 250
Automatically Include E-file Info Forms 250

Hold and Release State E-files 250



Open Return Preferences 251
Auto-start Timer In Returns 251

Prompt for Timesheet Entry on Return Close 251

Use AllCaps for Data Entry 251

Include AlternativeMinimumTaxForm in 1040 Returns 252

RefundMeter 252

Auto-Save Returns 252

DisplayValidation Errors 252

Show Form Tabson Left 252

Enable Payer Manager Preference 252

DisplayTaxResearch ToolTips 252

CalculateW-2 SocialSecurity andMedicareWages 252

Setting CheckReturn Filters 253

Disable Auto-Calculationson Detail Sheets 253

Select Forms Preferences 253
Default State 254

InformationWorksheet 254

Organizer 254

Client Communication Preferences 254
Federal and State/Local Letter Options 255

Paragraph Selection 256

Print Preferences 257
PrintWithout Zeros 257

PrintWatermarkon Client Copy 257

MaskSensitive Information on Client Copy 257

SuppressSSNswhen printing Organizer 257

Add Bookmarks to PDFs 258

Print a Separator for Filing, Client, and Preparer Copies 258

Remember Print Return Selections for Each Return 258

AutomaticallyClose Print Return Dialog After Printing 258

AutomaticallyClose the Print ProgressDialog After Print-
ing 258

Default Print Copies 258

Print Letters 259

Mailing Slip Orientation 259

CheckReturn Reports 259

View/Edit Print Packets 259

Form Display Preferences 260
Input BoxColor 260

Default Form Zoom Level 261

Updates Preferences 261
ProgramUpdates 261

FormUpdates 261

Calculator Preferences 262
Collapsible Calculator 263

Close Calculator After Insert 263

Capture Form Field Value Automatically 263

Backup and Files Preferences 263
AutomaticBackup 264

File Storage Location 264

Reset to the Default Location 264

Saving Selected Returns to a Specific Location 264

Importing Preferences From Another User 265

Preparing Returns 267
Creating Returns 268

Return Passwords 270

Opening Returns 271
Opening Password-Protected Returns 272

Opening ReturnsLocked byOther Users 272

OpenReturnMenus 273

Navigating Within Returns 280
Viewing or Selecting Forms in a Return 280

Navigating using Jump To or CrossReference 281

JumpTo 281

CrossReference 282

Backand Forward Buttons 283

Adding Forms to a Return 283
Installed Forms 283

"Update Available" and "Available Now" Forms 284

Messagesat the Top of Forms 284

Field Colors on Forms 285

Select FormsDialog Box 285

Discarding Forms 289

Renaming Forms 291

Saving Returns 291

Closing Returns 292

Interviews 293
Interview Sections (Tabs) 294

Navigating in the Interview 294

FrequentlyAskedQuestions (FAQs) 295

PDF Attachments 295
DecideWhat Type of PDFs to Attach 296

Creating and Attaching PDFsof Completed Forms 296

Creating and Attaching PDFs fromOther Sources 298

Viewing and Deleting Attachments 299

Duplicating Returns 299

Renaming Returns 300

Deleting Returns 300
Deleting Selected Returns 300

DeletingMarked Returns 301

Extensions 302
Extensionswith Zero Amounts 302

ExtensionsWith CustomAmounts 303



OpenReturn 304

Amending Returns 304
When Amendment Formsare Already Installed 304

When Amendment Formsare Not Yet Installed 305

Calculator 306
Calculator MemoryFunctions 308

Calculator Capture 309

Calculator Shortcuts 309

Information Worksheet/Signature Form 310
Signature Forms 310

Company InformationWorksheet 310

Individual InformationWorksheet 311

Checking Returns for Errors 312
TheCheckReturn feature: 312

CheckReturn Filters 313

ReviewingOverridden Fields 314

Customizing Master Forms 315
CustomizeMaster FormsDialog Box 317

Restore CustomizedMaster Forms 318

Lists Overview 319
Creating Itemized Lists 319

Creating Text Lists 320

Creating Custom Lists 322

Importing Existing Files into Lists 329

Exporting Lists 332

Printing Lists 333

Removing Lists 334

Deleting Rows from Lists 334

Working in Forms 335
Tips for Entering Data 336

Data Entry Validation 336
Data Validation Errors 336

ZIP Code Lookup 337

Duplicating Forms or Schedules 337
MaximumNumber of Copies 338

Cut, Copy, and Paste 338

Undo 338

Overriding Calculated Fields 339
Printing theOverride Report 340

Restoring Overridden Fields 341

Marking Fields as Estimated 341

Creating Links Between Fields 342
Canceling Relationshipsbetween Two Linked Fields 342

Exceptions: When FieldsCannot Accept a Link 343

Preparer Notes 343

Insert/Edit Notes 343

Remove a Note 345

Locked Fields 345

Inserting Text on Forms 345
Inserting Text 346

Removing Text 347

Inserting Pictures on Forms 348
Inserting a Picture 348

Removing a Picture 348

Input Sheets and Detail Schedules 349

Using Input Sheets or Detail Schedules 349

Using the Record Bar 349

Importing K-1 Data 351
New Returns 351

Updating K-1 Information on an Existing Return 352

Opening a ReturnWhen Associated K-1 Data Has
Changed 353

Unavailable Source Returnsor FormsWithin Source
Returns 354

Amended Source Returns 354

Importing Data from .csv Files 354

Saving an .xls as .csv 356

Accounting Import 356
Accounting Import QuickBooksOnline 357

Accounting Import for CAS 366

Form Update Report 369
FormUpdate ReturnsReport 369

FormUpdate FormsLog 370

Re-Downloading Forms in Marked Returns 371

E-filing 373
Federal E-filing Requirements and Eligibility 373

Apply to File ReturnsElectronically 373

Receive Your EFIN 373

State or Local E-filing Requirements 374
Stateswith AdditionalRequirements 376

E-File Signatures 376
Determining Prior Year AGI (Self-Select PIN method) 377

Resources for E-filing 378
IRSResources 378

WoltersKluwer, CCH Small Firm Services 378

Revenue Procedure/TechnicalE-file Publications 378

Modernized E-file 378

E-file Statuses 378

Avoiding Common E-file Rejection Errors 379
Update TaxProgram and FormsFrequently 379

Internet Connectivity and Software Accessibility 379



Creating E-files 380
Create E-file Dialog Box 381

E-file ID 384

Holding/Releasing State E-files 385

Displaying E-file Rejection Errors or Messages 385

Correcting E-file Rejection Errors 387

Transmitting E-files 388

Deleting E-files 390

Creating State E-files 391

Managing Acknowledgements (Acks) 392
AckTimeliness 392

State E-file Acks 393

Acknowledgement History 393

Receiving Acknowledgements 394

Extensions, Estimated Payments, and Payments 394

Tax Prep Utilities 399
Tax Summary/Carryover Worksheet 399

Last Year Comparison 400

Tax Planner 401

Married Joint - Separate Comparison 401

U.S. Averages Comparison 402

Standard Client Letters 405
Standard Letters 405

Custom Letters 406

Working with the Standard Client Letter 406
Add Standard Letters to AllReturns 406

Add a Standard Letter to anOpenReturn 407

Modifying Standard Letters 408

Delete a Standard Letter from aReturn 410

Fixed Asset Manager 411
Fixed Asset Manager And Enhanced Asset Man-
agement 412

Fixed Asset Manager Interface 413
Asset Tabs 413

Panes 413

Asset Information 413

Asset EntryToolbar 414

Search and Filter for Assets 414
Clear Your Search 416

Display Calculations for Asset 416

Asset Information Pane 417
Depreciation and Section 179 Tab 417

Auto/Listed Tab 418

DispositionsTab 420

Asset HistoryTab 429

Entering a New Asset 429

Duplicating Assets 430

Move Assets 431

Split Assets 433

Multiple Asset Account (MassAsset) 433

Maximize 179 437

Classifications 441
Global vs. LocalClassifications 441

CustomClassification 441

Add Items to a Classification 442

Assigning Classifications to Assets 443

Delete Classificationsand Items 443

Summary Information Pane 444

Asset Global Settings 444
Input Defaults 445

BonusElections 447

State CalcsTab 448

TaxYear Information 449

Reports Overview 451
Edit Mode for Reports 452

Preview Mode for Reports 456

Standard Reports 457

CustomReports 458

Printing an Asset 461

Entering Assets Directly on Form 4562 462
Form 4562 PagesandWorksheets 463

Viewing Calculated Depreciation on Form 4562 464

Print 465
Print Packets 466

Setting Global Print Options 468
Printer Selection 468

Paper Size (Letter, Legal, etc.) 469

Paper Source (Tray1, Tray2, etc.) 469

Print Orientation (Portrait or Landscape) 470

Printing Returns 470
Printing the Return asa PDF File 472

Printing the Current PageOnly 473

Print Return Dialog Box 473

Batch Printing Returns 475

Printing Checks 476
Configuring Printer for CheckPrinting 477

Reprinting Checks 478

Aligning Checks 479

Printing Reports 480

Print Preview 481

Reordering Print Sheets in a Return 481

Printed Mailing Slip Orientation 482



Printing Marked Client List 483

Printing Marked Client Labels 484

CCH iFirm 487
Sign In To CCH iFirm 487

CCH iFirm Menu 489

Export Existing Contacts to CCH iFirm 490
What's IncludedWhen you Export Contacts to CCH iFirm 490

Import CCH iFirm Contact Data into a New Return 490

Sync New ATX Contacts with CCH iFirm 491

Sync Contact Data on Open and Close 492
SynconOpen 493

Syncon Close 493

View CCH iFirm Job Status in Return Manager 494

View Job Details 494

Send CCH iFirm Invoice 495

Tracking Time in ATX 497
Sending Time fromATX to CCH iFirm 498

Viewing Timesheet Entries 499

CCH iFirm Client Portal 501
Upload to Client Portal 501

Tax Research and theMaster Tax Guide 503
TaxLine Research Tooltips and Indicators 505

Practice Aids 505
Client Letter Toolkit 506

SearchOnline 507

CCH Browser Search Plug-in Installation 510

CCH Browser Search Plug-in For Internet Explorer 512
Searching with Internet Explorer 514

CCH Browser Search Plug-in For Google Chrome 517
Searching with Chrome 519

Backup and Restore 521
Third PartyBackup Products 521

Backup and Files Preferences 521
AutomaticBackup 522

File Storage Location 523

Reset to the Default Location 523

Saving Selected Returns to a Specific Location 523

Automatic Backup 523
What Data is backed up aspart of AutomaticBackup? 523

Changing Backup Location in Preferences 524

Changing File Storage Location in Preferences 525

ManuallyMoving Files to a New Location 526

Manual Backup 527

Setup Data 528
Backing up Setup Data 529

Restoring Setup Data 529

Restoring Returns 530
Restoring Other Data 532

Backup vs. Export 532

Organizers 535
Organizer Types 535

1040 Comprehensive Organizer 535

1040 Standard Organizer (Condensed) 535

Organizer Preferences 535

Organizer Types 536
Comprehensive Organizer 537

Standard Organizer 537

Changing theOrganizer Type 538

Adding Organizers to Returns 539
AddingOrganizers to Open Returns 539

AddingOrganizers to a Batch of Returns 540

Creating a BlankOrganizer for a New Return 540

Use theOrganizer Letter for Scheduling 541

AddingOrganizer Sheets 542

Deleting Organizer Sheets 542

Organizer Engagement Letter 543

Printing Organizers 544
Printing anOpenReturn'sOrganizer 544

Printing Organizers for Marked Returns 544

Keyboard Shortcuts 547
GlobalShortcuts 547

ReturnManager Shortcuts 547

Rollover Shortcuts 548

E-file Manager Shortcuts 548

BankManager Shortcuts 548

Preparer/EROManager Shortcuts 548

CompanyManager Shortcuts 549

Payer Manager Shortcuts 549

BillingManager Shortcuts 549

OpenReturn Shortcuts 549

Client CommunicationManager Shortcuts 551

Calculator Shortcuts 551





Chapter

1
System Requirements
Systems that do not meet requirements often have issues with general system performance (speed) as well as speed
transmitting or downloading data—a problemmost tax businesses cannot afford during tax season. See the latest
system requirements at https://www.cchsfs.com/software-system-requirements/.

The System Analysis Tool scans your system and rates its compatibility with ATX.

System Analysis Tool
ATX provides a System Analysis Tool to help you determine whether your computer meets system requirements.

To download the System Analysis Tool:

1. Navigate to the ATX Knowledge Base.
2. In the Search box, type System Analysis Tool.
3. Click Search.
4. In the search results, click ATX™ 2017 System Analysis Tool.
5. In the Attachments box, click the Sfs.SystemAnalysisTool.exe link.
6. On the Save drop-down list, click Save As.
7. Save the file to your desktop.

To check your system:

1. Open the System Analysis Tool by double-clicking the icon on your desktop.
2. Windows displays anOpen File Security Warning dialog box. Click Run.
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Chapter 1: System Requirements

ATX displays the ATX System Analysis Tool dialog box:

3. Select Stand-Alone/Single Workstation or Server from the drop-down list depending on the type of install you will
use.

4. Select the drive to which ATX 2017 will be installed in the Please choose your installation drive: drop-down list.
5. Click Analyze System.
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Chapter 1: System Requirements

The System Analysis Tool displays the specifics of your computer's Operating System, Processor, Memory
(RAM), Available Disk Space, Computer Monitor, and Internet Connection along with a graph to inform you of
how your systemmatches up against theminimum and recommended system requirements for ATX 2017:

l Green bar - indicates that youmeet or exceed system requirements;
l Yellow bar - indicates that youmeet system requirements, but do not meet the preferred system requirements;
l Red bar - indicates that you do not meet the system requirements.

6. Click Close when finished.
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Chapter

2

Installation and Activation
ATX 2017 can be installed on an individual, stand-alone computer or it can be installed on a network with a designated
server andmultiple workstations.

If all your computers meet the System Requirements you're ready to install ATX.

IMPORTANT: Your ATX software will only install to the computer's primary hard drive. While the ATX
application location cannot be altered, you will be able to choose where the ATX work product data files you
create are stored (i.e, a secondary drive, network drive, external drive, etc.). See Changing Your File Storage
Location.

Locate Activation Code(s)
Activation codes are printed on the Fulfillment Confirmation Slip found in the shipment you received in themail.

If you use a payroll product, it has a separate installation and activation code. SeeW2-1099 or Payroll
Compliance.

Downloading Products
Download ATX 2017 from www.MyATX.com. See Downloading ATX.

15
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Chapter 2: Installation and Activation

ATX Installation and Activation Instructions
As you're installing ATX, the Select Your Install Type dialog box helps youmake the right selection for the computer on
which you're installing the system.

l What Install Type Do I Need?
l Stand-Alone Installation
l Network Server Installation
l Network Workstations Installation
l Workstation and Server Installation

Troubleshooting Network Installation
ATX is designed to identify a network server on which the product has already been installed. If this does not occur
automatically, the following topics can help youmanually identify the server:

l Finding Your Network Server
l Adding a Server
l Network Troubleshooting Tips

For Payroll Forms, a Separate Install is Required
If payroll products comewith your product bundle, the installation and forms are free. If your package does not include a
payroll product, you can download the payroll product free and obtain payroll forms on a pay-per-return basis.

For payroll installation instructions, seeW2-1099 or Payroll Compliance.

Do not install the payroll product to the same folder as ATX™ 2017.

ATX User Guide for Tax Year 2017
A PDF version of the guide is installed as part of the installation process. Updates will be included along with Program
Updates throughout the season. In case of Internet outage, the User Guide will serve as a temporary substitute for Program
Help.

Review Your ATX Purchase
To view your purchase:

1. Enter www.MyATX.com in yourWeb browser.

16
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Chapter 2: Installation and Activation

2. Under My Account, click My Products.

3. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
4. Enter your User Name in the User Name box and press the Tab key.
5. Enter your Password in the Password box.
6. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
7. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
8. Click Log In. The ATX Solution Center displays your subscriptions.

17



Chapter 2: Installation and Activation

Downloading ATX
To download ATX products from the Web site:

1. Enter www.MyATX.com in yourWeb browser.

2. Under Preparer Solutions, click Download Center.

3. From themenu items on the left, select the ATX Tax Program.

18
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Chapter 2: Installation and Activation

4. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
5. Enter your User Name in the User Name box and press the Tab key.
6. Enter your Password in the Password box.
7. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
8. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
9. Click Log In. MyATX displays the Download Center page.

10. Click Download.
11. Follow the prompts and instructions given. After downloading the ATX installer, see Installation and Activation for

an overview of the ATX installation process.
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What Install Type Do I Need?
Selecting the right ATX installation type is important. During installation, the Select Your Install Type dialog box helps you
make the right selection for the computer on which you're installing the program:

Standalone
Select this install type if you'll be preparing taxes on this workstation (computer) and you do not need to share this tax data
with any other workstations in your organization. This is the correct configuration for most single-computer, single-user
offices. See Stand-Alone Installation.

Network
Select this install type if you are not the only person in your office, or if you intend to bring additional people on during the
season and want to share data across a network. If you select Network, you'll have three installation choices for the current
computer.
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Server Only

Select this install type if the current computer will only be used as a server to store data and transfer data to other computers
on the network. Choose this setup if the current computer will not be used to prepare tax returns. See Network Server
Installation.

Workstation Only

Select this install type if you'll be preparing taxes on this workstation (computer) but intent to share this tax data with other
workstations and a server. See Network Workstations Installation.

If you select theWorkstation Only install type, it is assumed that you've already installed ATX on a server.

Server andWorkstation

Select this install type if this workstation (computer) will be used as a server and also to prepare tax returns. See
Workstation and Server Installation.
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Stand-Alone Installation
If you only need one computer system, or, if you do not need to share system data with other system users, a stand-alone or
single workstation setup is recommended.

This topic gives steps to perform the Stand Alone installation. If you're unsure of your install type, seeWhat Install
Type Do I Need?.

IMPORTANT! Before installing ATX, make sure your computer meets the System Requirements for a stand-alone
setup. Setups that meet or exceed the recommended requirements will experience the best performance results.

To install and activate ATX on a stand-alone or single workstation:

As a precaution against losing work in other programs, you should shut down all other applications on your computer
before beginning your ATX installation.

1. Do one of the following:
l Install from DVD: Insert the DVD provided in your product shipment into the DVD-ROM drive. Refer to If ATX
DVD Doesn't Start Automatically if necessary.

l Download fromWeb: ATX can be downloaded from the Customer Support Site. See Downloading ATX.

2. Click Next.
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3. Select the I accept the terms in the license agreement radio button to indicate that you have read and agree to
the terms of the license agreement; then, click Next.

4. Click Next.
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5. Click Next.

6. Click Stand-Alone.
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7. Confirm your selection by clicking Install.

The default location for stand-alone installations is C:\Program Files (x86)\CCH Small Firm
Services\ATX2017 for all supportedWindows operating systems.

The option to install the CCH Browser Search plug-in only displays if you do not already have the plug-in
installed.

8. Click the Install CCH Browser Search plugin check box.
9. Click Next.
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10. Click Finish.

This completes the ATX installation process. The ATX icon is placed on your desktop.

If you selected the option to install the CCH Browser Search plug-in, the installation will now begin. For
Information on installing and setup, see CCH Browser Search Plug-in Installation.

Stand-Alone Computer Activation
1. Double-click the ATX™ 2017 icon on your desktop.

The Activation Codes Dialog Box appears the first time you start the application after installation.
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2. Enter the product Activation Code from your Fulfillment Confirmation Slip. When you enter a successful activation
code, the Activate button is enabled.

3. Click Activate. The product name appears in the Activated Products pane.

If you purchased a product that is bundled with a Payroll Compliance orW2/1099 product, do not enter that
Activation Code in this dialog box. Instead, read the note at the bottom of the dialog box and click the link that
says Click here for installation instructions. SeeW2-1099 or Payroll Compliance for these installation
instructions.

4. ATX opens to theWelcome To ATX dialog box.

5. The User Name field defaults to Admin. Youmust first establish a password for the Admin user in order to access
ATX.
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Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

6. (Optional) Select the Remember me check box to have your User Name automatically populated when you
launch the application from this workstation.

7. Click Login. ATX opens to the ReturnManager and presents the Download Forms Updates dialog box (which
gives you the opportunity to get the latest forms).

8. In the Download Form Updates dialog box, click the Adjust form update settings link.

9. Select the check box(es) next to the package(s) you frequently work with under the Form Updates area of the
dialog box.

10. Scroll down to the section with the state check boxes; then, select the state(s) you want to include in your form
updates.

11. Click OK.
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12. In the Download Form Updates dialog box, click Continue.
13. When the Update Results dialog box appears, indicating that the download was successful, click Close.

Network Server Installation
If you want to share system data between users, and would like data stored in one central location, you should establish a
network setup in your organization. A network setup involves:

l A designated server.
l One or more additional workstations.

This topic only includes steps to install the server on a computer. However, a server-only install does not provide
access to the ATX application as a typical tax preparer uses it. This requires a workstation installation. To install both a
workstation and a server on the samemachine, seeWorkstation and Server Installation. If you're unsure of your
installation type, seeWhat Install Type Do I Need?.

IMPORTANT! Before installing ATX, make sure your network server meets the System Requirements for a server,
and that your network workstations meet requirements for stand-alone/single workstations. Setups that meet or exceed
the recommended requirements will experience the best performance results.

Installing ATX on the Network Server
As a precaution against losing work in other programs, you should shut down all other applications on your computer
before beginning your ATX installation.

To install and activate ATX on the network server:

IMPORTANT! After installing the ATX server, there will be no ATX 2017 icon on your desktop. This is because you
are intending for this computer to be usedONLY as a server, and you do not intend to use the ATX application on this
machine. If you also want to use this computer to open and use ATX, then you should follow installation directions in
Workstation and Server Installation.

1. Do one of the following:
l Install from DVD: Insert the DVD provided in your product shipment into the DVD-ROM drive. Refer to If ATX
DVD Doesn't Start Automatically if necessary.

l Download fromWeb: ATX can be downloaded from the Customer Support Site. See Downloading ATX.
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2. Click Next.

3. Select the I accept the terms in the license agreement radio button to indicate that you have read and agree to
the terms of the license agreement; then, click Next.
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4. Click Next.

5. Click Next.
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6. Select the Network option.

7. Click the Server Only option.
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8. Click Install.

Installation speedmay vary depending on your operating system or Internet speed.

9. Click Finish.

This completes the Server only installation process. To install a workstation only, see Network Workstations
Installation.

If you receive a Network Setup Not Complete message, click the Help link for Network Troubleshooting
Tips.
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Network Workstations Installation
Before installing ATX on network workstations, youmust do the following:

l Install and launch ATX on the server. See Network Server Installation.
l Accept any updates available on the server. See Downloading ATX.

This topic gives steps to perform the Network - Workstation Only installation. If you're unsure of your install type, see
What Install Type Do I Need?.

To setup ATX on a network workstation:

As a precaution against losing work in other programs, you should shut down all other applications on your computer
before beginning your ATX installation.

To install and activate an ATX workstation:

You should have already installed ATX on the server before trying to install ATX on a workstation. If you have not
installed the server yet, see Network Server Installation.

1. Do one of the following:
l Install from DVD: Insert the DVD provided in your product shipment into the DVD-ROM drive. Refer to If ATX
DVD Doesn't Start Automatically if necessary.

l Download fromWeb: ATX can be downloaded from the Customer Support Site. See Downloading ATX.

2. Click Next.
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3. Select the I accept the terms in the license agreement radio button to indicate that you have read and agree to
the terms of the license agreement; then, click Next.

4. Click Next.
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5. Click Next.

6. Select the Network option.
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7. Click theWorkstation Only option.

8. Click Install.

Installation speedmay vary depending on your operating system or Internet speed.
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The option to install the CCH Browser Search plug-in only displays if you do not already have the plug-in
installed.

The Install CCH Browser Search plug-in check box is selected by default. If you do not want to install the
CCH Browser Search plug-in, click the Install CCH Browser Search plug-in check box.

9. Click Next.

10. Click Finish.
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If you selected to install the CCH Browser Search plug-in, the installation will now begin. For information on
installing and setup, see CCH Browser Search Plug-in Installation.

This completes the ATX installation process. The ATX icon is placed on your desktop.

If you receive a Network Setup Not Complete message, click the Help link for Network Troubleshooting
Tips.

Workstation Activation
1. Double-click the ATX™ 2017 icon on your desktop. Typically, the system automatically connects the network

workstation with the server, and the ATX splash screen appears and remains on screen for a few seconds.

If the system doesn't automatically locate the server, a Find Network Server dialog box appears. See
Finding Your Network Server.

The Activation Codes Dialog Box appears the first time you start the application after installation.

2. Enter the product Activation Code from your Fulfillment Confirmation Slip.

You can copy and paste your activation code into this dialog box.

3. Click Activate. The product name appears in the Activated Products pane.

If you purchased a product that is bundled with a Payroll Compliance orW2/1099 product, do not enter that
Activation Code in this dialog box. Instead, read the note at the bottom of the dialog box and click the link that
says Click here for installation instructions. SeeW2-1099 or Payroll Compliance for these installation
instructions.
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4. ATX opens to theWelcome To ATX dialog box.

5. The User Name field defaults to Admin. Youmust first establish a password for the Admin user in order to access
ATX.

If User Names are not yet created, amessage will prompt the Admin user to create users.

Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
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l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

6. (Optional) Select the Remember me check box to have your User Name automatically populated when you
launch the application from this workstation.

7. Click Login. ATX opens to the ReturnManager and presents the Download Forms Updates dialog box (which
gives you the opportunity to get the latest forms).

8. In the Download Form Updates dialog box, click the Adjust form update settings link.

9. Select the check box(es) next to the package(s) you frequently work with under the Form Updates area of the
dialog box.

10. Scroll down to the section with the state check boxes; then, select the state(s) you want to include in your form
updates.

11. Click Apply, and thenOK.
12. In the Download Form Updates dialog box, click Continue.
13. When the Update Results dialog box appears, indicating that the download was successful, click Close.

Finding Your Network Server
In most cases, if you've already installed ATX on your network server, the system will automatically recognize the server's
location and will link a network workstation to the server.
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If the system is unable to find your server, the Find Network Server dialog box appears:

1. Select the server from the list.
2. Click Next.

3. Click Close.

If the server is not in the list, follow instructions for Adding a Server.

Adding a Server
If you are using a network environment, setting up a server is the first step in getting your network up and running. If you have
already installed ATX on the server but the server is not automatically identified during the network workstation installation,
youmay need to add the server manually.

To add the name of a server that does not automatically appear in the list:

1. From the Find Network Server dialog box, click the Can't Find Network Server? link.

See Finding Your Network Server.
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2. Click Browse.

3. Select the computer that is the server, and click OK.

The Add ATX Tax Server dialog box appears with the name of the selected server.

4. Click Next.
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5. Select the name of the server for which you just browsed, and click Next.

Installation will continue on the network workstation, now that the server has been identified.

See Network Workstations Installation.

Workstation and Server Installation
This topic provides instruction links for theWorkstation and Server selection during the installation routine.

To install ATX on this machine so it can be used as both an active workstation and as the network server:

1. Do one of the following:
l Install from DVD: Insert the DVD provided in your product shipment into the DVD-ROM drive. Refer to If ATX
DVD Doesn't Start Automatically if necessary.

l Download fromWeb: ATX can be downloaded from the Customer Support Site. See Downloading ATX.

2. Click Next.
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3. Click the I accept the terms in the license agreement radio button to indicate that you have read and agree to the
terms of the license agreement; then, click Next.

4. Click Next.
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5. Click Next.

6. Select the Network option.
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7. Click Workstation and Server.

8. Click Install.

Installation speedmay vary depending on your operating system or Internet speed.
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The option to install the CCH Browser Search plug-in only displays if you do not already have the plug-in
installed.

The Install CCH Browser Search plug-in check box is selected by default. If you do not want to install the
CCH Browser Search plug-in, click the Install CCH Browser Search plug-in check box.

9. Click Next.

10. Click Finish.

48



Chapter 2: Installation and Activation

This completes the ATX installation process. The ATX icon is placed on your desktop.

If you receive amessage that your network setup is not complete, click the Help link for Network
Troubleshooting Tips.

If you selected to install the CCH Browser plug-in, the installation will now begin. For information on installing
and setup, see CCH Browser Search Plug-in Installation.

Network Server andWorkstation Activation
1. Double-click the ATX icon.

The Activation Codes Dialog Box appears the first time you start the application after installation.

2. Enter the product Activation Code from your Fulfillment Confirmation Slip.
3. Click Activate. The product name appears in the Activated Products pane.

If you purchased a product that is bundled with a Payroll Compliance orW2/1099 product, do not enter that
Activation Code in this dialog box. Instead, read the note at the bottom of the dialog box and click the link that
says Click here for installation instructions. SeeW2-1099 or Payroll Compliance for these installation
instructions.
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4. ATX opens to theWelcome To ATX dialog box.

5. The User Name field defaults to Admin. Youmust first establish a password for the Admin user in order to access
ATX.

Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed
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6. (Optional) Select the Remember me check box to have your User Name automatically populated when you
launch the application from this workstation.

7. Click Login. ATX opens to the ReturnManager and presents the Download Forms Updates dialog box (which
gives you the opportunity to get the latest forms).

8. In the Download Form Updates dialog box, click the Adjust form update settings link.

9. Select the check box(es) next to the package(s) you frequently work with under the Form Updates area of the
dialog box.

10. Scroll down to the section with the state check boxes; then, select the state(s) you want to include in your form
updates.

11. Click Apply, then click OK.
12. In the Download Form Updates dialog box, click Continue.
13. When the Update Results dialog box appears, indicating that the download was successful, click Close.

Next step: PerformWorkstation Only installations and activate ATX on other computers on the network. See Network
Workstations Installation.

IMPORTANT! Network users will be required to sign in to use the ATX program. The Admin user must setup users in
Security Manager in order for users to acquire their User Names.
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Activation Codes Dialog Box
Activation code(s) are included in your initial product installation kit. They can be found on the Fulfillment Confirmation Slip.

To install ATX, you'll use one designated activation code. If you purchased an ATX bundle with payroll functionality, you'll
have a second activation code specifically for payroll.

If you purchase Additional License packs, ATX Add User License(s) appears in the Product pane. This single entry
covers all your Additional License purchases. To confirm your product purchases, go toMy Products on theMyATX
Solution Center.

The Activation Codes dialog box can be accessed two ways:

l When you first install ATX, it appears automatically.
l From within ATX, select Activate Product(s) from the Support menu to open the Activation Codes dialog box.

Item Description

Enter your Activation Code
Find your activation code(s) on the Fulfillment Confirmation slips
that comewith your Installation Kit.

Products
If you enter a successful activation code, the name of the product
appears in this pane. You can enter the activation codes for multiple
products and then activate all of them at once.

Information message
For customers who use payroll forms, this message provides a link
to installation instructions for payroll products. SeeW2-1099 or
Payroll Compliance.

Help Launches Program Help.
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Item Description

Activate Activates products listed in the Products pane.

Close Closes the Activation Codes dialog box.

If ATX DVDDoesn't Start Automatically
If you insert the ATX DVD and the installation doesn't start automatically, follow these steps:

1. Open theWindows Start menu and enter Run in the Search field.
2. In the Run dialog box, type X:\Startup.exe (where X = your DVD-ROM drive).
3. Click OK.

Using ATX on a Network
Working in a networked environment is an efficient way to share data amongmultiple users while ensuring the security of the
data in your network. Although there are a few restrictions, there are also someways that you can customize your
workstation without affecting other network users.

Customize Your NetworkedWorkstation

The following settings are stored on a per user basis, so you canmake changes without affecting the work of other users:

l Marking returns in any main manager. A user canmark some returns; then, if he/she logs into a different
workstation, he/she will see the same returns marked.

l Column sizing and re-positioning: You can change the size or position of any main or setupmanager without
affecting how it looks for other users. See Customizing Managers for more information.

Network Users Must Log in

All network users must have their own, unique user name in the system. This means several things:

l Each network can only have one Admin user.
l All network users must be set up in Security Manager (the Admin user is already set up by default). See Adding
Users to the System for more information.

l All network users will log in every time they open the application. See Logging In for more information.

Restrictions

You are restricted from doing the following if you're a networked ATX user:

l Users cannot log in on more than one workstation at a time. Users who share a User Namewill not be allowed
to login to the application at the same time.

l Returns can only be open by one network user at a time. A Locked Returnmessage tells you the name of the
user and the workstation ID where the return is open. This prevents overwriting of information.

l Only one user at a time can transmit e-files or process acknowledgements (Acks) through the EFC. A dialog
box appears telling you the name of the user who is already processing.

l Returns cannot be deleted if they're open by another user.
l Extensions. You cannot create or print an extension for an open return. Close the return and try again.
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Network Troubleshooting Tips
If you received a Network Server Not Complete message, follow the tips in this topic.

Unable to locate the ATX Tax Server

If the system can't automatically locate the server, check the following:

1. Have you installed ATX on the server yet?
l If no, youmust install on the server first before adding network workstations. See Network Server Installation
for complete instructions.

l If yes, go to Tip 2.
2. Did the server install successfully?

l If no, reinstall the server. (Check the server's Program Data and Program Files folders for ATX 2017 folders.
Delete these if found, then follow instructions in Network Server Installation to re-install ATX on the server.)

l If yes, refer to instructions in Adding a Server. From the Add ATX Tax Server dialog box, you can search for
the server by computer name. If the server is found, your network setup will continue.

3. If the server still cannot be found, reboot (restart) the server.
l Follow instructions for Adding a Server. If the server is found, setup will continue.
l If the server is still not found after the reboot, go to Tip 4.

4. Are the server and the workstation you are configuring on the same network?
l If no, contact an IT professional to assist.
l If yes, try instructions again for Adding a Server.

Server Connection Error

If the ATX program loses connection with the ATX server, youmay receive a server connection error:

This error can occur on networked workstations or on stand-alone systems.

If you receive this error, click Retry to restart the server.

If this does not resolve the issue, contact ATX Support.

Uninstalling ATX
To uninstall ATX, youmust uninstall both the ATX program as well as the ATX server from the Programs and Features folder
in your system's Control Panel. It's important to note that your data is not removed from the system during this process; it
remains intact and will be visible if you reinstall ATX.
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If you need to perform a complete uninstall (which would include uninstalling or removing the database from your
system), you should contact ATX Support for assistance.

Part 1: Uninstalling the ATX 2017 Program
To uninstall ATX:

1. Click theWindows® icon and select Control Panel.
2. Select Programs and Features.

For ATX, you'll see ATX 2017 and ATX Server 2017.

3. Right-click ATX 2017 in the program list.
4. Click Uninstall.
5. Click Yes.

Part 2: Uninstalling the ATX Server 2017
1. Click theWindows icon and select Control Panel.
2. Select Programs and Features.
3. Right-click ATX Server 2017 in the program list.
4. Repeat Steps 4 and 5 above.

Uninstalling ATX does not uninstall the CCH Browser Search plug-in.

W2-1099 or Payroll Compliance
If your ATX product bundle includes a payroll product, the payroll product must be installed (downloaded) separately. Most
customers will install it from theMyATX Support Center website.

The activation code for yourW-2/1099 or Payroll Compliance product is printed on your Fulfillment Confirmation Slip,
along with your ATX activation code. Make sure to enter the payroll code when downloading the payroll product from the
website.

Installing from theWebsite
To install either the W-2/1099 or Payroll Compliance products from the website:

1. Enter www.MyATX.com in yourWeb browser.
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2. Under Preparer Solutions, click Download Center.

3. From themenu items on the left, select ATX Payroll Program.
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4. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
5. Enter your User Name in the User Name box and press the Tab key.
6. Enter your Password in the Password box.
7. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
8. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
9. Click Log In.

10. Click Download.

A dialog box appears, asking you if you want to Run, Save or Cancel the installation.

11. Click Run to install to the current workstation.
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The installation begins and the License Agreement appears.

12. Click I Accept to indicate that you accept the terms of the License Agreement.

13. Enter yourW-2/1099 or Payroll Compliance activation code from the Activation/Installation Code box.

The product name appears in the Products pane.

14. Click Next.

15. Select an installation type:
l Standard Installation - click Details for Standard to see what's included. Select this for Stand-Alone
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installations.
l Custom Installation - click Details for Custom to see what's included. Select this for Network installations.

Do not install theW-2/1099 or Payroll Compliance product to the same folder as ATX™ 2017.

The Product Setup dialog box shows the progress of the installation.

16. To open the application, click Start.

17. To receive the latest version of the forms as well as the program, click Update Now.

Installing from aDVD
To install either the W-2/1099 or Payroll Compliance products from a DVD:

To install either theW-2/1099 Payroll Compliance products from aDVD, insert the DVD provided in your product shipment
into the DVD drive. If the program does not start automatically:
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1. Click theWindows Start button and type Run in the field.
2. In the Run dialog box, type X:\Setup.exe (where X = your DVD-ROM drive).
3. Click OK.

RunningW-2/1099 or Payroll Compliance on a Network
To run eitherW-2/1099 or Payroll Compliance on a network, you'll need to:

l Share the product installation folder to all workstations before running NetSetup on all the workstations. For folder
permission and sharing instructions, contact your network administrator.

l RunNetSetup on your workstations.
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Contact Us
Are you evaluating ATX?

Thank you for your interest! To order ATX products or for assistance choosing the right products for your firm, contact
one of our Software Consultants at 1-877-728-9776 or at SFS.Sales@wolterskluwer.com. Software Consultants are
available Monday through Friday, 8:30 AM to 6:00 PM Eastern Time.

Have you purchased ATX?

Whether you need technical support or the answer to a simple question, we offer a variety of ways to get your
questions answered.

l Fax
l Phone Support
l Community Forums - Talk to Us, Talk to Each Other
l Online Support
l MyATX Solution Center
l Using the ATX Knowledge Base
l ATX Communities
l Support Web Sites
l Customer Service Utilities

Fax
Send your questions (include screenshots if necessary) to the following number, so we can best assist you (be sure to
include Attention: Customer Care on all faxes):

l 1-888-815-7587
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Phone Support
For complete details on hours of operation both on and off-season, visit our Contact Us page by entering
https://www.cchsfs.com/contact/ in yourWeb browser.

l MAX Customers 1-800-638-8291

PRS Only
l PRS Customers 770-857-5602

Information YouMay Need
In some cases, a Customer Care representativemay ask you for your ATX program version number, as well as your Client
ID. Youmay also need to provide your installation type (stand-alone or network) and the computer path where ATX is
installed.

To access this information:

1. From any of theMain Managers, click the Support menu.
2. Select About.

The About ATX dialog box appears. The Copyright tab provides the Program Version as well as your Client ID:

The Copyright tab is displayed by default. The License, Programs, Version Info, and Additional
Information tabs provide further details.

Community Forums - Talk to Us, Talk to Each
Other
Our ATX Communities are a great way to ask questions and to exchange knowledge with us and other tax professionals. See
ATX Communities.
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Online Support
If you need technical assistance, be sure to use our online support available 24 hours a day at www.MyATX.com. You will be
able to find answers tomany of your questions.

Even More Online Resources
See the following topics to find out more about these resources:

l MyATX Solution Center
l Using the ATX Knowledge Base
l Support Web Sites

MyATX Solution Center
The Solution Center, accessed by enter www.MyATX.com in your web browser, is the starting point for a wide variety of
information and activities. It allows you to quickly access many tasks without logging in such as:

l Latest News
l Knowledge Base (Knowledge Library)
l ATX Blog
l Education Library
l ACA Resources
l Download Center
l System Requirements
l Shipping Schedule
l ATX Forms Schedule
l E-file Availability
l Calendars and Charts
l TeamViewer-Remote Utility
l CCH® IntelliConnect® Research
l National Tax School
l Protection Plus
l iTransact
l Staples Advantage
l Versicom Communications
l Banking Partners
l NATP

Using the ATX Knowledge Base
The ATX Knowledge Base is a valuable tool for all users. It contains answers to themost frequently-asked questions as
well as critical and timely information from the IRS and other agencies.
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To access the ATX Knowledge Base visit https://support.cch.com/sfs or click Knowledge Base from the support site.

Searching the Knowledge Base
To search the Knowledge Base:

1. In the Search box enter keywords, or you can enter a question like How can I pay my invoice?.
2. From the Apply Search To box click the "x" to clear the existing product selection, and then use the drop-down

feature to select a product.

Selecting a product from the Apply Search To box narrows your search results.

3. Click Search or press Enter.
4. Select an answer from the list or use the filters to narrow down your search.

Knowledge Base Entries

The pages that appear in your search results resemble a typical results page from any search engine (such as Google). Click
the desired answer(s) for more information on a particular topic.

To search within the summaries on a page of results, press Ctrl+F on your keyboard, or select Find (on This Page) on your
browser's Edit menu. Enter a term you expect to find in the search box. Find will take you to each occurrence of that term.
Click Find Next to move to the next occurrence.

ATX Communities
ATX Communities are online forums where you can discuss issues and ideas with your fellow ATX users. CCH SFS staff
monitors the forums and participates in discussions.

Getting Started
To get started, youmust first establish a Community Name.

To establish a Community name:

1. Visit www.MyATX.com.
2. Under Preparer Solutions, click Community Board.
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The Client Login page appears.

3. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key.
4. Enter your User Name in the User Name box and press the Tab key.
5. Enter your Password in the Password box.
6. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
7. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
8. Click Log In. MyATX displays the ATX Communities page.

9. Click Add Community Board Name, enter the name you wish to use and click Change Community Board
Name.

10. Click Go to ATX Communities.
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Support Web Sites
From the Support menu, you can access several helpful IRS and CCH Small Firm Services Web sites, including:

l BizFilings Business Services
l Check IRS Refund Status
l IRS Home Page
l IRS E-Services
l ATX Tax Products
l ATX Paper Products
l ATX Home Page
l MyATX Solution Center
l ATX Knowledgebase (Knowledge Library)
l ATX Blog

Checking the IRS Refund Status
From within ATX, you can check the IRS refund status of any return. The system displays a dialog box in the upper right
corner of the application with SSN, Filing Status and Refund Amount, if applicable.

To check the IRS refund status:

1. From Return Manager click the Support menu.
2. Expand theWeb Sites fly-out menu; then, select Check IRS Refund Status.

TheWhere's My Refund page of the IRS Web site also opens in a separate window.

3. Using the information in the Refund Information dialog box, follow the directions on theWhere's My Refund page
to determine the refund status.

Customer Service Utilities
There are several utilities built into ATX that enable Customer Service representatives to troubleshoot your issues. They are:

l Sending a Return to Customer Service
l Send Diagnostics to Customer Service
l Send E-file Log to Customer Service
l Synchronizing E-files With the EFC
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Synchronizing E-files With the EFC is only available to users who have permission to Receive
Acknowledgements.

Typically, you would only use one of these features if you're working with a Support representative.

Refreshing Application Configurations
This utility enables you to get updated e-file rules (program files needed to e-file returns) if they're needed before the auto-
update is scheduled to run or if there are issues with the system getting them.

It is one of the Customer Service Utilities (located under the Support menu) that Customer Service representatives use to
help diagnose problems.

To get the most recent e-file rules files:

This utility is available from any mainmanager or from an open return.

1. From the Support menu, select Customer Service Utilities.
2. From the list, select Refresh App Configurations.

The utility will remove your existing e-file rules files and replace them with themost up-to-date files. When the
process is complete, amessage appears telling you that your e-file rules configuration was successfully refreshed.

3. Click OK on this message.

Sending a Return to Customer Service
Occasionally, it may be necessary to send a return to Customer Service for troubleshooting.

To send a return to Customer Service:

1. From the Return Manager, select the return you wish to send to customer service.
2. Click the Support menu, expand the Customer Service Utilities fly-out menu; then, select Send Selected

Return To Customer Service.

3. Enter the incident number (provided by your Customer Service representative).
4. Click Send.
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5. Click Continue to finish.

After a brief delay, your Customer Service representative will be able to import the return you've sent and begin
troubleshooting. Please be prepared to walk the representative through your particular issue.

Send Diagnostics to Customer Service
Occasionally, it may be necessary to send diagnostics information to Customer Service to help with troubleshooting.

To send diagnostics information to Customer Service:

1. From Rollover Manager, E-file Manager, Bank Manager, or from an open return, click the Support menu.
2. Expand the Customer Service Utilities fly-out menu; then, select Send Diagnostics to Customer Service.

3. Enter the incident number (provided by your Customer Service Representative).
4. Click Send.

5. Click Continue.

After a brief delay, your Customer Service representative should receive the diagnostics file and begin troubleshooting.
Please be prepared to walk the representative through your particular issue.
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Send E-file Log to Customer Service
Occasionally, youmay need to send an E-file Log to Customer Service to help with troubleshooting.

To send an E-file log to Customer Service:

1. From any mainmanager or from an open return, click the Support menu.
2. Expand the Customer Service Utilities fly-out menu; then, select Send E-file Log to Customer Service.

3. Enter the incident number (provided to you by your Customer Service Representative).
4. Click Send.

5. Click Continue.

After a brief delay, your Customer Service representative should receive the e-file log and begin troubleshooting. Please be
prepared to walk the representative through your particular issue.

E-file Transmission Log

Data from every e-file transmission and acknowledgment is automatically consolidated into a .ZIP file, which, as a whole,
represents the transmission log. When you use the Send E-file Log to Customer Service function, the .ZIP file is
transferred to your Customer Service Representative.

Synchronizing E-filesWith the EFC
The Synchronize E-file Info with EFC feature updates e-file statuses and acknowledgement histories. It is one of the
Customer Service Utilities (located under the Support menu) that Customer Service representatives use to help diagnose
problems. You should only use this feature if requested to do so by a Customer Service representative.

Only users who have permission to receive acknowledgements have permission to sync with the EFC.
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To synchronize e-file information:

1. From Rollover Manager, E-file Manager, Bank Manager, or from an open return, click the Support menu.
2. Expand the Customer Service Utilities fly-out menu; then, select Synchronize E-file Info with EFC.

3. When the synchronization is complete, click Close.

The status of each return listed on the E-file Manager now matches the status for that return on the e-file servers.

70



Chapter

4

Administrative Tasks
The Admin user is generally the individual in the organization who has complete system rights. This includes the right to
add new users to the system and to grant all users their particular levels of access in addition to other preparatory tasks,
including:

l Adding Preparer/ERO Information
l Rollover Returns from Last Year
l Billing Manager
l Print Packets
l Client Communication Manager

This chapter includes information on:

l Adding Users to the System
l Creating a New Security Group
l Resetting the Admin Password
l Editing Return Passwords
l Removing a Return Lock
l Admin Console
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Setting Up the Admin User
If you're the office administrator, set yourself up as the Admin user with Administrative group actions. SeeModifying a
User's Security Profile.

You cannot change the default Admin user name or alter the Admin user's rights. You can, however, do the following:

l Reset the Admin user's password. See Resetting the Admin Password.
l Create a new user with Administrator group privileges. See Adding Users to the System.

Changing User Access and Passwords
The Admin user also has authority to change user access and privileges in the system:

l Modifying a User's Security Profile
l Deleting Users from the System

Changing File and Backup Locations
The Admin user can change the location where your tax preparation data is stored as well as the backup location for your
entire system:

l Changing Your File Storage Location
l Changing Your Backup Location

Manual Backups and Copying Backups to Local
Storage
Although the automatic Backup and Files Preferences is the recommended backupmethod, amanual Backup feature is
available as ameans of copying backup data to a local storage device (such as a flash drive). SeeManual Backup.

Initial Login and Setting Update Preferences
ATX requires login credentials for all users. The first time you access ATX, your office administrator must establish a
password for the Admin user and select update preferences.

To login and select update preferences:

1. Double-click the ATX icon on your desktop.
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2. The User Name field defaults to Admin. Youmust first establish a password for the Admin user in order to access
ATX.

Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

3. (Optional) Select the Remember User Name check box to have your User Name automatically populated when
you launch the application from this workstation.

4. Click Login.

5. Do one of the following:
l Click Continue to update forms per current Updates Preferences settings.
l To view or change current Updates Preferences settings prior to updating, click Adjust form update
settings.
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Subsequent Login and Update
After your initial login, the program remembers your Updates Preferences; you will not have to select them again, unless
you want to change them. With subsequent logins, the system immediately launches the Update function and downloads
forms and/or program updates according to your Preferences.

Adding Users to the System
Each user must have a unique User Name and Password. The Admin user sets up User Names and Passwords
in Security Manager.

Passwords are required and provide extra security. They are setup by the Admin user when adding new users to the system.

ATX includes user licensing with each product package, for each standalone or workstation installation that is
activated, a user license is required. Should you need additional user licenses, please contact your Account Manager at
1-877-728-9776.

Only the Admin user or users with Security Manager rights may access Security Manager.

To add a new user:

1. Click the Tools menu; then, select Security Manager.

2. Click New.
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3. In the User Name field, enter a user name (up to 20 characters).
4. In the Password field, enter a user password.

Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

5. In the Available groups pane, select the group to which the new user will be assigned.

See Default User Names and Groups.

6. Click Add --> tomove the selected group to the Assigned Groups pane.
7. Click OK.

Creating a New Security Group
If the default security groups do not meet the needs of your business, you can create your own custom group.

Only the Admin user or users with Security Manager rights may access Security Manager.

To create a new security group:

1. Click the Tools menu; then, select Security Manager.
2. Click the Groups tab.
3. Click New.
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4. In the Group Name field, enter the name of the new group.
5. In the Description field, enter a description for the new group.
6. To associate a set of actions with the group, do one of the following:

l Select the desired action(s) in the Available Actions pane; then, click Add --> tomove the selected action(s) to
the Group Actions pane.

l Click Add All --> to move all Available Actions to the Group Actions pane.
l Double-click desired actions in the Available Actions pane (one at a time) to move them to the Group Actions
pane.

7. Click OK when all desired actions for the new group appear in the Group Actions pane.

To remove an action from a group:

1. Do one of the following:
l Select the desired action(s) in the Group Actions pane; then, click <-- Remove tomove the selected action(s)
to the Available Actions pane.

l Click <-- Remove All to move all Group Actions to the Available Actions pane.
l Double-click the desired action(s) in the Group Actions pane (one at a time) to move them to the Available
Actions pane.

2. Click OK when all actions to be removed from the group appear in the Available Actions pane.

Resetting the Admin Password
If the Admin user gets inadvertently locked out of the system or forgets the Admin password, the Reset Admin Password
function can be used to reset the password.

To reset the Admin password from the Login screen:

1. Click the Reset Admin password link.
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2. Enter the ATX product activation code from the Fulfillment Confirmation Slip that was shipped with the product.

The activation codemust be entered correctly or the password fields will remain disabled.

3. Enter the new password under the activation code. For password guidelines, see Login and Password
Requirements.

4. Re-enter the new password in the bottom field.
5. Click Reset Admin Password.

Resetting a Locked User Account
When a user account becomes locked, the administrator (Admin user) must log in and reactivate the user in the system.
While the user will no longer be able to access the system, the system will still have the user name's setup information. This
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is a particularly useful security feature for businesses that have repeat seasonal employees, such as seasonal tax preparers.

Only the Admin user or users with Security Manager rights may access Security Manager.

To reactivate a user's profile:

1. Click the Tools menu; then, select Security Manager.

2. Click the user whose profile you want to unlock.
3. Click Modify.

4. Check the Active check box.
5. Enter a new password in the Password field.
6. Click OK.
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Editing Return Passwords
Individuals with Admin rights can establish an extra level of security for a return by creating a return password. A user must
know the current password for the return if a user wants to edit or delete the return. See Login and Password
Requirements.

If the password is unknown, only the Admin user (or a user with Administrative security rights) can edit or remove a return
password.

To edit a return password when you don't know the current password:

1. In the Return Manager, select the return whose password you need to edit.
2. Click the Options menu and expand the Administration fly-out menu; then, select Edit Password for Selected

Return.

3. To set a new password, enter the new password in the Enter a new password field.
4. Enter the password again in the Re-enter new password field.
5. Click Save.

To remove a password from a return:

1. Follow steps 1 and 2 for editing a password, above.
2. Leave the Enter a new password and Re-enter a new password fields blank.
3. Click Save.

Removing a Return Lock
Whenworking over a network, the system ensures that only one user can have a return open at any one time by locking the
return while it is opened. The Admin user can remove the lock, if necessary.

Only the Admin user or a user with Security Manager rights can access the Administration menu item.

If you try to open a return that is being viewed on another workstation, you will receive a warning stating that the return is
locked and which workstation has that return open. If, for whatever reason, the return cannot be closed on the workstation
that has the return locked, the Admin user may unlock the return.
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To remove the lock on a return:

1. In Return Manager, select the locked return.
2. Click the Options menu and expand the Administration fly-out menu.
3. Select Remove Lock for Selected Return.

4. Click Remove Lock.

Admin Console
The Admin Console helps the Admin user perform activities relating to the ATX system and/or ATX server. Whether you’re a
stand-alone user or a network Admin user, you should familiarize yourself with the new Admin Console.

What can you do in Admin Console?
The Admin user can perform the following tasks in the Admin Console on the File Settings tab:

l Find storage and backup locations/paths.
l Change the default backup location/path for the system. See Changing Your Backup Location.
l Change the storage location of your working tax prep data. See Changing Your File Storage Location.

Using a third party backup product (Carbonite, Mozy, Backblaze, and AmazonGlacier) may require you to
change your backup location to a location the third party product can access. See Changing Your Backup
Location.

On the Server Settings tab, Admin users can start or stop the ATX server (if needed, when working with Technical Support).
See Starting or Stopping the ATX Server.

Accessing the Admin Console
You can get to the Admin Console whether ATX is open or closed:

l If ATX is open, go to the Support menu; select About; then, click the Admin Console link.
l If ATX is closed, navigate to Start\All Programs\CCH Small Firm Services\ATX 2017\ATX 2017 Admin
Console
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The Server Settings tab provides the location of your physical address of the computer that is your ATX server,
and displays the server status and port numbers.

The File Settings tab displays the Storage Locations for your File Server and Backup/Restore Server. These
default locations may be changed by browsing to another location.
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ATX Server and the Stand-Alone Environment
Youmay be wondering, “Why is there a server if I am on a stand-alonemachine?” The simple answer is that even if you’re on
a stand-alonemachine, your system has two components: the ATX 2017 application, and the ATX 2017 server. The
server, while not residing on a separatemachine, still functions like a network server in that it stores data and feeds it to the
application as needed.

Server Errors on Stand-Alone Systems

Even on a stand-alonemachine, you can get a server error. The reason is that standalone systems aremore likely to
experience “sleep” or “hibernation” periods during which the connection between the ATX server and the ATX application
stops. Normally, when the system “wakes up,” the connection is automatically re-established, but there are occasions when
the system has trouble reconnecting. A simple “start/stop” routine usually revives the connection.

Starting or Stopping the ATXServer
Youmay be asked to start or stop the ATX Server by an ATX Technical Support Representative if you experience server-
related issues. These instructions will help you to follow along if you are directed by a Support Representative to start or stop
the server while troubleshooting your issue.

1. Do one of the following to open the Admin Console:
l If ATX is open, go to the Support menu; select About. Then, click the Admin Console link.
l If ATX is closed, navigate to Start\All Programs\CCH Small Firm Services\ATX 2017\ATX 2017 Admin
Console

The Server Settings tab provides the location of your physical address of the computer that is your ATX server,
and displays the server status and port numbers.

2. Under the Status column, right-click in the row for the server you want to start/stop.
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3. Select the following:
l Click Start to restart the server.
l Click Stop to stop the server.

4. Click Close.
5. Restart ATX.

Changing Your Backup Location
You can change the default backup location for your entire system database, including your returns. This task is reserved for
the Admin user.

IMPORTANT! If you are using an external hard drive as your new backup location, the external drivemust be
physically connected to the server.

Using a third party backup product (Carbonite, Mozy, Backblaze, and AmazonGlacier) may require you to change
your backup location, to a location the third party product can access.

CCH Small Firm Services does not provide technical support for third-party backup products.

To change backup locations:

1. Do one of the following:
l If ATX is open, go to the Support menu; select About; then, click the Admin Console link.
l If ATX is closed, navigate to Start\All Programs\CCH Small Firm Services\ATX 2017\ATX 2017 Admin
Console
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The Server Settings tab provides the location of your physical address of the computer that is your ATX server,
and displays the server status and port numbers.

The File Settings tab displays the Storage Locations for your File Server and Backup/Restore Server. These
default locations may be changed by browsing to another location.
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2. Click the File Settings tab.
3. Click the Browse button under Backup/Restore Server to navigate to and select a new backup location.

The storage location cannot be changed on a network workstation.

The new backup pathmust be a physical drive on the server or a fully-qualified universal naming convention
(UNC) path to another location on the network. If you use amapped drive for backups, it must be converted to
a fully-qualified UNC path. For detailed information, see theMicrosoft article on Naming Files, Paths and
Namespaces.

The new location will only be used for backups created after the change was applied. Existing backups will not
bemoved to the new location automatically. If you want existing backups to be stored in the new location, the
files must bemovedmanually. SeeManually Moving Files to a New Location.

4. Click Close.
5. Restart ATX.

These locations can also be changed on the Backup and Files Preferences tab of the Preferences dialog box.

Changing Your File Storage Location
ATX stores your tax preparation files in an area on your ATX server, separate from the application. If you have a stand-alone
setup and are wondering about the ATX server, see ATX Server and the Stand-Alone Environment.

While you cannot change the installation location of the application, you can change where your data is stored, if desired.

For example, if you have an extremely large number of returns, companies, payers, or billing rates, youmay want to locate
the storage on a larger or faster computer.

The file storage location is where your actual returns and associated data will be stored and accessed by the
workstations. This is not where backups of your returns are stored. Backups are stored separately under a Backup
folder on your ATX server. To change your backup location see Changing Your Backup Location.

The Admin user typically changes the file storage location, if required.

To change your file storage location:

1. Do one of the following:
l If ATX is open, go to the Support menu; select About; then, click the Admin Console link.
l If ATX is closed, navigate to Start\All Programs\CCH Small Firm Services\ATX 2017\ATX 2017 Admin
Console
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The Server Settings tab provides the location of your physical address of the computer that is your ATX server,
and displays the server status and port numbers.

The File Settings tab displays the Storage Locations for your File Server and Backup/Restore Server. These
default locations may be changed by browsing to another location.
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2. Click the File Settings tab.
3. Under the File Server section, click the Browse button to select a new path for the Storage Location field.

The new location will only be used for data created after the change was applied. Existing data will not be
moved to the new location automatically. If you want existing data to be stored in the new location, the files
must bemovedmanually. SeeManually Moving Files to a New Location.

The storage location cannot be changed on a network workstation.

4. To save, click Close.
5. Restart ATX.

These locations can also be changed on the Backup and Files Preferences tab of the Preferences dialog box.

Manually Moving Files to a New Location
Backups and files created prior to changing a backup or file storage location will not bemoved to the new location
automatically. If Backup and/or File Storage locations are changed, any files previously stored in the default locations must
bemovedmanually.

To manually move your existing backups and files to a newly designated location:

1. After the Backup and/or File locations have been changed, close ATX.
2. Navigate to the ATX 2017 Server. Existing Backup files are stored in the ATX 2017 Backup folder and Data files

are located in the ATX 2017 Files folder.

The default location is \ProgramData\CCH Small Firm Services\ATX 2017 Server.

3. Open the ATX 2017 Backup folder or the ATX 2017 Files folder, depending on which files are beingmoved.

Do not copy/move the entire folder.

4. Press Ctrl+A to select all files within the open folder, and then press Ctrl+C to copy all selected files.
5. Browse to the newly designated location and open the ATX 2017 Backup folder or the ATX 2017 Files folder,

depending on which files are beingmoved.
6. Press Ctrl+V to paste the copied files into the open folder.

Do not copy or remove the DataStore folder from the ATX 2017 Server folder. Doing so will result in
undesirable conditions/behavior in ATX.
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User Interface
The basic views that make up the ATX user interface give you an easy way tomanage your returns and supporting
information.

The three basic views in ATX are:

l Manager View
l Open Return View
l Diagnostics Pane

The application also provides a different "at-a-glance" view of the return information called Easy View.

Other features of the interface include:

l Main Managers
l Setup Managers
l Manager Pane
l Filters
l Toolbars
l Open Return Interface
l Progress and Results Dialog Boxes
l Zooming In and Out
l Messages and Warnings
l Refund Meter
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Manager View
Many of themanagers in the system present their data in a spreadsheet-like view, shown below.

When you're in most managers, you will see a list of the items that are available. For example, when you're in the Return
Manager, you will see a list of returns. In Rollover Manager, you will see a list of returns waiting to be rolled over to this
year's product. In E-file Manager, you will see a list of e-files.

In addition to theMain Managers, several Setup Managers helpmanage the data you use in the system, such as
preparers, companies, and payers. However, all theMain Managers in ATX are designed similarly, and provide you with a
view similar to what you see below.

See Security Manager, Billing Manager and Client Communication Manager for an explanation of their
interfaces and function.

TheManager View is made up of the following areas:

Manager Tabs
Eachmainmanager (Return Manager, Rollover Manager, E-file Manager, and Bank Manager) has it's own tab. Tabs
also appear above the application for each return you've opened. You can open up to three returns at a time.

Menus
Menus will change, depending upon themanager you select.

Toolbar
Likemenus, available buttons on the toolbar will change, depending upon themanager that is selected.

Manager-Specific Tabs
Somemanagers have secondary tabs or views. They often provide a subset of the selectedmanager's data.
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Filters
Filters help you sort data, narrowing your search for a specific return, e-file, or whatever type of data you want to view.

Manager Pane and Pagination Controls
TheManager Pane is where all the items contained in themanager are displayed. The pane works like web searches work.
If more items are in themanager than can be displayed on the screen, you can view multiple "pages" of information.

Scroll bar
The scroll bar allows you to scroll up or down in order to view information that is off screen.

E-file Information Pane
This small pane below theManager Pane shows e-file information for the last selected or highlighted return.

Open Return View
TheOpen Return View is what you see when a return is open. Although you can have three returns open simultaneously,
you can only view one at a time.

Form, Schedule andWorksheets tabs
The forms, schedules, and worksheets that you add to the return appear as tabs to the left of the return by default; see Open
Return Preferences.

Pages andWorksheet tabs
The Pages andWorksheet tabs at the bottom of the return represent the separate pages and areas for the form, schedule or
worksheet that's currently open.
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Diagnostics Pane
The Diagnostics pane, displays at the bottom of the screen in an open return. The Diagnostics pane helps you during the
following tasks:

l Check Return - when you're checking the return for errors.
l E-filing - when you need to check the return for e-filing specific errors.

When changes aremade after an e-file has been created, the returnmust be re-checked. Upon rechecking a
return, the Re-Check button changes to Re-Create E-file, allowing you to recreate the e-file to reflect the
changes that weremade.

Easy View
The Easy View feature is simply a different view of what you would normally see in the Return Manager. We call it Easy
View because it provides more of an "at-a-glance" view of the return information. You can view the Accounts Receivable
Tab and the Tax Warehouse Tab as well. Simply click the Easy View button on the toolbar to toggle back and forth
between Easy View and the standard Return Manager View.
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Use Easy View just like Return Manager. You can domany things in Easy View that you do in Return Manager, such as:

l Creating Returns
l Opening Returns
l Duplicating Returns
l Deleting Returns
l View Returns Tab, Accounts Receivable Tab and Tax Warehouse Tab information.

Main Managers
Themainmanagers, which are located as tabs at the top of the program window, help you organize specific tax preparation
tasks. Each of themanager tabs includes one or more view tabs, which appear below the toolbar. These tabs separate the
general information displayed by a particular Manager into more specific categories.

ReturnManager
The Return Manager displays information about your clients, their returns, and your firm's billing information.

Rollover Manager
The Rollover Manager lists returns that can be rolled over from last year or from a prior month or quarter.

E-file Manager
The E-file Manager handles all e-filing tasks, helping you track the status of your e-filed returns.

Bank Manager
The Bank Manager handles all tasks associated with providing bank products, as well as providing reports to assist you in
reconciling bank product fees.

The tabs representing open returns also appear at the top of the application (alongside Return Manager, E-file
Manager, and Bank Manager). SeeOpen Return Interface.

Setup Managers
The followingmanagers are generally used to help you set up information to be loaded intomultiple returns. Thesemanagers
are available under the Tools menu.
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Preparer/ERO Manager

Use the Preparer/ERO Manager to establish a list of paid preparers in your firm, along with the information that must be
included in any tax return’s Paid Preparer section.

Company Manager 

The Company Manager retains core information for companies, such as EIN, address, and state ID. This databasemakes
preparingmultiple returns for the same company faster andmore accurate. By default, companies are automatically added to
this repository when they are entered directly into returns.

Payer Manager

The Payer Manager is the database that retains core information for payers. By default, payers are automatically added to
this repository when they are entered on Input Worksheets and Detail Schedules.

Security Manager

The Security Manager enables the Admin user to set up users and passwords and to grant and/or restrict rights to specific
features within ATX.

Billing Manager

The Billing Manager allows you to set up rates for specific tax forms and schedules, flat rates by return type or preparer
and/or hourly billing rates by preparer. Rates entered appear on the billing invoice, which can be attached to returns like any
other form.

Client Communication Manager

The Client Communication Manager houses the Custom Client Letter functionality.

Manager Pane
TheManager Pane is the portion of the User Interface where all the items contained in themanager are displayed. Whether
you're working in a "top-level" manager (such as Return Manager) or a "secondary" manager (shown under the Tools menu,
such as Payer Manager), themanager grid functions the same, and allows you the same level of user control.

Users Adjust Columns to Meet their Individual Needs

All ATX managers display data in a spreadsheet format. Just like in any otherWindows spreadsheet program, you can
rearrange or resize columns to suit your individual needs. Manager customizations are stored on a per user basis. If you're
one of several users on a network, the customizations youmake will not affect how managers look for other network users.

In addition, your column adjustments will be saved as you exit themanager. The next time you open that manager, your
adjustments will still be there.
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SeeCustomizing Managers.

Pagination Controls Allow You to Page Through the Data

The items that appear in the search are based on the current Filter settings. See Filters.

In Top-Level Managers

Pagination controls are available on theManager Panes of the following top-level ATX managers:

l Return Manager
l Rollover Manager
l E-file Manager
l Bank Manager

In top-level managers, users can choose to display 50, 100, or 500 (default) items per page.

In SecondaryManagers

Pagination controls are also available in the following secondary-level managers:

l Preparer/ERO Manager
l Company Manager
l Payer Manager
l Enrollment Manager

In secondary-level managers, users can choose to display 10 (default), 50, or 100 items per page.
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How to Use Pagination Controls:

To do this... ...see this Lettered area... ...and do this.

Change number of items
appearing on a page

A

Click the down arrow in A andmake another
selection. Note that options are different for
top-level managers than for secondary
managers.

Go to first item in search/Previous
page

B Click multiple arrows/Click single arrow

Go to next page/Go to last item in
search

D Click multiple arrows/Click single arrow

View number of pages of data C
Enter a page number and press Enter and
ATX takes you to the corresponding page.

View number of total items in
search

E n/a
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Filters
Filters help you sort data, narrowing your search for a specific return, e-file, or whatever type of data you want to view.

All Main Managers contain filters. The filters are different in eachmanager.

To use filters to narrow the list of data in the view, select the check box for the category of data you want to view. You can
select as many filters as you want. The list will narrow immediately according to your selection.

Using the keyboard to navigate from one filter to another:

l Use Tab and Shift+Tab keys tomove forward and backward from one filter to another
l Use the Up Arrow and Down Arrow keys tomove from one filter group to another
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Find filter
Use the Find filter (and corresponding field) as you would use the Search field in other applications.

To find a return with the Find filter:

1. Select the Find check box.
2. In the empty field, enter some defining information.

For example, if you only wanted to view returns containing LLC in the Return Name, it would look like this:

Clear Filters button
A manager-specific Clear Filters button appears at the bottom of every filter pane, allowing you to revert to the complete list
of returns, e-files, preparers, or other data you're viewing.

Toolbars
The product displays most frequently-used functions in a toolbar at the top of the application. The toolbar is made up of a
series of buttons that, when clicked, will prompt key functionality. Depending on the selectedmanager (such as Return
Manager, Rollover Manager, E-file Manager or Bank Manager), different toolbar buttons will be available.

ReturnManager Toolbar

Toolbar Button Description Shortcut

Open Opens the highlighted or selected return. Ctrl+O

New
Opens the Select Forms Dialog Box, which is the first step in starting a
new return.

Ctrl+N

Delete Deletes the highlighted or selected return. Ctrl+D

Mark All
Selects the check box beside all the returns listed in the Return
Manager.

Unmark All
Deselects the check box beside all the returns listed in the Return
Manager.

Easy View Switches the Return Manager view to Easy View.

Preferences Opens Return Manager Preferences.
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Toolbar Button Description Shortcut

CCH iFirm
Launches CCH iFirm , a solution for your office that assists with office
workflow and your accounting client's needs.

Client Portal
Launches CCH iFirm Client Portal, where you can organize and share
important documents with clients.

ePayment Launches iTransact.com.

Calculator Launches the Calculator. F8

Preparer/ERO
Opens the Preparer/ERO Manager dialog box, which allows you to
enter preparer information in a common data repository so it can be
easily selected during return preparation.

Program
Launches Program Updates. If the button is red, a program update is
available but has not been loaded on your system. If the button is green,
the program is up-to-date.

Forms
Launches Form Updates. If the button is red, form updates are available
but have not been loaded on your system. If the button is green, all forms
are up-to-date.

Help Opens Program Help. F1

Notifications

Launches the ATX Blog, which contains a series of posts about tax-
related events and information that ATX customers need to know. The
Notifications button (present on the toolbar in all Main Managers) is red
when new notifications (blog posts) are available (and have not been
viewed). The button is green when notifications are all up-to-date.

Rollover Manager Toolbar

Toolbar Button Description Shortcut

Rollover
Rolls over any data within the Rollover Manager that has a selected
(marked) check box. This includes any of the returns, or other
administrative data (company, payer, preparer/ERO, forms or hourly).

Mark All
Marks the check box beside all the returns listed in the Rollover
Manager.

Unmark All
Deselects the check box beside all the returns listed in the Rollover
Manager.
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Toolbar Button Description Shortcut

Browse
If your current program is not automatically found (in the default
directory), a Browse for Folder dialog box allows you to browse to the
location on your computer where your returns from last year are stored.

Preferences Opens Rollover Manager Preferences.

Notifications

Launches the ATX Blog, which contains a series of posts about tax-
related events and information that ATX customers need to know. The
Notifications button (present on the toolbar in all Main Managers) is red
when new notifications (blog posts) are available (and have not been
viewed). The button is green when notifications are all up-to-date.

Help Opens Program Help. F1

E-file Manager Toolbar

Toolbar Button Description Shortcut

Open Opens the highlighted or selected e-file.

Transmit Transmits the highlighted or selected e-file(s).

Receive Acks

When the IRS receives a file from you (via our product), it electronically
transmits an acknowledgement (ack) which you can then receive. To
receive acks for one or more returns, mark them and click the Receive
Acks button.

Mark All
Selects the check box beside all the returns listed in the E-file
Manager.

Unmark All
Clears the check box beside all marked returns listed in the E-file
Manager.

Preferences Opens E-file Manager Preferences.

Notifications

Launches the ATX Blog, which contains a series of posts about tax-
related events and information that ATX customers need to know. The
Notifications button (present on the toolbar in all Main Managers) is red
when new notifications (blog posts) are available (and have not been
viewed). The button is green when notifications are all up-to-date.

Help Opens Program Help. F1
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Bank Manager Toolbar

Toolbar Button Description Shortcut

Disbursement Details
Launches the Disbursement Details dialog box which shows details on
the disbursement associated with a particular return, as well as the fees
that are deducted from the disbursement.

Print Checks

If you have internet access, this button automatically opens the CCH
Small Firm Services Client Login. After logging in, you can go to the
Online Check Printing center, where you canmanage and print your
currently available checks.

Ctrl+H

Receive Acks
To receive acks for one or more returns, mark them and click the
Receive Acks button.

Preferences Opens All Managers Preferences.

Notifications

Launches the ATX Blog, which contains a series of posts about tax-
related events and information that ATX customers need to know. The
Notifications button (present on the toolbar in all Main Managers) is red
when new notifications (blog posts) are available (and have not been
viewed). The button is green when notifications are all up-to-date.

Help Opens Program Help. F1

OpenReturns Toolbar
If you have opened a return, you'll see the following toolbar:

Toolbar Button Description Shortcut

Save Saves the open return. Ctrl+S

Add Forms
Opens the Select Forms Dialog Box, which allows you to select
additional forms to add to the open return.

Restore

Only returns that have been backed up using the Backup and Restore
featuremay be restored to the application. Allows you to browse to a
location where your backup returns are stored, and select a return to
restore to the application. Backup returns have the return name prefix
and a .atx17Backup file extension.
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Toolbar Button Description Shortcut

Start Link/Finish Link
Creates a link between fields on a form. Button behaves like a toggle
switch.

Interview Opens the Interviews tool above the return.

Back Moves to the previous form or worksheet that was open. Ctrl+B

Forward
If you havemoved back and forth on several forms within a return, will
move you forward to a form later in the sequence.

Ctrl+Shift+F

Check Return Checks the open return that you're currently viewing.

Print
Launches the Print Return Dialog Box, which allows you to print the
entire return.

Ctrl+P

Page Prints the current page.

CCH iFirm
Launches CCH iFirm , a solutions for your office that assists with office
workflow and your accounting client's needs.

Client Portal
Launches CCH iFirm Client Portal, where you can organize and share
important documents with clients.

E-file
Launches the Create E-file process for the return that you're currently
viewing.

ePayment Launches iTransact.com.

Calculator Opens the Calculator. F8

Preparer/ERO
Opens the Preparer/ERO Manager, which allows you to enter multiple
preparers and their respective information into a common data repository
so they can be easily selected by preparers as they assemble returns.

Tax Research Launches Tax Research in your web browser.

Search Online

Displays a search box where you can type your search criteria and ATX
launches your Internet Browser where you can search using the CCH
Browser Search plug-in. If the plug-in is not installed you are prompted to
install the CCH Browser Search plug-in at this time.

Practice Aids

Provides signature forms, specific elections, flowcharts, worksheets,
checklists, tables, and tools using your Tax Research Login
Credentials entered on the Return Manager tab of the Preferences
dialog box.

Notifications

Launches the ATX Blog, which contains a series of posts about tax-
related events and information that ATX customers need to know. The
Notifications button (present on the toolbar in all Main Managers) is red
when new notifications (blog posts) are available (and have not been
viewed). The button is green when notifications are all up-to-date.

Help Opens Program Help. F1
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Notifications
The Notifications toolbar button gives quick access to the ATX Blog, which is a series of posts about tax-related events and
information that ATX customers need to know.

The Notifications button is red when new notifications are available (and have not been viewed). The button is green when
notifications are all up-to-date. The Notifications button is present on the Toolbars of all Main Managers.

To open the ATX Blog, do one of the following:

1. Do one of the following:
l Click the Notifications button on the toolbar.
l From any mainmanager, click the Support menu; then, expand theWeb Sites fly-out menu and select ATX
Blog.

Open Return Interface
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Forms, Schedules, and Spreadsheets
By default, forms, schedules, or spreadsheets are displayed as tabs to the left of the return

To open a form, schedule or spreadsheet, click the corresponding tab.

To move form tabs to the top of the return:

1. From the open return, click the Tools menu; then, select Preferences.

Open Return Preferences are displayed.

2. Clear the Show the form tabs on the left check box.
3. Click Apply.
4. Click OK.

Pages &Worksheet Tabs and Button
The Pages & Worksheets button is followed by a row of numbered and named tabs. Each represents a page, input sheet,
detail schedule, and/or worksheet in the currently displayed form, schedule, or custom spreadsheet. The arrows (circled in
red) allow you to scroll between all the pages and worksheets in the form.

As an alternative to the tabs along the bottom of the window, click Pages & Worksheets to display all forms and
worksheets from top to bottom.

To scroll up or down, click the up or down arrows.

Several types of tabs can appear at the bottom of a form. Themost likely tabs are numbered, and correspond to actual form
pages. Other tabs can represent:
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l Input sheets
l Supporting schedules
l Worksheets that may or may not be relevant for your client

To open a page or worksheet, click the corresponding tab.

Progress and Results Dialog Boxes
Progress and Results dialog boxes appear during processes that do not happen instantly. The dialog box outlines multiple
steps involved in performing the requested function as well as a progress bar that shows the percentage of completion for the
requested function. While the process is occurring, the progress bar moves and the steps involved in the process are
checked off as they are completed. When the entire process is complete, the dialog box becomes a "Results" dialog box,
showing either successful or unsuccessful results.

Progress and Results dialog boxes appear during the following processes:

l Rollover
l Updates (program and forms)
l Opening a newly created return
l Opening existing returns
l Transmitting information
l Printing
l Importing/Exporting

Progress Dialog Box
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Results Dialog Box

Successful Results

Unsuccessful Results

Zooming In and Out
The Zoom Slider tool, as well as Enlarge and Reduce options, enable you to adjust themagnification of any page on forms,
schedules, or worksheets for the return you have open.

Enlarge/Reduce
The Enlarge and Reduce options adjust the size in 25% increments.

106



Chapter 5: User Interface

To enlarge or reduce the page (form):

1. Do one of the following:
l Click the Tools menu; then, click Enlarge or Reduce.
l Press Ctrl + (+) to enlarge the form or Ctrl + (-) to reduce it.

2. Repeat the previous step until the page is displayed at the desired size.

Zoom Slider
The Zoom Slider (which can be found on the bottom right of each form) allows you to dynamically change the size of the
return from 25% to 200% actual size.

Both features apply only to the screen view; print sizes remain the same. Also, these settings only apply to the current
return, and are not saved when you close the return.

Messages and Warnings
Informational Messages
Informational messages tell you something about the product or process that you're working on. Message boxes aremarked
with either a questionmark or with a blue circle with the "i":

WarningMessages
Warnings often appear when you are in jeopardy of losing data. They bear the red exclamation point symbol:
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Refund Meter
The Refund Meter, located in the upper right corner of an open return, indicates the refund or amount due for the return. This
amount is updated automatically as you enter data into the return.

The Refund Meter is enabled by default.

If the taxpayer owes money, the Refund Meter is red.

If the taxpayer is entitled to a refund, the Refund Meter is green.

If taxpayer owes no taxes, but is due no refund, the Refund Meter is blue.

Click the Refund Meter to open a detailed Tax Summary/Carryover Worksheet for the return.
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6
Getting Started
The purpose of this section is to help you get up and running with ATX as soon as possible. The basic information you
will need to get started can be found in the following topics:

l Government Instructions
l Internet Connection
l Display Settings
l Activating Other Products FromWithin ATX
l Logging In
l Editing Passwords
l Updating ATX
l Form Update Report
l Administrative Tasks
l Setup Checklist
l Help and Support
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Setup Checklist
A thorough and timely setup early on can save you countless hours during the busy season when you need themmost.

Setup Task Instructions in Program Help/User
Guide Done?

Install and Activate ATX Installation and Activation

Define Admin User Password Login and Password Requirements

Update Updating ATX

Confirm Backup and File Storage Locations

Backup and Restore
Backup and Files Preferences
Changing Your Backup Location (required for
most third party products)

Add User Accounts and Passwords Adding Users to the System

Define/Restrict User Tasks and Passwords
Modifying a User's Security Profile
Editing Passwords

Rollover from ATX 2016
Rollover Other Data
Rollover Returns from Last Year

Add/Verify Preparers/EROs
Adding Preparer/ERO Information
Entering an ERO EFIN

Set Up System Preferences Preferences

Set Up Client Letters
Working with the Standard Client Letter
Client Letter Templates

Set Up Billing Rates Setting Up Hourly Rates

Set up Global Print Options Setting Global Print Options

Set Up Print Packets Print Packets

Review Settlement Solution Options and Enroll

Bank Products
FeeCollect™
FeeCollect PS Package
Enrollment Manager

Set up Fees
Bank Product Fees
Setting Up E-file Fees

Customize Managers and Set up Custom Fields
and Forms

Customizing Managers
Customizing Master Forms
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Setup Task Instructions in Program Help/User
Guide Done?

Practice Returns
Preparing Returns
Creating Returns
Adding Forms to a Return

Review E-file Information
Adding Preparer/ERO Information
Modernized E-file

CCH iFirm Setup (if applicable)

Sign In To CCH iFirm
Export Existing Contacts to CCH iFirm
Setup Jobs for Job Status (opens CCH iFirm
help)

Display Settings
Our software is optimized for a screen resolution of 1024 x 768 pixels or better (Super VGA, using standard fonts). Higher
resolutions display screen fonts more clearly and show the full width of our forms. If your current screen resolution is lower
than this recommended setting, you should adjust the resolution.

Change your screen resolution instructions fromMicrosoft.

Many video cardmanufacturers replace the standardWindows display options with customized boxes andmenus. If
your settings do not resemble the examples used by Microsoft, refer to your video cardmanufacturer documentation.

Government Instructions
TheGovernment Instructions feature displays the instructions written by the taxing agency that explain how to complete
federal and state forms.

Government Instructions aremade available in PDF format via the agency Web site (such as www.irs.gov). Youmust
have an active Internet connection as well as an installed PDF viewer (such as Adobe Reader) to view government
form instructions.

Each time ATX is opened, a process runs to determine whether or not Government Instructions have been downloaded to
your machine; if not, you'll be given the opportunity to do so. An updatemessage is displayed if the instructions are not up-to-
date, giving you an opportunity to update.

FromOutside a Return
To access government instructions from outside a return:

1. From any of theMain Managers, do one of the following:
l Click the Support menu; then, select Government Instructions.
l Press F3.
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2. Select the form you want. See Finding Specific Forms.
3. Do one of the following:

l From the PDF column, click the View Instr link.
l Click the View menu; then, select Government Instructions.
l Press F3.

From Inside the Return
To access government instructions for the current form, do one of the following:

l Click the Support menu; then, select Government Instructions.
l Press F3.

The system will detect whether or not you have instructions installed on your system, and whether those instructions are the
most up-to-date.

If Instructions Are Not Installed

Click Check for Form Updates. If the instructions are available, they'll be downloaded to your machine and will open
automatically.
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If Instructions Are Not Current

Click Update. The updated instructions will be downloaded to your machine and will open automatically.

Internet Connection
Themost important e-filing prerequisite is the ability to transmit your data. There are two considerations to keep inmind: 1)
the speed of your Internet connection; and 2) the type of connection.

Connection Speed
Although e-files themselves are not particularly large files by today's standards, over the course of the tax season you will
need to frequently update your program files and the various forms you will be filing. Often, these files are large andmany
users find that a dial-up connection is simply too slow to be practical. We recommend using a broadband connection, such as
DSL or cable.

Connection Type
You can have either a direct connection or a portal connection to the Internet. A direct Internet connection is one in which your
computer uses the standard TCP/IP Protocol to communicate with other computers and access Internet services, such as e-
mail, Telnet, or FTP. While connected via TCP/IP, you can check your e-mail, for example, with any e-mail program you
choose. Your Internet service provider (ISP) does not require you to use its program to access e-mail or other Internet
services.

If your Internet service provider is an Internet portal service, youmay not have access to all Internet services, or youmay be
required to use your provider's software for specific services. In some cases, this software—or limitations imposed by the
provider—may prevent you from transmitting your e-files. If you connect to the Internet through such a service, youmay need
to contact your provider to ensure that their service supports ATX e-file software.

Firewalls
A firewall prevents unauthorized access to and from a network or a stand-alone computer by monitoring and controlling
communication at specific entry points, or ports. A firewall can be a physical device (hardware), a program (software), or
both.

To use ATX software to e-file your returns, youmust ensure that your firewall is configured to allow communication between
your computer and ATX. For many software-based firewalls, this configuration step is simply amatter of adding your
software to the firewall's list of trusted programs (or a similar designation). If your firewall requires specific information about
authorized contacts, enter the following values where appropriate:
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DNS: ws.atxmax.com

Port: 443

If you upgrade your firewall software, youmay need to re-enter this information. Visit
http://www.microsoft.com/security/default.aspx for more information on firewalls.

Activating Other Products FromWithin ATX
If you upgrade your ATX package, you'll need to enter your new Activation Code before the system will recognize your
upgraded status and allow access to any new features youmay have acquired.

If you purchase Additional License packs, ATX Add User License(s) appears in the Product pane. This single entry
covers all your Additional License purchases. To confirm your product purchases, go toMy Products on theMyATX
Solution Center.

To activate your upgraded ATX product:

1. From Return Manager, click the Support menu; then, select Activate Products.

2. Enter activation codes for any additional products you want to activate, then click Activate. If the activation code is
successfully entered, the name of your product appears in the Products pane.

Login and Password Requirements
ATX requires login credentials for all users. The first time you access ATX, your office administrator must establish a
password for the Admin user.
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Your 2016 ATX login password does not carry-forward to 2017 ATX, youmust create a new login password.

To learnmore about your initial access to the system, see Initial Login and Setting Update Preferences.

Each user must have a user account with a User Name and Password. The Admin user sets up User Names and
Passwords in Security Manager.

All users will be required to log in upon opening ATX. To learnmore about accessing the system as a user, see Logging In.

ATX requires you to login after 24 hours of activity or 30minutes of inactivity.

If you click Close ATX on the login page, changes made to open returns will not be saved.

Password Requirements
The Admin user is required to establish user accounts and passwords for all users. Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

Expired Password

Passwords expire every 90 days. ATX provides reminders informing you that your password will need to be reset soon. To
reset your password before the expiration, click Change Password when the password reminder appears. If your password
has expired, use the Edit User Password link on the Login page to change your password.

If the Admin user gets inadvertently locked out of the system or forgets the Admin password, the Reset Admin Password
feature can be used to reset the password. See Resetting the Admin Password.

If a non-Admin user gets inadvertently locked out of the system or forgets their password, the Admin user will use Security
Manager to reactivate and change the password on account. See Resetting a Locked User Account.

Initial Login and Setting Update Preferences
ATX requires login credentials for all users. The first time you access ATX, your office administrator must establish a
password for the Admin user and select update preferences.

To login and select update preferences:

1. Double-click the ATX icon on your desktop.
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2. The User Name field defaults to Admin. Youmust first establish a password for the Admin user in order to access
ATX.

Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

3. (Optional) Select the Remember User Name check box to have your User Name automatically populated when
you launch the application from this workstation.

4. Click Login.

5. Do one of the following:
l Click Continue to update forms per current Updates Preferences settings.
l To view or change current Updates Preferences settings prior to updating, click Adjust form update settings.
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Subsequent Login and Update

After your initial login, the program remembers your Updates Preferences; you will not have to select them again, unless
you want to change them. With subsequent logins, the system immediately launches the Update function and downloads
forms and/or program updates according to your Preferences.

Logging In
ATX requires login credentials for all users. See Login and Password Requirements.

To log in to ATX use the following steps:

1. Double-click the ATX icon on your desktop.

Your user name and passwordmust be set up in ATX for you to log into the system. If you don't have a user
name or password, see your ATX system administrator.

2. In the User Name field, enter your user name.
3. Enter your password in the Password field, and click Login.

The Password field is case-sensitive. Passwords are required and add an extra measure of data security.

4. (Optional) Select the Remember User Name check box to have your User Name automatically populated when
you launch the application from this workstation.

5. Click Login.

Resetting a Locked User Account

When a user account becomes locked, the administrator (Admin user) must log in and reactivate the user in the system.
While the user will no longer be able to access the system, the system will still have the user name's setup information. This
is a particularly useful security feature for businesses that have repeat seasonal employees, such as seasonal tax preparers.
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Only the Admin user or users with Security Manager rights may access Security Manager.

To reactivate a user's profile:

1. Click the Tools menu; then, select Security Manager.

2. Click the user whose profile you want to unlock.
3. Click Modify.

4. Check the Active check box.
5. Enter a new password in the Password field.
6. Click OK.

Editing Passwords

If you want to change your password, youmust know your current password in order to complete this process.
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If you do not know your current password use one of the following:

l If the Admin user gets inadvertently locked out of the system or forgets the Admin password, the Reset Admin Pass-
word function can be used to reset the password. See Resetting the Admin Password.

l If the user gets inadvertently locked out of the system or forgets their password, use Security Manager to reactivate
and change the password on the account. See Resetting a Locked User Account.

Users are required to sign into ATX on theWelcome To ATX dialog box using their User Name and Password. See
Logging In.

Editing User Passwords

To add or edit your user password:

1. From Return Manager, click the Options menu; then, select Edit User Password.

2. In the Enter current password field, enter your current password.
3. In the Enter a new password field, enter your new password.
4. In the Re-enter new password field, enter your new password again.

An error message will appear if the Enter a new password and Re-enter new password fields do not
match.

5. Click Save.

Updating ATX
In ATX, there are two separate types of updates:

l Forms Updates, which offer themost recent forms available for filing
l Program Updates, which update the ATX application.
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Forms Updates
You can select the forms you want to include when checking for form updates in Updates Preferences. By default, ATX
automatically searches for and installs any available Federal forms each time the program is opened. You'll have to specify
the state(s) for which you want to download forms.

To get Forms Updates from inside the ATX application:

Click the Forms button on the toolbar; then, click Continue in the Download Form Updates dialog box.

If the button is green, then your program is already up to date.

Program Updates
A Program Update is an updated version of the ATX software program. You can receive program updates in the following
ways:

l By clicking the Program toolbar button from inside the application; or
l By downloading them from the website.
l Premium DVD (additional purchase required).

Server Out-Of-Date

When your ATX server version is out-of-date, ATX displays the followingmessage indicating you need to update your server.
The Program toolbar icon displays red indicating a server update is required. ATX provides a Program toolbar icon tooltip to
differentiate between workstation and server Program Updates.

Getting Program Updates from Inside the Application
To get Program Updates from inside the ATX application:

Click the Program button on the toolbar; then, click Continue in the Download Program Updates dialog box.

If the button is green, then your program is already up to date.
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Getting Program Updates from theWeb
In addition to receiving updates and update alerts within ATX, you can also access your ATX software updates from the
Solution Center website.

To download a program update from the Web:

1. Enter www.MyATX.com in yourWeb browser.
2. Under Preparer Solutions, click the Download Center link.

The Client Login page appears.

3. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
4. Enter your User Name in the User Name box and press the Tab key.
5. Enter your Password in the Password box.
6. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
7. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
8. Click Log In.

The Download Center tab of theMyATX Support Center Website appears.

9. From themenu on the left, click the Program Updates link for the current tax year.

The Tax Program Updates page appears.

10. Select the desired program update.

11. Click Next.
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12. Click Finish to exit the InstallShieldWizard.

Help and Support
Help is offered in several ways. Themost commonly used are as follows:

l The Support Menu gives access to a variety of resources, including Program Help, the User Guide, Education
Library, Release Notes, tax related web sites, and Customer Service Utilities.

l Program Help (F1) contains detailed information on the features and functions offered in ATX.
l Government Instructions (F3) include instructions from the Internal Revenue Service (IRS) for federal and state
tax forms. SeeGovernment Instructions.

Education Library
The ATX Education Library, features short instructional videos and accompanying guides designed to help you work with your
tax preparation software. Each video guides you step-by-step through important program features and topics to help you
prepare for tax season.

There are topics to help with the following:

l Installation and Networking
l Rolling over returns
l Backup and Restoring Files
l Client Letters and Client CommunicationManager
l Updating your ATX Software
l Printing and Setting Up Print Packets

Visit the Education Library for other videos to help with ATX features and functionality. You can access the
Education Library either from theMyATX Solution Center or by entering https://www.cchsfs.com/atx_
education_library/ in your Internet browser.

122

https://support.atxinc.com/
https://www.cchsfs.com/atx_education_library/
https://www.cchsfs.com/atx_education_library/


Chapter

7

ATX Managers
Managers are areas of the application that help you organize or manage themany tasks required in the return
preparation process. There areMain Managers, Setup Managers, and Functional Managers. Each will be
discussed in detail in this section:

l Return Manager
l Rollover Manager
l E-file Manager
l Bank Manager
l Preparer/ERO Manager
l Company Manager
l Payer Manager
l Security Manager
l Billing Manager
l Client Communication Manager
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Main Managers
Tasks that you probably tend to perform on a daily basis are accessed via the tabs at the very top of the ATX window.

Main Managers Description

Return Manager
The Return Manager allows you to view and sort all the returns entered in your system.
Allows you to sort returns based on completion, refund status, and accounts receivable.

Rollover Manager
The Rollover Manager lists returns that can be rolled over from last year or from a prior month
or quarter.

E-file Manager The E-file Manager handles all e-filing tasks.

Bank Manager
The Bank Manager handles all tasks associated with providing bank products. This Manager
also includes reports to assist in reconciling bank product fees.

Each of themainmanager tabs includes one or more view tabs, which appear below the toolbar. These tabs separate the
general information displayed by a particular manager into more specific categories.

OpenReturn(s) Tabs
When a return has been opened, the Return Name appears in a tab ATX™ 2017 alongside the other mainmanager tabs. When
a return is open, all forms, worksheets, and letters are displayed in tab format beneath the toolbar. SeeOpen Return
Interface.

Setup Information Managers
Setup InformationManagers are located under the Tools menu.

Information Managers Description

Preparer/ERO Manager

The Preparer/ERO Manager allows you to enter Preparer/ERO information
associated with your business. Information can include firm information, as well
as specific information related to e-filing capabilities (such as a personal EFIN or
whether they are an ERO).

Company Manager
The Company Manager allows you to enter companies for whom you prepare
returns. Makes data entry onmultiple returns faster and easier.

Payer Manager
Allows you to enter payers that have been entered on forms (such as W-2 and
1099). See Payer Manager.
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Functional Managers
Functional Managers are located under the Tools menu.

Functional Managers Description

Security Manager
Allows you to define on a task-by-task basis the level of program access you
want each user to possess. See Security Manager.

Billing Manager
Enables you to set up hourly rates for people in your organization, as well as
form rates for any or all of the forms and schedules. See Billing Manager.

Client Communication Manager
Houses the Client Communication Manager dialog box, which allows you to
create customized client letters and/or templates to be used globally or per-
return.

Customizing Managers
Rearranging and Resizing Columns
All ATX managers display data in a spreadsheet format. Just like in any otherWindows spreadsheet program, you can
rearrange or resize columns to suit your individual needs. Manager customizations are stored on a per user basis. If you're
one of several users on a network, the customizations youmake will not affect how managers look for other network users.

The next time you open that manager, your adjustments will still be there.

To resize a column, click and drag the column border to the left or right.

The cursor turns into a double-sided arrow.

To move a column:

1. Click and drag the header of the column you want to move.
2. Drag it to the desired location.

To reset columns to their default width and/or position, click the Options menu; then, select the Reset Current Tab or
Reset All Tabs.

To hide or display columns:

1. From Return Manager, click the Options menu; then, select Customize Fields.
2. Select the check box for the field you want to hide or display.
3. Click OK.
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Changing Data in Manager Views
In Return Manager, Rollover Manager, Bank Manager, and E-file Manager you can change information in many fields
by typing over the text; other fields are protected fields and cannot be changed.

To enter or change data in a Manager view:

1. Open themanager.
2. Click a field and begin entering or editing data.
3. Press Tab to advance to the next field. To reverse direction, press the Shift+Tab keys. You can also use the arrow

(cursor) keys to navigate to fields in the same record or to move from one record to another in the same column.

Return Manager
Your software opens to the Return Manager by default. This manager allows you tomanage your clients’ tax returns,
accounts receivable, and company information for tax returns.

To open Return Manager, click the Return Manager tab at the top of the application window.
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Returns Tab
The Returns Tab lists returns in the system and provides basic information on each return.

E-file Information Pane
By default, the E-file status for the selected return is shown at the bottom of your screen. If you would like to change the
default setting, see Return Manager Preferences.

Accounts Receivable Tab
Select the Accounts Receivable Tab to view the billing status for each customer.

TaxWarehouse Tab
Select the Tax Warehouse Tab tab for a tax summary of each return.

How To Topics:

l Customizing Fields
l Creating Returns
l Opening Returns
l Finding Specific Forms
l Closing Returns
l Deleting Returns
l Duplicating Returns
l Renaming Returns
l Marking Returns Complete
l Easy View
l Importing Returns
l Exporting Returns
l Export All Returns
l Exporting Marked Client List

ReturnManager Menus
The Return Manager contains the followingmenus:

ReturnsMenu

Menu Item Description Shortcut

Open Selected Return
Opens the return that is highlighted in blue (not
checked).

Ctrl+O

New Return
Opens the Select Forms Dialog Box which allows you
to choose the forms that will make up the new return.

Ctrl+N
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Menu Item Description Shortcut

Close All Open Returns
Simultaneously closes all returns you have open in
application.

Duplicate Selected Return Creates a duplicate copy of the highlighted return. Ctrl+D

Delete Selected Return Deletes the return highlighted in the Return Manager. Ctrl+Delete

Delete Marked Returns
Displays the Delete Marked Returns dialog box,
which is a reminder that deleted returns cannot be
recovered.

Print Packets
Opens Print Packets, which help you set default print
options for selected print copies (Filing, Client,
Preparer, or Custom).

Process Selected Return with ePayment Launches iTransact.com

Import>Returns

Opens aWindows Explorer window, from which you
can browse to an exported return file (in .atxExport
format). This file can then be imported into the
application.

Import>Converted Returns
Import returns converted from other software packages
(must be .ndf files).

Export Marked Returns

Allows you to select specific returns for export.
Displays the Browse For Folder dialog box, where you
can select a location to store the returns you're
exporting.

Export All Returns
Displays the Browse For Folder dialog box, where you
can select a location to store all exported returns.

Backup

Opens the Backup dialog box, which allows you to
manually backup returns and associated data. The
dialog box lets you select one or more returns for
backup.

Restore

Opens the Restore dialog box, which allows you to
select one or more returns to restore to the application.
Only returns that have been backed up using the
Backup and Restore featuremay be restored to the
application.

Organizers
(visible only during the last release of the
tax cycle, usually in October)

Allows you to do any of the following: Create Organizers
for Marked Returns, Create Blank Organizers for New
Return, or Print Organizers For Marked Returns.
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Menu Item Description Shortcut

Change Printer

Launches the Print Setup dialog box, which allows you
to change the default printer (for your system) and to
make both size and orientation changes for the printed
output. You can also install a new printer from the
Network link on this dialog box.

Create/Print Extensions

Creates federal and state extensions for multiple returns
(with or without amounts due), adds the required
extension form to each return. Also prints the required
extension forms as part of the process.

Batch Print Marked Returns
Opens the Returns Marked for Printing dialog box,
and allows you to specify print settings for a group of
selected returns.

Ctrl+P

Exit Closes the application.

OptionsMenu

Menu Item Description

Preferences Opens Preferences which allow you to set up preferences for the program.

Administration
Enables an Admin user (or user with access to Security Manager) to Edit Password for
Selected Return or Remove Lock for Selected Return. See Editing Return Passwords
and Removing a Return Lock.

Edit User Password
Opens the User Password dialog box, which enables users to establish or change their
system passwords. See Editing Passwords.

Customize Fields
Opens the Customize Fields dialog box, which allows the user to define how they want the
Return Manager to appear, and what data they want displayed.

Reset Current Tab
If a user has rearranged the column order or width on the current tab, this menu item will reset
the view to the original program defaults.

Reset All Tabs
If a user has rearranged the order or size of the columns on any of the tabs in the openmanager,
Reset All Tabs will reset all tab views to their original defaults.

Tools Menu

Menu Item Description

Preparer/ERO Manager
Opens the Preparer/ERO Manager, which allows you to enter, modify and
manage preparer and ERO information in the system.

Company Manager
Opens the Company Manager, which allows you to enter, modify and
manage company information in the system.
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Menu Item Description

Payer Manager
Opens the Payer Manager, which allows you to enter, modify and
manage payer information in the system.

Security Manager
Opens the Security Manager, which allows an Admin user to set upmultiple
users in the system. Also allows you to specify the tasks that users may or
may not perform in the system.

Billing Manager
Opens the Billing Manager, which allows you to set up standard and/or
specific billing rates by individual, by the hour, or by form.

Client Communication Manager
Opens the Client Communication Manager dialog box which allows you to
create and/or edit custom client letters and templates.

Calculator Opens the Calculator.

ViewMenu

Menu Item Description

Returns Displays the Returns Tab when the Return Manager is open.

Accounts Receivable Displays the Accounts Receivable Tab when the Return Manager is open.

Tax Warehouse Displays the Tax Warehouse Tab when the Return Manager is open.

Mark All Displayed Returns
Selects the check box of all returns on the current page, indicating that the
checked returns are ready for batch processing.

Unmark All Displayed Returns Deselects all returns on the current page.

Mark/Unmark Selected Return Selects or deselects the check box for the selected (highlighted) return.

Easy View Opens the Easy View window.

FormsMenu

Menu Item Description

Form Update Report
Lists the forms that were contained in themost recent update. Summarizes
changes made to the form and also contains a list of returns using each form.

Customize Master Forms
Opens the Customize Forms dialog box, which allows you to customize
forms tomeet specific business needs. See Customizing Master Forms.

Reports Menu

Menu Item Description

Print Marked Client List Print a list of marked clients' pertinent information.
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Menu Item Description

Export Marked Client List Export a list of marked clients' pertinent information.

Print Marked Client Labels Print address labels for marked clients.

CCH iFirm

Menu Item Description

My Dashboard
Launches your CCH iFirm dashboard, which is an overview of your business’ efficiency,
annual review, resource allocation, work in progress, andmore.

My Jobs Launches your CCH iFirm jobs, where you can view jobs in CCH iFirm.

My Invoice Launches your CCH iFirm invoices, where you can view and create invoices in CCH iFirm.

My Reports
Launches your CCH iFirm PracticeManagement reports, where you canmeasure the
performance of teammembers and see how your firm is performing.

My Timesheet Launches your CCH iFirm timesheet, where you can track your personal time by job.

Client Portal
Launches CCH iFirm Client Portal, where you can organize and share important documents
with clients.

Support Menu

Menu Item Description Shortcut

Program Help Opens Program Help. F1

Government Instructions

If you're in an open return, this menu item launches the
Government Instructions for the current form (if instructions are
available). If you're not in an open return, this menu item launches
the Select Forms Dialog Box, where you can click the View Instr
link to see instructions for specific forms.

F3

Education Library Opens the Education Library help topic.

Release Notes
Opens Release Notes, which give you details about new or
changed functionality in each version of ATX.

User Guide
Launches the PDF version of the ATX User Guide for Tax Year
2017.

Contact Us
Shows you three ways you can contact CCH Small Firm Services
to obtain help with your application: by submitting a question via
theWeb site, via fax, or telephone.
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Menu Item Description Shortcut

Web Sites

Opens the following web sites: BizFilings Business Services,
Check IRS Return Status, IRS Home Page, IRS E-Services,
other ATX Tax Products, ATX Paper Products (for tax
professionals), ATX Home Page, theMyATX Solution Center,
the ATX Blog, and the ATX Knowledgebase.

Check for Updates

Allows you to easily obtain updated program and forms information
through an automated process. Also notifies you of preferences
that you can set pertaining to this update process.

This is not available in Rollover Manager.

Customer Service Utilities
Enables you to provide information to Customer Service so they
may resolve your program issues.

Show Hidden Dialogs

Several dialog boxes have a Don't show this message again
check box so you can avoid receiving the samemessage over and
over again. If you've opted to not show these dialog boxes, the
Show Hidden Dialogs option reverses those selections, so you
will see the dialog boxes again.

Activate Products
Launches the Activation Codes Dialog Box. Enter the activation
code for the product you want to open or update.

Install Payroll 2017
Opens the Program Help topic forW2-1099 or Payroll
Compliance.

About

Displays the About ATX dialog box which displays the program
version, product copyright information, and customer's Client ID.
When calling Customer Care, youmay be asked to provide one or
more of the numbers listed in this dialog box.
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ReturnManager Filters
Filters are located on the left side of the screen. The Return Manager filters allow you to select which returns you want to
view at a specific time.
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You can filter your returns in the following ways:

Filter Description Shortcut

Find check box and field

By checking the Find check box, you can then search for a
return by entering search criteria in the Find field. This is
especially useful when you're searching for a return by
name/company name or SSN/EIN.

Ctrl+F

Return Types - Individual, Corporate,
Other

Select one or more of these check boxes to view only these
return types in the Return Manager.

Only filters matching return types in the Returns List appear.
For example, if you had no Corporate returns, the Corporate
check box would not appear in the filter.

Complete View returns that have beenmarked as complete.

Incomplete View returns that have beenmarked as incomplete.

Marked Returns
View returns that aremarked by selecting the check box at the
beginning of the row.

E-file Status
Select one or more of these check boxes to view only the returns
with specified e-file status.

Accounts Receivable
Accounts receivable filters display a list of returns based on the
number of days their billing is outstanding.

Tax Warehouse
Tax Warehouse filters allow you to filter according to each
return's tax status.

Clear Filters
This button clears all the filters and displays all returns for the
Return Manager.

Returns Tab
The Returns tab is the default view in the Return Manager. All the returns in the system are listed. Returns marked
Complete can be hidden from view if desired. See All Managers Preferences.

Tomodify the columns displayed in the tab, see Customizing Managers.
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Accounts Receivable Tab
To view Accounts Receivable info for your office, click the Accounts Receivable tab.

Only the Admin user and users granted Accounts Receivable rights in Security Manager may access the Accounts
Receivable tab.

To open the Accounts Receivable view:

In the Return Manager, click the Accounts Receivable tab.

Accounts Receivable filters

If you want billing information on outstanding accounts, select one of the Accounts Receivable filters in the Return
Manager. Filters allow you to view outstanding accounts in the following categories:

l 0-30 Days
l 31-60 Days
l 61-90 Days
l Over 90 Days

Tomodify the columns displayed in the tab, see Customizing Managers.

TaxWarehouse Tab
The Tax Warehouse tab gives you a spreadsheet-like view of all your returns, in summary form. Taxable Income, Total
Tax, Total Refund, Medical Expenses, Taxes Owed, and Tax Bracket are just a sampling of the type of information
consolidated on the Tax Warehouse tab.

Only the Admin user and users granted Tax Warehouse rights in Security Manager may access the Tax
Warehouse tab.

To open the Tax Warehouse, from within the Return Manager, click the Tax Warehouse tab.
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TaxWarehouse Filters

Filters allow you to view returns according to the following categories:

l Tax Due
l Tax Refund

Sorting the Return List
To sort your return list:

l On the Returns Tab in the Return Manager, click any of the column headings. The data will sort in ascending or
descending order.

l To reverse the order, click the same column heading a second time.

For example, to display your returns chronologically, according to the date on which they were last modified, click the
Modified column heading.

E-file Information
The E-file Information pane on the Return Manager tab displays for the selected return and is shown at the bottom of your
screen.

136



Chapter 7: ATX Managers

The E-file Information pane and the E-file column on the Returns tab displays e-file status for the selected return. The
indicators on the Return Manager tab give you a quick way to see the status of a return without having to check E-file
Manager.

Status
Indicator

Status Indicator Description

No icon indicates an e-file is not created for the selected return.

Yellow indicates an e-file or extension is created for this return or is awaiting acknowledgement from the
agency.

Green with white check-mark indicates the return is accepted by the agency.

Red indicates the return was rejected by the agency. Click on E-file Manager to review the rejection.

Green circle indicates the extension for the return was accepted by the agency.

Customizing Fields
You can create custom fields in the Return Manager.

To Customize Fields:

1. From Return Manager, click the Options menu; then, select Customize Fields.
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2. Scroll to the bottom of the list. You'll see Custom Fields 1 through 10.
3. Select the check box next to the field you want to customize.
4. Click the Rename button.

The Rename button will remain disabled until a check box is selected.

5. Enter the new field name and click OK.
6. Use theMove Up orMove Down buttons to reposition any field in the list.

Resetting the fields to their default settings hides custom fields in themanager view, but it does not delete
them from the Customize Master Forms Dialog Box. You can still re-establish them in the view by re-
selecting the corresponding check box(es), if desired.

Marking Returns Complete
You can indicate that a return is complete by marking it in the Return Manager.

If you're using ATX in a networked environment, the changes youmake in Return Manager (such as marking returns
complete or moving and re-sizing columns) will not appear on other workstations. They will be unique to your workstation
only.
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To mark a return complete, select the check box under the complete column in the Return Manager.

Saving changes to returns marked Complete:

If youmake changes to a return that is marked Complete, you will receive the followingmessage:

Importing Returns
The Import feature lets you import one or more returns into ATX if they meet the following criteria:

l Returns where the year matches the ATX year. Returns from prior years should be imported into ATX for the tax
year of the return, and then rolled over into the current year. See Rollover Returns from Last Year.

l Returns were created in ATX. Returns created in other products require conversion in order to be imported into
ATX. For more on conversions, go to our MyATX Solution Center and click Conversions.

l Returns that were exported from ATX using ATX's Export function. These can be imported on any computer
that has the same year of ATX installed (imported return year must match ATX year).

To import returns:

1. From the Return Manager, click the Returns menu.
2. Expand the Import fly-out menu and select Returns.

The Import Returns dialog box appears.

3. Navigate to the return(s) to be imported.
4. Highlight the return(s) to be imported.

To select multiple files, hold the Ctrl key while highlighting the files.

5. Click Open.
6. If there are existing returns that match the returns being imported, the Confirm Replace dialog provides the option

to Replace the existing return with the imported return or to Import as Copy (the imported return will be named as
a copy and the existing return will not be changed). Select the appropriate radio button for each return listed.

Import as Copy is selected by default.

139

https://support.atxinc.com/


Chapter 7: ATX Managers

E-files (including related acknowledgments, bank application records and PDF attachments) are not included if
you select Import as Copy...

7. Click Import.

8. Click Close.
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Unsuccessful Imports

If your imported return has an e-file, you cannot transmit that e-file until you synchronize the e-file with the EFC. (This
will ensure that the e-file was not transmitted prior to import). Even if you're not ready to transmit the imported e-file,
youmay want to sync with the EFC to ensure that the imported return's e-file status, bank status, and Acks are up-to-
date. See Synchronizing E-files With the EFC.

Importing Converted Returns
By running the proper conversion utility, returns created in other software packages may be converted to .ndf files and
imported into ATX.

To import converted returns:

Before returns can be imported they must be converted to .ndf files and stored locally on your computer.

1. From the Return Manager, click the Returns menu; then, expand the Import fly-out menu and select Converted
Returns.

The Converted Returns dialog box appears.

2. Browse to the location where your converted returns are stored.
3. Select the returns you wish to import; then, click Open.

The Import Progress dialog box appears followed by the Import Results dialog box.

4. Click Close.

Exporting Returns
Use the Export feature to save one or more returns to a flash drive, hard disk drive or other storagemedia, or to transfer your
returns from one computer to another.

You can export a return from either the Return Manager or from an open return. If you use Return Manager you can export
more than one return at a time.

Youmust not rename an exported return in yourWindows file directory. Renaming the file will prevent the possibility of
importing it back into ATX.
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Exporting Returns from the ReturnManager
To export one or more returns from Return Manager:

1. In the Returns column, select the check box(es) to mark the return(s) you want to export.
2. Click the Returns menu; then, select Export Marked Returns.

3. Click Export Marked Returns.

A Browse for Folder dialog box appears.

4. Navigate to and select a folder to house your exported returns.
5. Click OK.

6. Click Close.

Exported returns appear in the destination folder with an *.atx[taxyear]Export file format (such as
*.atx17Export).

Open and Modified Returns
If you havemarked returns open that have beenmodified you will see amessage similar to the following:
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Exporting Open Returns
To export an open return:

1. Save any changes.
2. Click the Returns menu; then, select Export Return.

A Browse for Folder dialog box appears.

3. Navigate to and select a folder to house your exported returns.
4. Click OK.

Export All Returns
Use the Export feature to export all returns to a flash drive, hard disk drive or other storagemedia, or to transfer your returns
from one computer to another.

Youmust not rename an exported return in yourWindows file directory. Renaming the file will prevent the possibility of
importing it back into ATX.

Be sure to close any open returns, only closed/unopened returns are exported when using the Export All Returns
feature.

To export all returns from Return Manager:

1. Click the Returns menu; then, select Export All Returns.
2. A Browse for Folder dialog box appears.
3. Navigate to and select a folder to house your exported returns.
4. Click OK.

5. Click Close.

Exported returns appear in the destination folder with an *.atx[taxyear]Export file format (such as
*.atx17Export).
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ExportingMarked Client List
A Client List may be exported to a .csv file whenever you need it with just a few clicks. The Client List contains your clients'
pertinent information including Name or Company Name, Return Type, Address, Telephone Number, e-Mail, andmore.
By exporting to a .csv file, you can further manipulate the data listedmuch like you would with an Excel spreadsheet.

To export a Marked Client List:

1. Mark the returns for the clients whose information you wish to appear in the Client List.

Click Mark All on the toolbar to mark all returns and include all clients.

2. From the Return Manager, click the Reports menu; then, select Export Marked Client List.

The Export as csv File dialog box appears.

3. Enter a name for the file in the File Name: entry.
4. Browse to the desired export location for the file.
5. Click Save to finish.

Rollover Manager
Use the Rollover Manager to roll over income and property tax returns from last year, or to roll over sales tax returns from
last quarter or last month.

If last year's version of ATX is not installed on the system (or not installed in the default location), you'll receive a
message asking you to browse for the correct system folder.

The following data is transferred into the current year’s return:

l Names
l Payers for Forms 1099, and employer information for Forms W-2
l Depreciable assets
l Carry forward data from passive activity losses, capital losses, net operating losses, and contributions
l Names of business, rental, and farm properties
l Names of partnerships, S-corporations, and trusts or estates from which the taxpayer received a K-1 in the previous
year

l Names of companies, shareholders, partners, and beneficiaries for business returns
l Data from customizedmaster forms
l User-entered notes on individual cells in forms (only those notes marked Permanent will be rolled over)
l Itemized, text, and custom lists
l Custom List templates (User-specific. Only users who create them can roll them over.)
l Client Letters (attached to a return)
l Global Client Letter Templates (including customizations)
l Print Packets (User-specific. Only users who create them can roll them over.)
l Asset Classifications
l Custom Reports

Custom lists are rolled with returns that are rolled over from last month or last quarter.
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Client Letters with associated obsolete forms in 2016 do not roll over.

Payroll returns are not supported in ATX 2017. If you have not yet installed the 2017W2 and 1099 or Payroll
Compliance software, seeW2-1099 or Payroll Compliance.

To open the Rollover Manager, click the Rollover Manager tab at the top of the application.

Rollover Manager Tabs
Rollover Manager has two views – 2016 Returns Tab and Last Month/Quarter Tab. To select a view, click the desired tab
above the list of returns.

2016 Returns Tab

When you roll over last year's return, the program retrieves selected data from the last year's return and uses this information
to populate the corresponding forms for the current year.

Last Month/Quarter Tab

The Last Month/Quarter Tab lists your clients returns from a prior month or quarter available for rollover.

Rollover Manager Menus
The Rollover Manager contains the followingmenus:

Rollover Menu

Menu Item Description Shortcut

Rollover Marked Data

Rolls over any data within the Rollover Manager that has a
selected check box into ATX format. This includes any of the
returns, or other administrative data (company, payer,
preparer/ERO, form rates or hourly rates).

Ctrl+R

Rollover Marked Returns
Rolls over themarked returns from the previous year's ATX
product into the current year's ATX product.

Browse for Last Year's Returns
If last year's ATX program is not found in the default directory, a
Browse for Folder dialog box allows you to browse to the
location on your computer where your returns are stored.

Rollover
Preparer/ERO Information

Rolls over Preparer/ERO Manager information from last
year's ATX product to your current ATX product.

Rollover Companies Information
Rolls over Company Managerinformation from last year's
ATX product to your current ATX product.

Rollover Payer Information
Rolls over Payer Manager information from last year's ATX
product to your current ATX product.
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Menu Item Description Shortcut

Rollover Form Rates
Rolls over form rates from last year's ATX product to your
current ATX product.

Rollover Hourly Rates
Rolls over hourly rates from last year's ATX product to your
current ATX product.

Rollover Custom List Templates
Rolls over the custom list templates created by the ATX user.
See Creating Custom Lists.

Rollover Global Client Letter
Templates

Rolls over last year's Global Client Letter Templates to your
current ATX product.

Rollover Print Packets
Rolls over last year's Print Packet setup to the user's current
ATX product.

Rollover Asset Classifications
Rolls over last year's Asset Classifications from Fixed Asset
Manager.

Rollover Custom Reports Rolls over the custom reports from Fixed Asset Manager.

Exit Closes the ATX program.

Tools Menu

Menu Item Description Shortcut

Preferences Opens the Preferences dialog box.

Security Manager
Opens the Security Manager, which allows Admin users to set up
multiple users in the system and specify the tasks that users may or
may not perform.

Calculator Opens the Calculator. F8

ViewMenu

Menu Item Description

2016 Returns Displays the 2016 Returns Tab and a list of 2016 returns available for rollover.

Last Month/Quarter Displays the Last Month/Quarter Tab and a list of current year returns.

Mark All Displayed Returns
Selects the check box of all returns on the current page, indicating that the checked
returns are ready for batch processing.

Unmark All Displayed Returns Clears the check boxes for all returns shown on the current page.

Mark/Unmark Selected Return Selects or clears the check box for the highlighted return.
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CCH iFirm

Menu Item Description

Export Contact to CCH iFirm Exports contact information to CCH iFirm.

Support Menu

Menu Item Description Shortcut

Program Help Opens Program Help. F1

Government Instructions

If you're in an open return, this menu item launches the
Government Instructions for the current form (if instructions are
available). If you're not in an open return, this menu item launches
the Select Forms Dialog Box, where you can click the View Instr
link to see instructions for specific forms.

F3

Education Library Opens the Education Library Help topics.

Release Notes
Opens Release Notes, which give you detail about new or changed
functionality in each version of ATX.

User Guide
Launches the PDF version of the ATX User Guide for Tax Year
2017.

Contact Us
Shows you three ways you can contact CCH Small Firm Services
to obtain help with your application: by submitting a question via the
Web site, via fax, or telephone.

Web Sites

Opens the following web sites: BizFilings Business Services, IRS
Home Page, IRS E-Services, other ATX Tax Products, ATX
Paper Products (for tax professionals), ATX Home Page, the
MyATX Solution Center, the ATX Blog, and the ATX
Knowledgebase.

Check for Updates
Allows you to easily obtain updated program and forms information
through an automated process. Also notifies you of preferences that
you can set pertaining to this update process.

Customer Service Utilities

Enables you to provide information to Customer Service so they
may resolve your program issues. See one of the following
activities:

l Refreshing Application Configurations
l Send Diagnostics to Customer Service
l Send E-file Log to Customer Service
l Synchronizing E-files With the EFC
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Menu Item Description Shortcut

Show Hidden Dialogs

Several dialog boxes have a Don't show this message again
check box so you can avoid receiving the samemessage over and
over again. The Show Hidden Dialogs option reverses those
selections, so you will see the dialog boxes again.

About

Displays the About ATX dialog box which displays the program
version, product copyright information, and customer's Client ID.
When calling Customer Care, youmay be asked to provide one or
more of the numbers listed in this dialog box.

Rollover Manager Filters
Filters are located on the left side of the screen. The Rollover Manager filters allow you to select which returns you want to
view at a specific time.

The following table describes each of the filters in detail:

Filter Description Shortcut

Find check box and field
By checking the Find check box, you can then search for a rollover
return by entering search criteria in the Find field. This is especially
useful when you're searching for a return by last name.

Ctrl+F

Return Type (Individual,
Corporation, etc.)

Select one or more of these check boxes to view only these return types
in the Rollover Manager.

Rolled Over View returns that have been rolled over from last year's product.

Not Rolled Over View returns that have yet to be rolled over.

Marked Returns
View returns that have beenmarked by selecting the check box at the
beginning of the row.

Clear Filters Clears all the filters and displays all returns for the Rollover Manager.
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Rollover Returns from Last Year
You can roll over returns in two ways: either one at a time, or in batches. Whichever method you choose, ATX makes sure
that last year's data rolls smoothly into this year's system and is "ready to go" when you open it in this year's product.

We strongly recommend updating your current and prior year software before rolling over returns.

To roll over returns from last year:

If you've entered preparer and/or ERO information in Preparer/ERO Manager and you want this information to
automatically appear on all rolled over returns, see Rollover Manager Preferences.

1. In Rollover Manager, mark the return(s) you want to roll over.

If no returns appear in Rollover Manager, your systemmay not recognize where you have your returns
stored. See If Returns Do Not Automatically Appear in Rollover Manager in this topic.

Grayed Returns: Returns that are grayed out in Rollover Manager were rolled over in the previous year's
product but were never opened. Move the cursor over the return item and follow the recommendation on the
tooltip to enable the return.

2. Do one of the following:
l Click the Rollover button on the toolbar.
l Click the Rollover menu; then, select Rollover Marked Returns.
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3. Click Close.

See Renaming Returns to rename the rolled over return.

Administrative data can be rolled over at the same time as marked returns by selecting the appropriate check
box(es) at the bottom of the Rollover Manager. See Rollover Other Data.

If Returns DoNot Automatically Appear in Rollover Manager
If last year's ATX program is not in the default location, returns will not automatically appear in the Rollover Manager.

To get your returns to appear in Rollover Manager:

1. Click the Rollover button.

An informational dialog box appears with themessage Last year's ATX program could not be found.

2. Click the Browse button; then navigate to the folder where you stored last year’s returns.
3. Click OK.

150



Chapter 7: ATX Managers

WhenRolled Over Returns Cannot beOpened

To fix rolled over returns that cannot be opened due to mismatched or out-of-date forms:

1. In last year's ATX program, open the return; then, close the return.
2. In this year's ATX tax program, double-click the return in Return Manager to open it.

Forms are not always immediately available for a return that you've rolled over. See Forms Not Yet Rolled
Over.

Unsuccessful Rollovers

If your rollover is unsuccessful, the system gives you guidance on what to do to resolve the specific issue. Thesemessages
appear in the Rollover Progress and Rollover Results dialog boxes.

Missing Forms and/or Incomplete Data
If the rollover is unsuccessful due tomissing forms and/or incomplete data, follow these instructions:

1. Open and close the return in last year's ATX program. (If you hadmissing forms in your rollover, make sure that the
forms in question are in last year's return.)

You do not need to save the return.

2. Re-open the return in ATX 2017.

Corrupted Returns
If the return you're attempting to roll over is corrupt, your options are as follows:

l Open and close the return in last year's ATX program; then re-open the return in ATX 2017
l Restore the return from a backup of ATX 2016 data; then, rollover the return again into ATX 2017.

If the return is corrupted, youmay experience some data loss.
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Failure to Communicate with Rollover Service
If your rollover is unsuccessful due to a failure to communicate with the rollover service:

1. Browse to C:\Program Files (x86)\CCH Small Firm Services\ATX2017.
2. Double-click the Sfs.Max.RolloverService.exe to restart the rollover service.
3. Try the rollover again.

Other Internal Errors
If you receive amessage that indicates an internal error, restart the application and try your rollover again. If this is still
unsuccessful, contact ATX Technical Support.

2016 Returns Tab

The 2016 Returns tab in the Rollover Manager displays a list of all the 2016 returns that are available to be rolled over into
the current product.

Payroll returns are not supported in ATX 2017. If you have not yet installed the 2017W2 and 1099 or Payroll
Compliance software, seeW2-1099 or Payroll Compliance.

To view 2016 returns that are available for Rollover, open the Rollover Manager.

Returns that were rolled over in last year's product but not opened are grayed out in your current Rollover Manager. To
rollover these returns, they must first be opened and saved in last year's program.

Column/Field Descriptions

The following table details the columns and/or fields appearing in the 2016 ATX™ 2017 Returns tab view:

Column/Field Description

Return Name Name on the rolled over return.

Client # An optional number that can be assigned to a client or customer, if desired.

Type Return type, such as 1040 or 1120.

SSN/EIN Social Security Number or EIN for the return.

Telephone Telephone number associated with the return.

Email Email address for the contact for the return that's being rolled over.

Address Mailing address for the individual whose return was rolled over.

City Residing city for the individual whose return was rolled over.

State Resident state for the individual whose return was rolled over.

ZIP ZIP Code for the individual whose return was rolled over.

Preparer Name of preparer who prepared the rolled over tax return.

Partner Name of the preparer's partner, if applicable.
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Forms Not Yet Rolled Over

Forms that reside in rolled over returns are not always available or installed in the current year's product. In this situation,
you'll receive amessage dialog box that instructs you to check for updated forms. If the update process gives you the forms
in the return, you'll be able to open it. If not, you should keep checking for updates until the forms are ready.

Forms Not Yet Available
You'll receive the followingmessage when some of the return forms are installed, but others are not yet available:

Select the Rollover When Available check box to automatically roll over the form if it is available the next time you open the
return.

Click Continue to open the return with the forms that have already been rolled over.

No Forms Available
If none of the forms in the rolled over return are available, you'll receive the followingmessage:

Forms aremade available during a season. To check for updates, click the Forms button on your toolbar. If the Forms
button is Green, your forms are already up to date.

If no forms are available, the return cannot be opened.
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Rollover Other Data
By default, the system automatically rolls over the following types of administrative data from last year's product:

l Asset Classifications
l Companies
l Custom List Templates (User-specific. Only users who create them can roll them over.)
l Custom Reports
l Form Rates
l Global Client Letter Templates (including customizations)
l Hourly Rates
l Payers
l Preparers
l Print Packets (User-specific. Only users who created them can roll them over.)

If a template has been customized in the current year product, prior year changes will not rollover. If you want
the prior year customizations to roll over, delete or restore the template in the current year product, then re-
rollover Global Templates. Changes made in the current year template will be lost.

To roll over administrative information from last year:

1. In Rollover Manager, clear the check box(es) for data that you do not want to rollover.

The number of items in each administrative data category appears in parentheses, such as Preparers (1).

2. Do one of the following:
l Click the Rollover button on the toolbar.
l Click the Rollover menu; then, select Rollover Marked Data.
l Press Ctrl+R.
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3. Click Close.

When administrative items are successfully rolled over, the number of items for the corresponding data should
change to zero. If you rolled over three preparers, you should see Preparers (0) after the rollover.

To view rolled over administrative data:

From Return Manager, click the Tools menu; then, select the appropriate manager based on the data you've
rolled over:

l Preparer/ERO Manager
l Company Manager
l Payer Manager
l Billing Manager

For Custom List Templates, Global Client Letter templates, and Print Packets, look in the corresponding area
of the application.

Custom List Templates and Print Packets are user-specific items, so they can only be rolled over by the
ATX user who created them.

When Form Rates aremodified by a user the data is not rolled over.
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Rollover of Invalid Data

The Rollover Manager will convert information containing invalid data. When you open rolled over data, invalid data is
outlined in red. If you hover over the exclamationmark, a popup tool tip explains why the data is invalid:

Rollover Returns from Last Month/Quarter
You can roll over returns from the previous month or quarter, so you don't have to re-key the return. When you roll over a return
from the last month or quarter, the system creates a new return with the same forms and client information, but with the new
period’s reporting dates.

We strongly recommend updating your current and prior year software before rolling over returns.

Payroll returns are not supported in ATX 2017. If you have not yet installed the 2017W2 and 1099 or Payroll
Compliance software, seeW2-1099 or Payroll Compliance.

To roll over a monthly or quarterly return to the next period:

1. In Rollover Manager, click the Last Month/Quarter Tab.

2. Select the check boxes for the return(s) you want to roll over.
3. Do one of the following:

l Click the Rollover button on the toolbar.
l Click the Rollover menu; then, select Rollover Marked Returns.

The Rollover Results dialog box appears.

4. Click Close.
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Last Month/Quarter Tab

The Last Month/Quarter tab in the Rollover Manager displays a list of all current year returns.

Payroll returns are not supported in ATX 2017. If you have not yet installed the 2017W2 and 1099 or Payroll
Compliance software, seeW2-1099 or Payroll Compliance.

To view Last Month/Quarter returns that are available for Rollover:

From the Rollover Manager, click the Last Month/Quarter tab.

The following table details the columns and/or fields appearing in the Last Month/Quarter tab view:

Column/Field Description

Return Name Name on the rolled over return.

Client # An optional number that can be assigned to a client or customer, if desired.

Type Return type, such as 1120 or 1040.

SSN/EIN Social Security Number or EIN for the return.

Telephone Telephone number listed on the return, if applicable.

Email Email address of the contact for the return that's being rolled over.

Address Mailing address for the rolled over return.

City Residing city for the individual whose return was rolled over.

State Resident state for the individual whose return was rolled over.

ZIP ZIP Code for the individual whose return was rolled over.

Preparer Name of preparer who prepared the rolled over tax return.

Partner Name of partner, if applicable.
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E-file Manager
The E-file Manager organizes and tracks the status of e-files that were created from your returns. E-files that appear in the
E-file Manager can be sorted and filtered by creation or transmission status, or by completion status. You can filter the list of
e-files.

To open E-file Manager, click the E-file menu; then, select E-file Manager.

You can only delete an e-file from the E-file Manager if it has a Created or Rejected status. E-files with any other
status cannot be deleted.

E-file Manager Menus
The E-file Manager contains the followingmenus:

E-file Menu

Menu Item Description Shortcut

Transmit Marked E-files Begins transmission of marked e-files to the ATX e-file servers. Ctrl+T

Receive Acknowledgements
Connects to ATX to update acknowledgements and bank status
information.

Ctrl+K

Hold Marked E-files
Prevents themarked (checked) e-file(s) in E-file Manager from
being transmitted.

Release Marked E-files
Releases the hold on themarked (checked) e-files done through
the Holding/Releasing State E-files function.

Display Selected E-file Rejection
Errors

Opens the E-file Rejection Errors pane at the bottom of the
form, which displays rejection errors for a single return or
multiple marked returns.

If a return is changed after the e-file was created,

Ctrl+R
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Menu Item Description Shortcut

it must be re-created before transmitting.

Display Selected E-file
Action Required

Displays the specific actions required by specific states for an
e-filed return, if any have been indicated by the relevant agency.
Enabled when you have selected an e-filed return in E-file
Manager or when you have an e-filed return open. The pane
that is used to display e-file error messages is also used for
displaying e-file actions.

Delete Selected E-files
Deletes the single e-file selected in the list, if it qualifies for
deletion. Deleting an e-file does not delete the tax return.

Ctrl+Delete

Delete Marked E-files
Deletes all e-files that aremarked, if they quality. Deleting e-
files does not delete the tax returns.

Display Selected E-file
Acknowledgement History

Displays the history for selected return. You can view details
and print the history.

Display Marked E-file
Acknowledgement Histories

Displays histories for marked returns.

Open Related Return Opens the return that is associated with the e-file. Ctrl+O

Exit Closes ATX program.

OptionsMenu

Menu Item Description

Preferences Opens Preferences which allows you to set up preferences for the program.

Reset Current Tab
If a user has rearranged the column order or width on the current tab, this menu item will
reset the view to the original program defaults.
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Tools Menu

Menu Item Description Shortcut

Enrollment Manger
Opens the Enrollment Manager, which allow the Admin users tomanage
and view bank enrollments.

Security Manager
Opens the Security Manager, which allows an Admin user to set upmultiple
users in the system. Also allows you to specify the tasks that users may or
may not perform in the system.

Calculator Opens the Calculator. F8

ViewMenu

Menu Items Description Shortcut

Mark All Displayed E-files
Selects the check box of all e-files shown on the current page, indicating that
the checked e-files are ready for batch processing.

Unmark All E-files Deselects all e-files shown on the current page.

Mark/Unmark Selected
E-files

Selects or deselects the check box for the selected (highlighted) e-file.

Refresh E-file List Refreshes the list of returns in E-file Manager. F5

Reports

Menu Item Description

Print Marked Client List Print a list of marked clients' pertinent information.

Export Marked Client List Export a list of marked clients' pertinent information.
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Support Menu
See Support Menu under the Return Manager Menus topic.

E-file Manager Filters
Filters allow you to select which e-files you want to view at a specific time. You can filter the E-file Manager view based on
Return Type, creation status, transmission status, or completion status.

Return type filters appear dynamically, based on the data in your system. For example, the system shown below only
contains returns that fit the Individual andOther categories:

Use the following filters to manage the e-file returns that appear in the E-file Manager:

Filter Description Shortcut

Find check box and field

By selecting the Find check box, you can then
search for an e-filed return by entering search criteria
in the Find field. This is especially useful when you're
searching for a return by last name.

Ctrl+F

Return Type (Individual, Corporate, etc.)
Select the check box(es) corresponding to the return
type(s) you want to view in the E-file Manager.

Created
View e-files that have a Created status (but have yet
to be Transmitted).

Held View e-files that you've placed on hold.

Duplicated Select this check box to view duplicated returns.

Transmitted View e-files with a Transmitted status.

Rejected View e-files with a Rejected status.

Conditional

View e-files that have been given a Conditional
acknowledgement from the IRS. Conditional status
is generally reserved for 940/941 PIN registration e-
files.
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Filter Description Shortcut

Accepted
View e-filed returns that have been accepted by the
IRS.

Complete View e-files that aremarked Complete.

Incomplete View e-files that are incomplete.

Marked Returns
View e-files that have beenmarked (check box has
been selected)

Clear Filters button
Clears all the filters and displays all returns for the E-
file Manager.

Bank Manager
ATX partners with banking institutions to provide the following bank-related services:

l Bank Products, such as electronic refund checks (ERC), refund transfers (RT), and bank cards;
l FeeCollect™, which enables preparers to collect their fees electronically from their client's refund;
l FeeCollect PS Package, which enables preparers to collect their fees electronically from their client's refund with
additional options for collection and disbursement;

l Protection Plus, which protects the taxpayer against softwaremiscalculations and certain preparer errors.

The Bank Manager lets you see all the bank-related products and disbursements on a per-return basis. This includes
disbursements made to your customers (via bank products) or to yourself (FeeCollect).

To open the Bank Manager:

Click the Bank Manager tab at the top of the application window.

If you have not completed the enrollment process, you'll see amessage with a link to the Enrollment
Manager. See Enrollment Process.
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Bank Products tab

The Bank Products Tab allows you to see detailed information on each return to which a bank product is attached. Bank
Products can be added to 1040 returns.

Disbursements tab

The Disbursements Tab allows you track the number of disbursements distributed to your clients. You can also use Bank
Manager to track amounts distributed using FeeCollect™ service.

Banks

Wework with two banks - Santa Barbara Tax Products Group and 3Fund™.

Contact the banks directly to determine specific registration and enrollment requirements, fees, and benefits for each type of
bank product.

How To Topics:

l Enrollment Process
l Updating Enrollment Statuses
l Setting Up E-file Fees
l Adding Bank Products to Returns
l Viewing Disbursement Details
l Re-Creating Bank Applications
l Transmitting Re-Created Bank Applications
l Printing Checks
l Configuring Printer for Check Printing
l Aligning Checks
l Reprinting Checks

Bank Manager Menus
The Bank Manager contains the followingmenus:

Disbursements Menu

Menu Item Description Shortcut

Print Checks

If you have internet access, this button automatically opens
the CCH Small Firm Services Client Login page. After
logging in, you can go to the Online Check Printing center,
where you canmanage and print your available checks.

Ctrl+H

View Selected Disbursement Details
Opens the Disbursement Details dialog box, which shows
detail on all disbursements associated with a particular
return. See Viewing Disbursement Details.

Exit Closes the ATX program.
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ApplicationsMenu

Menu Item Description Shortcut

Transmit Re-created Bank
Applications

Select this function to transmit a bank application that you've re-created. This
function is only available if you have an accepted e-file with a rejected bank
application. See Re-Creating Bank Applications.

Receive
Acknowledgements

Connects to ATX to update acknowledgements and bank status information. Ctrl+K

Display Rejected Errors
Opens the return and displays the error(s) related to the bank application in the
Rejection Errors pane at the bottom of the ATX window.

Ctrl+R

Open Associated Return Opens the return that is highlighted in blue. Ctrl+O

OptionsMenu

Menu Item Description

Preferences Opens All Managers Preferences.

Reset Current Tab
If a user has rearranged the column order or width on the current tab, this menu item will reset
the view to the original program defaults.

Reset All Tabs
If a user has rearranged the order or size of the columns on any of the tabs in the open
manager, this option resets all tab views to their original defaults.

Tools Menu

Menu Item Description Shortcut

Enrollment Manger
Opens the Enrollment Manager, which allows the Admin user to manage and
view bank enrollments.

Security Manager

Opens the Security Manager, which allows the Admin user to set upmultiple
users in the system and specify the tasks that users may or may not perform.

Only users with Security Manager rights can access Security Manager.

Calculator Opens the Calculator. F8

ViewMenu

Menu Item Description

Bank Products Opens the Bank Products Tab in Bank Manager.

Disbursements Opens the Disbursements Tab in Bank Manager.
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Reports

Menu Item Description

Fee Report Opens theMyATX Solution Center Reports page.

Unpostable Report
Displays a report created when the bank sends an acknowledgement to the Preparer/ERO
that the funds are unpostable. Unpostable funds are generally received because the bank
application has not been approved. See Unpostables Report.

TPG Online Reports Links to the bank website, where you can obtain reports.

3Fund Online Reports Links to the bank website, where you can obtain reports.

Support Menu

Menu Item Description Shortcut

Bank Web Sites
Provides links to the bank web sites that support the application's bank-
related products.

Program Help Opens the Program Help in a web browser. F1

Government Instructions

If you're in an open return, this menu item launches the Government
Instructions for the current form (if instructions are available). If you're not
in an open return, this menu item launches the Select Forms Dialog Box,
where you can click the View Instr link to see instructions for specific
forms.

F3

Education Library Opens the Education Library help topics.

Release Notes
Opens the ATX 2017 RELEASE NOTES, which give you detail about new
or changed functionality in each version of ATX.

User Guide Launches the PDF version of the ATX User Guide for Tax Year 2017.

Contact Us
Shows you three ways you can contact CCH Small Firm Services to obtain
help with your application: by submitting a question via the website, via fax,
or telephone.

Web Sites

Opens the following web sites: BizFilings Business Services, IRS Home
Page, IRS E-Services, other ATX Tax Products, ATX Paper Products
(for tax professionals), ATX Home Page, theMyATX Solution Center, the
ATX Blog, and the ATX Knowledgebase.

Check for Updates
Allows you to easily obtain updated program and forms information through
an automated process.

Customer Service Utilities

Enables you to provide information to Customer Service so they may
resolve your program issues. See one of the following activities:

l Refreshing Application Configurations
l Send Diagnostics to Customer Service
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Menu Item Description Shortcut

l Send E-file Log to Customer Service
l Synchronizing E-files With the EFC

Synchronizing E-files With the EFC is only available to users who have
permission to Receive Acknowledgements.

Show Hidden Dialogs

Several dialog boxes have a Don't show this message again check box
so you can avoid receiving the samemessage over and over again. The
Show Hidden Dialogs option reverses those selections, so you will see
the dialog boxes again.

About

Displays the About ATX dialog box which displays the program version,
product copyright information, and customer's Client ID. When calling
Customer Care, youmay be asked to provide one or more of the numbers
listed in this dialog box.

Bank Manager Filters
The Bank Manager filters change depending on the tab (view) you select on the Bank Products Tab or the Disbursements
Tab.

Bank Products Filters

If you've selected the Bank Products Tab, your filter will appear as follows:

Filter Description Shortcut

Find check box and field
By checking the Find check box, you can then search for bank
products by entering search criteria in the Find field.

Ctrl+F

Created Displays bank products with a bank status of Created.

Transmitted Displays bank products with a bank status of Transmitted.
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Filter Description Shortcut

Rejected
Displays bank products with a bank status of Rejected. Rejected
bank applications appear in Bank Manager in red. To fix rejected bank
applications, refer to Re-Creating Bank Applications.

Accepted Displays bank products with a bank status of Accepted.

Complete
Displays all bank products where the Complete check box is selected
in the Bank Manager.

Incomplete
Displays all bank products where the Complete check box is
unmarked in the Bank Manager.

Clear Filters
When viewing the Bank Products Tab, clears all the filters and
displays all bank products.

Disbursement Filters

If you select the Disbursements Tab, the Disbursement filters appear dynamically, based on the bank products you offer:

Filter Description Shortcut

Find check box and field
By checking the Find check box, you can then search for disbursements
by entering search criteria in the Find field.

Ctrl+F

Product Types

Select a check box to filter disbursements. In ATX, the following products
can be used for bank products:

l 3Fund Check
l 3Fund Direct Deposit
l RT Check (Refund Transfer - check)
l RT Direct Deposit
l FeeCollect™
l Card

Check Select this check box to view disbursements made via check.
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Filter Description Shortcut

Direct Deposit Select this check box to view disbursements made via direct deposit.

Bank Card Select this check box to view disbursements made via bank card.

Complete
Select this check box to view all disbursements where the Complete
check box is selected in the Bank Manager.

Incomplete
Select this check box to view all disbursements where the Complete
check box is not selected in the Bank Manager.

Clear filters
Clears all specific filter settings, providing a view of all the disbursements
in the system.

Bank Products Tab
The Bank Products tab, found in the Bank Manager, allows you to see detailed information on each return to which a bank
product is attached. See Bank Products.

To view the Bank Products tab:

Click the Bank Manager tab at the top of the application window. The Bank Products tab is the default view.

Bank Products Column/Field Descriptions

The following table details the columns and/or fields appearing in the Bank Products tab:

Column Description

Return Name Name of the return as listed on Return Manager.

Client # A number assigned by your organization to the return in Return Manager, if applicable.
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Column Description

Complete

Completion status of the return.

Returns bearing bank applications with statuses of Transmitted or Rejected by Bank
cannot bemarked complete.

SSN Social Security Number on the return.

Bank Status
Status of the bank application. When an e-file is created with a bank application, the bank
status is Created. See Bank Status/Acknowledgements.

Bank Status Date Date that the current bank status went into effect.

E-file Status
Status of the e-filed return as it relates to acceptance of the return, as displayed in the E-file
Manager.

E-file Status Date Date the E-file Status was set in E-file Manager.

Product Type The refund option selected on the 1040 EF InfoWorksheet.

# of Disbursements This is a count of how many disbursements are in the Bank Manager for that TIN.

EFIN
The Electronic Filing Identification Number for the ERO as stated on the 1040 EF Info
Worksheet.

E-file ID A set of numbers used for electronic filing. See E-file ID.

Rejection Reasons
This field is populated if an error is returned by the EFC, Bank, or the IRS. A message
describing the error appears in this field.

IRS Payment The amount refunded by the IRS as a result of the bank product application.

IRS Payment Date Date that IRS Payment is processed.

State Payment The amount refunded by the State as a result of the bank product application.

State Payment Date Date that State Payment is processed.

Disbursements Detail Column/Field Descriptions

The lower portion of the Bank Products tab contains disbursement detail relating to the selected return. If there are no
disbursements for the selected return, a No Disbursements message appears in the Disbursement Details pane.

Column Description

Disbursement Type The way the bank product was disbursed (such as Check or Direct Deposit).

Disbursement Date
The date the disbursement was made. If the disbursement is a check, this is the date the
check is authorized. If direct deposit, this is the date that the deposit is made.

Amount The amount of the disbursement.
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Column Description

Authorization # The authorization number of the check or deposit.

Bank Status The status of the disbursement.

Bank Status Date The date that the disbursement was made.

Check # If the disbursement is a check, this field displays the check number.

Disbursements Tab
The Disbursements tab of the Bank Manager allows you to track the number and status of bank products distributed to your
clients, as well as amounts distributed using the FeeCollect™ service.

To view amounts disbursed, click the Disbursements tab From the Bank Manager:

Column/Field Descriptions

Column Description

Client # A number assigned by your organization to the return in the Return Manager, if applicable.

Complete Completion status of the return as set in the Return Manager.

SSN Social Security Number of the return receiving the disbursement.

Return Name Name of the return as listed in the Return Manager.

Product Type The refund option selected on the 1040 EF InfoWorksheet.

Disbursement Type Check, Direct Deposit, or Bank Card.
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Column Description

Disbursement Date Date that the disbursement was made.

Amount Amount of the disbursement.

Authorization # A unique number assigned by the bank authorizing the disbursement.

Bank Status Status of the disbursement. The status is the equivalent of a bank acknowledgement.

Bank Status Date Date that the current bank status went into effect.

Check # Number of the check, if check was the disbursement type.

Bank Products
Bank products enable you to get your clients their refunds quickly and securely.

CCH Small Firm Services partners with two banks - Santa Barbara Tax Products Group, LLC (SBTPG) and 3Fund - to
provide bank products on 1040 returns.

Types of Bank Products

3Fund
3Fund offers customers two ways to receive their refunds:

l 3Fund Check
l 3Fund Direct Deposit

Refund Transfer (RT)
Customers can receive their refund transfers via check or direct deposit. The following RTs are offered with our product:

l RT Check
l RT Direct Deposit

Bank Card
Customers can receive their refunds via a debit card issued by the bank.

HowBank ProductsWork
Only Admin users or users with Administrator group privileges can enroll to use bank products.

Step 1 - Enroll Your EFIN with the Bank

Bank products are implemented through the bank that supports the product you select. Youmust enroll your EFIN with the
bank before being able to offer the bank product to your clients. Use Enrollment Manager to check the status of your bank
product enrollment until it is Accepted or Approved. See Updating Enrollment Statuses.

To enroll online for bank products:

1. Make sure you are connected to the Internet.
2. Visit https://support.atxinc.com.
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TheMyATX Solution Center Website appears.

3. Under Account Services, select Refund Settlement Solutions.

The Client Login screen appears. After logging in, the ATX Solution Center launches Manage My Account.

4. To enable available settlement solutions, complete all sections, including the Business Owner and EFIN Owner
sections.

5. In theMy Settlement Solutions section, click Enroll/Notify Bank, for the type of settlement solution you want to
offer.

6. In the Provider section, click your selection and complete the TPG application.
7. Follow directions on the web page to complete the enrollment application.

Step 2 - Request a Bank Product for a Return

To offer a bank product to a client, youmust complete another application along with the return. The bank application is listed
as a form in the Select Forms Dialog Box.

When complete, the bank app is then transmitted along with the rest of the e-file.

To add a bank product to a return:

1. Open the return.
2. Click the Add Forms button on the toolbar.

The Select Forms Dialog Box appears.

3. In the Find field, type Bank.
4. Select the bank application and click the Open Forms button.

The tab for the bank application is added to the return.

5. Complete the application.
6. Click the 1040 EF Info form tab.
7. At the bottom of the return, select the Payment and Refund worksheet.
8. Have your client sign the authorization form.
9. Create the e-file.
10. Continue to update your acknowledgements until your bank application is accepted. See Receiving

Acknowledgements.

In Case Your Bank Application is Rejected

You can have a situation where your e-file is accepted but the bank application is rejected. Depending upon the reason for
rejection, you can correct, re-create, and resubmit the bank application. See Re-Creating Bank Applications.

FeeCollect™
FeeCollect allows you to deduct professional fees directly from your client's tax refund.

FeeCollect is not available for use in conjunction with any other Settlement Solutions.

Before you can use the FeeCollect service, youmust enroll your Electronic Filing Identification Number (EFIN).

For frequently asked questions about FeeCollect, visit www.support.atxinc.com/feecollect/ESPFAQ.htm.
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HowFeeCollect Works
Only Admin users or users with Administrator group privileges can enroll to use FeeCollect.

Step 1 - Enroll Your EFIN with the Bank

Although it is not a bank product, FeeCollect is implemented through Santa Barbara Tax Products Group (TPG). You
must enroll your EFIN with TPG before being able to use FeeCollect. Use Enrollment Manager to check the status of your
FeeCollect enrollment until it is Accepted or Approved. See Updating Enrollment Statuses.

To enroll online for FeeCollect service:

1. Go to www.MyATX.com.

TheMyATX Solution Center Web site appears.

2. Under Account Services, select Refund Settlement Solutions.

The Client Login screen appears. After logging in, the ATX Solutions Center launches Manage My Account.

3. To enable available settlement solutions, complete all sections, including the Business Owner and EFIN Owner
sections.

4. In theMy Settlement Solutions section, to select FeeCollect, click Enroll/Notify Bank.
5. In the Provider section, click FeeCollect and complete the TPG application.
6. Once you have completed the enrollment process, return to your ATX software, while remaining connected to the

Internet.
7. To check on the status of your application, see Updating Enrollment Statuses.

Step 2 - Request FeeCollect for a Return

The FeeCollect application is a form that you attach to the return. Complete the form, e-file the return, and have your client
sign a form authorizing the bank to deduct your preparer fees from the refund. If your FeeCollect application is accepted by
the bank, your preparer fees are deducted from your client's refund and deposited to your account. The remainder of the
refund is deposited to your client's account.

FeeCollect is only for clients who select Direct Deposit as their refundmethod.

To request FeeCollect service on a return:

1. Open the return.
2. Click the Add Forms button on the toolbar.

The Select Forms Dialog Box appears.

3. In the Find field, type Fee.
4. Select the FeeCollect Application, and click the Open Forms button in the Select Forms Dialog Box.

The FeeCollect tab is added to the return.

5. Complete the application.
6. Click the 1040 EF Info form tab.
7. At the bottom of the return, select the Payment and Refund worksheet and select the FeeCollect option on the

worksheet.
8. Have your client sign the authorization form.
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9. Create the e-file.
10. Continue to update your acknowledgements until your FeeCollect application is accepted.

When do I receivemy professional fees?

Banks usually receive the refund in 10-14 days. Then, the bank deducts the professional fees from the refund, and
immediately deposits the remainder into your client's bank account. The bank deducts its $15 service fee from your
professional fees.

State tax refunds are also deposited into your client's bank account as soon as the bank receives the funds.

FeeCollect PS Package
The FeeCollect PS package offers a variety of preferred services to assist EROs inmultiple areas of their business
operations. A "solutions fee," which will apply to each unique SSN/TIN, will include the services listed below:

l Return status notification via text, email, or phone for all returns - Versicom Communications and CCH Small Firm
Services have partnered to offer Toll-Free Tax Infoline PLUS (TFTI+), a unique service that keeps your clients
informed on the status of their tax return and refund through automatic text messages and e-mail alerts;

l ERO fees collected on both Refund or Balance Due federal return;
l Multiple taxpayer options - options include direct deposit, debit card, or direct debit from bank account (paper check
is available for an added fee);

l Appropriate disclosure and bank application forms are automatically loaded into the return;
l Optional Protection Plus and Check Printing add-ons are also available.

Customers in IL, NY andME who process refund settlement products must purchase the FeeCollect PS package.

Protection Plus
An enrollment process is required for all Protection PLUS customers. To complete the enrollment process, or for more
information, call 866-942-8348 or go to https://taxprotectionplus.com/cch-online-enrollment.

If the client is receiving a bank product, the fee will automatically be deducted from their refund. If the client isn’t receiving a
bank product, simply collect the fee during tax preparation and Protection Plus will send you a bill for these customers.

Protection Plus is only available for Federal 1040 returns.

ERO Benefits of Protection Plus:

l Training and education provided from Protection Plus
l Dedicated resources to call with any questions
l Additional revenue stream for EROs up to an additional $70 per return
l Error protection
l Saves time since Protection Plus will assist taxpayers who receive a letter from the IRS
l Strong Spanish offering
l Freemarketingmaterials through Protection Plus
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Taxpayer Benefits of Protection Plus:

l Audit Assistance – help with denied EIC, education credits andmore
l Assistance with IRS letters the taxpayer may receive
l Up to $2,500 reimbursement for tax, interest and penalties (Excludes: AK, AR, CT, ID, ME, NH, ND, TN, RI & PR)
l Fast claim response
l Protection on returns with Sch C, E & F
l Tax Debt relief assistance
l Assistance with rejected ITIN (W7) applications
l Spanish support available

Bank Product Fees
There are several fixed, optional, and adjustable fees associated with most bank products. These fees are defined in the
bank product that is attached to the return.

Bank Fee

This is the fee the Processor charges to process the bank product. This fee will be taken out of the taxpayer's refund and will
be retained by the Processor.

To identify the fee for a bank product:

1. Open the return with the bank product.
2. Click the form tab for the bank product application.
3. At the bottom of the form, click the Projected Fee tab.

The Projected Bank Fees are listed at the top of this worksheet.

Tax Preparation Fee

This is the fee charged by the ERO for preparing the tax return. This fee is set by the ERO andwill be taken out of the
taxpayer's refund. The bank products processor (the Processor) will deposit this fee into the ERO's bank account.

The Processor may set limits to the amount you can charge in conjunction with their products. Do not change the
amount of this fee after it has been established with the Processor. Doing so could result in a temporary loss of your
Approved status with the Processor, leaving you unable to process their product(s) in the interim.

Transmission Fee

This is the fee charged for each taxpayer’s approved Federal bank product application transmitted through CCH SFS. Please
view your fees on the Support website to see the amount of this fee. This fee will be taken out of the taxpayer's check and
will be sent to CCH SFS.

State Transmission Fee (if applicable)

This fee is the amount CCH SFS charges for each taxpayer’s bank check or direct deposit for all approved state bank
product applications transmitted through CCH SFS. Please view your fees on the Support website to see the amount of this
fee. This fee will be taken out of the taxpayer's refund and will be sent to CCH SFS.
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Electronic Filing Fee (if applicable)

This is the fee the ERO charges the taxpayer to electronically file the return. This fee is set by the ERO andwill be taken out
of the taxpayer's refund. The Processor will deposit this fee into the ERO's bank account.

Bank Technology Fee

This is the fee charged by the bank, so it is essentially a bank service charge. Out of this money, Electronic Return
Originators (EROs)may receive a percentage for every bank product provided.

Service Bureau Fee (if applicable)

This is an optional fee set by amain office that has multiple sub-offices. The service bureau fee is set or charged by amain
office to its sub-offices. Themain office sets the fee during ERO enrollment and is paid to themain office by the bank.

Unpostables Report
In some cases, banks receive refunds for taxpayers who do not have approved bank applications on file. The bank sends an
acknowledgement to the preparer/ERO that the funds are unpostable. The preparer/ERO receives this acknowledgement
during Ack processing, and then the report is created.

Unpostable funds will be returned to the taxing agency if the bank is not provided with account information (via an approved
bank application).

To view the Unpostables Report:

1. From the Bank Manager, click the Reports menu; then, select Unpostable Report.

2. To print the Unpostables Report, click Print.

Enrollment Manager
The Enrollment Manager is where you:

l Enroll with a bank to offer or use Bank Products or FeeCollect™.
l Check for updates to your enrollment status.
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l Set or change Transmitter fee, Service Bureau fee, E-file fee, and/or Protection Plus Add On fee.

The Enrollment Manager lists the EFINs in your organization, shows the bank-related services in which each EFIN is
enrolled, and the enrollment statuses.

To access the Enrollment Manager:

From either the E-file Manager or the Bank Manager, click the Tools menu; then, select Enrollment Manager.

Enrollment Manager Filters

You can filter your enrollments in the following ways:

Filter Description Shortcut

Find check box and field
By selecting the Find check box, you can then search for a rollover
return by entering search criteria in the Find field. This is especially
useful when you're searching for a return by last name.

Ctrl+F

Bank Products View EFINs that have submitted enrollment for a bank product.

FeeCollect View EFINs that have enrolled for FeeCollect™ service.

Clear Filters
Clears all filter selections and displays all EFINs that have enrolled
for Bank Products or FeeCollect™.

Enrollment Function Description

Help Opens the Program Help window to view information about the Enrollment Manager.

Reset Columns
If you rearrange the order or size of the columns in the current tab of themanager, this
resets the columns to their original order and size.

Preparer/ERO Manager Opens the E-file tab of the Preparer/ERO Manager, where you can setup an EFIN.

Update Status Checks for the status of the enrollment.

Export Exports enrollment information.

Close Closes the Enrollment Manager.
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Enrollment Process

Youmust enroll your EFIN with the bank in order to offer Bank Products and FeeCollect™.

Your EFIN must already be recorded in the Preparer/ERO Manager. See Entering an ERO EFIN.

Before Enrollment

Enrollment is completed online. An active Internet connection is required.

You cannot enroll an EFIN unless you are an Admin user or have Administrator group privileges.

To access the online enrollment application for the product(s) you want to offer or use:

1. From Bank Manager, do one of the following:
l Click the Enroll Now link.
l Click the Tools menu; then, select Enrollment Manager.

To enroll in bank products, the EFIN must be listed in the Preparer/ERO Manager. See Entering an ERO
EFIN.

2. To enroll, click the Enroll Online link in the column of the product you want to offer.
3. Under My Account, click Refund Settlement Summary.

The Client Login screen appears.

4. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
5. Enter your User Name in the User Name box and press the Tab key.
6. Enter your Password in the Password box.
7. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
8. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
9. Click Log In.
10. Complete theMy Settlement Solutions section.
11. Once you have completed the enrollment process, return to your ATX software, while remaining connected to the

Internet.
12. In the Enrollment Manager, click Update Status. You'll receive an acknowledgement of your enrollment status.
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Acknowledgement of Enrollment Application
Youwill usually receive a same-day acknowledgement of application transmission. If your application is rejected, you will
see the word Rejected next to your EFIN in the Status column of the Enrollment Manager. If it is accepted, you will see a
green check mark next to your EFIN.

If your application is rejected, you canmake the appropriate changes online from the ERO/Bank Application link on the
MyATX Solution Center site. Correct any errors on your application, and then resubmit it.

Updating Enrollment Statuses

Youmust enroll your preparer/EROEFIN with a bank in order to use Bank Products or the FeeCollect™ service. To
determine if you've been approved to offer or use these products, youmust continue to check your enrollment status.

To update the enrollment status:

1. From the Bank Manager or from the E-file Manager, click the Tools menu.
2. Select Enrollment Manager.

3. Click Update Status.

4. Click Close.
5. View the updated status in the Enrollment Manager.

Setting Up E-file Fees

You can designate e-filing fees for each EFIN listed in the Preparer/ERO Manager and displayed in the Enrollment
Manager.
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To set up an e-file fee for an EFIN:

1. From either the E-file Manager or the Bank Manager, click the Tools menu.
2. Select Enrollment Manager.

The Enrollment Manager appears.

3. Double-click the desired cell in the E-file Fee column for the corresponding EFIN.
4. Enter the e-file fee.

You cannot set an e-file fee for EFINs that use FeeCollect™.

5. Click Close.

Adding Bank Products to Returns
If a client requests a Refund Transfer (check or direct deposit) or 3Fund (check or direct deposit), complete the
corresponding form and file it along with the return.

Bank products are only available on 1040, 1040-A, and 1040-EZ returns. Bank products are not available on business
returns.

To add a bank product (application) to a return:

1. Open the return.
2. Click the Add Forms button on the toolbar.

The Select Forms Dialog Box appears.

3. In the Find filter box, type Bank.
4. Select a bank product.
5. Click the Open Forms button on the toolbar.

Forms vary by provider, so your form may differ from the one pictured above.

6. Complete all of the worksheets for the form.
7. Do one of the following:

l Click the Save button on the toolbar
l Click the Returns menu; then, select Save Return
l Press Ctrl+S
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To attach a bank product from the EF Info Worksheet:

1. Open the return.
2. If you've not already done so, add an EF Info Worksheet to the return. For specific instructions, see Adding

Forms to a Return.
3. Click the 1040 EF Info tab to open the worksheet.

The EF Info Worksheet appears.

4. At the bottom of the return, click the Payment and Refund worksheet tab.
5. Scroll down to the Refund Options section.

The refund options that appear on the EF Info form are directly related to the bank products for which the EFIN
is enrolled. If you have not completed the enrollment process, see Enrollment Process.

6. Select the check box(es) for the refund type desired.
7. Save your changes.

E-filing Returns with Bank Products

Returns with bank product applications are e-filed just like other returns. After transmission, the bank product then receives
its own status as the customer and preparer await the disbursement of the refund and/or preparer fees.

Bank applications cannot be altered after e-file transmission unless the return status is Accepted and the bank
application status is Rejected. See Re-Creating Bank Applications.

Bank Status/Acknowledgements
When you e-file a return with a bank product, the Bank Manager gives you the status on the approval of the bank product
and the status of the return in relation to the EFC and the IRS. If your e-file receives a Rejected bank status, youmust correct
the bank errors displayed in E-file Manager, then re-create and re-transmit the bank application. For complete instructions,
see Re-Creating Bank Applications.

This table defines acknowledgement information that can appear in the Bank Status column on the Bank Products Tab and
Disbursements Tab of the Bank Manager.

Status Description

Created
The e-file (with bank product) has been created and the return is ready to be transmitted
to the Electronic Filing Center (EFC).
Next Step: Transmit E-file.

Transmitted to EFC
The return has been successfully transmitted to the EFC. Its status on our server does
not allow it to be re-transmitted.
Next Step: Wait for acknowledgements.

Transmitted to Bank or
Agency

The return has been transmitted to the bank or appropriate tax agency.
Next Step: Wait for acknowledgements.

Rejected by EFC
The return contains errors that must be corrected. It has not been transmitted to the IRS
or state. Next Step: Correcting E-file Rejection Errors.

181



Chapter 7: ATX Managers

Status Description

Rejected by Bank
The e-file was successfully transmitted to and received by the IRS or state, but it
contained errors relating to the bank product.
Next Step: Correcting E-file Rejection Errors.

Accepted

Return was successfully transmitted to and accepted by the IRS or state. The bank
application was also accepted, and a disbursement has been scheduled. To view the
scheduled disbursement, refer to Bank Products Tab and look in the Disbursement
Detail area.

Bank Product Status is Updated when Federal E-file Status Changes

Unless the bank product has been rejected by the bank, the bank product status will change according to the chart below if
there is a change to the Federal e-file status:

If Fed E-file Status Changes to... ...then Bank Status
Changes to...

...unless the Bank
Status Is...

Duplicated Rejected by EFC Rejected by Bank

Rejected by Agency Rejected by EFC Rejected by Bank

Viewing Disbursement Details
The Disbursement Details dialog box shows detail on the disbursement associated with a particular return, as well as the
fees that are deducted from the disbursement.

The arrow buttons allow you tomove back and forth amongst multiple disbursements, if more than one disbursement is
associated with one return.

To view the details of a disbursement for a specific return:

1. Open the Bank Manager.
2. Select the return for which you want to view disbursements.
3. Click the Disbursements menu; then, select View Selected Disbursement Details.
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Disbursement Details Field Descriptions

Column Description

Return Name Name associated with the return.

Disbursement Type Check, Direct Deposit, or Bank Card.

Disbursement Date Date and time that the disbursement was made.

Authorization Number A unique number assigned by the bank authorizing the disbursement.

Status
Status of the disbursement, which is part of the bank application. See Bank
Status/Acknowledgements.

Status Date Date and time that the current bank status went into effect.

Check Number Number of the check, if check was the disbursement type.

Amount Amount of the disbursement.

Arrow tabs
Use these arrows to scroll throughmultiple disbursements associated with one return (if
applicable). Single arrows move you from one disbursement to another in the list. Double
arrows place you at the first disbursement or last disbursement for the return.

X of X
Displays the current disbursement record out of a total of disbursement records
associated with the given return.

Close Closes the dialog box.

Re-Creating Bank Applications
If your federal e-file is accepted but the attached bank application is rejected, you can correct the errors, then re-create and
re-transmit the bank application.

Errors in the bank application are listed along with other return-related errors in the E-file Manager.

Bank applications cannot be altered after e-file transmission unless the return status is Accepted and the bank
application status is Rejected.
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To re-create a rejected bank application:

1. Open the Bank Manager.
2. Select the return with the rejected bank application, which appears in red:

3. Click the Applications menu; then select Display Rejected Errors.

4. Correct each bank application error shown at the bottom of your screen.
5. Click the E-file menu; then select Re-create Bank Application.

6. Click Continue.

If the bank application has been successfully re-created, it no longer appears red in the Bank Manager.

7. Save the return.

Youmay re-create the bank application as many times as you need after the initial rejection, until you
successfully create and transmit the bank application.

Transmitting Re-Created Bank Applications

If your Federal e-file status is Accepted but the attached bank application is Rejected, you can fix the errors, then re-create
and re-transmit the bank application. To re-create the bank application, see Re-Creating Bank Applications.

To re-transmit the re-created bank application:

1. Open the Bank Manager.
2. Click the Applications menu; then, select Transmit Re-Created Bank Applications.

184



Chapter 7: ATX Managers

Youmust close the return in order to transmit the re-created bank application. Open returns will be unmarked
and you will not be allowed to transmit.

3. Select the check box(es) for the bank application(s) you want to transmit.
4. Click Transmit.

5. Continue to update your acknowledgements until your bank application is accepted. See Receiving
Acknowledgements.

Youmay re-create the bank application as many times as you need after the initial rejection, until you
successfully create and transmit the bank application.

Preparer/EROManager
The Preparer/ERO Manager is where you can record paid preparer and ERO information required for the tax returns. Once
entered, Preparer/ERO information can be added to returns manually per return (see Inserting Preparer/ERO Information)
or automatically for all returns (see Preparer Manager Preferences).

To open the Preparer/ERO Manager:

From the Return Manager, do one of the following:

l Click the Tools menu; then, select Preparer/ERO Manager.
l Click the Preparer/ERO button on the toolbar

Use the Preparer/ERO Manager to enter your preparer/ERO data.
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Unlike company and payer data, preparer/ERO data that is manually entered on a return will not be saved in
the Preparer/ERO Manager.

Preparer/ERO Function Description

Find (Ctrl+F)
If you select the check box and begin typing in the field, the window will jump to an
entry matching the text entered.

Clear Filters Clears the Find filter and displays the entire list of preparers in alphabetical order.

Pagination controls
Pagination controls can be used to determine the number of items on a page as well
as which page of data you're viewing. SeeManager Pane.

Add New Inserts a new row with blank fields for new preparer information.

Delete Removes the selected preparer's information from the Preparer/ERO Manager.

Export
Exports a list of all the preparers stored in the Preparer/ERO Manager into a .csv
file.

Close Closes the Preparer/ERO Manager.

Help Opens Program Help.

Reset Current Resets columns in selected tab to their default size and arrangement.

Reset All Resets columns in all tabs to their default size and arrangement.

Adjust Preparer/ERO Settings Opens Preparer Manager Preferences.

Preparer/EROManager Tabs

Preparer tab

Enter basic information about the preparer, including Name, PTIN and/or SSN.

Firm tab

Enter Preparer EIN, Firm Name, Address, e-mail, and Phone Numbers.

E-File tab

Enter information for preparers who file electronically, such as EFIN and ERO designation.

Because the EF InfoWorksheet uses the EFIN and ERO information as entered in the Preparer/ERO Manager, it is
imperative that the information is entered correctly.

Adding Preparer/ERO Information
You can enter an unlimited number of preparers in Preparer/ERO Manager. However, to be able to sign in and use the
system, an individual must be set up as a user in Security Manager. See Adding Users to the System.
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To add preparers and/or EROs to the system:

1. From Return Manager, do one of the following:
l Click the Preparer/ERO button on the toolbar.
l Click the Tools menu; then, select Preparer/ERO Manager.

2. Click Add New.
3. Enter the preparer or ERO information.
4. Click Close.

Preparer/ERO information that is added directly to a return will not be saved in the Preparer/ERO Manager.

Special ID Numbers for States

NYTPRIN for New York State Preparers
New York State tax preparers must register each year with the New York State Department of Taxation and Finance to
receive a New York Tax Preparer Registration Number (NYTPRIN). In order to have the NYTPRIN automatically added to
returns, youmust enter this number in the NYTPRIN column on the Preparers tab of the Preparer/ERO Manager. For
more information on the NYTPRIN, visit http://www.tax.ny.gov/tp/tpreg.htm.

Preparers who are exempt from the NYTPRIN should use the drop down list to select the exemption code from the
NYTPRIN Excl column on the Preparers tab of the Preparer/ERO Manager.

NM CRS for New Mexico Preparers
Anyone engaged in business in New Mexicomust register with the Taxation and Revenue Department. As part of
registration, the business receives a state tax ID number known as a Combined Reporting System (CRS) number. This
registration is themainmethod for reporting the State’s major business taxes.

Preparers who receive aW-2 from a tax preparation firm or company do not need a CRS number; they should use the firm’s
CRS ID Number when preparing returns. Contractors must apply for their own CRS ID Number, and should not use the firm’s
CRS number.

To apply for a CRS ID number or for more information on the topic, visit www.tax.newmexico.gov.

Printing Preparer Signatures on Returns

IRS Notice 2004-54 permits preparers to use software to print the preparer signature on tax returns. Many states have
adopted the same rule. Check with your state's Department of Revenue for details.
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To automatically have a preparer/ERO name appear in the Preparer's signature block on tax returns:

1. Click the Tools menu; then, select Preparer/ERO Manager.

2. On the Preparer tab, select the Print Signature check box.
3. Click Close.

If you prepared returns prior to selecting this option, you will have to reenter the preparer/ERO on the return.
See Inserting Preparer/ERO Information.

Entering an ERO EFIN
Only users with Admin or Office Manager security privileges can perform the task(s) discussed in this topic.

To enter an EFIN for a Preparer/ERO:

1. From the Return Manager, do one of the following:
l Click the Preparer/ERO button on the toolbar.
l Click the Tools menu; then, select Preparer/ERO Manager.

2. Click the E-file tab.

3. Highlight the desired Preparer/ERO, and enter their EFIN in the appropriate field.
4. Select the ERO check box.
5. Click Close.
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To enable a Preparer/ERO to sign in and use the system, he/shemust be set up as a user in Security Manager. See
Adding Users to the System.

Initial EFIN Defaults to Secondary Preparers

If the initial preparer (the first you enter in the Preparer/ERO Manager) has an EFIN, the program automatically assigns the
same EFIN to subsequent preparers. If subsequent preparers are EROs and will be using their own EFINs to submit returns,
be sure to enter the correct EFIN for those preparers.

If a preparer is not an ERO, delete the EFIN from the record.

Deleting Preparer/ERO Information
To delete preparer or ERO information from the system, use the Preparer/ERO Manager.

To delete Preparer/ERO information:

1. From Return Manager, do one of the following:
l Click the Preparer/ERO button on the toolbar.
l Click the Tools menu; then, select Preparer/ERO Manager.

2. Highlight the row to be deleted.
3. Click Delete.

4. Click Delete to confirm.

Changes made to Preparer/ERO information via the Preparer/ERO Manager are not automatically transferred to
existing returns that contain the information.
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Inserting Preparer/ERO Information
This topic provides instructions onmanually inserting a preparer or ERO into a single return. To automatically insert a default
preparer or ERO on all your returns, use Preparer Manager Preferences.

To insert preparer/ERO information on a return:

1. Open the return.
2. Do one of the following:

l Click the Preparer/ERO button on the toolbar.
l Click the Tools menu; then, expand the Preparer/ERO fly-out menu and select Insert Preparer/ERO.

3. Select from the following:
l No Change (keep any existing preparer/ERO info)
l None (remove any existing preparer/ERO info)
l One of the preparers/EROs in the list (if applicable)

4. Click OK.

TheManage Preparers link automatically opens the Preparer/ERO Manager. Preparer and/or ERO information can be
entered and then inserted into the open return and/or future returns.

The Adjust Preparer/ERO Settings link opens Preparer Manager Preferences.

Removing Preparer and ERO Information
If the Preparer and/or ERO information in a return is incorrect, it can easily be removed.

To remove preparer and/or ERO information from a return:

1. Open the return.
2. Click the Tools menu.
3. Expand the Preparer/ERO fly-out menu; then, select one of the following:

l Remove Preparer
l Remove ERO
l Remove Both

Exporting Preparer/ERO Information
This procedure exports the entire preparer list as a .csv file to the location you designate.
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To export a list of preparers:

1. From the Return Manager, do one of the following:
l Click the Preparer/ERO button on the toolbar.
l Click the Tools menu; then, select Preparer/ERO Manager.

2. Click Export.

The Export Preparers window appears.

3. Browse to the location where your Preparer/ERO information is to be saved.
4. In the File name field, enter a name for your exported .csv file.
5. Click Save.

Company Manager
The Company Manager allows you to save core information for companies, such as EIN, Address, and State ID. This
makes preparingmultiple returns for the same company faster andmore accurate.

As you prepare returns, the program automatically records the company information in the Company Manager. You can
alsomanually add companies.

191



Chapter 7: ATX Managers

To open the Company Manager from Return Manager, click the Tools menu; then, select Company Manager.

To open the Company Manager from an open return, click the Tools menu; then, select Insert Company.

Company Manager Function Description

Find (Ctrl+F)
If you select the check box and begin typing in the field, the dialog box will jump
to an entry matching the entry.

Clear Filters
Clears the Find filter and displays the entire list of companies in alphabetical
order.

Pagination controls
Pagination controls allow you to set the number of items on a page as well as
which page of data you're viewing. SeeManager Pane.

Add New
Inserts a new row with blank fields in which new company informationmay be
entered.

Delete Removes the selected company's information from the Company Manager.

Export Exports a .csv file of all companies stored in the Company Manager.

Close Closes the Company Manager.

Insert on Form
Inserts the highlighted company information onto the current form (only
available from an open return).

Help
Opens the Program Help window to information pertaining to Company
Manager functionality.

Reset Columns
If you rearrange the order or size of the columns in the current tab of the
manager, this resets the columns to their original order and size.

Adding Companies
To add Companies to the Company Manager:

1. From Return Manager, click the Tools menu; then, select Company Manager.

2. Click Add New.
3. Enter the company’s information on the row provided.
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4. Click Close.

Inserting Company Information
If a company's information is stored in Company Manager, it can be inserted into a return when you need it with just a few
clicks of your mouse.

To enter company information on a return:

1. Open a return.
2. Click the Tools menu; then, select Insert Company.

3. Highlight the row containing the desired company information.
4. Click Insert on form.

Deleting Companies
You can delete one company entry at a time from the Company Manager.

To delete a company from the list:

1. Click the Tools menu; then, select Company Manager.

2. Highlight the company you want to delete.
3. Click Delete.
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Exporting Companies
This procedure exports the entire company list as a .csv file to the location you designate.

To export company information:

1. From the Return Manager, click the Tools menu; then, select Company Manager.

2. Click Export.

The Export Companies dialog box appears.

3. Navigate to or create the folder where the file is to be saved.
4. Enter a name for the file.
5. Click Save.

Payer Manager
The Payer Manager retains information on companies and employers who generateW-2 and 1099 information for your
1040, 1040A, and 1040-EZ clients. Once entered in the system, a payer is saved and can be quickly added to subsequent
W-2s and 1099s from a convenient drop-down list.

To access Payer Manager and view payers:

From the Return Manager, click the Tools menu; then, select Payer Manager.
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Payer Manager Function Description

Find (Ctrl+F) check box/field
If you select the check box and begin typing in the field, the window will jump to an entry
matching the entry.

Clear Filters Clears the Find filter and displays the entire list of payers in alphabetical order.

Pagination controls
Pagination controls allow you to set the number of items on a page as well as which
page of data you're viewing. SeeManager Pane.

Add New Inserts a new row with blank fields for new payer information.

Delete Removes the selected payer information from the Payer Manager.

Export Exports a .csv file of all payers stored in the Payer Manager.

Close Closes the Payer Manager.

Help Opens Program Help window to information about Payer Manager.

Reset Columns
If you rearrange the order or size of the columns in the current tab of themanager, this
resets the columns to their original order and size.

Adding Payers to the System
You can add payers to the system in two ways:

l Enter payer information onW-2 or 1099 forms
l Enter payer information directly into the Payer Manager

Using either method, the system saves any payer information in the Payer Manager. This information is thenmade
available onW-2s and 1099s via the QuickEntry - Select Payer drop down list. See Using QuickEntry to Select Payers.

Adding Payers to the System from a Form

The default Enable Payer Manager setting in Open Return Preferences ensures that any payer information entered
directly on aW-2 or 1099 form will be automatically saved to the Payer Manager repository. For subsequent W-2s and
1099s, the payer appears in the QuickEntry - Select Payer drop-down list.

Payer information is added when entered onto forms W-2, W-2G, 1099-G, 1099-R, 1099-S, 1099-DIV, 1099-INT, and
1099-MISC.

To add new payer information to a W-2 or 1099:

The instructions assume that you've created a return with either aW-2 or 1099 input worksheet attached.

1. From the open return, click either theW-2 or 1099 tab.

The input worksheet of the corresponding form appears.

You can enter payer information on either the Input or Detail worksheet, depending on your preference.

2. Enter payer information on the form.
3. To save the return, do one of the following:
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l Click the Save button on the toolbar.
l Click the Returns menu; then, select Save Return.

To add payers directly to the Payer Manager:

1. From Return Manager, click the Tools menu; then, select Payer Manager.

2. Click Add New.
3. Enter the payer’s information on the row provided.
4. Click Close.

UsingQuickEntry to Select Payers
TheQuickEntry function is a drop-down list of payers already in the system. Payer information can be entered directly into
the Payer Manager or can be entered directly into aW-2 or 1099 form.

TheQuickEntry function is found at the top of the followingW-2 and 1099 forms:

l W-2
l W-2G
l 1099-G
l 1099-R
l 1099-S
l 1099-DIV
l 1099-INT
l 1099-MISC

To add previously-saved payer information to a W-2 or 1099 Form:

This instruction assumes that you've created a return with either aW-2 or 1099 input worksheet attached.

1. From the open return, click the tab for theW-2 or 1099.
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2. Click the QuickEntry - Select Payer field to select it.
3. Do one of the following:

l Click the drop-down arrow.
l Begin typing the payer Name or EIN in the field. The list is filtered as you type.

4. Select the desired payer.

Making Changes to Previously-Saved Payer Information

If youmake changes to existing payer information (selected from theQuickEntry - Select Payer drop-down list), those
changes will also be saved to the Payer Manager when the return is saved.

Deleting Payers
You can delete one payer entry at a time from the Payer Manager.

To delete a payer from the list:

1. From Return Manager, click the Tools menu; then, select Payer Manager.
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2. Highlight the row containing the payer information to be deleted.
3. Click Delete.

Exporting Payers
This procedure exports the entire payers list as a .csv file to the location you designate.

To export the list of payers:

1. From the Return Manager, click the Tools menu; then, select Payer Manager.

2. Click Export.

The Export Payers dialog box appears.

3. Navigate to the folder where the file is to be saved.
4. Enter a name for the file.
5. Click Save.

Security Manager
The Security Manager is used tomanage user access to ATX. It allows the Admin user to set up users andmanage user
access to a variety of system functions.

Only the Admin user or users with Security Manager rights may access Security Manager.

For each new user, the following tasks should be performed in Security Manager:

l Assignment of a User Name: Users are assigned a User Name whichmust be used to gain access to the system.
l Assignment of a Password: Users are assigned a Password which are required for all users.
l Assignment to a User Group: Users are assigned to one or more security groups (which define the system tasks
they can perform). Users can only perform the tasks that are included in their security group's list of available
actions.

Network users must have a user profile in Security Manager in order to log into ATX.
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To open Security Manager, click the Tools menu; then, select Security Manager.

Users Tab
The Users tab (and the dialog boxes that you access from it) allows you to add new users to the system and to define the
tasks (via the security group assignments) to which each user has access.

Groups Tab
TheGroups tab (and the dialog boxes that you access from it) allows you to edit default security groups and define custom
security groups tomeet your business needs.

Security Manager Terminology
If you've never worked with system security, there are a few terms you'll need to know:

User

Anyone who uses the system in someway. All users must have a corresponding User Name that he or she will use to log in.

Action

A task or group of tasks that users perform in the system, such as Print Return or Create e-file.

Active status

An Active status indicates that a user is current, thus enabling them to log in and perform their assigned system actions.
Active is the default state for all users.

If you deactivate a user, you block the user from logging into the system. User information is retained and the user can be
made Active again at any time.

Group (or, Group Membership)

The security Group combines a list of system actions. This Group represents the user's level of system access. Each user
must be assigned to a group in order to grant them the access they need to perform their job tasks. For a list of available
actions, see Security Manager Available Actions.
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If you have a user that does not fit into one of the default groups, you can assign the user to multiple default groups or you can
assign a unique set of actions to that user by Creating a New Security Group.

Admin User

The Admin user is the individual in the organization who has complete system rights, including the right to add new users to
the system and to grant all users their particular levels of access.

User Passwords are Required
Users are required to have passwords to access the system. By assigning a password to a user, unauthorized activity can be
prevented by controlling user actions within the system.

l Users can edit their own passwords. See Editing Passwords.
l If a user forgets a password, the Admin user (or a user with Security Manager privileges) can reset the user's
password without having to know the current password. SeeModifying a User's Security Profile or Resetting the
Admin Password.

Default User Names andGroups
Your system has one default User Name and several default Security Groups, listed below. See Security Manager
Available Actions for an explanation of each available action.

Default User
Name Default User Group System Rights/Access Restrictions

Admin Administrator
Complete and unrestricted
access to all system
functionality.

Cannot modify available actions
in this group.

Basic Group
Includes basic system
functionality (such as Start or
Edit a Return).

Cannot modify available actions
in this group.

Office Manager

Includes all basic system
functionality, as well as most of
the Available Actions. The
Office Manager group does
not have access to the
following functions: Access
Security Manager, Create E-
files, and Delete E-files.

Tax Preparer

Includes all basic system
functionality, in addition to
Create E-files, Mark Returns
Complete, Delete E-files, and
Print Returns.
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Default Admin User

The product requires an administrative user to set up preliminary data in the system and tomanage users. Consequently, the
Admin user is the default user name. The Administrator group is automatically associated with it, enabling the Admin user to
set up other users in the system as well as necessary system data.

Default User Groups

The other default groups are a sample of group assignments you can establish in Security Manager. You can assign users
to these defaults, modify the Office Manager and Tax Preparer defaults, or create new groups and customize the actions
of each according to your needs.

Security Manager Available Actions
The system has a set of basic actions (such as Start and Edit a Return) that are automatically assigned to all user groups.
(Basic actions are not listed under Available Actions).

The following is a list of additional Available Actions that can be assigned to a group.

Actions are only available to a user if the user is assigned to a security group with which the actions are associated.

Available Action Information about Action

Access Security Manager
Permission to open and work in Security Manager. This action is
typically reserved for individuals who perform administrator type
duties in the organization.

Access Preparer/ERO Manager
Permission to open and input information on tax preparers in the
Preparer/ERO Manager.

Access Accounts Receivable Tab

Permission to view the Accounts Receivable Tab of the Return
Manager, which shows the client's billing status. If the user is not
granted access to Accounts Receivable, corresponding columns
within Return Manager will also be restricted.

Access Tax Warehouse Tab

Permission to view the Tax Warehouse Tab, which is a summary
of tax information from a client's return. If the user is not granted
access to Tax Warehouse, corresponding columns within Return
Manager will also be restricted.

Marking Returns Complete
Permission to use the Complete column in Return Manager to
mark a return Complete. A returnmay bemarked complete based
on your organization's return completion requirements.

Unmarking Returns Complete
Permission to remove the X from the Complete column in Return
Manager.

Print Returns Permission to print a whole return or pages of a return.

Access Billing Manager Permission to open and work in the Billing Manager.
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Available Action Information about Action

Access Client Communication Manager
Permission to open and work in the Client Communication
Manager, which includes the Client Letter feature. See Standard
Client Letters.

Create E-files Permission to create an e-file from an open tax return.

Transmit E-files Permission to transmit an e-file to the EFC.

Receive Acknowledgements

Permission to receive acknowledgements from the EFC. See
Managing Acknowledgements (Acks).

Users who have permission to receive acknowledgements also
have permission to sync with the EFC.

Delete E-files Permission to delete a saved e-file.

Adding Users to the System
Each user must have a unique User Name and Password. The Admin user sets up User Names and Passwords
in Security Manager.

Passwords are required and provide extra security. They are setup by the Admin user when adding new users to the system.

ATX includes user licensing with each product package, for each standalone or workstation installation that is
activated, a user license is required. Should you need additional user licenses, please contact your Account Manager at
1-877-728-9776.

Only the Admin user or users with Security Manager rights may access Security Manager.

To add a new user:

1. Click the Tools menu; then, select Security Manager.

202



Chapter 7: ATX Managers

2. Click New.

3. In the User Name field, enter a user name (up to 20 characters).
4. In the Password field, enter a user password.

Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

5. In the Available groups pane, select the group to which the new user will be assigned.

See Default User Names and Groups.

6. Click Add --> tomove the selected group to the Assigned Groups pane.
7. Click OK.

Modifying a User's Security Profile

You canmodify a user's profile in the following ways:

l Change the User Name
l Edit the Password (users can also do this themselves)
l Change the user's assignedGroup, or add other groups
l Deactivate the user's security profile

Only the Admin user or users with Security Manager rights may access Security Manager.
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To change the user's assigned group:

1. Click the Tools menu; then, select Security Manager.

2. Highlight the user whose profile you want to modify.
3. Click Modify.

To change a User name:

You cannot change the default Admin user name. You can, however, create a new user with Administrator group
privileges.

1. In theModify User dialog box, type a new user name in the User name field.
2. Click OK.
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To edit a password:

Users can change their own password by following steps in the Editing Passwords topic. To change the password,
they must know the current password.

1. In theModify User dialog box, type a new password in the Password field.

Passwords must follow these guidelines:

l 8 - 20 characters
l At least 1 UPPER case letter
l At least 1 lower case letter
l At least 1 number
l At least 1 punctuation or special character (ex.? ! $ & * )
l Spaces are allowed

2. Click OK.

To add a group to the user's profile:

1. In theModify User dialog, click the group you want to add in the Available groups pane.
2. Click the Add button.

You can also double-click the group(s) you want to add.

3. Click OK.

The group appears in the Assigned groups pane.

To remove a group from the user's profile:

1. In theModify User dialog, click the group you want to remove in the Assigned groups pane.
2. Click the Remove button.

You can also double-click the group(s) you want to remove.

3. Click OK.

The group appears back in the Available groups pane.

Deactivating a User in the System

If you're the Admin user, you can deactivate a user's security profile without removing the profile information from the
system.

The Active check box on theModify User dialog box can be used to deactivate or reactivate a user in the system. While the
user will no longer be able to access the system, the system will still have the user name's setup information. This is a
particularly useful security feature for businesses that have repeat seasonal employees, such as seasonal tax preparers.

Only the Admin user or users with Security Manager rights may access Security Manager.

To deactivate a user's profile:

1. Click the Tools menu; then, select Security Manager.
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2. Click the user whose profile you want to deactivate.
3. Click Modify.

4. Clear the Active check box.
5. Click OK.

Re-activating a User
Re-activating a user's security privileges in the system is the reverse of deactivation. Simply select the Active check box on
theModify User dialog box and save the changes.

Deleting Users from the System
Only the Admin user or users with Security Manager rights may access Security Manager.
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To delete a user from the system:

1. Click the Tools menu; then, select Security Manager.

2. Highlight the user you want to delete.
3. Click Delete.

4. Click Yes.

Creating a NewSecurity Group
If the default security groups do not meet the needs of your business, you can create your own custom group.

Only the Admin user or users with Security Manager rights may access Security Manager.

To create a new security group:

1. Click the Tools menu; then, select Security Manager.
2. Click the Groups tab.
3. Click New.
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4. In the Group Name field, enter the name of the new group.
5. In the Description field, enter a description for the new group.
6. To associate a set of actions with the group, do one of the following:

l Select the desired action(s) in the Available Actions pane; then, click Add --> tomove the selected action(s) to
the Group Actions pane.

l Click Add All --> to move all Available Actions to the Group Actions pane.
l Double-click desired actions in the Available Actions pane (one at a time) to move them to the Group Actions
pane.

7. Click OK when all desired actions for the new group appear in the Group Actions pane.

To remove an action from a group:

1. Do one of the following:
l Select the desired action(s) in the Group Actions pane; then, click <-- Remove tomove the selected action(s)
to the Available Actions pane.

l Click <-- Remove All to move all Group Actions to the Available Actions pane.
l Double-click the desired action(s) in the Group Actions pane (one at a time) to move them to the Available
Actions pane.

2. Click OK when all actions to be removed from the group appear in the Available Actions pane.

Modifying Security Groups
Only the Admin user or users with Security Manager rights may access Security Manager.

To modify a security group:

1. Click the Tools menu; then, select Security Manager.
2. Click the Groups tab.
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3. Select the group to bemodified.
4. Click Modify.

To change the Group Name or Description:

1. In theModify Group dialog box, edit the Group Name and/or Description as desired.
2. Click OK.

To add actions to a group:

1. In theModify Group dialog, do one of the following:
l Select the desired action(s) in the Available Actions pane; then, click Add --> tomove the selected action(s) to
the Group Actions pane.

l Click Add All --> to move all Available Actions to the Group Actions pane.
l Double-click desired actions in the Available Actions pane (one at a time) to move them to the Group Actions
pane.

2. Click OK when all desired actions for the new group appear in the Group Actions pane.
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To remove actions from a group:

1. In theModify Group dialog box, do one of the following:
l Select the desired action(s) in the Group Actions pane; then, click <-- Remove tomove the selected action(s)
to the Available Actions pane.

l Click <-- Remove All to move all Group Actions to the Available Actions pane.
l Double-click the desired action(s) in the Group Actions pane (one at a time) to move them to the Available
Actions pane.

2. Click OK when all actions to be removed from the group appear in the Available Actions pane.

Remaining Group Actions will still be available to the group.

Deleting Security Groups
Only the Admin user or users with Security Manager rights may access Security Manager.

To delete a security group:

1. Click the Tools menu; then, select Security Manager.
2. Click the Groups tab.

3. Select the group to be deleted.
4. Click Delete.

5. Click Yes to confirm.
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If any users are assigned to a group, that group cannot be deleted.

Restricted Access Message
The Restricted Access message appears when users attempt to perform a system activity (or action) and they have not
been granted rights to that particular function:

The Admin user can log in and resolve this issue personally. Alternatively, the Admin user can enable the user to access the
restricted feature(s) by doing one of the following:

l Remove the existing group to which the user is assigned and assign a group that can access the desired feature(s).
SeeModifying a User's Security Profile.

l Create a new group containing the desired action(s); remove the existing group from the user's profile, and assign
the new group. See Creating a New Security Group.

l Modify the security group to which the user is already assigned (add a new action). SeeModifying Security
Groups.

The Administrator and Basic groups cannot bemodified.

Close ATX and restart for these changes to take effect.
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Billing Manager
The Billing Manager allows you to set up rates for specific tax forms and schedules, as well as hourly billing rates for
preparers and other individuals in your firm. The rates you enter in the BillingManager are automatically entered on the billing
invoice, which you can attach to a return like any other form.

Changes youmake to Billing Rate information are only applied to returns created after the changes aremade.

To open the Billing Manager:

From Return Manager, click the Tools menu; then, select Billing Manager.

Form and Schedule Rates
Standard rates for tax forms and schedules are set on the Form Rates tab of the Billing Manager.

To access the Form Rates tab:

1. Click the Tools menu; then, select Billing Manager.
2. Click the Form Rates tab.
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Form Rates tab

The Form Rates tab includes filtering features, as well as Import/Export functionality:

Filters and Buttons Description

Find
Type the name or number of the form for which you're looking. This is the general search
function.

Rate Type the rate (dollar amount) for which you're looking.

Federal, State, Local Filter the form list by jurisdiction.

Form Type Filter the form list by type, such as Corporate, Individual, or Partnership.

Clear Filters Clears all filters and displays all forms in the list.

Help link Displays the Program Help topic related to the Billing Manager.

Change Rates Enter a new, common rate for all the filtered forms.

Import Browse for the folder in which a .csv file of form rates is located.

Export Browse for the folder into which you'd like to save a .csv file of form rates.

Close Closes the Billing Manager.
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Setting Up Form and Schedule Rates
If you do not roll your billing rates over from last year, the first time you access the Billing Manager, the program will open
with the Change Form Rates dialog box on top of the Form Rates tab of the Billing Manager. This gives you an opportunity
to set initial standard rates for forms.

To set a common basic rate for all forms or schedules:

1. Click the Tools menu; then, select Billing Manager.

If you have selected any Billing Manager filters, the rate you enter will only apply to the forms that appear as a
result of the filter selections.

2. In the Change Form Rates dialog box, enter a rate for all forms and schedules in the filtered list.
3. In the Change Form Rates dialog box, click Change Rates. The new rates will appear in the list in the Form

Rates tab of the Billing Manager.
4. Click Close.
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Setting UpHourly Rates
Hourly rates for preparers and other individuals in your organization are set up in the Billing Manager.

To set up standard hourly rates for one or more people in your organization:

1. Click the Tools menu; then, select Billing Manager.

2. Click Add New.

A new row appears in the table. The Name field is highlighted.

3. In the Name field, enter the name of the preparer or individual in the organization.
4. In the Rate field, enter the hourly rate for the preparer or other individual.
5. Repeat steps 2 through 4 for any additional billable individuals.
6. Click Close.
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Hourly Rates tab

The Hourly Rates tab includes the following functionality:

Function Description

Find Allows you to search for a preparer, individual, or rate.

Clear Filters Clears the Find filter and displays all names in the list.

Help Opens Program Help.

Add New Click to add a new preparer or individual with an hourly rate.

Delete Deletes the highlighted row/entry.

Import Browse for the folder in which a .csv file of hourly rates is located.

Export Browse for the folder into which you'd like to save a .csv file of hourly rates.

Close Closes the Billing Manager.

Changing Form Rates
Form Rates can be changed at any time. However, the changes youmake will only affect returns created after the
changes aremade.

To change a specific form rate:

1. Click the Tools menu; then, select Billing Manager.
2. Click the Form Rates tab.
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3. In the Rate column enter the desired rate for each form.
4. Click Close to save your changes and exit.

If you have already opened the Billing Invoice in a return, changing the standard rates will not change the rates for that
return. Youmust either discard the billing invoice and open a new one, or change the rates specifically for that invoice.

Changing Rates in anOpenReturn
Changing the billing rates for the open return will affect that return only and will not change other standard rates.

To change form and schedule rates for an open return:

1. From the open return, click the Tools menu; then, select Billing Manager.

2. In the Rate column, enter the new rate for the form.
3. Click Close to save your changes.

To change hourly rates associated with the open return:

1. From the open return, click the Tools menu; then, select Billing Manager.

The For This Return tab of the Billing Manager appears.

2. Select the Hourly Rates tab.

The Hourly Rates tab of the Billing Manager appears.

3. In the Rate column, enter the new hourly rate.
4. Click Close to save your changes.
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Exporting Billing Rates
You can use the Billing Manager to export your form and/or hourly billing rates to .csv files. UsingMicrosoft Excel, you can
modify the .csv file, if desired, and then import it back to your primary computer or to another computer. See Saving an .xls
as .csv.

To export standard form rates:

1. Click the Tools menu; then, select Billing Manager.
2. Click the Form Rates tab.

3. Click Export.

A Browse For Folder dialog box appears.

4. Navigate to the location where the file is to be saved.
5. Click OK.
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To export standard hourly rates:

1. Click the Tools menu; then, select Billing Manager.

2. Click Export.

The Browse for Folder dialog box appears.

3. Navigate to the location where the file is to be saved.
4. Click OK.

Modifying Billing Rates in a .csv File
If you need to change your billing rates, youmay find it easier to do this in aMicrosoft Excel format than tomake the
changes in the system.

To modify billing rates in a .csv file, you must:

1. Export the .csv file to a directory on your system. See Exporting Billing Rates.
2. Modify the .csv file (see instructions in this topic).
3. Import the .csv file back into the ATX product. See Importing Billing Rates.

To modify the billing rates in the .csv file:

Both the forms rates and hourly billing rates are exported in a .csv file format. The .csv file can be opened and edited with
Microsoft Excel.

1. Right-click the .csv file (FormBillingRates.csv or HourlyBillingRates.csv).
2. Click Open with and click Microsoft Excel to open the file.
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3. Make your changes in Excel.
4. Save the file.

Importing Billing Rates
Only .csv files may be imported.

Importing Form Rates
To import standard form billing rates:

1. Click the Tools menu; then, select Billing Manager.
2. Click the Form Rates tab.

3. Click Import.

A Browse for Folder dialog box appears.

4. Navigate to and select the file for import.
5. Click OK.
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6. Click Yes to confirm.

7. Click OK.

Importing Hourly Rates
To import standard hourly billing rates:

1. Click the Tools menu; then, select Billing Manager.

2. Click Import.

A Browse for Folder dialog box appears.

3. Navigate to and select the file for import.
4. Click OK.
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5. Click Yes to confirm.

6. Click OK.

Adding a Billing Invoice to a Return
After you add an invoice to a return, you canmodify the rates for that return, bill flat fees, andmodify the invoice in other
ways.

When sending an invoice to CCH iFirm, ATX prompts you to add the Billing Invoice to the return. See Send CCH iFirm
Invoice.

To add the billing invoice to a return:

1. Open the return.
2. Click the Forms menu; then, select Billing Invoice.

The Billing Invoice includes the following pages:

Billing Pages Description

Options Allows you to select a variety of billing options for the particular return.

Invoice
Displays a statement of charges for the return. These charges are pulled from the Forms
Rates and Hourly Rates tabs of Billing Manager.

Hourly Billing Rates Provides a breakdown of all the hourly billing rates associated with the return.

By Worksheet
Use this worksheet to customize the Statement or Invoice. Type in any worksheets you
want to include as part of the invoice. Select the check box beside the Description to include
that item in the invoice.

Forms Statements Lists the forms and schedules prepared for the particular return.

Excluded Forms
Lists all forms in the return. Check the box for each form you want to include on the Forms
Statement or Invoice.
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If you have already opened the billing invoice in a return, changing the standard rates will not change the rates for that
return. Youmust either discard the billing invoice and open a new one, or change the rates specifically for that invoice.

Completing the Billing Invoice
The Billing Invoice is a form that can be added to any return. After adding it to the return, you canmodify it or customize it.
See Adding a Billing Invoice to a Return.

When you add the Billing Invoice to the return, the Billing Options page is the first to appear.

Billing Options Page

Preparer Information
To print your firm's information on the invoice, select the Print on Invoice check box. To change information, type over the
existing text.

Changes youmake apply only to this invoice.

Client Information
Your client's name and address are identical to the corresponding fields on the return. To change the invoice name or
address, type over the text.

Billing Methods
You can combine all charges into one line item or create a detailed billing statement. To combine the charges and create a
summary billing, select the Combine all charges above check box.

To change billing descriptions on the invoice, type over the text in the Description fields.

Invoice Page

Invoice Date
The Invoice Date reflects your computer's current system date, but the Date field may be overridden to reflect any date you
choose.

Billing a Flat Fee
To bill a flat fee for a specific return:

1. Open the return.
2. Click the Forms menu; then, select Billing Invoice.

The Billing Invoice is added to the return.

3. Select the Options tab at the bottom of the Billing Invoice.
4. Scroll down to the Check the box(es) for the appropriate billing method(s) section.
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5. Select the Flat fee billing check box.
6. In the Amount field, enter the appropriate fee.

Client Communication Manager
The Client Communication Manager enables you to create and customize client letters for your clients. Templates are
available that can be edited to suit your needs. Templates may bemodified and saved for future use. A blank template is
available to give you complete flexibility in the creation of custom client letters. Graphics and digitized signatures may also be
added to your client letters to give them a personal touch.

ATX also offers Standard Client Letters. The Client Communication Manager may be used to add graphics and/or edit
content for these as well.

To open the Client Communication Manager, do one of the following:

l From an open return, click the Forms menu; then, select Client Letter.

l From Return Manager, click the Tools menu; then, select Client Communication Manager.
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Client CommunicationManager Menus
The followingmenus are available when you open the Client Communication Manager:

Menu/Menu Item Description Shortcut

Templates - Open Opens the selected (highlighted) template or letter. Ctrl+O

Templates - Save Saves the selected (highlighted) template or letter. Ctrl+S

Templates - Save As
Opens the Save As dialog box, allowing you to save the
selected (highlighted) template or letter as a different name.

Ctrl+Shift+S

Templates - Rename Allows you to rename custom letters to a different name. F2

Templates - Delete
If no template is open in the Editor pane, deletes the selected
(highlighted) template or letter in the Templates pane. If a
template is open, deletes the open template.

Templates - Close Template Closes the open template that is currently selected.

Templates - Import
Allows you to import a letter in rich text format (.rtf extension)
into the Client Letter Editor.

Templates - Export Allows you to export a letter in a rich text format (.rtf extension).

Templates - Exit Closes the Editor pane.

Tools - Insert Page Break Inserts a page break in the active template. Ctrl+Return

Tools - Insert Image
Allows you to insert an image into a letter (.bmp, .jpg, .gif, or
.png format).

Tools - Insert Table
Opens the Insert Table dialog box, allowing you to specify the
number of rows and columns in the table, as well as border color
and border thickness.
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Menu/Menu Item Description Shortcut

Tools - Attach Letter to Return
Enabled only when in an open return. Allows you to attach the
letter to the open return. Letter appears as a separate tab (like a
form) in the return.

Tools - Restore
Restores selected template to default. This will erase any
modifications made to the template and bring it back to its
default state.

View - Edit Mode
Displays the Templates and Variables panes, and shows all
the variables in the template or letter.

View - Preview Mode

Closes the Templates and Variables panes, and displays the
letter without any formattingmarkers, as it would appear in
finished form. Data from the corresponding return is placed
where variables were in the template.

Support - Education Library Opens the Education Library Help topics.

Support - Help
Opens Program Help in your Internet browser to the Client
Communication Manager topic.

F1

Client Communication Toolbar
The Client Communication Manager toolbar contains many components of your average text editing program.

Template Tools

Tool Description

When a template/letter is selected in the Templates pane, this opens the item in the Editor pane.

Saves the template/letter that is currently open in the Editor pane.

Only available when using the Blank template. When working with the Blank template to create a
custom letter, youmust use the Save As feature in order to leave the template itself blank.

Closes the template/letter that is open in the Editor pane.

Attaches the open letter or template to the open return.
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Tool Description

Restores the selected letter or template to its default state.

Text Tools

Tool Description

Use the Select All button to select all text/variables in the open letter or template for editing.

Select the desired font from the drop-down list.

Select the desired font size from the drop-down list.

Click to bold selected text.

Click to italicize selected text.

Click to underline selected text.

Click to select text color for selected text.

Click to select text highlight color for selected text.

Formatting Tools

Tool Description

Click to Left Align selected text or images.

Click to Center selected text or images.

Click to Right Align selected text or images.

Click to Justify selected text or images.

Click to start a Bulleted List.

Click to start a Numbered List.

Editing Tools

Tool Description Shortcut

Click to Copy the selected text or image. Ctrl+C
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Tool Description Shortcut

Click to Cut the selected text or image. Ctrl+X

Click to Paste from clipboard. Ctrl+V

Click to Undo the last action.

Click to Redo the last undone action.

Insert Tools

Tool Description

Click to Insert a Picture or Graphic into the open template at the cursor location. Supported file
types are .png, .jpg, .gif, and .bmp.

Displays Insert Table dialog box, which allows you to choose the number of rows, columns,
border color, and border thickness.

Find and Replace/Spell Check Tools

Tool Description

Provides standard Find and Replace functionality for all open templates.

Click to Spell Check the current template.

Edit Mode vs PreviewMode
This topic explains the two Client Letter views that are available in the Client Communication Manager.

From an open return, click the Forms menu; then, select Client Letter.

Upon opening the desired letter or template, the Client Letter has two views:
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l Edit Mode, (pictured above) which is the default mode, shows you all the variables andmakeup of the template.
l Preview Mode, (pictured below) which is visible when you select the Preview Mode radio button on the toolbar,
allows you to preview the letter as it would appear in final form. So, instead of seeing the variables in the letter, you
will see the actual data from the return plugged into the letter.

If you are unable to see the Edit Mode and Preview Mode radio buttons on the toolbar, either increase the
size of the Client Communication Manager window by clicking and dragging an edge or corner or click the

button on the toolbar.

The Client Communication Manager must be opened from an open return in order to access Preview Mode. If the
Client Communication Manager is opened from the Return Manager, Preview Mode will be unavailable as will the
Variables pane.

Client Letter Templates
A template is a pre-defined letter that you can use over and over again to create individual letters for your clients. Templates
contain variable markers that grab information from the return and place it into the letter, resulting in a customized letter for
your client.

Master Templates

The followingmaster templates have been included to cover basic e-file and paper filing tax scenarios:

Master Template Description

Engagement Letter Spells out the business agreement between your firm and your client.

Individual Tax Due
For clients who have a tax balance due that will be paid to the taxing agency via direct debit or
mail.

Individual Refund For clients who expect a tax refund via direct deposit or mail.

Cover Sheet Can be used for collating or filing purposes.

Mailing Slip Can be used inmailing copies to your client.
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Master Template Description

Organizer Letter Standard letter to be included with Organizer.

Blank Fully customizable blank template.

You can:

l Modify theMaster Template tomeet your business needs.
l Generate individual client letters from the template.
l Create new, customized templates for your business.

Template Parameters
l The program stores up to 20 templates in the Client Communication Manager (including theMaster Templates).
l Template Names must be nomore than 30 alpha-numeric characters (special characters are not permitted).

Double-click any template to open it for viewing or editing.

Customizing aMaster Template

Standard text editing and formatting tools are available on the Client Communication Toolbar. When the template is open in
the Editor pane, you can work in the letter as you would in other text editors or word processing applications (such as
Microsoft WordPad).

Customizations made tomaster templates will rollover from one year to the next.

To customize a master template:

1. From an open return, click the Forms menu; then, select Client Letter.

The Client Communication Manager must be accessed from an open return in order to view Preview Mode
or Variables. If the Client Communication Manager is opened from the Return Manager, Preview Mode
and Variables will be unavailable. If you are unable to see the Edit Mode and Preview Mode radio buttons on
the toolbar, either increase the size of the Client Communication Manager window by clicking and dragging
an edge or corner, or click the button on the toolbar. See Edit Mode vs Preview Mode.

2. In the Templates pane, double-click themaster template you want to use. (Master templates included are
Engagement Letter, Individual Tax Due, Individual Refund, Cover Sheet, Mailing Slip, Organizer Letter,
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and Blank.)

3. Make the changes you want to make in the Editor pane.

Edits made this way will be saved globally. This means that the edited template, when added to any future
returns, will contain the changes that were saved. Thus, it is strongly recommended to only make generic
edits that are not specific to any particular taxpayer. SeeModifying Standard Letters for specific
instructions on editing letters locally (per return).

4. Click Save.

To create a custom template from the Blank template, youmust use the Save As button and name it as
desired. If you need to rename that template, select it, click the Templates menu, then click Rename. Enter
the new name and click OK.

5. To attach the newly modified letter/template to the open return, click the Attach button on the toolbar.
6. Close the Client Communication Manager when finished.

If at any time you would like to restore any Master Template to its default state:

1. Open the desired template.
2. Do one of the following:

l Click the Restore button on the toolbar.
l Click the Tools menu; then, select Restore.
l Right-click the desired template; then, select Restore.

Using Variables in the Client Letter
Variables are only available if the Client Communication Manager is opened from an open return. If opened from
Return Manager, the Variables pane will not be seen.

What is a variable?

A variable is a placeholder in a template or document. The variable shows the system what type of data should be
specifically inserted into the final document. As the name suggests, the data that is plugged in varies, based on the data
entered in the tax return.

231



Chapter 7: ATX Managers

For example, where the [Federal - Taxpayer's Name] variable is used, the Federal Letter will be populated with the
Taxpayer's Name as entered into the return on Form 1040, Page 1.

Variables in the Editor and in the Variables Pane
A list of variables is available to the right of the Editor pane. Many of these variables appear in theMaster Templates that are
provided. If theMaster Templates do not meet your needs, you can create your own template using these variables as well as
adding and/or removing text as desired. Adding Variables to a Letter or Template is easy with their drag and drop
functionality.

When you open the template (in Edit Mode), the variable will be in brackets, in blue, as shown below:

Types of Variables
In the Variables pane, you'll see that you can select the following variable types:

l Federal 1040
l State

Adding Variables to a Letter or Template

If you want to create a totally customized letter of your own, you would probably begin with the Blank Template. However,
you can add, move, or delete variables in the other Master Templates as well.

To add variables:

1. From an open return, click the Forms menu; then, select Client Letter.

232



Chapter 7: ATX Managers

The Client Communication Manager appears.

2. In the Templates pane, double-click the template you want to open. (In this example, we opened the Blank
Template.)

3. Drag and drop the desired variable(s) from the Variables pane into the editor.
4. Add text, graphics, digitized signatures, and/or table(s) as desired.

5. When you've arranged the variables, text, graphics, etc. in the order you want them to appear in the letter, click
Save As to create a new letter or template.

The Save As instruction is specific to the Blank template. If you are adding/editing variables in another
template or letter, click Save.

Once created, the new template can be attached to returns as needed.

If at any time you would like to restore any Master Template to its default state:

1. Open the desired template.
2. Do one of the following:

l Click the Restore button on the toolbar.
l Click the Tools menu; then, select Restore.
l Right-click the desired template; then, select Restore.
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AddingGraphics
With the Client Communication Manager, you can add graphics such as company logos and/or digitized signatures to your
letters to personalize them for your business.

The ATX Client Communication Manager supports .bmp, .gif, .jpg, and .png file types.

Adding aGraphic
To add a graphic or logo to any letter:

1. Open the Client Communication Manager.
2. In the Templates pane, double-click the template or letter.

The letter appears in the Editor pane.

3. Place your cursor in the location where you want to add the graphic.
4. Do one of the following:

l Click the button on the toolbar.
l Click the Tools menu; then, select Insert Image.

TheOpen dialog box appears.

5. Browse to the location where the desired image is stored.
6. Select the image file, and click Open.

7. Use the formatting tools in the toolbar to move or reposition the image.
8. Save the letter or template when editing is finished, then attach it to returns as needed.

Adding a Signature
To add a digitized signature to your client letter:

1. Scan your signature and save it in one of the following formats: .bmp, .jpg, .gif, or .png.

If the image needs to be cropped or resized to fit properly on the page, you can usually use a simple graphics
editor (such as Microsoft Paint) to modify the image.
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2. Open the Client Communication Manager.
3. From the Templates pane, double-click the client letter or template to which you wish to add the signature.

The letter opens in the Editor pane.

4. In the Editor pane, move your cursor to where you want the signature placed.
5. Do one of the following:

l Click the button on the toolbar.
l Click the Tools menu; then, select Insert Image.

6. Select the image file, and click Open.

7. Use the formatting tools in the toolbar to move or reposition the image.
8. Save the letter or template when editing is finished, then attach it to returns as needed.

If the Client Communication Manager is accessed and edited from an open return, you will have the option
to save Locally (affecting the open return in which the letter or template is being used only) or Globally
(affecting all future returns in which the template or letter is used).

If at any time you would like to restore any Master Template to its default state:

1. Open the desired template.
2. Do one of the following:

l Click the Restore button on the toolbar.
l Click the Tools menu; then, select Restore.
l Right-click the desired template; then, select Restore.

Deleting a Client Letter
Any custom letter whether imported or created from the Blank template can be deleted.

Master Templates and Standard Client Letters cannot be deleted from the Client Communication Manager, but
once attached, any Client Letter can be deleted from a return. See Delete a Standard Letter from a Return.

To delete a client letter:

1. Open the Client Communication Manager.
2. In the Templates pane of the Client Communication Manager, highlight the letter to be deleted.
3. Click the Templates menu; then, select Delete.
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4. Click Yes to confirm.

You can also delete the open letter in the Editor pane.

Inserting a Table in a Client Letter
To insert a table in a client letter:

1. From the Return Manager, click the Tools menu; then, select Client Communication Manager.

2. From the Templates pane, double-click the template in which to place a table.
3. Click the Tools menu; then, select Insert Table.

4. Set the desired number of rows and columns, as well as the table border color and thickness.
5. Click OK.
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To edit table text:

You can enter text into the table as you would any standard table. Use the tab and arrow keys tomove between cells in the
table. You can also use the formatting tools in the toolbar.

Attaching Custom Letters
Using the Client Communication Manager, you can create a letter and attach it to a return in Preview Mode or in Edit
Mode. See Edit Mode vs Preview Mode.

You can also add Standard Client Letters to all returns upon creation via Client Communication Preferences set in
the Preferences dialog box.

To attach a letter to a return:

1. With the return open, click the Forms menu; then, select Client Letter.
2. From the Templates pane, double-click the desired Letter or Template.

3. Click the Attach button on the toolbar.
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4. Select which template(s) are to be attached.
5. Click Attach.

Client Letters appear as Form tabs in the return and can be viewed by clicking the tab just like other forms in
the return. When a client letter is displayed in an open return, the default view is Preview. To edit the letter
while attached to the return, either select the Letter Options radio button or click Edit Formatting. See
Modifying Standard Letters.

Client Letters cannot be edited in a return that has beenmarked complete. To edit the client letter after it has been
attached to the return, first ensure the return is not marked complete.

Importing Client Letters
You can import .rtf (Rich Text Format) files into the Client Communication Manager. If you've created a letter in a word
processing application (such as Microsoft®Word, WordPad, or Notepad) you can pull it into the editor to be used as a
client letter template. Save the file as .rtf by using the Save As feature and selecting Rich Text Format (*.RFT) in the Save
As Type drop-down list (in the Save dialog box).

See Program Help for your word processing application for more information on the Save As feature and the Rich Text
Format file type.

To import a Client Letter Template as an .rtf file:

1. Open the Client Communication Manager by doing one of the following:
l From an open return, click the Forms menu; then, select Client Letter.
l From the Return Manager, click the Tools menu; then, select Client Communication Manager.

The Client Communication Manager appears.

2. Click the Templates menu; then, select Import.
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3. Select the desired file.
4. Click Open.

The Client Communication Manager appears.

The imported file should now appear in the Templates pane.

Exporting Client Letters
You can export letters created in the Client Communication Manager. They will be saved as a .rtf (Rich Text Format) files.

To export a single client letter:

1. In the Templates pane of the Client Communication Manager, highlight the letter to be exported.
2. Do one of the following:

l Right-click the highlighted letter and select Export.
l Click the Templates menu; then, select Export.

A Browse For Folder dialog box appears.

3. Navigate to the location where the exported file(s ) will be stored.
4. Click OK.
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5. Click Close.

Select multiple client letters by pressing and holding the Ctrl key while clicking each client letter to be exported.

Printing the Client Letter
Because you attach a Client Letter to your return just like any other form, you'll print the letter using the same Print Return
features you would use to print any other portion of the return.

The instructions assume that you have attached the letter to the return. See Attaching Custom Letters.

To automatically print any Client Letter that is attached to a return:

1. Do one of the following:
l From the open return, click the Tools menu; then, select Preferences.
l From the Return Manager click the Preferences button on the toolbar.
l From another manager, click the Options menu; then, select Preferences.

The Preferences dialog box appears.

2. Click the Print tab.
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In the Print Letters section, the Client check box is selected by default, and will print automatically with the return.

3. Select the check box for each copy type to be printed by default along with returns.
4. Click OK to apply the change and close the dialog box, or Apply to apply the changes and leave the dialog box

open.
To print the Client Letter from an open return:

1. Click the Print button on the toolbar.

The Client Letter check boxes are selected per copy type based on your Print Preferences selections.
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2. Select the Letters (and any other desired Documents, Reports, Forms, Statements, Worksheets, and/or
Attachments to be printed with the return. Make these selections in the tree of the Print Return Dialog Box.

Selections must bemade for each copy type desired. See Print Packets, Setting Global Print Options, and
Printing Returns.

3. Click Print.

The Print Progress dialog box appears, followed by the Print Results dialog box when the print job is complete.

4. Click Close.
To print only the Client Letter (without other portions of the return):

1. In the return, click the Client Letter tab.
2. Do one of the following:

l Click the Page button on the toolbar.
l Click the Returns menu; then, select Print Current Page.

The Print Progress dialog box appears, followed by the Print Results dialog box when the print job is complete.

3. Click Close.
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Preferences
You can customize how certain features work by selecting your preferred settings in the Preferences dialog box.

If you work on a network, your preferences will be associated with your user name so they'll remain the same even if
youmove from one networked computer to another.

Preferences may be set for the following functional areas:

l All Managers Preferences
l Return Manager Preferences
l Rollover Manager Preferences
l Preparer Manager Preferences
l E-file Manager Preferences
l Open Return Preferences
l Select Forms Preferences
l Client Communication Preferences
l Print Preferences
l Form Display Preferences
l Updates Preferences
l Calculator Preferences
l Backup and Files Preferences
l Importing Preferences From Another User

To open the Preferences dialog box:

Do one of the following:

l Click the Preferences button on the toolbar.
l From the Return Manager, E-file Manager, or Bank Manager, click the Options menu; then, select
Preferences.

l From Rollover Manager, click the Tools menu; then, select Preferences.

The Preferences dialog box appears.

What's displayed in ATX when Preferences is accessed will determine which section of Preferences is
opened. For example, if Preferences is opened while an open return is displayed, Open Return
Preferences will be shown.
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Preferences Dialog Box
The Preferences dialog box has the following functions:

Dialog Element Description

Tabs Click a tab and the preferences associated with that part of the application appears.

Help Opens Program Help.

Reset Defaults
Resets all preferences on all tabs to their original default settings with the exception of the
Backup and Files Preferences.

Import Preferences
Launches the Import Preferences dialog box, where you can import preference setting from
another user.

OK Applies changes and closes the dialog box.

Apply Applies changes only, leaving the dialog box open.

Cancel Closes the Preferences dialog box.

All Managers Preferences
All Managers Preferences are settings that pertain to functionality in most or all of themanagers.

244



Chapter 8: Preferences

The following preference settings are found on the All Managers tab of the Preferences dialog box:

ShowPopup Tooltips in all Managers and Dialogs
This preference is enabled by default and displays a small text box that pops up when your hover over certain buttons,
menus, and elements in ATX. The popup text box describes the function or provides some information regarding the item. To
disable this preference, clear the check box.

Hide Returns Marked Complete
This preference is disabled by default. When enabled, returns that have beenmarked Complete by selecting the check box
in the Complete column of the Returns Tab in Return Manager are hidden in Return Manager, E-file Manager, and
Bank Manager. To enable this preference, select the check box. SeeMarking Returns Complete.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.
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Return Manager Preferences
Return Manager Preferences provide settings specific to the Return Manager and log information for iTransact, CCH
iFirm and Tax Research and the Master Tax Guide services.

The following preferences are found on the Return Manager tab of the Preferences dialog box:

Reset to Default Sorting On Startup
Resets return order and column positions to the default every time you open ATX.

ShowE-file Status Information for Selected Return
Selected by default. Displays the E-file Status column and data for all returns in Return Manager. To disable, clear the
check box.

iTransact Merchant Services Client ID
Enter your iTransact ID so you can access iTransact Merchant Service from ATX (click the ePayment button on the
toolbar).
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CCH iFirm
Enter your information so that ATX can integrate with CCH iFirm. In the CCH iFirmWebsite Address box, copy and paste
your address from your CCH iFirm account email, then click Sign Into iFirm. See Sign In To CCH iFirm.

ATX and CCH iFirm work together to simplify your office workflow. As a Client Portal subscriber, you'll have the ability to
upload tax return PDFs from ATX to Client Portal. During the upload process, ATX will ensure that iFirm creates a portal for
the client if required, and when this preference is checked, will also direct iFirm to send a portal invitation email to the client
so they can get registered for their portal website. For more information please see ATX Help or the CCH iFirm Help Center.

Tax Research Login Credentials
When you enter your Tax Research user name and password, ATX can automatically launch your subscriptions for Tax
Research or theMaster Tax Guide. If you do not know your login credentials, use the registration email link to retrieve
your information.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.

Rollover Manager Preferences
Rollover Manager Preferences enable you to automatically populate your default Preparer and/or ERO information into
your rolled over returns, as well as to check for form updates and optimizememory during the rollover process.

The following preference settings are found on the Rollover Manager tab of the Preferences dialog box:

Delete Sold Assets
This preference is enabled by default. Assets sold in the prior year return will be deleted and will not rollover into the current
year. To disable this preference, clear the check box.
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Rollover Itemized, Text and Custom Lists
This preference is enabled by default. Itemized, text, and custom lists are rolled over automatically. To disable this
preference, clear the check box.

Enter Current Year Default Preparer on Rolled-Over Returns
This preference is disabled by default. If enabled, the Preparer information entered in Preparer/ERO Manager and
selected in Preparer Manager Preferences will automatically be entered into each rolled over return. To enable this
preference, select the check box.

Be sure to select your default preparer in Preparer Manager Preferences before enabling this preference.

Enter Current Year Default ERO onRolled-Over Returns
This preference is disabled by default. If enabled, the ERO information entered in Preparer/ERO Manager and selected in
Preparer Manager Preferences will automatically be entered into each rolled overr return. To enable this preference, select
the check box.

Be sure to select your default ERO in Preparer Manager Preferences before enabling this preference.

Always Check for Form UpdatesWhenOpening Rolled Returns
This preference is enabled by default. As returns are rolled over, ATX will automatically check for form updates before
processing rollover data and opening the rolled over returns. To disable this preference, clear the check box.

OptimizeMemory Usage During Rollover
This preference is enabled by default. During the rollover process, your computer's memory will be optimized for maximum
performance. To disable this preference, clear the check box.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.
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Preparer Manager Preferences
Preparer Manager Preferences allow you to set up a standard Preparer and/or ERO defaults for all new returns.
Preferences set here can also be applied to all Rollover returns if desired. See Rollover Manager Preferences.

The following preference settings are found on the Preparer Manager tab of the Preferences dialog box:

Enter Preparer on All NewReturns
This preference is disabled by default. If enabled, a Preparer can be selected to be associated with all new returns. To enable
this preference, select a preparer from the drop-down list.

Preparers must be set up in Preparer/ERO Manager or they will not appear in the drop-down list.

After rolling over Preparer information, the Enter Preparer on All New Returns box displays with a specified preparer
if you selected to Enter Preparer on All New Returns in ATX 2016.

Enter ERO on All NewReturns
This preference is disabled by default. If enabled, an ERO can be selected to be associated with all new returns. To enable
this preference, select an ERO from the drop-down list.

EROs must be set up in Preparer/ERO Manager or they will not appear in the drop-down list.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.

After rolling over Preparers information, the Enter ERO on All New Returns box displays with a specified preparer if
you selected to Enter ERO on All New Returns in ATX 2016.
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E-file Manager Preferences
E-file Manager Preferences control the application's ability to automatically include E-File Info Forms in new returns as well
as hold and release state e-files.

The following preference settings are found on the E-file Manager tab of the Preferences dialog box:

Automatically Include E-file Info Forms
This preference is enabled by default. ATX automatically adds the E-File Info Form to each Individual and/or Business return.
To disable this preference, clear the check box(es) for Individual and/or Business returns.

The Electronic Filing Information Form (also known as EF Info) is a required form for all e-filed returns.

Hold and Release State E-files
This preference is enabled by default. All state e-files will be held until their corresponding Federal e-files have been accepted
by the IRS, at which time the e-file will be released for Transmission. To disable this preference, clear the check box.

For a fuller understanding of Hold and Release functionality, see Holding/Releasing State E-files, Creating E-files,
and E-file Creation Results Dialog Box.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.
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Open Return Preferences
Open Return Preferences affect the view you see when you open a form or return in ATX. These preferences also
determine system behaviors with forms such as Use ALL CAPS for data entry.

The following preference settings are found on theOpen Return tab of the Preferences dialog box:

Auto-start Timer In Returns
Enabled by default. This preference automatically starts a timer when opening a return in ATX. To disable this preference,
clear the check box.

Prompt for Timesheet Entry on Return Close
Enabled by default. If time has been logged but not submitted to CCH iFirm, this preference prompts you to submit a
timesheet entry before closing the return. See Tracking Time in ATX.

Use All Caps for Data Entry
When you select this preference, ATX automatically capitalizes text on input fields in an open return. Open returns must be
closed and re-opened for the change to take affect.

The following areas are not affected by the All Caps preference:

l Client Letters
l Preparer/ERO Information
l Company Information
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l Insert Text on Form
l Preparer Notes

Include AlternativeMinimum Tax Form in 1040 Returns
This preference is disabled by default. If enabled, ATX will automatically add Form 6251, AlternativeMinimum Tax -
Individuals to every new 1040 return you create. To enable this preference, select the check box.

RefundMeter
This preference is enabled by default. When enabled, ATX displays a Refund Meter that dynamically changes and displays
the amount of the payment or refund due as you complete the Federal return. To disable this preference, clear the check box.

Auto-Save Returns
This preference is disabled by default. When enabled, ATX will automatically save all open returns at regular intervals based
on your selection. To enable this preference, select the check box and choose an interval (default is 5 minutes).

Returns that have already been e-filed or returns that have beenmarked Complete will not be saved.

Display Validation Errors
This preference is enabled by default. When enabled, ATX automatically checks particular cells for proper data formatting. If
the data is not entered into a particular cell correctly, an Entry Validation message is displayed with an explanation of the
proper formatting for that cell. To disable this preference, clear the check box.

Show Form Tabs on Left
This preference is enabled by default. When enabled, form tabs appear to the left of the open form. When disabled, form tabs
will appear above the open form. To disable this preference, clear the check box.

Enable Payer Manager Preference
This preference is enabled by default. When enabled, the Add to Payer Manager check box is selected in Forms W-2 and
1099 and any payer data entered on those forms is saved to the Payer Manager. To disable this preference, clear the check
box.

Sort payers by:
By default, payers are sorted by Name. Select the Employer ID Number (EIN) radio button to designate that for default
sorting.

Display Tax Research Tool Tips
This preference is enabled by default. When enabled, ATX displays Tax Research tool tips for Federal signature forms. To
disable this preference, clear the check box.

CalculateW-2 Social Security andMedicareWages
This preference is enabled by default. When enabled, Social Security (SS) andMedicare wages are automatically calculated
based on wages entered in Box 1 of theW-2. To disable this preference, clear the check box.
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Setting Check Return Filters
The Default Check Return Filters settings determine the type of messages displayed when you use the Check Return
feature.

ATX always checks for Errors. By default Warnings, Informational, Estimates, Notes, and E-file messages will also be
displayed. The overrides option is disabled by default. To enable and havemessages regarding overridden fields displayed
also, select the Overrides check box. To disable any of thesemessages, clear the check boxes as desired.

ATX does not allow you to disable Errors.

Disable Auto-Calculations on Detail Sheets
This preference is disabled by default. If enabled, auto-calculation will be temporarily disabled when you're working in a
Detail sheet. When the Detail sheet is closed, the auto-calculation will run. To enable this preference, select the check box.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.

Select Forms Preferences
Select Forms Preferences help youmake choices about the types of forms that are automatically retrieved when you open
new returns.

The following preference settings are found on the Select Forms tab of the Preferences dialog box:

253



Chapter 8: Preferences

Default State
This preference is set to All by default. If you select a single state from the Default State preferences, only the forms for the
selected state appear in the Select Forms Dialog Box.

InformationWorksheet
This preference is enabled by default. When enabled, ATX automatically adds the InformationWorksheet to any new return
that does not include a federal signature form (1040, 1065, 1120, etc.). To disable this preference, clear the check box.

Organizer
WhenOrganizers are added to returns, Organizer Preferences settings determine whether or not to use the
Comprehensive Organizer. Use Comprehensive Organizer is selected by default. Clear the check box to disable and
opt for the Standard Organizer instead.

Organizers are not available until the final version of ATX each year.

The Comprehensive Organizer includes detailed worksheets for items such as income, deductions, contributions, and
Schedules K-1 received by your clients.

The Standard Organizer is a condensed, non-customizable group of forms that can be printed with a return for your
customers.

When you use the Create Organizer for Marked Returns feature or the Print Organizers for Marked Returns
feature, ATX adds or prints the Organizer according to your preference selections under the Include the following
when adding an organizer section.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.

Client Communication Preferences
Client Communication Preferences are disabled by default. Settings made here determine the following:

l Which Client Letters and/or accompanying sheets to automatically include in every new return upon creation.
l Whether to combine the letters (regardless of when they may be attached to a return).
l Pronoun usage (I/me or we/us).
l Which paragraphs to include in your letter.
l In which order paragraphs are to appear in each letter.
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The following preference settings are found on the Client Communication tab of the Preferences dialog box:

Federal and State/Local Letter Options
Client Letter, Estimate Letter, Return Cover Sheet, Estimate Letter Cover Sheet, and Return Mailing Slip can be
automatically added to each return as it is created. Select the check box for each one you would like to automatically add or
the Select All check box to automatically include all as returns are created. Select Federal, State/Local, or both.

Printing

Determine whether to Combine client and estimate letters and whether to Include privacy notice on client and estimate
letters by selecting Federal, State/Local, or both. You can also opt to Combine Federal and State/Local letters by
selecting the check box.

Default Font

By default, client letter font and font size set to Arial, size 10. If you prefer a different font and/or font size use the appropriate
drop-down list. Any changes to font or font size only affects client letters from this point forward any existing client letters are
unaffected by the change.

Preferred Pronoun Text

By default, letters are generated to use the First person, singular (I/me) perspective. If you would prefer to use the First
person, plural (we/us) perspective, select the check box.

Other Information

By default, client letter text will state that client's returns "have been e-filed" or "will be e-filed" based on e-file status for the
return at the time the letter is generated. In some situations, a preparer may desire the client letter text to read contrary to the
actual e-file status at the time the letter is generated. This text may be changed within the letter of each return under Letter
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Options. To change this text globally (affecting all letters in all returns), select Has been e-filed orWill be e-filed from the
drop-down list.

Paragraph Selection
Determine which paragraphs appear in each letter and the order in which paragraphs will appear. By default, all paragraphs
will appear in all letters.

To remove specific paragraphs from a letter:

1. Select the letter to be changed in the drop-down list.
2. Clear the check box for each paragraph to be removed from the letter.
3. Repeat as desired for other letters.

To change the order in which paragraphs will appear in a letter:

1. Select the letter to be changed in the drop-down list.
2. Do one of the following:

l Drag and drop paragraphs within the Preferences dialog box until they are ordered as desired.
l Select the desired paragraph, and then use the arrow buttons tomove the selected paragraph into the desired
position.

3. Repeat as desired for other letters.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.
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Print Preferences
Print Preferences allow you to set up standard defaults for printed copies when you are Printing Returns.

Print Without Zeros
This preference is disabled by default, if enabled, zeros will be present in all empty calculated and estimated fields when a
return is printed. To enable this preference, select the check box.

Print Watermark on Client Copy
This preference is enabled by default. When enabled, a watermark will be printed on all pages of the Client Copy. By default,
the watermark will read CLIENT COPY. To disable this preference, clear the check box.

Print Packets settings for the Client Copy can be used to customize watermark text if desired.

Mask Sensitive Information on Client Copy
This preference is disabled by default. If enabled, sensitive information (Dates, SSN/EIN, and Account Numbers) will be
hidden in the printed Client Copy. To enable this preference, select the check box.

Suppress SSNs when printing Organizer
This preference is enabled by default. When enabled, Social Security Numbers will be hidden in a printed Organizer. This
helps to protect the privacy or your clients.
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Add Bookmarks to PDFs
This preference is enabled by default. The PDF Bookmark feature creates bookmarks for available forms in the return,
allowing you to quickly access specific information.

Print a Separator for Filing, Client, and Preparer Copies
This preference is disabled by default. If enabled, a separator sheet will be added between copy types when printed.

Remember Print Return Selections for Each Return
This preference is disabled by default. If enabled, ATX will remember any changes youmake to a return's print selections in
the Print Return Dialog Box prior to printing. Selections are remembered per return. To enable this preference, select the
check box.

Automatically Close Print Return Dialog After Printing
This preference is enabled by default. ATX will automatically close the Print Return Dialog Box each time a return is printed.
To disable this preference, clear the check box.

Automatically Close the Print Progress Dialog After Printing
This preference is enabled by default. When enabled, ATX will automatically close the Print Progress dialog box each time a
return is printed. To disable this preference, clear the check box.

Default Print Copies
These preferences allow you to set certain default Print behaviors by copy type. Settings selected here will be applied as
default each time a return is printed. Changes made to Print Packets or the Print Return Dialog Box while Printing Returns
will override these preference settings, but only for that print job.

Print Packets

Copy types selected here will be printed with each return that is printed. Filing is selected by default.

Print Worksheets for

Worksheets will be included in printed returns for each copy type selected here. Client and Preparer are selected by default.

Print Statements for

Statements will be included in printed returns for each copy type selected here. Filing, Client, and Preparer are selected by
default.

Print Federal Attachments for

Federal Attachments will be included in printed returns for each copy type selected here. Filing is selected by default.
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Always print duplex

For copy types selected here, returns will always be printed in Duplex (both sides of paper). None are selected by default
because not all printers are capable of Duplex printing. Check your printer specifications to determine if your printer supports
Duplex printing. Select each copy type that you want to use Duplex printing by default.

Duplex printing is not permitted for Filing copy.

Print Letters
Settings made here will determine which copy types (if any) will include a Client Letter, Return and Est. Voucher Cover
Sheets, and/or a Voucher Letter. Client is selected by default to include all three. Make selections as desired for Filing and
Preparer copies.

Mailing Slip Orientation
These settings determine the orientation of themailing slip that is automatically included with each printed return. Portrait is
selected by default. Select Landscape to change the orientation.

Return Address Alignment

This setting determines the alignment of the return address on the printedmailing slip. Left is selected by default. Select
Center to change the alignment.

Check Return Reports
These settings determine which Check Return reports (if any) will be automatically included with each printed return.
Available selections are:

l Skip reports if no errors
l Report Errors
l Report Warnings
l Report Informational
l Report E-file
l Report Estimates
l Report Overrides
l Report Notes

All except Skip reports if no errors and Report E-file are selected by default. Select and/or clear check boxes as desired to
change these settings.

View/Edit Print Packets
Click View/Edit Print Packets to display the Print Packets dialog box.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.
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Form Display Preferences
Form Display Preferences allow you to determine the background color of input boxes and the default zoom level to use
when viewing forms.

The following preference settings are found on the Form Display tab of the Preferences dialog box:

Input Box Color
The selectionmade here determines the background color of input boxes. Available selections are:

l Lemon
l Lime
l Violet
l Rose
l Peach
l Yellow

Lemon is selected by default. Select another color to change the default setting.
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Default Form Zoom Level
This setting determines the zoom level used when forms are opened. Zoom is set to 100% by default. Move the slider left to
decrease the zoom level. Minimum zoom level is 25%. Move the slider right to increase the zoom level. Maximum zoom
level is 200%.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.

Updates Preferences
Updates Preferences enable you to determine whether Program and Form updates will occur each time ATX is opened or at
a particular time each day. You can also select which Federal and State form types to update.

Program Updates
This setting determines how often Program Updates will occur (if an update is available). Update program on startup is
selected by default. Clear the check box to disable this setting. As an alternative you can set a particular time for ATX to
search for and apply Program Updates (if an update is available). To designate an update time, select the Update program
at check box, and then select the desired time by clicking the up and down arrows.

If an update time is set, ATX must be open at that time in order to receive the update. If ATX is closed at the
designated update time, you will be prompted to complete the update the next time ATX is opened.

Form Updates
This setting determines how often Form Updates will occur (if updates are available). Update forms on startup is selected
by default. Clear the check box to disable this setting. As an alternative you can set a particular time for ATX to search for
and apply Form Updates (if updates are available). To designate an update time, select the Update program at check box,
and then select the desired time by clicking the up and down arrows.
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If an update time is set, ATX must be open at that time in order to receive the updated forms. If ATX is closed at the
designated update time, you will be prompted to complete the update the next time ATX is opened.

Select the Forms YouWant to IncludeWhenChecking for Form Updates

This setting determines which Federal and State form types will be included with each Form Update. All form types under the
Federal column are selected by default. Clear as desired for form types that you don't wish to include. Select form types
under the State column as desired for State forms you would like to include in Form Updates.

Select the States YouWant to IncludeWhenChecking for Form Updates

States selected here will be included in Form Updates. None are selected by default. Select states as desired or Select All to
include all State forms.

Optimize Form Download for SlowConnections

This preference is disabled by default. If enabled, ATX bypasses the standard form download processes for themost
commonly-used forms whereby the full form (with all form patches) is included in the program update.

Selecting this option improves download speed but will slow return processes (because the system will not have ready
access to the full form).

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.

Calculator Preferences
Calculator Preferences allow you to control certain Calculator behavior.
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The following preferences are found on the Calculator tab of the Preferences dialog box:

Collapsible Calculator
This setting determines what the calculator does after you've used it. The following selections are available:

l Automatically Collapse - Minimizes the Calculator
l Keep Calculator Collapsed - Hides the Calculator
l Keep Calculator Expanded - Displays the full Calculator

Keep calculator expanded is selected by default. To change this setting, select another check box as desired.

Close Calculator After Insert
This preference is disabled by default. If enabled, the calculator will close after a number is inserted from the calculator onto a
form. Select the check box to enable.

Capture Form Field Value Automatically
This preference is disabled by default. If enabled, when a field within a form has focus and you launch the Calculator, the
amount from the field will be captured.

After making changes to Preferences, click Apply to save your changes and close the Preferences dialog box, or
click OK to save your changes and leave the Preferences dialog box open.

Backup and Files Preferences
The Backup and Files Preference tab is where you can identify or change the location where your returns and data is
backed up or stored. ATX has an Automatic Backup Preference that is enabled by default when ATX is installed.
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Automatic Backup
All your returns are automatically backed up whenever they are closed. With each return, ATX also backs up e-files, bank
product information, asset data, and any PDF attachments. In addition, ATX backs up data in the Company Manager,
Payer Manager, Preparer/ERO Manager, and Billing Manager twominutes after the last change is made or when the
manager is closed. See Automatic Backup.

Any changes to the Backup and Files Preferences tab affects all users.

Where are backups stored?

By default, your backup data is stored on the C:\ drive of either your stand-alonemachine or your network server, depending
on your installation type.

ATX backs up data automatically when the Automatic Backup check box is selected. If the Automatic Backup is not
selected, aManual Backup is required. The Automatic Backup process includes all data except Setup Data. To backup
your Setup Data aManual Backup is required.

Important Tips About Backup Locations: We strongly recommend that all Admin users change the default backup
location to a permanent location (e.g. another drive) that is not on the stand-alone computer or network. This will
protect backup information from being lost if you have a computer or server failure. While you should never use a flash
drive as your primary backup device, you can use an external hard drive for your backups if you leave it permanently
attached to your stand-alone system or network server.

Youmay need to change your Backup Location if you want to use a different location on your network or if using a third party
backup product. If you need to change your Backup Location, see Changing Backup Location in Preferences.

Using a third party back product such as (Carbonite, Mozy, Backblaze, and AmazonGlacier) may require you to
change your backup location to a location the third party product can access.

File Storage Location
The File Storage Location is where your actual returns and associated data will be stored and accessed by the
workstations. This is not where backups of your returns are stored. For more information on File Storage Location, see
Changing File Storage Location in Preferences.

Reset to the Default Location
Reset Defaults is located on the Backup and Files tab.

To reset to the default Backup Location, browse to: X:\ProgramData\CCH Small Firm Services\ATX 2017 Server\ATX
2017 Backup

To reset to the default File Storage Location, browse to: X:\ProgramData\CCH Small Firm Services\ATX 2017
Server\ATX 2017 Files

X = the drive where ATX is installed.

Saving Selected Returns to a Specific Location
To save specific returns to a specific location, use the Export feature. See Exporting Returns.

264



Chapter 8: Preferences

Importing Preferences From Another User
After establishing your ATX Preferences you can import these settings to another user account using the Import Preference
feature, saving you time during the setup process.

To import preferences from another user, use the following steps:

1. Click the Preferences button on the toolbar.

2. Click the Import Preferences link.

3. Select a user from the Choose a User drop-down list.
4. Click Import.
5. Click Apply; and then click OK to close.
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9
Preparing Returns
In this section, all aspects of return preparation are discussed from return creation to the filing of extensions and
everything in between.

l Creating Returns
l Return Passwords
l Opening Returns
l Navigating Within Returns
l Adding Forms to a Return
l Saving Returns
l Closing Returns
l Interviews
l PDF Attachments
l Amending Returns
l Duplicating Returns
l Renaming Returns
l Deleting Returns
l Extensions
l Calculator
l Information Worksheet/Signature Form
l Checking Returns for Errors
l Customizing Master Forms
l Lists Overview
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Creating Returns
To start a new return:

1. From Return Manager, do one of the following:
l Click the New button on the toolbar.
l Click the Returns menu; then, select New Return.
l Press Ctrl+N.

2. Highlight the form(s) you want to add to the return.

To select multiple forms, simply click each desired form.

3. Click the Open Forms button on the Select Forms toolbar.
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If you use CCH iFirm you are able to import client contact information when starting a new return. See Import
CCH iFirm Contact Data into a New Return

To save the new return:

1. Do one of the following:
l Click the Save button on the toolbar.
l Click the Returns menu; then, select Save Return.
l Press Ctrl+S.

By default, ATX names the return for the Taxpayer (and Spouse, if applicable).

2. Do one of the following:
l Accept the default name and click Save.
l Enter a new name for the return; then, click Save.
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Return Passwords
Passwords can be added to returns for an additional layer of security. Once added, passwords may be changed or removed.

Any user who knows the password can edit or remove it. However, if the password was lost, only the Admin user or
another user with Administrator rights can change or remove it.

Passwords are case-sensitive, must contain nomore than 20 characters, and cannot begin with a space.

To add a password to a return:

1. From the open return, click the Edit menu; then, select Return Password.

Passwords may also be added when saving a return for the first time. See Saving Returns.

2. Enter and Re-enter the password in the appropriate fields.
3. Click Save.
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To edit or change a return password:

To change a return password, youmust be in the open return; therefore, youmust know the current password. If you
don't know the password, see your Administrator to edit or remove the password. See Editing Return Passwords.

1. From the open return, click the Edit menu; then, select Return Password.

2. Enter the current password in the Enter current password field.
3. Enter and Re-enter the new password in the appropriate fields.
4. Click Save.

To remove a password from a return:

1. Follow steps 1 and 2 for editing a password, above.
2. In the Enter a new password and Re-enter a new password fields, enter nothing.
3. Click Save.

Opening Returns
ATX allows you to open andmanage up to three returns simultaneously. Each return is represented by a tab at the top of the
screen, to the right of themainmanager tabs.

For CCH iFirm users, when you open a return, if there are any changes from CCH iFirm ATX, recognizes these
changes and prompts you to sync the changes. For more information see Sync Contact Data on Open and Close.

To open a return:

1. From any mainmanager (except Rollover Manager), highlight the return you want to open.
2. Do one of the following:

l Double-click the desired return.
l Select a return; then, click the Open button on the toolbar.
l Select a return; then, click the Returns menu and select Open Selected Return.
l Select a return; then, press Ctrl+O.
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For a detailed explanation of the components of the open return, seeOpen Return Interface.

Opening Password-Protected Returns

1. Enter the current password.

If a password has been assigned to a return, youmust know the password in order to open the return. If you do
not know the password, only the Admin user or a user with Administrator rights can change the password.

2. Click OK.

Opening Returns Locked by Other Users
If you work on a network, the system prevents more than one user from opening a return at a time. If you try to open a return
that is already open, you'll receive the followingmessage:
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The Locked Return message tells you the User Name and theWorkstation ID that has the return is open.

OpenReturnMenus
When you're in an open return, the followingmenus appear:

ReturnsMenu

Menu Item Description Shortcut

Save Return Saves the return you're currently viewing. Ctrl+S

Close Return Closes the return you're currently viewing.

Delete Return
Displays a warningmessage, asking you if you're sure you want to
delete the return. Will delete the return you're currently viewing.

Rename Return
Opens the Rename Return dialog box, which requires you to enter the
new name for the return you're currently viewing.

New Return
Opens the Select Forms Dialog Box so you can select forms for a
new return.

Ctrl+N

Duplicate Return
Copies the return you're currently viewing and opens the new copy of
that return.

Amend Return
Duplicates the return (including all Federal and state forms) and installs
any required amendment forms automatically (as long as they are
available).

Process Return with ePayment
Launches the iTransact electronic payment process for the selected
return.

Close All Open Returns Simultaneously closes all the returns you have open.

Import Data

Enables you to import data from the following forms from
PaperlessPLUS Premier: W-2, 1099MISC, 1099DIV, 1099R,
1099INT.

Import K-1 data from 1041, 1065 and 1120S returns into 1040,
1040NR, 1041, 1065, 1120, or 1120S returns. See Importing K-1
Data.
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Menu Item Description Shortcut

Accounting Import Initiates Tax Import from CAS Client Write-Up.

Export Return Saves the return as a .csv file to a location of your choice.

Print Packets Opens the Print Packets dialog box.

Change Printer

Launches the Print Setup dialog box, which allows you to change the
default printer (for your system) and tomake both size and orientation
changes for the printed output. You can also install a new printer from
the Network link on this dialog box.

Print Return
Opens the Print Return Dialog Box, which allows you to print the
entire return or portions of it. You can also select your printer from this
dialog box.

Ctrl+P

Print Current Page Prints only the current page you're viewing.

Exit Closes the application.

Edit Menu

Menu Item Description Shortcut

Mark as Estimate Marks a field's value as an estimated amount. F4

Insert/Edit Note
Opens a note editor for the active field. Allows you to attach a note
to a particular field. See Preparer Notes.

Ctrl+T

View Notes Opens the Notes pane.

Remove Note Deletes selected note from active field. Ctrl+M

Insert Text
Turns the cursor into a + symbol. Drag and drop to the desired
position, then enter text. See Inserting Text on Forms.

Remove Text Allows you to delete text inserted in a form.

Insert Picture
Turns the cursor into a + symbol. Drag and drop to the desired point,
then select image. See Inserting Pictures on Forms.

Remove Picture Delete selected image from form.

Undo Reverses the last command. Ctrl+Z

Restore Field Restores field to default value. See Restoring Overridden Fields. Ctrl+R

Cut Cuts the selected area within a field. Ctrl+X

Copy Copies the selected value. Ctrl+C

Paste Pastes copied or cut info from clipboard (copied or cut info). Ctrl+V
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Menu Item Description Shortcut

Start Link Establishes the current field as the source field.

Finish Link Marks the current field as the destination field.

Rename Current Form Tab Allows you to rename the tab for the current form.

Return Password
Displays the Return Password dialog box, which allows you to set
a password for the particular return. See Return Passwords.

Record Tools
Allows you to Add Record, Delete Record, and Sort Records,
where applicable.

Ctrl+A = Add;
Ctrl+D = Delete

Tools Menu

Menu Item Description Shortcut

Preferences Opens the Preferences dialog box.

Check Return Select item(s) that will be checked in the return.

Enlarge Enlarges the view of the form in 25% increments. Ctrl+(+)

Reduce
Reduces the view of the form in 25% increments. Ctrl+(-)

Preparer/ERO Gives you the following options: Insert Preparer/ERO, Remove
Preparer, Remove ERO, Remove Both, Manage
Preparers/EROs.

Insert Company
Displays the Company Manager, which allows you to insert a
company onto the form (and also store the information for subsequent
use).

Security Manager
Opens the Security Manager, which allows an Admin user to set up
multiple users in the system. Also allows you to specify the tasks that
users may or may not perform in the system.

Billing Manager
Opens the For This Return tab of the Billing Manager, which displays
the forms in the return.

Calculator Opens the Calculator. F8

NavigateMenu

Menu Item Description Shortcut

Interview Opens the current return in Interview format. See Interviews.
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Menu Item Description Shortcut

Forms in Return
Displays the Forms in Return dialog box, listing all the forms and worksheets
in the return you're currently viewing.

Ctrl+O

Jump To
Enables you to JumpTo the forms, schedules, or worksheets from which the
data in the calculated field is derived.

F6

Cross Reference
References the source of a given calculation. If multiple fields are involved,
click the desired field to jump to that field.

F7

Back Moves you to the previous form in the return. Ctrl+B

Forward Moves you to the next form in the return. Ctrl+Shift+F

FormsMenu

Menu Item Description Shortcut

Add New Forms...
Opens the Select Forms Dialog Box which allows you to choose
forms to add to the open return.

Ctrl+F

Duplicate Form Copies the form you're currently viewing.

Discard Form Deletes the current form from the open return. Ctrl+1

Discard Multiple Forms
Opens the Discard Multiple Forms dialog box which allows you to
delete multiple forms from the open return.

Ctrl+Shift+1

Client Letter
Opens the Client Communication Manager, enabling you to attach a
client letter to the open return.

Billing Invoice
Adds a Billing Invoice to the open return. See Completing the Billing
Invoice.

Send CCH iFirm Invoice Sends the Billing Invoice to CCH iFirm.

Planning/Analysis
Add Tax Summary/Carryover Worksheet, Last Year Comparison,
Tax Planner, Married Joint - Separate Comparison, or U.S.
Averages Comparison to the open return.

Extensions Inserts the appropriate extension form in the return.

Lists Enables you to create an Itemized List, Text List, or Custom List. Ctrl+I

Ohio Cities Worksheet
(visible only when you purchase
the Ohio Cities Allocation
package)

Inserts the Ohio Cities Worksheet (Cities Taxes Paid to Other
Jurisdictions) into the return. Ctrl+H

Organizer
(visible only during the last release
of the ATX, usually in October)

Allows you to add one of twoOrganizer Types to a return so your
customers can provide you with information for the upcoming tax
season.
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E-file Menu

Menu Item Description

Create E-file

Opens the Create E-file Dialog Box, which asks you to begin the e-file process by
selecting jurisdictions in which you want to e-file the return.

If the form you're currently viewing is not eligible for e-filing, you'll receive amessage.

Attach PDF Attaches a PDF file to the e-file of the return.

Display Rejection Errors
Opens the E-file Rejection Errors pane at the bottom of the form, which displays the
IRS or State rejection errors for the return.

Display E-file
Actions Required

Displays the specific actions required by specific states for an e-filed return, if any have
been indicated by the relevant agency. Enabled when you have selected an e-filed
return in E-file Manager or when you have an e-filed return open. The pane that is used
to display e-file error messages is also used for displaying e-file actions.

Display Acknowledgement
History

Displays acknowledgement history for the open return.

Re-create Bank Application
Allows you to re-create a bank application if your Federal e-file was accepted but the
attached bank application was rejected. The e-file must show an Accepted status and
the returnmust include a bank application.

Help for E-filing Opens Program Help to the Creating E-files topic.

Tax Research

Menu Item Description

Tax Research
Launches your Tax Research subscription using your Tax Research Login
Credentials entered on the Return Manager tab of the Preferences dialog box.

Master Tax Guide
Launches theMaster Tax Guide using your Tax Research Login Credentials
entered on the Return Manager tab of the Preferences dialog box. See Return
Manager Preferences.

IRS Publications
Launches IRS Publications using your Tax Research Login Credentials entered on
the Return Manager tab of the Preferences dialog box. See Return Manager
Preferences.

Client Letter Toolkit
Launches additional Client Letters using your Tax Research Login Credentials
entered on the Return Manager tab of the Preferences dialog box.

Elections and Compliance
Toolkit

Provides you with hundreds of sample elections and compliance statements,
background information, due dates, and citations to relevant authority information.

Launches the Elections and Compliance Toolkit using your Tax Research Login
Credentials entered on the Return Manager tab of the Preferences dialog box.
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Menu Item Description

Penalties and Interest
Calculator

Provides a way you can calculate penalties and/or interest due for the late filing of a
return and/or late payment of taxes due.

Launches the Penalties and Interest Calculator using your Tax Research Login
Credentials entered on the Return Manager tab of the Preferences dialog box.

Depreciation Toolkit

Provides you a way to create a depreciation schedule, calculate any recovery year’s
depreciation amount or simply determine the depreciation rate for any recovery year.

Launches the Depreciation Toolkit using your Tax Research Login Credentials
entered on the Return Manager tab of the Preferences dialog box.

Practice Aids
Provides elections, flowcharts, worksheets, checklists, tables, and tools using your
Tax Research Login Credentials entered on the Return Manager tab of the
Preferences dialog box.

Line Explanations Provides line-specific research content on CCH's online Tax Research platform.

Questions and Answers Provides key questions and answers relating to compliance topics for federal forms.

Filled-in Forms Provides you with filled-in forms on CCH's online Tax Research platform.

Elections & Statements Provides you with elections and statements on CCH's online Tax Research platform.

Search Online
Launches your Internet Browser where you can search using the CCH Browser plug-
in. If the plug-in is not installed you are prompted to install the CCH Browser plug-in at
this time.

ATX Community Board
Use the Community Board to share ideas, tips, and best practices with other ATX
users.

CPE Link - Education and CPE
Launches the online learning website, which delivers CPE to tax and accounting
professionals through webinars and self-study courses.

Upgrade my Tax Research
Launches a web page where you can choose to purchase additional tax research
products.

CCH iFirm

Menu Item Description

My Dashboard
Launches your CCH iFirm dashboard, which is an overview of your business’ efficiency,
annual review, resource allocation, work in progress, andmore.

My Jobs Launches your CCH iFirm jobs, where you can view jobs in CCH iFirm.

My Invoice
Launches your CCH iFirm invoices, where you can view and create invoices in CCH
iFirm.

My Reports
Launches your CCH iFirm PracticeManagement reports, where you canmeasure the
performance of teammembers and see how your firm is performing.
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Menu Item Description

My Timesheet Launches your CCH iFirm timesheet, where you can track your personal time by job.

View Job Details Opens job details for the job associated with the open return.

Contact Details
Opens CCH iFirm Contact Detail for the open return, where you can view and edit contact
information.

Client Portal
Launches CCH iFirm Client Portal, where you can organize and share important
documents with clients.

Support Menu

Menu Item Description Shortcut

Program Help Opens Program Help in a web browser. F1

Government Instructions
From an open return, launches the Government Instructions for the
current form. Outside of a return, click the View Instr link (in the Select
Forms Dialog Box) for the desired form.

F3

Education Library Opens the Education Library Help topics.

Release Notes
Opens for the current version and all prior versions released during the
current year.

User Guide Launches the ATX User Guide for Tax Year 2017.

Contact Us

Shows you three ways you can contact CCH Small Firm Services to
obtain help with your application: by submitting a question via theWeb
site, via fax, or telephone. You can also use the form that is linked to the
topic to consolidate information for Customer Service.

Web Sites

Opens the following web sites: BizFilings Business Services, IRS
Home Page, IRS E-Services, other ATX Tax Products, ATX Paper
Products (for tax professionals), ATX Home Page, theMyATX
Solution Center, the ATX Blog, and the ATX Knowledgebase.

Check for Updates
Allows you to easily obtain updated program and forms information
through an automated process. Also notifies you of preferences that you
can set pertaining to this update process.

Customer Service Utilities
This series of utilities enable you to provide information to Customer
Service so they may resolve your program issues. See Customer
Service Utilities.

Show Hidden Dialogs

Several dialog boxes have a Don't show this message again check
box so you can avoid receiving the samemessage over and over again.
The Show Hidden Dialogs option reverses these selections, so you
would see these dialog boxes again.
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Menu Item Description Shortcut

About

Displays the About ATX dialog box which displays the program version,
product copyright information, and customer's Client ID. When calling
Customer Care, youmay be asked to provide one or more of the
numbers listed in this dialog box.

Navigating Within Returns
The Navigation bar at the bottom of the open return consists of the Pages & Worksheets button and a series of tabs. Each of
these tabs is associated with a numbered form page, schedule, worksheet, or other page of the active form.

To navigate through a single page, do one of the following:

l Press Enter or Tab tomove from the current field to the next field. To reverse direction, press Shift+Tab.
l Click a field or use the arrow keys tomove the cursor to a specific field.
l Press Page Up and Page Down to scroll through a page quickly.

To navigate through multiple pages of an active form, do one of the following:

l Use the navigation tabs below the active form.
l Use the tools on the Navigate menu.
l Click Pages & Worksheets (left of the navigation bar).

To navigate back to page 1 of a form:

l Right-click anywhere on the form, and then select (Form Name), page 1.

To navigate between forms, do one of the following:

l Click the tabs above the open return.
l Use the tools on the Navigate menu.

Viewing or Selecting Forms in a Return
In addition to the tabs that run across the top of the open return, the Forms In Return dialog box gives you a complete list of
all the forms in the return.

To view or select forms in a return:

1. Open a return.
2. Click the Navigate menu; then, select Forms in a Return.
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3. To select a form from the list, click the desired form (or, use the arrow keys and press Enter).

Navigating using Jump To or Cross Reference
The values in white calculated fields come from one or more source forms, schedules, or worksheets. Use JumpTo to jump
directly to the source form, worksheet or schedule or list the forms that contribute to this value.

When the value in a white calculated field is derived frommultiple sources, use Cross Reference to see a list of fields that
contribute to this value. You can then select one and navigate to a specific source field.

You can also use the Back and Forward Buttons tomove between forms in the order you last viewed them.

JumpTo
On all forms, schedules, and worksheets, white fields denote values that are calculated from data entered elsewhere. The
JumpTo feature enables fast navigation to the forms, schedules, or worksheets from which these data sources are derived.
Calculated fields are always white (whereas input fields are blue).

To use the Jump To feature:

1. With the cursor in any calculated field, do one of the following:

l Click the JumpTo button in the field.
l Click the Navigate menu; then, select JumpTo.
l Press F6.
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The Page/Worksheet column tells you where the data is located on the corresponding form.

2. Click the item to jump to the location.

If the Form Has Not Been Added to the Return

If the form says Add New Form in the Page/Worksheet column, the form has yet to be added to the return but is required to
calculate the amount. To add the form, click the Add New Form text.

Jump To Lists

The Jump To feature also appears if a list has been attached to a form field. A preparer can create an itemized list - for repairs
andmaintenance of a business, for example. When selected, the field displays the Jump To button, enabling the user to open
up the list:

Cross Reference
When the value in a white calculated field is derived frommultiple sources, use the Cross Reference feature to display a list
of all fields that contribute to this value and to navigate to a specific source field.

To use the Cross Reference feature:

1. Select a white calculated field.
2. Do one of the following:

l Right-click the field, and then select Cross Reference.
l Click the Navigate menu; then select Cross Reference.
l Press F7.
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3. Click a form tomove directly to the referenced field, or click Cancel to remain in the active field.
4. To return to the previous location, click the Back button on the toolbar.

Back and Forward Buttons
The Back and Forward buttons enable browser history navigation between recently active forms. After moving from one
form to another, or from one page to another in the same form, you can retrace your route or switch quickly between forms by
clicking the Back and Forward buttons on the toolbar.

Adding Forms to a Return
The Select Forms Dialog Box lists forms that can be added to a return. See Finding Specific Forms.

Installed Forms
To add installed forms to an open return:

1. Open a return.
2. Do one of the following:

l Click the Add Forms button on the toolbar.
l Click the Forms menu; then, select Add New Forms.
l Press Ctrl+F.
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3. Use the filters to find specific forms.
4. Select one or more forms.
5. Click the Open Forms button on the Select Forms toolbar.

"Update Available" and "Available Now" Forms
Forms with either the Update Available or Available Now form status can be added to your return using the steps shown
above. However, the Update Progress and Update Results dialog boxes will appear briefly while the program is
downloading the form, and then the form will open in the return.

Messages at the Top of Forms
Special instructions appear in blue at the top of some forms. These instructions explain how the forms calculate or list other
forms youmay need to include.
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Field Colors on Forms
Data fields, or cells, are color-coded according to the type of information they contain.

You can change this color by changing the Input Box preference. See Form Display Preferences .

Field Color Data Description

Blue
An input field that will accept user entries. With very few exceptions, all information should be
entered in blue fields.

Light Yellow
The currently active data entry field. When the cursor is active in a blue field, the field changes to
light yellow.

White
A field that contains links or calculations referred to by the program. You will receive a warning
message whenever you attempt to enter information directly in a white field.

Pink
A calculated field that you've overrode. To restore the original links and calculations of a pink field,
select the field, and then click the Restore button.

Violet Contains an estimated amount.

Green Indicates a link to another field. See Creating Links Between Fields.

Select Forms Dialog Box
The Select Forms dialog box allows you to choose the forms you want to add to your return. The Filter Pane (left) helps you
narrow the form list for easier form selection.

To access the Select Forms dialog box, do one of the following while in the Return Manager:

l Click New on the toolbar.
l Click the Returns menu; then, select New Return.
l Press Ctrl+N.
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From an open return, do one of the following:

l Click the Add Forms button on the toolbar.
l Click the Forms menu; then, select Add New Forms.
l Press Ctrl+F.

The Select Forms dialog box appears.

Status Column (Form Statuses)

The Status column shows the availability of the forms:

l Installed – The form is installed on your computer and will load when you open the form.
l Update Available – The form is installed on your computer, but an updated version is available. When you select it
and click Open Forms, the updated form will be downloaded and it will open.

l Available Now – The form is not yet installed on your computer. When you select it and click Open Forms, the form
will be downloaded and will open. These will be highlighted in dark yellow.

l Unavailable – The form is not yet available in ATX. These will be highlighted in dark yellow.
l Customized – TheMaster Form has been customized. See Customizing Master Forms.

ViewGovernment Instructions

The View Instr link under the PDF column opens a PDF version of the government instructions for the corresponding form.
SeeGovernment Instructions.

Approved

The Approved column provides a visual indicator for agency approved forms. When a form receives approval ATX displays a
green check-mark indicating the form approval from the agency.
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Select Form filters

Select Forms allows you to filter the form list in several ways:

l Find: (Ctrl+F) field: Use the Find field to enter search parameters.
l Federal, State or Local check boxes: Choose one, two, or all three (if selecting State and you would like all
states, select All from the drop-down list.)

l Form type check boxes: Check one or more form types, such as Individual, Corporation, or Fiduciary.
l Selected Forms check box: Check the Selected Forms check box if you've highlighted specific returns in the list.
Only the highlighted forms will appear in view.

l Clear Filters button: Check this box to clear the filters and to display a list of every form in the system.

Menus and Buttons

Formmenus, menu items and buttons are detailed in the table below.

Menu Menu Item Description Button

Forms
Open Selected Forms
(Ctrl+O)

Opens all highlighted forms. Open Forms

Clear All Form Selections Clears any selections in the list of forms. Clear

Cancel Closes the Select Forms dialog box. Cancel

View View Last Selected Form
Opens the last form selected in a read-only window to determine if
it is the desired form.

View Form

Choose State Filters forms for the state selected.

Government Instructions Opens the PDF instructions for the current form, if available. F3

Finding Specific Forms

The Filter Pane in the left portion of the Select Forms window makes it easy to locate specific forms when you start a new
return or add forms to an existing return.

To use the Select Forms filters:

1. Open the Select Forms Dialog Box by Creating Returns, or by Adding Forms to a Return.
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2. To find a specific form, enter a keyword or form number in the Find field.
3. Select one or more of the desired taxing authorities (Federal, State, or Local).
4. To search for specific state forms:

l Click the State check box.
l Click the down arrow on the All drop-down list. A list of state abbreviations appears.
l Select a state.

If you have selected a default state in Select Forms Preferences, that state will be automatically
selected in the drop-down list.

5. Select one or more return types (such as Individual, Corporate, or Partnership).
6. To clear all currently selected filters, click the Clear Filters button.
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Discarding Forms
ATX allows you to discard a single form or discardmultiple forms at once.

Discard Single Form

Use the Discard Form commandwhen you want to remove a single form from a return. This command also deletes any data
you have entered on that form.

To discard forms:

1. From the open return, right-click the form tab.
2. Click Discard Form.

3. Click the Discard button to confirm your decision.

When you discard a form, all form data is permanently deleted. You cannot undo this command.

DiscardMultiple Forms

Use the Discard Multiple Forms commandwhen you want to removemore than one form from a return. This command also
deletes any data you have entered on those forms.

To discard multiple forms:

1. From the open return, right-click the form tab.
2. Click Discard Multiple Forms.
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3. Do one of the following:
l Select the box next to each form you wish to discard.
l Click the Select all box to select all forms.
l Use theQuick Select boxes to select all States, Local forms, or Letters in the open return.

When you discard a form, all form data is permanently deleted. You cannot undo this command.

When a parent form is selected, ATX auto selects all child forms. For example if you select Form 4562, ATX
auto selects the Fixed Assets form.

4. Click Discard.

To clear your initial selection click the Select all box.
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Renaming Forms
You can append the name of many forms tomake themmore relevant to the return. For example, youmay want to rename
theW-2 attached toMichael and Sarah Smith's tax return. In this example, the form namewill be appended with your change.

You cannot rename a signature form.

To rename a form:

1. Right-click the form tab.
2. Select Rename Form.

3. Enter the new name for the form.
4. Click Rename.

The new name appears in the form tab:

Saving Returns
To save changes in an open return, do one of the following:

l Click the Save button on the toolbar.
l Click the Returns menu; then, select Save Return.
l Press Ctrl+S.

To save an unnamed return:

1. Do one of the following:
l Click the Save button on the toolbar.
l Click the Returns menu; then, select Save Return.
l Press Ctrl+S.
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The Add Return Password link allows you to add a password to the return, if desired. See Return
Passwords.

2. In the Please enter a return name field, enter the return name.
3. Click Save.

You can set an Auto-Save interval in Open Return Preferences as well.

Closing Returns
To close a single return:

1. Do one of the following:
l Click the X in the open return's tab at the top of the application.
l Click the Returns menu; then, select Close Return.

If there are unsaved changes in the return, the Save Changes dialog box appears.

2. Do one of the following:
l Click Save to save the return in its current state.
l Click Don't Save and Close to close the return without saving.
l Click Cancel to close the Save dialog box without saving and leave the return open.

The Add Return Password link allows you to add a password to the return, if desired. See Return
Passwords.

To close all open returns:

1. Click the Returns menu; then, select Close All Open Returns.
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2. Click one of the following:
l Save All to save all the open returns.
l Save None to save none of the open returns.
l Choose which open returns you want to save.
l Cancel to closes the Save All Open Returns dialog box and displays the current open return.

For CCH iFirm users, when you close a return containing any changes from ATX, ATX syncs with CCH iFirm and
recognizes any differences in the information and prompts you to sync the changes. For more information see Sync
Contact Data on Open and Close.

Interviews
2017 Interviews are typically not available at the beginning of the season, but aremade available during a later release.

The Interview tool guides you step-by-step through a series of questions for the return. As you enter data in the Interview
tool, that data is simultaneously populated on the forms in the return (which appear directly below the Interview). The program
also automatically adds forms or schedules to the return that are required as a result of your Interview responses.

In some sections of the return, youmay be asked to enter information directly on the forms.

The Interview tool is used for the following types of Federal returns:

l 1040
l 1065
l 1120
l 1120S

To start the Interview do one of the following:

l Click the Interview button on the toolbar.
l From an open return, click the Navigate menu; then, select Interview.
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To close the Interview, click Close Interview at the top right.

If you re-open an Interview after having closed it, the system opens where you left off.

Interview Sections (Tabs)
The Interview is divided into the following informational sections, or tabs, which appear at the top of the interview. The tabs
that appear depend on the signature form that you've selected for the return. Different tabs appear for different return types.

For example, the following are the Interview section tabs for Form 1040:

l Client Info
l Income
l Assets
l Adjustments
l Deductions
l Taxes & Credits
l Finish

Each tab contains several topics related to the tabbed section of the Interview.

Navigating in the Interview
Use the following navigation tomove around in the Interview:

Section to section:

l Click one of the Interview Section tabs.

Topic to topic within a section:

l Click the Previous or Next buttons.
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Field to field in a topic:

l Press Tab or Shift+Tab.

Frequently AskedQuestions (FAQs)
Frequently-asked questions for the interview topic appear in a bulleted list to the right of the Interview. When you hover over
an FAQ, it turns into a hyperlink. Click the link for the for answers to the question.

PDF Attachments
As part of the IRS Modernized e-File program, some electronically filed returns can be transmitted with certain PDF
attachments. Where the IRS or state allows, specific PDF attachments are either allowed or required. Some agencies also
allow other PDF attachments to bemade to the return. The program will offer the ability to attach PDFs where the agencies
have allowed it.

Conditions that Must Exist to Add an Attachment:

1. The returnmust have an EF Info Worksheet.
2. If the PDF you want to add is a form, youmust first add the form to the return. See Adding Forms to a Return.
3. Remove password protection from any PDF you intend to attach in order to successfully e-file the return.
4. The e-file must not be in a Transmitted or Accepted state.

Use Adobe Acrobat or another program to create the required PDF attachment. For instructions on removing password
protection from your PDF files, refer to help for that program.

If you try to add an attachment after you've created an e-file (but have yet to transmit it), the system will prompt you to
re-create the e-file.
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DecideWhat Type of PDFs to Attach
Some forms that are required as PDF attachments may already be in your return as part of the normal tax return preparation
process. See Creating and Attaching PDFs of Completed Forms.

Other required attachments might come from third parties (such as brokerage statements, property tax bills, etc.). See
Creating and Attaching PDFs from Other Sources.

Creating and Attaching PDFs of Completed Forms
Creating PDFs of completed forms in the return:

Once you've completed the form within the return, you can save it as a PDF from within the return.

1. From the open return, click the Print button.

The Print Return Dialog Box appears.

2. Under the Select the copies you wish to print section, click the down arrow and select ATX 2017 PDF Print as
your printer.

3. Under theWhat do you want to print section, clear the check box for all the forms except the form you want to
make a PDF.

4. Click the Print button at the bottom of the dialog box.

The Save As dialog box appears.

5. In the File name field, enter the name for the PDF form.

By default, the system will save the file under the return name. You can keep this name, or modify it to include
the form number.

6. Click the Save button on the Save As dialog box.

The Print Results dialog box will appear and close if printing is successful. If printing is not successful, you'll
receive amessage.

To attach PDFs of completed forms:

1. From the open return, click the E-file menu; then, select Attach PDF.

If the Attach PDFmenu item is disabled, the current return does not allow PDF attachments.
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You can expand the Attach PDFs dialog box by dragging the right border of the dialog box to the right. This
allows you to view long form descriptions.

2. If the item you want to add is listed in the Attach PDFs dialog box, double-click the attachment (or, click the paper
clip, outlined in red).

The Select PDF dialog box appears.

3. Browse to the location where the PDF is stored.
4. Select the file and click Open.

Most state and IRS programs require certain attachments to be given particular file names. The program will
automatically enforce this naming policy if one of the pre-defined attachment options is selected.

The paper clip is replaced by the View button, Delete button, and the attachment size; which indicates that the
item is attached.

ATX allows attachments up to 256K. For attachments larger than 256K you need to reduce the PDF file size by
scanning the document at a low resolution or by using a 3rd-party PDF downsizing tool.

5. Click Close at the bottom of the Attach PDFs dialog box.
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6. Click Continue.
7. Follow instructions in Creating E-files to re-create the e-file.

Creating and Attaching PDFs fromOther Sources
To create a PDF version of a paper document that you've received from a third party or via e-mail, scan the
document to a PDF file.

Refer to your scanner or copier Help file for instructions.

To reduce PDF file size, scan documents no higher than 150 dpi and use black and white printing.

To attach PDFs of other documents:

Other documents are any documents not specifically listed in the Attach PDFs dialog box.

1. From the open return, click the E-file menu; then, select Attach PDF.

The Attach PDFs dialog box appears.

2. Scroll down to the bottom of the dialog box and double-click the Other attachment.

The Select PDF for Other Attachment dialog box appears.

3. Browse to the location where you've stored the PDF file.
4. Select the file and click Open.

The Add Other Attachment dialog box appears.

5. Enter the name for the other attachment and click OK.

6. Click Close.
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Viewing and Deleting Attachments
To view the attached PDF document:

From the Attach PDFs dialog box, click the View button next to the document you want to view.

To delete any attached PDF document:

1. From the Attach PDFs dialog box, click the Delete button next to the document you want to delete.

The Remove Attachment message appears.

2. Click Yes.

Duplicating Returns
The Duplicate Return command saves a copy of the active return under another name. Duplicate returns enable you to
consider various scenarios without changing the existing information in the original return. Once you duplicate a return, both
returns will be listed in Return Manager.

To duplicate an open return:

1. Click the Returns menu; then, select Duplicate Return.

2. Enter a name for the duplicate return, or accept the name given by the program.
3. Click Duplicate.

To duplicate a return in Return Manager:

1. Select the return you want to duplicate.
2. Click the Returns menu; then, select Duplicate Selected Return.

3. Enter a name for the duplicate return, or accept the name given by the program.
4. Click Duplicate.
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Renaming Returns
Renaming the return changes the name of the return as it is stored in the system, but it does not change your client’s name in
the return or any other tax return information.

To rename an open return:

1. Click the Returns menu; then, select Rename Return.

2. Enter a new name for the return.
3. Click Rename.

You can also click the return name in Return Manager and rename the return when the cursor appears.

To rename a return in Return Manager:

1. Click the Return Name field of the return to be renamed.
2. Type a new name.

Deleting Returns
You can delete returns from the Return Manager list view, or you can delete the return while it is open.

A deleted return cannot be recovered.

Deleting Selected Returns
The selected return appears in blue, and is determined by the position of your cursor in the return list.

To delete returns in Return Manager:

1. Highlight the return.
2. Do one of the following:

l Click the Delete button on the toolbar.
l Click the Returns menu; then, select Delete Selected Return.

If you're working on a network and another user has this return open, you cannot delete the return; you'll receive
a Locked Return message telling you the name of the other user.
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3. Click Delete Return.

To delete an open return:

1. Open the return you intend to delete.
2. Click the Returns menu; then, select Delete Return.

The Delete Return warning dialog box appears.

3. Click Delete Return.

DeletingMarked Returns
To delete marked returns:

1. Mark the return(s) you wish to delete by selecting the check box next to each desired return.
2. Click the Returns menu; then, select Delete Marked Returns.

If a return is open, it cannot bemarked for deletion. This situation applies if it's open on your workstation or if
it's open by another user on a networked workstation. If you're on a network, the Details columnwill display
the other user who has it open.

3. Clear the check box for any returns you do not wish to delete.
4. Click Delete Marked Returns.
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Extensions
When you use the Create/Print Extensions function, all copies will be sent to your default printer. To change your
default printer, click the Printer Setup link in the Returns Marked for Printing dialog box. If you use a PDF Printer as
default, your copies will be sent to the location selected in the Browse For Folder dialog box upon clicking Print.

Using the Create/Print Extensions function from the Returns menu of Return Manager automates much of the normal
data entry for this tax preparation task.

The Create/Print Extensions feature:

l Creates Federal and State extensions with or without amounts due.
l Automatically adds the required extension form to each return.
l Creates extensions for multiple returns simultaneously .
l Automatically updates the tax returns and prints the forms.
l Creates business and 1040 extensions in the same batch.

You cannot create or print an extension for returns marked Complete.

If you do not install one or more extension forms, the program first processes all available extensions, and then prompts you
to install themissing forms.

Extensions with Zero Amounts
To create/print an extension for marked returns with zero amounts:

1. In the Return Manager, select the check box for returns for which you want to create/print extensions.
2. From the Returns menu, select Create/Print Extensions.
3. Select For Marked Returns with Zero Amounts.

4. Select or deselect the returns to include as desired.
5. Click Continue.
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6. Make your printing selections.
7. Click Print.

ExtensionsWith Custom Amounts
This method prints the tax liability currently shown on the return. You can use this amount as the required payment, or you
can enter a custom amount.

To prepare and print extensions with Custom Amounts:

1. In the Return Manager, select the check box for returns for which you want to create/print extensions.
2. From the Returns menu, select Create/Print Extensions.
3. Select For Marked Returns with Custom Amounts.

4. Click Continue.
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5. To enter a different amount due, enter the new amount in the Custom Amount column.
6. Click Continue.

The Returns Marked for Printing dialog box appears.

7. Make your printing selections.
8. Click Print.

OpenReturn
To prepare an extension from an open return:

You can only create an extension from an open return if you're working on a stand-alone workstation. Network users
must close the return first before creating and printing extensions.

1. Click the Forms menu; then, select Extensions.
2. If the correct extension form has been installed, it will be added to the return.
3. Enter the appropriate information.

Amending Returns
You can amend a return using the Amend Return feature. This feature duplicates the return (including all Federal and State
forms) and installs any required amendment forms automatically (as long as they are available).

Some return types require no special amendment forms. In this situation, the program automatically selects the Amended
Return check box on the return's signature form.

All amended returns are saved with the following suffix: (Amended).

When Amendment Forms are Already Installed
To amend a return when amendment forms are installed:

1. Open the return to be amended.
2. Click the Returns menu; then, select Amend Return.
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If the amendment form(s) are installed, the program adds them to the return and opens the return.

3. Do one of the following:
l For returns with amendment forms, click the amendment form and enter the corrections directly in the Correct
amount column.

l For returns without amendment forms, the Amended Return check box will be checked on the signature form
of the duplicate return. Enter the corrections directly on the appropriate form(s) in the return.

4. Complete the explanation section on either the amendment form, or on the appropriate form(s) in the return.
5. Click Save.

The Return Name bears the (Amended) suffix:

6. Click Save.

When Amendment Forms are Not Yet Installed
To amend a return when forms are not installed:

1. Open the return to be amended.
2. Click the Returns menu; then, select Amend Return.

If the forms are not installed, the Forms Not Installed dialog box appears:

3. To install the forms, click Update.
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4. Click Close.

The amended return opens, with the available amendment forms automatically added to the return.

Calculator
To open the Calculator, do one of the following:

l Click the Calculator button on themain toolbar.
l Click the Tools menu; then, select Calculator;
l Press F8.
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To use the Calculator:

1. Use themouse or the numeric keypad to enter numbers and operators.
2. Click the = button to perform the calculation.

How To Topics:

l Calculator Preferences
l Calculator Capture
l Calculator Memory Functions
l Calculator Shortcuts

Button Definition Shortcut Alternate Shortcut

Memory Clear Ctrl+L

Memory Recall Ctrl+R

Store in Memory Ctrl+M

Add to Memory - Adds current
value to value stored inmemory. If
a value is stored inmemory, anM
appears to the left of the screen.

Ctrl+A Ctrl+P

307



Chapter 9: Preparing Returns

Button Definition Shortcut Alternate Shortcut

Subtract fromMemory - Subtracts
current value from value stored in
memory.

Ctrl+S Ctrl+Q

Backspace

Clear Current Entry Delete

Clear All Ctrl+Delete ESC

Plus/Minus F9

Equals Enter

Capture - Captures number from
any field on any form, schedule, or
worksheet (so youmay use it in a
calculation).

F11

Insert - Inserts calculator value into
current cell on form.

Insert

Calculator Memory Functions
The Calculator has standardmemory functions.

The Calculator stores only one number at a time.

Click theMS button to save the number shown on the Calculator.

To access a stored number, click theMR button.

To add to and subtract from a stored number:

1. Enter the number to add or subtract from the number currently stored inmemory.
2. Click the + or - button.
3. Click MR (Memory Recall).
4. Click the = button.

To clear a number frommemory, click MC (Memory Clear).

When you close the Calculator, any value stored inmemory is lost.
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Calculator Capture
The Calculator can capture values from or insert values into any field on a form, schedule, or worksheet. The Capture and
Insert buttons are found side by side on the Calculator (shown below).

To capture a value from a form field:

1. Navigate to the desired field on the form.
2. Open the Calculator by doing one of the following:

l From the Return Manager, click the Calculator button on the toolbar.
l Click the Tools menu; then, select Calculator.
l Press F8.

3. Click the Capture button (camera button, outlined in red).

To insert a value from the calculator into a form field:

1. With the value you want to insert displaying on the Calculator screen, navigate to the desired field on the form.
2. Click Insert (outlined in red).

The value appears in the form field.

Calculator Shortcuts
l F8 - Opens the Calculator.
l F11 - If the Calculator is already open, copies the value from the current field to the Calculator.
l Insert - Copies the current Calculator value to the selected field on the form, schedule or worksheet.
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l Backspace - Erases most recently-entered digit.
l Delete - Clears the Calculator (but not the current calculation result).
l ESC - Clears both the Calculator and the current calculation result.

Information Worksheet/Signature Form
When you create a new return, if you do not select a primary form (signature form), the program automatically adds an
Information Worksheet (or Info Sheet) to the return. This is a default preference.

The InformationWorksheet enables the preparer to gather basic information on the taxpayer. This worksheet consists of the
following pages:

l Company InformationWorksheet
l Individual InformationWorksheet

If you later add a signature form to the return, it replaces the InformationWorksheet. Data entered on the Information
Worksheet is automatically transferred to the signature form, if applicable.

Signature Forms
A Signature Form is the primary form on which the taxpayer (or representative) signs the return. Examples include Form
1040, 1120, and 1065. Most Federal and State returns include a signature form.

The product only allows only one Federal signature form per return; however, you can include as many State signature forms
as your client needs.

Signature forms cannot be renamed in the system.

You can change the Federal signature form inmost returns without losing data. For example, you can change from Form
1120 to Form 1065 and retain the data you already entered.

Company InformationWorksheet
The Company InformationWorksheet (Company Info tab) is the first page of the InformationWorksheet. When preparing a
company return, preparers use this default form in lieu of a Federal signature form.

Section Field Name Description

Company Company Name Company or owner name.

Doing Business As
If an owner is listed in the Company Name field, enter DBA in this field (e.g. "Mark
Smith, LLC").

Federal EIN Federal Employer Identification Number.

State ID Company's State Identification Number.

Address Street, Suite Street address and suite number of the company.

City, State City and State locations for the company.
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Section Field Name Description

ZIP Code ZIP code for the company.

Foreign Country If the company is in a foreign country, name of country.

Contact Person Contact person at the company.

Telephone
Number

Primary phone number for the company.

Fax Number Fax number for the company.

Cell Phone
Number

Cell number for the contact person.

E-Mail Address E-mail address for the contact person.

Form Dates
For Date
Beginning

Preparing a return for calendar year or fiscal year beginning on this date.

For Date Ending
Preparing a return for calendar year or fiscal year ending on this date. Will link to all
forms opened in the return.

Date Incorporated Date that the company was incorporated.

Individual InformationWorksheet
The Individual InformationWorksheet (Info Sheet tab) is page two of the InformationWorksheet. A check box at the top of
the worksheet allows you to print it.

The Individual Information Worksheet contains the following fields:

Section Field Name Description

Filer and Spouse Filer's Name fields
First name, Middle Initial, Last Name, Suffix (Mr., Ms.,
etc.).

Filer's SSN Filer's Social Security Number.

Spouse's Name
Spouse's First name, Middle Initial, Last Name, Suffix (Mr.,
Ms., etc.).

Spouse's SSN Spouse's Social Security Number.

Address Street, Apartment No. Filer's street address and/or apartment number.

City, State Filer's city of residence.

ZIP Code Filer's ZIP Code.

Foreign Country
If the filer lives in a foreign country, enter the name of the
country.
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Section Field Name Description

Phone number
Fields for Home, Work, Cell, and Fax numbers. Check the
phone number that the filer considers their Daytime
number.

E-mail address Filer's E-mail address.

Filing Status Check Boxes
Choose from the following: Single, Married filing jointly,
Married filing separately, Head of household,
Qualifying widow(er) with dependent child.

Checking Returns for Errors
The Check Return feature checks a return for common errors andmissing data. The process of checking a return for errors is
also called diagnostics.

Even if you're paper filing, running Check Return helps you avoid IRS rejections and/or issues with your client's
return.

The Check Return feature:
l Recalculates the return before scanning it for errors, critical omissions, and warnings.
l Adds missing or associated forms that should be included in the return.

If a form was previously attached to the return and discarded, it will not be included.

l Lists errors that must be corrected in order to file the return.
l Lists informational diagnostics youmay want to review but don't require action on your part.
l Reports any fields whose amounts were overridden or marked as estimated.
l Lists errors specific to e-filing as well as basic errors relating to either form of filing.
l Lists errors specific to paper filing as well as basic errors relating to either form of filing.

Although the Check Return feature identifies missing and/or inconsistent information, it cannot verify the
accuracy of the information provided in the return.

To check your return for possible issues:

1. From the open return, do one of the following:
l Click the Check Return button on the toolbar.
l Click the Tools menu; then, select Check Return.
l Press Ctrl+E.

The Diagnostics pane appears. It displays errors and warnings.

2. In the Diagnostics pane, click an error or warning.
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The selection is highlighted in blue. In the form area, the system jumps to the corresponding field in the form:

3. Correct the error, as necessary.
4. Click the Re-Check button on the Diagnostics pane to clear the error.

The Diagnostics pane also appears when you create an e-file, and the button name changes from Re-Check
to Re-Create E-file(s). See Creating E-files.

6. Repeat the steps above until you've cleared the Diagnostics pane of errors.
7. After you have corrected the errors, create the e-file. See Creating E-files.

You cannot electronically file returns that contain errors or estimates. However, you can electronically file returns that
contain informational or warningmessages.

To hide specific errors temporarily, select the boxes next to the errors and click the Hide Marked check box. Click the
Clear Filters button to display any errors that were previously hidden.

Printing Check Return Diagnostics

To print a report of your Check Return results, click the Print button above the Diagnostics pane.

Check Return Filters
The Check Return feature has a filter pane to the left of the window that allows you to sort throughmessages you'd like to
see when you calculate a return.

Filter Types

You can select any combination of filters:

l Errors - Displayed in red. You cannot electronically file returns that contain errors.
l Warnings - Displayed in orange. You can file a return containing a warning.
l Informational - Displayed in blue. You can file a return containing an informational message.
l Estimated amounts - Displayed in red, like errors (you cannot file returns with estimated amounts).
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l Overrides - Displayed in blue.
l Notes - Displayed in black (permanent notes) and red (needs review notes). When you click a Note entry, the Notes
pane opens. See Preparer Notes.

l Paper File - Errors relating specifically to paper filing requirements. Displayed in red.
l E-File - Errors relating specifically to e-filing requirements; displayed in red.

You cannot electronically file returns that contain errors or estimates. The system will give you amessage
asking you to correct themessage.

l Hide Marked - If you check on individual problems in the filter pane, you can hide those from the diagnostic output.
l Clear Filters - Click the Clear Filters button to clear all the filter selections and to display all the information
available in all of the categories.

Using the Check Return Filter
To select which data you want to view:

1. Select one or more of the diagnostic filter check boxes to the left of the Check Return diagnostic pane to display
only the desiredmessages.

2. To hide a specific diagnostic result from view, select the box next to it, and then check Hide Marked.
3. To display previously hidden diagnostics, click Clear Filters.
4. After you'vemade the appropriate changes to the return, click Re-Check.

Fixing a Check Return Issue

To fix issues in your return, click the item in the Check Return diagnostic pane. This will take you directly to the source field
in the form.

ReviewingOverridden Fields
Because the program keeps track of overridden fields, you can display a list of all fields you have overridden.

To view the list of overridden fields, follow these steps:

1. Open the return.
2. Click the Check Return button on the toolbar.

3. In the filters area of the Check Return pane, select Overrides.
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The program displays a list of the fields you have overridden and their current values.

4. Click any item in the list to navigate directly to that field.

Customizing Master Forms
Master forms are the forms and worksheets included with the program which you access from the Select Forms Dialog
Box. You can customizemaster forms to better meet your business needs and save data entry work. For example, you can
customize the 3rd party designee on Form 1040.

When you save a customizedmaster form, it replaces the original form in the Select Forms Dialog Box and has a status of
Customized. Thereafter, the customized version is used when that form is added to returns.

You can easily restore any customizedMaster Form to its original state. See Restore Customized Master Forms.

Returns created prior to the customization are not updated with the customizedmaster form.

You can customize a form in any of the following ways:

l Inserting Text on Forms
l Inserting Pictures on Forms
l Creating Itemized Lists
l Creating Text Lists
l Creating Custom Lists

To customize a master form:

Close all open returns before customizingmaster forms.

1. From Return Manager, click the Forms menu; then, select Customize Master Forms.

See Customize Master Forms Dialog Box.
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2. Select a form.

You cannot select more than one Federal signature form at a time, but you can select a Federal signature form
and any other non-signature forms and schedules.

3. Click the Open Forms button.
The customizable form opens as though it was a new return namedCustomize Master:

4. Modify the forms as needed.
5. Do one of the following:

l Click the Save button on the toolbar.
l Click the Returns menu; then, select Save Masters.
l Press Ctrl+S.
l Close the Customize Master tab.

6. Close the form.

The form now has a Customized status when you view it in the Select Forms Dialog Box:

Customized Fields Have Gold Background

When you view the form in an open return, customized fields have a gold background:
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This background color will not appear on printed copies of the form.

If youmake changes to the customized fields in a customizedmaster form, the Restore Customized Master Forms
function will restore the customized value to the field - not the original value before customization of the form.

CustomizeMaster Forms Dialog Box
The Customize Master Forms dialog box allows you to select forms that you'd like to customize to better meet your
business needs, or to save you data entry time. For step-by-step procedures, see Customizing Master Forms.

To access the Customize Master Forms dialog box:

From Return Manager, click the Forms menu; then, select Customize Master Forms:

The Customize Master Forms dialog box functions in much the samemanner as the Select Forms Dialog Box, with the
exception of menu items and buttons in the chart below.

Menus and Buttons unique to the Customize Master Forms dialog box:

Menu Menu Item Description Button

Customize Open Selected Master Forms (Ctrl+O) Opens all highlighted forms. Open Forms
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Menu Menu Item Description Button

Restore Single Selected Master Form

When you've selected a customized
return, this menu item launches the
Restore Master Form dialog box that
enables you to restore the form to its
original state.

Clear All Forms
Selection

De-selects all highlighted forms. Clear

Cancel
Closes the Customize Master Forms
dialog box. 

Cancel

View View Last Selected Form

Opens the last form selected and displays
it in a Print Preview, read-only window to
determine if it is the desired form. Enables
you to print a blank copy of the form.

View Form

Choose State

Expands the All drop down list in the
Federal/State/Local area of the dialog
box filters. From the list, you can select a
state. The forms list is filtered accordingly.

Government Instructions
Opens Government Instructions for the
selected form.

Restore CustomizedMaster Forms
Only one customizedmaster form may be restored at a time.

To restore a customized master form to its original state:

1. From the Return Manager, click the Forms menu; then, select Customize Master Forms.
The Customize Master Forms Dialog Box appears.

2. Select the form you want to restore.
3. From the Customize menu, select Restore Single Selected Master Form.

4. Click Restore.

In the Customize Master Forms Dialog Box, notice that the Status of the form changes back to Installed, the form's
original state.
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Lists Overview
In ATX, you can create several types of lists and attach them to a form field. Once created, you can export the lists to a
separate .csv file, or print the list as part of the return. You can create the following types of lists:

l Itemized Lists: An itemized list is a list of items with associated dollar amounts. When you build the itemized list on
a field, the system totals the item and places the total in the form field. Typically, you could create an itemized list on
a form field that requires you to total several items.

l Text Lists: The text list is a list of items with no associated dollar amounts.
l Custom Lists: The Custom List feature enables you to define the rows, columns, and data types that you want to
appear in a list or spreadsheet. Like itemized and text lists, a custom list is created on a specific form field.

Creating Itemized Lists
The Itemized List function enables you to create a list of items with corresponding amounts that can be attached to a
specific field on a form. The total for the items appears in the field where you created the list. The itemized list becomes a
permanent part of the form.

By default, Itemized Lists are rolled over from the previous year or period. To change this default behavior, see
Rollover Manager Preferences.

To create an itemized list on a field in a return:

1. In an open return, open the form to which you want to add the list.
2. Move the cursor to the field where you want to add the list.
3. Do one of the following:

l Click the Forms menu; then, select Lists; then, select Itemized Lists.
l Right-click; then, select Itemized List.
l Press Ctrl+I.

The cursor is positioned in the List Name field.

4. In the List Name field, enter a list name.
5. To enter the first item, place your cursor in the first row (1) and enter the Description and Total.
6. To add another item to the list, click Add Record(s).
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A blank record (row) appears (2) below the first row.

7. Repeat this process until you've completed your list.
8. Click OK when you're finished.

The form field now contains the total of the itemized list. The green background indicates that a list is attached to
the field:

To open a list:

Place your cursor on any field with a list, and then click the JumpTo arrow.

Features of Itemized List Dialog

Field/Button/Check Box Description

List Name Enter a name for the list, as desired.

Import
Allows you to import a .csv file into the list. See Importing Existing Files into
Lists.

Export Enables you to export the list as a .csv file. See Exporting Lists.

Add Record(s) Adds a row to the list.

Delete Record Deletes the selected row from the list.

Apply Sort to Data Not available with itemized list.

Find Enter criteria by which you can search for an item in the list.

OK Saves items added to the dialog box and closes the dialog box.

Cancel Closes the dialog box without saving.

Creating Text Lists
The Text List function enables you to add a text list to fields on a form. Unlike the Itemized List, the Text List doesn't have
numeric values associated with it.

By default, text lists are rolled over from the previous year or period. To change this default behavior, see Rollover
Manager Preferences.

To create a text list:

1. In an open return, open the form to which you want to add the list.
2. Move the cursor to the field where you want to add the list.
3. Do one of the following:

l Click the Forms menu; then, select Lists; then, select Text Lists.
l Right-click; then, select Text List.
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The cursor is positioned in the List Name field.

4. In the List Name field, enter a list name.
5. Place your cursor in the first row (1) and enter the Description and Total.
6. To add another item to the list, click Add Record(s).

A blank record (row) appears (2) below the first row.

7. Repeat this process until you've completed your list.
8. Click OK when you're finished.

The green background on the form field indicates that a list is attached to the field:

Opening Lists

Fields that have an associated list appear with a green background.

To open a list:

Place your cursor on any field with a list, and then click the JumpTo arrow.

Features of Text List Dialog

Field/Button/Check Box Description

List Name field Enter a name for the list, as desired.

Import button
Allows you to import a .csv file into the list. See Importing Existing Files into
Lists.

Export button Enables you to export the list as a .csv file. See Exporting Lists.

Add Record(s) button Adds a row to the list.

Delete Record button Deletes the selected row from the list.

Apply Sort to Data button Not available with text list.
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Field/Button/Check Box Description

Find field Enter criteria by which you can search for an item in the list.

OK button Saves items added to the dialog box and closes the dialog box.

Cancel button Closes the dialog box.

Creating Custom Lists
Design your own list that can be directly associated with a form field. Define the rows, columns, and data types that you want
to appear in the list. If you're planning to re-use this list, save it as a template, so you can re-use it in other returns.

Custom lists will roll over with any returns you roll from the last month or last quarter.

The two-part Custom List dialog box allows you to simultaneously:

l Design the list;
l View and edit the list.

You can also choose to save the list as a template to be used on other lines or in other returns.

Custom List Dialog
To open the Custom List dialog box:

1. In an open return, open the form to which you want to add the list.
2. Move the cursor to the field where you want to add the list.
3. Do one of the following:

l Click the Forms menu; then, select Lists; then, select Custom List.
l Right-click; then, select Custom List.
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About the dialog box
The Custom List dialog box is made up of two window panes:

Design Your List pane

If you're creating a brand new list from "scratch," the Design Your List pane (top) helps you 1) create the columns you want
in your list; 2) determine the format of the data in each column (such as Text, Date, Number, or Percent); and 3) indicate
whether or not you want a column's total to link to the form.

View & Edit Your List pane

The bottom pane allows you to view and/or edit the list that you designed in the Design Your List pane. You can also import
data from another list (saved in .csv format) and/or export data to a .csv file.

Designing a List from Scratch
To design a completely new Custom List from scratch:

1. Follow directions above to open the Custom List dialog box. The Custom List dialog box opens. The Create from
scratch radio button is already selected.

2. Tab to the first row under the Column Name. Enter the first column's name (by typing over the default text).
3. Tab to the Column Formatting field; when the drop-down arrow appears, click the arrow. The list of available

formats appears:

323



Chapter 9: Preparing Returns

4. Select the type of data format for the information in that column.
5. To set up another column, click the Add Column button.
6. Repeat steps 2 through 5 for every column.
7. (OPTIONAL) If you'd like the total from one column to be linked to the form, click the Link Column Total To Form

check box for that column.

Only one column in each list can be linked to the form.

8. In the List Name field (in the View & Edit Your List pane), enter a name for your list.

When you're finished setting up your columns, the list should appear in the View & Edit Your List pane:

9. Click OK to save the new custom list in that field on the form.
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The dialog box closes. The list is saved on the field where you entered it. The field background color is turned
green, indicating the presence of a list.

Opening a Custom List
To open a custom list:

1. In an open return, place your cursor in a field that has a custom list (fields with lists have green backgrounds).
2. Do one of the following:

l Click the Forms menu; then, select Lists; then, select Custom List.
l Right-click; then, select Custom List.

Removing a List from a Field
To remove a list that that's been added to a form field:

1. In the open return, place the cursor in the field with the list you want to remove.
2. Click the Forms menu.
3. Select Lists; then, select Remove List.

4. Click Remove.
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Deleting Columns
To delete a list column:

1. Click the Delete Column button in the Design Your List pane (top).

If you have entered data in the column you're deleting, you will lose the data.

2. Click Delete Column.

Saving a List as a Template

Once created, any list can be saved as a template for use in any return. Users can roll over their own custom list templates
from year to year by selecting the Custom List Templates check box at the bottom of the Rollover Manager. See Rollover
Other Data.

To save a list as a template:

1. From the return, place your cursor on the green field with the list.
2. Do one of the following:

l Click the Forms menu; then, select Lists; then, select Custom List.
l Right-click; then, select Custom List.

The Custom List dialog box appears.

3. Click the Save As Template button.

The Template Name dialog box appears.

4. Enter the name of the template:

5. Click Save.
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The List Source has now been changed, and the template appears in the drop-down:

This template will now be available whenever you open the Custom List feature.

Updating a Template
To update a template:

1. Open the Custom List dialog box.

SeeOpening a Custom List.

2. Click the down arrow beside the Design Your List pane.
3. Select the Use a Template radio button.
4. From the drop-down list, select the template you want to update:

5. Click Update List Source.

The Custom List dialog box opens.

6. In the Design Your List pane, make changes to the columns, data format, or link to form selection.
7. Click the Save Template button.
8. Click OK.
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Managing List Templates

TheManage Templates function allows you to delete or rename a template.

To delete a custom list template:

1. From the Custom List dialog box, click theManage Templates button.

2. Select the Delete check box for the template.
3. Click Save.

To rename a custom list template:

1. From the Custom List dialog box, click theManage Templates button.

TheManage Templates dialog box appears.

2. Double-click the template name.
3. Type the new name in the field (overwriting the old name).
4. Click Save.
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Importing Data into a List

You can import data from any file saved in .csv format into a new or existing custom list. See Saving an .xls as .csv.

However, before you import, please note: the number of columns in the import datamust match the number of columns in the
custom list. If you have the same number of columns, proceed with your import; if you don't, it makes this a two-part process.
First, youmust set up or adjust the number of columns in the custom list to match the number of columns in the imported
data. When this is done, you can then import the data.

Part 1: Setting Up Columns to Receive the Imported Data

Before you begin, youmust know how many data columns you'll need in the list to accommodate the imported data.

1. Open the Custom List dialog box.
2. In the Design Your List pane, click the Add Column button until the number of columns you've addedmatches the

number of columns in the import file.

Part 2: Importing the Data

1. From the Custom List dialog box, in the Design Your List pane, click the Import button.
2. Select the .csv file to import.

See Importing Data from .csv Files.

Exporting Data from the List

You can export data from a custom list to a .csv file.

To export data from your list, see Exporting Lists.

Importing Existing Files into Lists
The Import functionality in itemized, text, or custom lists uses a general .csv import function used in other areas of the
application to import existing data from a .csv file into your newly created text, itemized, or custom list.

To import an existing list in .csv format into a text, itemized, or custom list:

1. Open the form where you want to create the list with the imported data.
2. Place your cursor in the field where you want to create the list and do one of the following:

l Click the Forms menu; select Lists; then, select the list type you want to create.
l Right-click; then, select the list type you want to create.
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3. Click the Import button in the upper left corner of your List dialog box.

4. To import the .csv file, click the Browse button.

TheOpen dialog appears.

5. Navigate to the .csv file you want to import.
6. Click Open.
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7. Select the check box for any row of data you want to import. To select all rows, select the topmost check box
(outlined in red).

8. In each column header, click the drop-down arrow (beside "Please Select") and select an information type for that
column of data.

For columns to which you cannot assign an information type, leave the program default (Please Select) or
select Omit this column from the drop-downmenu.

9. At the bottom of the dialog, select one of the following Import Methods:
l Append below existing records - this option adds the import data you select.
l Permanently delete all data prior to import - this option deletes all the existing data and imports only the
information selected here.

10. Click Import.

11. Click Close.
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Exporting Lists
Any list that is created in ATX and attached to a form field can be exported to a .csv file.

To export a list:

1. Open the form with the list you want to export.
2. Place your cursor in the green field and click the JumpTo arrow.

The List dialog box opens.

3. Click the Export button.

The Save Export As dialog box appears.

4. In the File name field, enter a name for the .csv file.
5. Click Open.

6. Click Close.
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Printing Lists
Any type of list that you create (Itemized, Text, or Custom) is automatically included as a printable item in the return. These
lists appear at the bottom of the Federal Worksheets section of the Print Return Dialog Box.

To print lists along with the return:

1. Open the return with the list(s) you want to print.
2. Do one of the following:

l Click the Print button on the toolbar.
l From the Returns menu, select Print Return.
l Press Ctrl+P.

The Print Return Dialog Box for the return appears.

3. Under theWhat do you want to print section, expand the Federal Worksheets section; then, expand the
signature form section (such as 1040 or 1120).

333



Chapter 9: Preparing Returns

4. Select the check box(es) for the list(s).
5. Click Print.

Removing Lists
To remove a list that that's been added to a form field:

1. In the open return, place the cursor in the field with the list you want to remove.
2. Click the Forms menu.
3. Select Lists; then, select Remove List.

4. Click Remove.

Deleting Rows from Lists
To delete a row from any kind of list:

1. Open the list.

Form fields with attached lists have a green background. To open them, click the JumpTo arrow beside the
field.

2. Highlight the list you want to delete.
3. Click the Delete Record button.

4. Click Delete.
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Working in Forms
This section outlines the features that are available while working in forms:

l Tips for Entering Data
l ZIP Code Lookup
l Duplicating Forms or Schedules
l Data Entry Validation
l Cut, Copy, and Paste
l Undo
l Overriding Calculated Fields
l Restoring Overridden Fields
l Marking Fields as Estimated
l Creating Links Between Fields
l Preparer Notes
l Locked Fields
l Inserting Text on Forms
l Inserting Pictures on Forms
l Input Sheets and Detail Schedules
l Using Input Sheets or Detail Schedules
l Using the Record Bar
l Importing K-1 Data
l Importing Data from .csv Files
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Tips for Entering Data
To decrease chances of erroneous e-file rejections, the program automatically deletes lone spaces or lone decimal point
entries in numeric fields, just as if you pressed the Delete key manually.

Data fields are color-coded according to the type of information they contain. Fields that accept user input without overrides
have blue backgrounds. In general, you should only enter data in blue fields.

To enter data:

1. Activate an input field by clicking the field or pressing the arrow keys on your keyboard.
2. Selecting a check box with themouse does one of the following:

l Inserts an X in the box
l Clears the box if it was already checked

3. To navigate to a check box without changing its status, press Enter or Tab in the previous field.
4. Enter the appropriate information.

Fields requiring special number formats, such as phone numbers, dates, and tax ID numbers, are preformatted.
You do not need to add hyphens or other such characters when entering this information.

5. Advance to the next field by pressing Enter or Tab.

To reverse direction, press Shift+Tab.

To edit or delete data:

1. Navigate to the field that contains the data you want to edit or delete.
2. You can use themouse to navigate to any field, but if the cursor is inside an active (yellow) field, first press Enter or

Tab.
3. To delete the entire entry, press Delete.
4. To edit the existing information, press Backspace, edit the data, and then press Enter.

Data Entry Validation
Some form fields may require data to be in a specific format. To ensure that required field data is entered in the proper format,
ATX automatically validates the format and type of information.

Data Validation Errors
When you type something into a field that the system does not expect, youmay receive a validation error like this:
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To correct a validation error:

1. On the Entry Validation dialog box, click Edit.

The dialog box closes and the cursor is placed directly in the field with the error.

2. Correct the error.

ZIP Code Lookup
The ZIP Code lookup feature works on the Federal signature forms andW2/1099 forms that contain address fields. Go to the
ZIP Code entry, type the ZIP Code, press Enter and ATX populates the city and state.

Enter the ZIP Code in the applicable field.

If the ZIP Code is not found, enter the correct city and state in the applicable fields.

You can also change the city and/or state associated with a ZIP Code in ATX.

1. Enter the ZIP Code in the applicable field.
2. ATX enters the city and state automatically.
3. Change the city or state in the applicable field and press the Tab key.

Duplicating Forms or Schedules
The Duplicate Form function allows you to includemultiple copies of certain forms, schedules, or worksheets in a return.

If a form, schedule or worksheet cannot be duplicated, this menu item will be disabled.

To duplicate forms:

1. Open a return.
2. Select the form tab for the form you want to duplicate.
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3. Right-click the form tab and select Duplicate Form.

The system creates the duplicate with a suffix of :02. For example, the duplicate of W-2 would beW-2:02.
Duplicates may be renamed.

MaximumNumber of Copies
Some forms have amaximum number of duplicates. Once you've reached themaximum number, the Duplicate Formmenu
item is disabled.

Even if you've reached themaximum limit, you can still add another copy of the form using the Select Forms Dialog Box.
However, the forms added above and beyond themaximum will not flow into calculations in the return.

Cut, Copy, and Paste
The product uses standard Cut, Copy, and Paste functions to copy or move information from one form to another (in an open
return) or from one field to another (if you're in aManager view).

l Cut - Ctrl+X
l Copy - Ctrl+C
l Paste - Ctrl+V

You can also use these commands to transfer data to or from other applications (Microsoft Excel, for example).

You can reverse the effect of any of these commands by using the Undo function.

To cut and paste information from a form field to another location:

1. Select the field that contains the information you want to cut.
2. Press Ctrl+X.
3. Place your cursor to the field or location you want to paste the information.
4. Press Ctrl+V.

To copy information to another form field or another application (such as Microsoft Excel):

1. Select the field that contains the information you want to copy.
2. Press Ctrl+C.
3. Place your cursor to the field or location you want to paste the information.
4. Press Ctrl+V.

Undo
The Undo function removes the last entry that was made in a field, or reverts the last command.

For example, if youmanually entered an amount in a field that previously had a value of zero, Undo changes the field value
back to zero. Similarly, if you pasted an amount into a field, and then selected Undo, the amount would be removed from the
field.

To undo:

From the field in question, do one of the following:
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l Click the Edit menu; then, select Undo.
l Press Ctrl+Z.

Overriding Calculated Fields
Calculated fields contain links or formulas that the program references. You can enter data or formulas in a calculated field by
overriding the current link or formula. Calculated fields, which normally bear a white background, display a pink background
when overridden.

Avoid overriding calculated fields whenever possible. Overridingmay interfere with creating e-files and it prevents the
Check Return feature from completing full diagnostics for a return.

To remove an override and restore program calculations for a field, use the Restore command on the toolbar. See Restoring
Overridden Fields.

To override a calculated field:

1. Place the cursor in the calculated field.
2. Begin entering a value or other data.

If the field is calculated from data on the current sheet, the Override Field dialog box appears:

3. Click Override.

The field color changes to yellow, indicating an editable field. A pink system note also indicates that you are
overriding a calculated field.

4. Enter the amount in the field.

When you tab off the field, the overridden field color turns to pink.
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To avoid receiving the Override Field dialog box in the future, select the Don't show this message again check box.

To override a field calculated from data on another form:

1. Place the cursor in the calculated field.
2. Begin entering a value or other data.

If the field is calculated from data on another form, the Calculated Field dialog box appears:

You can click JumpTo and enter information the source of the calculation to avoid an override.

3. Click Override.

The field color changes to yellow, indicating an editable field.

4. Enter the amount in the field.

When you tab off the field, the overridden field color turns to pink.

Printing the Override Report
The Print function allows you to print the override report as part of the printed return, or as a separate document.

To print a report showing all overridden fields in a return:

1. Open the return.
2. Do one of the following:

l Click the Print button on the toolbar.
l Click the Returns menu; then, select Print Return.
l Press Ctrl+P.

The Print Return Dialog Box appears.

3. In theWhat do you want to print? area of the dialog box, select the Override & Estimate Report check box.
4. To preview the report, click the Print Preview button on the dialog box.
5. To print the report, click the Print button at the bottom of the dialog box.
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Restoring Overridden Fields
The Restore function restores the original contents of an overridden field.

To restore a field to its original content:

1. Place your cursor in the overridden field.

Overridden fields are pink. SeeOverriding Calculated Fields.

2. Do one of the following:
l Click the Restore button on the toolbar.
l Right-click and select Restore Field from the context menu.
l Click the Edit menu; then, select Restore Field.

The field is changed to white again, and the value is restored to the original value before it was overridden.

Marking Fields as Estimated
You canmark an amount as estimated, leaving a trail for you to come back and finalize the estimated amount.

To mark a field as estimated, do one of the following:

l Right-click the field and select Mark as Estimate.
l Click the Edit menu; then, select Mark as Estimate.
l Press F4.

An estimated field will have a purple background (unless it has been overridden, in which case it will be pink). The
amount will be italicized:

To quickly locate all fields marked estimated:

1. Run the Check Return feature by doing one of the following:
l Click the Check Return button on the toolbar.
l Click the Tools menu; then, select Check Return.
l Press Ctrl+E.

2. In the Check Return filter pane, select Estimates.

Estimated fields messages will now appear in red in the Check Return pane.
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Creating Links Between Fields
Use the Start Link and Finish Link feature to create a link between two fields on any form (including schedules and
worksheets). This function, represented by the Start Link/Finish Link toggle button on the toolbar above an open return, links
text or numeric values from one field (source field) to another field (destination field).

After a link has been established, changes made in the Start Link field are reflected in the destination field. When checking a
return for errors (Check Return), the Finish Link field (destination) will bemarked as an overridden field.

Start/Finish links automatically roll over from prior year or prior period returns.

To create custom links:

1. Select the source field.
2. Do one of the following:

l On the toolbar, click the Start Link button.
l From the Edit menu, select Start Link.

3. Navigate to the destination field on any form, schedule, or worksheet.
4. Do one of the following:

l On the toolbar, click the Finish Link button.
l From the Edit menu, select Finish Link.

If it takes longer than 40 seconds to finish the link, the request will be canceled.

Destination fields have a green background.

Canceling Relationships between Two Linked Fields
To undo the link between two fields:

1. Place the cursor in the destination (green) field.
2. Do one of the following:

l On the toolbar, click the Restore button.
l From the Edit menu, select Restore Field.
l Press Ctrl+R.

When the green background disappears from the destination field, you know the link has been removed.
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Exceptions: When Fields Cannot Accept a Link
The following fields cannot be linked:

l Input or Detail Sheets
l Itemized Lists
l Circular references or mathematical loops

Whenever a field cannot be linked, you'll receive amessage that will alert you to this exception.

Preparer Notes
You can use the Insert/Edit Notes feature tomake preparer notes in particular fields, or to flag fields that need to be
reviewed by others. Although notes do not appear in the printed return, they do roll over from one year to the next.

The notes can bemade only in fields intended for user entry.

Insert/Edit Notes
To insert a note in a field:

1. Open the return.
2. Place your cursor in the field where you want to insert the note.
3. Do one of the following:

l Right-click and select Insert/Edit Note from the context menu.
l Click the Edit menu; then, select Insert/Edit Note.
l Press Ctrl+T.

4. In the Title field, enter a name for the note.
5. Select one or both check boxes for each note:

l Permanent Note - Remains with the return. The note will be rolled over with other return data. Permanent notes
appear in black text in the Diagnostics pane.

l Needs Review - A reminder flag that allows you to communicate that the return needs to be reviewed by
someone else. These notes appear in red text in the Diagnostics pane.

6. In the empty pane below, enter the text of the note.
7. Click Save.
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The Note is moved to the left pane:

8. Click Close to close the Notes pane.

When you tab off the field, a red note indicator appears in the upper right corner of the field:

When you hover over red note indicators, a tooltip displays your note.

Notes History

The product records the history of the note, including the note text entered on a particular date and the user name that entered
the note.

To view note history:

1. With the cursor positioned in the field bearing a note indicator, do one of the following:
l Right-click and select Insert/Edit Note from the context menu.
l Click the Edit menu; then, select Insert/Edit Note.

The Notes pane appears.

2. Near the bottom of the pane, click the down arrow beside History.
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Remove a Note
To remove a note:

1. Place your cursor in the field where you want to remove the note.
2. Do one of the following:

l Right-click and select Remove Note from the context menu.
l Click the Edit menu; then, select Remove Note.

You can also delete a note from the Notes pane by highlighting the item and clicking the Delete Note button
on the pane.

Locked Fields
On some forms, youmay encounter a locked field. Locked fields prevent you frommaking changes to data that flows from a
source calculation. When you try to enter data in a locked field, the following dialog box appears:

Tomodify the information at the source, click the JumpTo button. When youmodify the information in the source field, it will
flow back to the locked field.

Inserting Text on Forms
In ATX, you can add special text to a form. For example, you can add special text to a worksheet, such as "Initial Here" if
you want the taxpayer to review specific entries. This text can be added to any form, and the form can be saved as a
Customizing Master Forms that can be used for all your returns.

The Insert Text menu item will appear disabled on certain forms that are write-protected by the taxing agency.
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Inserting Text
To add text to a form:

1. Open the form to the page/worksheet where you want to add the text.
2. From the Edit menu, select Insert Text.

The cursor becomes a large + symbol.

3. Drop the cursor anywhere on the page or worksheet where you want to place the text.

4. In the Text box, enter the text you want to appear.
5. Click the Font button to change the appearance of the text.

6. Make your selections; then, click OK.
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7. Click OK.

The dialog box closes and the text box appears on the form.

8. To adjust the text box, click to select it. Blue squares will appear around the text box.
9. Do either or both of the following, depending on how you want the image placed on the form:

l To resize it, click the corner of the text box, and drag in or out on a diagonal.
l Tomove it, click in themiddle of the text box; then, drag the whole image to its location.

The text box is saved with the form when you save the return.

Removing Text
To remove inserted text from a form:

1. Click the text in the form to select it.
2. Do one of the following:

l Click the Edit menu; then, select Remove Text.
l Press the Delete key.
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3. Click Delete.

Inserting Pictures on Forms
In ATX, you can add a picture or image to a form. For example, you can save your signature as an image file, add it to the
1040 Preparer section, and save this as a Customized Master that can be used for all your returns. See Customizing
Master Forms.

The application supports the .bmp, .gif, .jpg, and .png image formats. Once added to a form, the image will be printed (both
physically and in PDF form) as an integrated part of the form.

The Insert Picture menu item will appear disabled on certain forms that are write-protected by the taxing agency.

Inserting a Picture
To add a picture to a form:

1. Open the form to the page/worksheet where you want to add the picture.
2. From the Edit menu; then, select Insert Picture.

The cursor becomes a large + symbol.

3. Drag and drop the cursor in the field where you want to insert the picture.

A Windows Open dialog box appears.

4. Navigate to the location of the image/picture file; then, click Open.

The image appears on the form.

5. To adjust the image, click to first select it. The selected image has blue squares surrounding the image.
6. Do either or both of the following, depending on how you want the image placed on the form:

l To resize it, click the corner of the image, and drag in or out on a diagonal.
l Tomove it, click in themiddle of the image; then, drag the whole image to its location.

The image is saved with the form when you save the return.

Removing a Picture
To remove a picture from a form:

1. Click the picture in the form to select it.
2. Do one of the following:

l Click the Edit menu; then, select Remove Picture.
l Press the Delete key.
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3. Click Delete.

Input Sheets and Detail Schedules
Forms that use both an input sheet and a detail schedule also use a Record Bar to add, delete, sort, or find records. See
Using the Record Bar.

Some of the forms that use this method of data entry are:

l Schedule D – Schedule D Input Sheet
l Form 8949 – Sales and other Dispositions of Capital Assets
l FormW-2 – Wage and Tax Statement Input Sheet
l Forms 1120S and 1065 – Schedule K-1 Input Sheet

Using Input Sheets or Detail Schedules
Onmulti-copy forms, you can use the Input sheet or the Detail schedule (or both).

To enter data on input sheets or detail schedules:

1. Open a form containing amulti-copy worksheet.
2. Click the Input or Detail tab at the bottom of the screen.
3. Complete the information required to report the tax event.
4. Review the Input sheet or the Detail schedule totals to verify that all calculations are correct.

In some cases, the calculations will not be correct until you enter all of the necessary information. In cases
where you have chosen to use special calculation amounts, you will have to override certain fields and enter
the correct information.

Columns in someDetail schedules may be sorted in ascending or descending order by clicking the column
header. Additionally, when sorted, some forms will display an Apply Sort to Form button. Clicking the Apply
Sort to Form button will sort the information in the form itself (for example, applying the sorted data in the
Detail schedule of Form 8949 will sort the same data in Pages 1 and 2 (Parts 1 and 2) of Form 8949.

To locate missing information or items that do not agree with the sums reported, click Check Return.

Using the Record Bar
Each input sheet and each line on a detail schedule is a record. Use the Record Bar above the input sheet or detail schedule
to add, delete, or find records, or to browse through the records sequentially.

349



Chapter 10: Working in Forms

To add records to an Input worksheet or Detail worksheet:

1. From the first page of the input sheet or detail schedule, click the Input or Detail tab, as desired.

2. Do one of the following:
l Click the Add New Record button (see B, above).
l Click the Edit menu, expand the Record Tools fly-out menu, and then select Add New Record.
l Press Ctrl+A.

The Record number advances by one, and the Input Sheet fields are cleared.

To navigate through the records (see A, above):

l Tomove sequentially through the records, use the left and right arrows directly beside the Record number.
l To return to the first record, click the double left arrow.
l To go to the last record, click the double right arrow.

To delete records from an Input worksheet:

1. From the Input worksheet of the form, select the record to be deleted.
2. Do one of the following:

l Click the Delete Record button (see B, above).
l Click the Edit menu, expand the Record Tools fly-out menu, and then select Delete Record.
l Press Ctrl+D.

3. Click Delete.

To delete rows from a Detail worksheet:

1. From the Detail worksheet, select the row you want to delete.
2. Click the Delete Record button at the top of the worksheet.
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3. Click Delete.

Importing K-1 Data
The following are instructions for importing Schedule K-1 information from 1041, 1065, and 1120S returns. You can import K-1
data into the following types of ATX returns: 1040, 1040NR, 1041, 1065, 1120, and 1120S returns.

NewReturns
To import K-1 information:

Youmust have a completed return with Schedule K-1 data. See Creating Returns.

1. Create a new return (supported return types are listed at the beginning of this topic).
2. With the new return open, click the Returns menu.
3. Expand the Import Data fly-out menu; then, select K-1 Data.

All returns are checked by default. If you do not want to import data from one or more of these returns, deselect
the check box.

4. Click Import Data For Marked Returns to import the K-1 Data.
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The information from thematching 1041, 1065, or 1120S return(s) is added to the applicable K-1 Input Worksheet(s)
in the new return. The corresponding forms are added to the new return:

If youmake subsequent adjustments to K-1 data on 1041, 1065, and 1120S returns, the system will notify you
of changes when you open the corresponding new return. At that time, you'll be given the opportunity to update
K-1 information.

Messages You May Receive

The SSN and/or EIN must be entered on the new return in order to begin importing data. If it is not in place, you'll receive a
message dialog box. You'll also be notified if the system cannot locate any 1041, 1065, or 1120S returns with SSNs or EINs
corresponding to the 1040 or 1040NR return.

Updating K-1 Information on an Existing Return
To update imported K-1 information on an existing return:

1. Make the changes to the Sch K-1 form in the 1041, 1065, or 1120S return.
2. Open the existing return.
3. With the return open, click the Returns menu.
4. Expand the Import Data fly-out menu; then, select K-1 Data.
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Previously imported returns are shown in blue.

5. Select the check boxes for the returns you want import.
6. Click Import Data For Marked Returns.

ATX loads the new data into the new return.

Opening a ReturnWhen Associated K-1 Data Has Changed

Click Update to import the changed data into the destination return, or click Skip to open the return without updating the K-1
data.
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Unavailable Source Returns or FormsWithin Source Returns

Click Continue to open the return without updating the data.

Amended Source Returns
If a source return is amended, both the original and the amended return appear in the Import Data Change dialog box. Select
the Amended return and click Update.

If you try to select the original source return, you'll receive a Duplicate EIN message:

Click Switch to select the Amended return instead.

Importing Data from .csv Files
On select forms with Detail worksheets, you can import detail data from .csv files directly into the worksheet.

To import detail data from a .csv file to a detail worksheet:

1. Open the form.
2. At the bottom of the form, click the Detail tab.
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3. Click the Import button.

4. To import the .csv file, click Browse.

TheWindows Open dialog box appears.

5. Navigate to the .csv file you want to import.
6. Click Open.
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7. Select the check box for any row of data you want to import. To select all rows, select the topmost check box
(outlined in red).

8. In each column header, click the drop-down arrow (beside "Please Select") and select an information type for that
column of data.

For columns to which you cannot assign an information type, leave the program default (Please Select) or
select Omit this column from the drop-downmenu.

9. At the bottom of the dialog, select one of the following Import Methods:
l Append below existing records - this option adds the import data you select.
l Permanently delete all data prior to import - this option deletes all the existing data and imports only the
information selected here.

10. Click Import.

11. Click Close.

Saving an .xls as .csv
To save an Excel spreadsheet as a .csv file:

1. With the desired spreadsheet open in Excel, click the File menu; then, select Save As.

The Save As dialog box appears.

2. Browse to the location to which you would like to save your file.
3. In the Save as type: drop-down list, select csv (comma delimited).
4. Click Save.

Accounting Import
You can import your accounting data into tax returns from CAS Client Write-Up or QuickBooks Online. This section provides
information on supported forms and how to perform each type of accounting import.
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CAS Client Write-Up import:

l Accounting Import for CAS
l Importing CAS Accounting Data into ATX
l Exporting CAS Files

QuickBooks Online import:

l Accounting Import QuickBooks Online
l Importing QuickBooks Online Accounting Data into ATX
l Data from QuickBooks
l Importing Another Company into a Return

Accounting Import QuickBooks Online
ATX Tax software can import your accounting data into tax returns from QuickBooks Online.

Supported Returns and Activities:

The Accounting Import feature imports accounting data into the following forms:

Form 1040, U.S. Individual Income Tax Return

l Schedule C (1040), Profit or Loss from Business

Form 1065, U.S. Return of Partnership Income

Form 1120, U.S. Corporation Income Tax Return

Form 1120S, U.S. Income Tax Return for an S Corporation

Importing QuickBooks Online Accounting Data into ATX

Accounting data exported from QuickBooks Online can be imported into ATX and the amounts will flow to the activities
mapped during the import process. If the required forms do not yet exist in the return, they will need to be added before doing
the import process. See Accounting Import QuickBooks Online.

To import accounting data:

1. Open your client's tax return in ATX.

The Schedule C (1040), Profit or Loss from Business, must already be added to the return.

2. From the Returns menu, select Accounting Import, and then click QuickBooks Online.
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3. Enter your e-mail address or user ID in the Email or user Id box.
4. Enter your password in the Password box.
5. Click the Remember me check box if you want QuickBooks to remember your User ID the next time you log in.
6. Click Sign In.

l Youmay be asked to validate your information either by text or e-mail. Select your preferredmethod and click
Continue. Once you receive the 6-digit code enter the code in the Enter the 6-digit code box, and click
Continue.
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8. Select the Company/Firm from the drop down list, and then click Confirm.

9. Read the authorize conditions, and then click Authorize.
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10. Select a company from the Client drop-down list.
11. Enter a starting date in the Start Date box and ending date in the End Date box.
12. Select the basis of accounting from the Basis of Accounting drop down list, and then click Continue.

13. Select the schedule from the Schedule drop down list. This step is only for 1040 return types.
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14. From the Import QuickBooks Data dialog box verify themapping information, and then click Import. ATX auto
assigns tax lines based on the account type and sub type. See Data from QuickBooks .

Unassigned items in the Tax Line column do not import, so you should verify all linemapping before
importing accounting data. If changes are needed for the Tax Line column, click the cell and use the drop
down list to make changes. Once changes are complete, click Save to save the changes. ATX saves these
changes and uses them the next time the client is selected.

Clicking the Refresh Data From QuickBooks link resets assignedmapping for the client.

15. Click Import.

Data from QuickBooks

The Import QuickBooks Data dialog box allows you to change tax linemapping, and/or update imported data from
QuickBooks.

Changing Tax Line Mapping
If changes are needed to the Tax Line column, click the cell and use the drop down list to make changes. Once changes are
complete, click Save to save the changes. ATX saves these changes and uses the savedmapping the next time the client is
selected.

Clicking the Refresh Data From QuickBooks link resets assignedmapping for the client.

Refresh Data and Re-Import
There are times that youmay need to refresh the data from QuickBooks and re-import the information to ATX.
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To refresh the data from QuickBooks and re-import:

1. Open your client's tax return in ATX.
2. From the Returns menu, select Accounting Import, and then click QuickBooks Online.

l If prompted log in to QuickBooks.

3. From the Import QuickBooks Data Authorized Client(s) dialog box, click Continue.
l Click Authorize New Client if you havemore than one client for this return or if the wrong client was selected.

If the wrong client was selected previous imported data is not removed, verify information after import.

4. Select a company from the Client drop-down list.
5. Enter a starting date in the Start Date box and ending date in the End Date box.
6. Select the basis of accounting from the Basis of Accounting drop down list, and then click Continue.
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7. Select the schedule from the Schedule drop down list. This step is only for 1040 return types.

8. Click the Refresh Data From QuickBooks link, verify themapping and then click Import.

Unassigned items in the Tax Line column do not import, so you should verify all linemapping before
importing accounting data. If changes are needed for the Tax Line column, click the cell and use the drop
down list to make changes. Once changes are complete, click Save to save the changes. ATX saves these
changes and uses them the next time the client is selected.

Clicking the Refresh Data From QuickBooks link resets assignedmapping for the client.

Importing Another Company into a Return

When a client has more than one schedule for a return you can use the Authorize New Client link to import the additional
accounting data into ATX.

To add an additional company to a return:

1. Open your client's tax return in ATX.
2. From the Returns menu, select Accounting Import, and then click QuickBooks Online.

l If prompted log in to QuickBooks.
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3. Click Authorize New Client if you havemore than one client for this return.

4. Select the Company/Firm from the drop down list, and then click Confirm.
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5. Read the authorize conditions, and then click Authorize.

4. Select a company from the Client drop-down list.
5. Enter a starting date in the Start Date box and ending date in the End Date box.
6. Select the basis of accounting from the Basis of Accounting drop down list, and then click Continue.
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7. Select the schedule from the Schedule drop down list. This step is only for 1040 return types.

8. From the Import QuickBooks Data dialog box, verify themapping information, and then click Import. ATX auto
assigns tax lines based on the account type and sub type. See Data from QuickBooks .

Unassigned items in the Tax Line column do not import, so you should verify all linemapping before
importing accounting data. If changes are needed for the Tax Line column, click the cell and use the drop down
list to make changes. Once changes are complete, click Save to save the changes. ATX saves these changes
and uses them the next time the client is selected.

Clicking the Refresh Data From QuickBooks link resets assignedmapping for the client.

Accounting Import for CAS
ATX Tax software can import your accounting data into tax returns from CAS Client Write-Up. Accounting Datamust be
exported from CAS andGL accounts must bemapped to their corresponding tax line. Oncemapping is complete, the data
may be imported into ATX and the amounts will flow to themapped tax lines.

Supported Returns and Activities:

The Accounting Import feature imports accounting data into the following forms:
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Form 1040, U.S. Individual Income Tax Return

l Schedule C (1040), Profit or Loss from Business
l Schedule E (1040), Supplemental Income and Loss (rent and royalty properties)
l Schedule F (1040), Profit or Loss from Farming
l Form 4835, Farm Rental Income and Expense

Form 1065, U.S. Return of Partnership Income

Form 1041, U.S. Return for Estates and Trusts

Form 8825, Rental Real Estate Income and Expenses of a Partnership or an S Corporation

Form 1120, U.S. Corporation Income Tax Return

Form 1120S, U.S. Income Tax Return for an S Corporation

Form 990, Return of Organization Exempt From Income Tax

Form 990EZ, Short Form Return of Organization Exempt From Income Tax

Importing CASAccounting Data into ATX

Accounting data exported from CAS may be imported into ATX and the amounts will flow to the activities mapped during the
export from CAS. It is not necessary to add activities to the tax return prior to the import. If the required forms do not yet exist
in the return, they will be added during the import process.

To import accounting data:

1. Open your client's tax return in ATX.

The SSN or EIN must already be entered.

2. Click the Returns menu; then, expand the Accounting Import fly-out menu and select Client Write-Up.

If the file has been saved to another location during export, you will see a browse dialog box. Simply browse to
the export file, click Open, then the Activity Selection dialog box will appear.
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The Imported Activities column lists each activity to be imported. The Tax Return Activities column shows
the form(s) to which data will be imported. <Add New> signifies that the form will be added during the import
process.

3. Click Import to complete the process.

The Import Progress... dialog box appears, followed by the Import Results dialog box.

All necessary forms have been added to the return and totals have been imported to themapped tax lines.

Exporting CAS Files
To export CAS files in IMP format:

1. With the desired client open in CAS, click the Activities menu; then, expand the Exports fly-out menu and select
Tax Export.

2. In the General Ledger Tax Interface for dialog box, select the Client Entity, Tax Interface (ATX), and Tax
Year.

3. Click Continue.

If you have another CAS client that has already beenmapped and you would like to use identical mappings for
this client or if you would like to rollover mappings for this client from a prior year, click Rollover Tax Line
Items then follow the instructions in the Roll In Tax Line Assignments from dialog box.
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4. Do one of the following:
l Select the desired GL account in the Destination List; then, double-click the corresponding tax line in the
Select List.

l Drag the desired tax line from the Select List to the appropriate GL account in the Destination List.
5. Click Export.

The Browse For Folder dialog box appears.

6. Do one of the following:
l Click OK to export to the default location (recommended).
l Browse to another save location for the export, then click OK.

Form Update Report
When updates are downloaded to your system, the Form Update Report dialog box tells you about the changes to forms.
This dialog box has two tabs:

l Form Update Returns Report
l Form Update Forms Log

Form Update Returns Report
The Form Update Report lists forms that have been updated that are included in your returns.

To view the Form Update Returns Report:

1. Do one of the following:
l Click the Forms menu; then, select Form Update Report.
l Click the Updates button; then, on the Updates dialog box, click the Form Update Report link.
l From any Updates dialog box, click the Form Update Report link.

369



Chapter 10: Working in Forms

2. Click Next to see the changes made to the next form in the Forms Updated list.

UI Element Description

Forms Updated Lists the forms that were included in the update.

Changes made to this form Lists the changes made in the form selected in the Forms Updated pane.

Returns containing this form
Lists the return names containing the form that is selected in the Forms Updated pane.
A check mark indicates a return that has beenmarked Complete.

Help Opens Program Help.

Prev/Next Moves to the information for the Previous or Next form in the Forms Updated pane.

Close Closes the dialog box.

Form Update Forms Log
The Form Update Forms Log lists all forms updated on a selected day.

To view the Form Update Log:

1. Do one of the following:
l Click the Forms menu; then, select Form Update Report.
l Click the Updates button; then, on the Download Form Updates dialog box, click the Form Update Report
link.

l From any Updates dialog box, click the Form Update Report link.
2. Click the Forms tab.
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3. To view the update log for a different date, click the calendar (outlined in red) and select a new date.

Re-Downloading Forms in Marked Returns
This function allows you to delete corrupted forms in specific returns and replace them with themost up-to-date forms.

To re-download forms in marked returns:

1. In Return Manager, mark the return(s) whose forms you want to replace.
2. Click the Support menu.
3. Select Customer Service Utilities; then, select Re-Download Forms in Marked Returns.

All the forms in the return will be checked. If you do not want to replace a specific form, simply clear the check
box.

4. Click Re-Download Forms.
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5. To view the list of updated forms, click the Form Update Report link, and select the Forms tab.
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E-filing
E-filing is a complex subject. For those who are unfamiliar with e-filing, we've provided a long list of topics that will give
you the background and information you need to get set up and begin e-filing returns.

Aside from the regular ATX System Requirements, the only requirement for e-filing is broadband internet access.

Federal E-filing Requirements and Eligibility
Apply to File Returns Electronically
To become an authorized e-file provider, follow directions on the Becoming an Authorized e-file Provider page of the
IRS Web site.

If your application is accepted, youmay continue to participate in the program as long as you and your business meets
and adheres to IRS e-file requirements.

This process can take up to 45 days to complete.

Receive Your EFIN
If you are approved, you'll receive an acceptance letter containing your credentials and your unique Electronic Filing
Identification Number (EFIN), whichmust appear on all your e-filed returns.

You only complete the application once. After you have been authorized to participate, you will receive an acceptance
letter before the start of every subsequent tax season, as long as all of the following are true:

l Your address is up-to-date on IRS e-file Application records;
l You transmitted at least one e-file that was acknowledged as accepted for the previous or the current year;
l You are not denied, suspended, or expelled from participation in IRS e-file.
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Preparers operating in California, New York, Maryland, andOregonmust meet additional requirements mandated by their
respective State Agencies State or Local E-filing Requirements.

State or Local E-filing Requirements
There are considerable state-to-state variances in e-filing rules and requirements. Some states allow you to e-file your returns
directly to them, while others only accept e-files after they have first been validated and forwarded by the IRS. Youmay e-file
state returns using one of threemethods, as determined by the state:

l Linked or Fed/St – The federal and state returns are linked together. The IRS will verify that the indicated Federal
return has been accepted before forwarding the state return to the state. If the Federal return has not been received,
or has been rejected, the state return will be rejected with Error Code STATE-902: The IRS Submission ID
referenced in the State Submission Manifest must be in accepted status.

l State Only e-file (Unlinked) – State Only e-file is a joint IRS/state program. The IRS receives state e-file returns,
validates that they are in the proper format (but doesn't validate the data or content), and then forwards them to the
state(s).

l Direct e-file – A direct e-file state accepts transmissions independently and without regard to the status of the
Federal e-file. However, we do not recommend transmitting an e-file directly to a state until the IRS has
acknowledged receipt of an error-free Federal return.

To learn about a particular state's e-filing requirements, or about the transmission method you need to use:

1. Go to www.MyATX.com in your Internet browser.

TheMyATX Solution Center page appears.

2. In the upper right corner of the page, click the Login link.

3. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
4. Enter your User Name in the User Name box and press the Tab key.
5. Enter your Password in the Password box.
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6. Select the Remember me check box if you want the Solution Center to remember your information the next time
you log in.

7. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click
the Verify button.

8. Click Log In.

TheMyATX™ Support Center Web site appears.

9. Click the E-File Center tab at the top of the page.

10. Click the State DORs link on the left side of the page.

11. On themap, click the state for which you want information.
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12. Click the desired link.

States with Additional Requirements
With the exception of California, New York, Maryland andOregon, all states automatically accept all EROs without additional
state registration.

California requires registration with the California Tax Education Council and Continuing Education Credits.
*Certified Public Accountants, Enrolled Agents, Attorneys who are members of the State Bar, and certain specified government,
banking or trust officials are exempt.

New York requires tax preparers to obtain a New York Tax Preparer Registration Number (NY TPRIN).
*Certified Public Accountants, Enrolled Agents, Attorneys who are members of the State Bar, and certain specified government,
banking or trust officials are exempt. Certain other specified exemptions may also apply. Visit the NY Department of Taxation and
Finance for more information.

Maryland requires a Federal PTIN, registration fee, and an examination.
*Certified Public Accountants, Enrolled Agents, Attorneys who are members of the State Bar, and certain specified government,
banking or trust officials are exempt.

Oregon imposes strict licensing requirements on all tax preparers.
*Enrolled Agents may qualify for limited exemption.

E-File Signatures
Like any conventional return, an e-file is not considered valid until both you and your client(s) have signed it. The IRS will
accept any of the three digital signingmethods described in the table below. Only the Self-Select PIN method results in a truly
paperless e-file.

To request an E-file PIN, enter www.irs.gov/Individuals/Electronic-Filing-PIN-Request in your Internet browser.

Signature
Methods Taxpayer ERO (Preparer) Paper Forms Required

Practitioner PIN
1. Complete and sign
Form 8879 (Part II).

1. Enter taxpayer's PIN
on EF InfoWorksheet (if
authorized by taxpayer)
on Form 8879.

Form 8879. DONOT FILE.
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Signature
Methods Taxpayer ERO (Preparer) Paper Forms Required

2. Enter PIN on EF
InfoWorksheet (if
ERO is not authorized
to do so).

2. Enter 5-digit EROPIN
on EF Info worksheet.

Retain for three years from the Return Due
Date or IRS Received Date, whichever is
later. See Form Instructions.

Self-Select PIN

1. Enter PIN on EF
InfoWorksheet or
complete Form 8879,
authorizing ERO to do
so.

2. Enter taxpayer’s
prior year AGI on EF
Info worksheet.

1. Enter 5-digit EROPIN
on EF Info worksheet.

2. Enter taxpayer’s PIN
on EF Info worksheet (if
authorized by taxpayer
on Form 8879).

3. Enter taxpayer’s prior
year PIN or AGI on EF
InfoWorksheet.

None, if taxpayers enter their PINs on the EF
InfoWorksheet. Otherwise, complete Form
8879, but do not file it. Instead, retain the
form for three years from the Return Due
Date or IRS Received Date, whichever is
later.

E-File PIN
Enter E-File PIN on
EF Inf Worksheet
Prior Year PIN field.

1. Enter 5-digit EROPIN
on EF Info worksheet.

2. Enter taxpayer’s PIN
on EF InfoWorksheet (if
authorized by taxpayer
on Form 8879).

None, if taxpayers enter their PINs on the EF
InfoWorksheet. Otherwise, complete Form
8879, but do not file it. Instead, retain the
form for three years from the Return Due
Date or IRS Received Date, whichever is
later.

One of themost common e-file rejections involves a disagreement between the prior year AGI amounts on file with the
IRS and the amounts entered by taxpayers using the Self-Select PIN method. Although Practitioner PIN requires you to
complete Form 8879, this form is not filed. Consequently, we recommend the Practitioner PIN method as themore
reliable method.

Determining Prior Year AGI (Self-Select PINmethod)
When taxpayers sign their electronic tax returns using the Self-Select PIN method, you need to include their prior year
adjusted gross income (AGI) amounts, so the IRS can validate the taxpayers' identities.

For this purpose, the prior year AGI is considered the AGI on the taxpayer’s originally filed prior-year return as the IRS
accepted it.

l Do not factor in math error corrections by the IRS or adjustments reflected in amended returns.
l Negative amounts are valid when the prior-year AGI (as defined above) is a negative number.
l If the prior-year return was filed as Married filing jointly (MFJ) with the same spouse, enter the same prior-year total
AGI for each taxpayer. Do not divide the amount between the taxpayers.

l If the prior-year return was filed as MFJ with a different spouse, enter the prior year total AGI from the joint return
filed with the ex-spouse.

l A zero amount is valid when the taxpayer’s prior-year AGI is zero, when the taxpayer did not file a prior-year return,
and when the prior-year return was filed after December 9. If you e-file a return using the Self-Select PIN method and
the prior-year AGI does not match the IRS Master file, the IRS will reject the return, citing the FD0679 or FD0680
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error code. If taxpayers are unsure of their original prior-year AGI amounts, have them contact the IRS Customer
Service department at (800) 829-1040. To avoid possible errors due tomismatched AGI, use the Practitioner PIN
signaturemethod instead.

Resources for E-filing
IRS Resources
The IRS issues various form instructions, notices, and publications that contain requirements for filing individual and
business tax returns electronically. We recommend that you review the following resources before you begin e-filing:

l IRS and state instructions for 1040 forms
l IRS and state instructions for 1065 forms
l IRS and state instructions for 1120, 1120-F and 1120S forms
l IRS and state instructions for 990, 990-EZ, 990-PF and 1120-POL forms
l IRS and state instructions for 940, 941, and 944 forms
l Information for IRS e-file providers: enter https://www.irs.gov/tax-professionals/e-services-online-tools-for-
tax-professionals in your Internet browser.

l Publication 1345, Handbook for Authorized IRS e-file Providers of Individual Income Tax Returns
l Publication 4163, Modernized e-File (MeF) Information for Authorized IRS e-file Providers for Business Returns

Government Forms and Instructions

To download IRS form instructions, notices, and publications, enter www.irs.gov/formspubs/index.html into your Internet
browser.

Wolters Kluwer, CCHSmall Firm Services
Additional resources are available on theMyATX Solution Center site:

To access the site, go to www.MyATX.com.

Revenue Procedure/Technical E-file Publications
To download the revenue procedure and e-file specific publications, visit www.irs.gov/Tax-Professionals/e-File-
Providers-&amp;-Partners/IRS-e-file-Technical-Publications.

Modernized E-file
Modernized E-file (MeF) employs a standard XML format, which enables you to attach various required statements and other
supporting documentation to the return. This ability is fully supported by your tax software. See PDF Attachments.

To determine whether youmust e-file your business returns or for more information about MeF, visit the IRS Web site
by entering www.irs.gov into your Internet browser.

E-file Statuses
This table defines the terms that can appear in the Status column of the E-file Manager.
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Status Description

Created

The e-file has been created and the return is ready to be transmitted to the e-file server, or
EFC.

If youmake any changes to the return after this point, youmust re-create the e-file.

Held Indicates you havemarked this return Held to prevent it from being transmitted until later.

Duplicated
A return with this SSN/EIN was previously transmitted to the agency. For duplicate SSNs,
youmust contact the agency to resolve the issue.

Transmitted to EFC
The return has been successfully transmitted to our Electronic Filing Center (EFC). Its
status on our server does not allow it to be retransmitted.

Transmitted to Agency We have transmitted this return to the appropriate tax agency.

Rejected

Changes weremade to the return after creating the e-file but before transmitting it to the
EFC. Youmay have added or removed forms, printed cycling forms (estimated vouchers,
etc.), or edited and saved the return in another way. To ensure the e-file reflects the current
return, youmust re-create the e-file before transmitting it.

Rejected by EFC
The return did not pass our validation process and has not been transmitted to the IRS or
state. See Correcting E-file Rejection Errors.

Rejected by Agency
The e-file was successfully transmitted to and received by the IRS or state, but it contained
errors. See Correcting E-file Rejection Errors for instructions on correcting the errors.

Accepted
Return was successfully transmitted to and received by the IRS or state. It has now been
processed and validated. This is the final status for most e-files.

Receive Acks
Return was imported or restored from a backup and the e-file status was not accepted;
consequently, you need to Receive Acks to receive themost current e-file status from the
EFC. See Receiving Acknowledgements.

Accepted with Messages
The return was successfully transmitted to and received by the agency. However, the
agency has also transmitted one or moremessages with the acceptance. See Displaying
E-file Rejection Errors or Messages.

Avoiding Common E-file Rejection Errors
There are several things you can do to avoid e-filing rejection errors:

Update Tax Program and Forms Frequently
Frequent updates will help prevent IRS rejections. See Updating ATX.

Internet Connectivity and Software Accessibility
Themost important e-filing prerequisite is the ability to transmit your data via an Internet connection. In regard to your
connection, there are a few things you should keep inmind order to avoid e-filing problems:
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l Connection speed – We recommend using a broadband connection, such as DSL or cable. In most cases, dial-up
is too slow to handle the size of the e-filed return.

l Connection type – You can have either a direct connection or a portal connection to the Internet. A direct Internet
connection is one in which your computer uses the standard TCP/IP Protocol to communicate with other computers
and access Internet services, such as e-mail, Telnet, or FTP. While connected via TCP/IP, you can check your e-
mail, for example, with any e-mail program you choose. Your Internet service provider (ISP) does not require you to
use its program to access e-mail or other Internet services.

l Firewalls - A firewall prevents unauthorized access to and from a network or a stand-alone computer. A firewall can
be a physical device (hardware), a program (software), or both. Tomake sure you have a good connection between
your system and the EFC, you'll have to set some parameters in your firewall software.

Creating E-files
After completing the return, we recommend running the Checking Returns for Errors function and correcting e-file errors.

If a required form is missing from the return, the application automatically adds it when you create the e-file.

To create e-files:

Before creating an e-file, make sure that the EFIN used on the EF Info form has been entered in the Preparer/ERO
Manager. See Entering an ERO EFIN.

1. Open the return to be e-filed.
2. Do one of the following:

l Click the E-file button on the toolbar.
l Click the E-file menu; then, select Create E-file.

The Create E-file dialog box displays messages relating to the e-file jurisdictions available to create. See the
Create E-file Dialog Box topic for an explanation of themessages.

3. Follow themessage directions in the dialog box to add required forms.

Once you've corrected themessage(s), the check box for that return type will become enabled.

4. Select the check boxes for the return type you want to e-file.
5. Click Create.
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The E-file Creation Results Dialog Box shows you whether or not your e-file(s) were successfully created, and
whether or not you need to correct errors or review warnings before officially transmitting the e-file.

6. Click OK.

The Diagnostics pane appears below the forms. To successfully create an e-file, youmust fix any errors. Errors
appear in red, warnings in orange, and informational messages in blue.

7. In the Diagnostics pane, click an error or warning.

The selection is highlighted in blue. In the open form area above the Diagnostics pane, the system jumps to the
corresponding field in the form:

8. When your errors are corrected, click the Re-Create E-file(s) button.
9. If you receivemore errors, repeat the correction process until your e-file is successfully created.

If youmake changes to a return after the e-file was created, youmust re-create the e-file before transmitting.

Create E-file Dialog Box
The Create E-file dialog box allows you to select the returns (state and/or Federal) that you want to e-file. It has built-in IRS
business knowledge that gives you an error, warning, or informational message whenmissing data or forms in the returnmay
prevent you from e-filing.

The Create button only becomes enabled when you resolve these e-file related errors.
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Create E-file Messages

The followingmessages may appear when you create e-files:

Create E-file Messages Message Description

There are required forms missing from
your return

Click the left arrow to reveal the name of themissing form. Click the Add
required forms link to add the required forms to the return. The required
form tabs will appear at the top of the page.

Some forms in your return have not been
approved for e-filing

Displays if forms associated with the return are not yet approved for e-filing.
Click the arrow to the left of themessage to show the form. (You cannot
correct this until the form becomes available.)

Form X is required but has some errors
or warnings of its own

Displays if a State e-file you're trying to produce requires you to select the
Federal also, but you can’t select the associated Federal e-file because it
has an error. To correct the error, youmust first resolve the problem(s) listed
under the Federal option.

At least one of the following e-file types is
required to select this e-file...

Displays if a State e-file requires you to select the Federal also, but you don’t
have the appropriate Federal forms in your return. A list of appropriate e-file
types would be displayed. To correct the error, add one of the forms to your
return.

Form X is required to e-file Form Y and
will be selected automatically

Indicates that certain forms are prerequisites for other forms. The system
will automatically select prerequisite forms if they are available.
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E-file Creation Results Dialog Box

Holding/Releasing State E-files
By default, ATX will automatically hold and release state e-files for states that prefer prior Federal e-file acceptance.

To access this preference, click the Adjust state e-file settings link.

The E-file Manager Preferences tab appears. The Automatically hold and release state e-files for states that
prefer prior Federal e-file acceptance preference is enabled by default. Clear the check box to disable.

To release a held e-file from the E-file Creation Results dialog box:

Held e-files are denoted by a preceding the form name.

1. Use your cursor to hover over the red transmission icon next to the form type. The popup text indicates that the
State e-file is on hold until the Federal is accepted:

2. To release the State e-file, click .
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The notification changes to , indicating that the e-file has been released.

3. Click OK.

E-file ID
The program automatically assigns an E-file ID when a return is e-filed. It appears under the E-file ID column in the E-file
Manager.

Submission ID

A Submission ID is a 20-digit number assigned to an e-file when it is first created. It has become themost widely accepted
E-filing identifier since the inception of Modernized E-file (MeF).

The following table identifies the component parts of a sample Submission ID:

Preparer’s
EFIN (6
digits)

Processing
Year (4 digits)

Julian Day (3
digits) Unique Alphanumeric Number (7 digits)

999999 20XX 014 1a2b3c4

The Federal and State e-files will be assigned unique Submission IDs.

Some Federal and state products use neither an E-file ID nor a Submission ID. Examples include 5500, W-2, 1099, and
94X.

E-file ID Errors

The calculations used to create Submission IDs are designed to prevent duplication. However, if a duplicate Submission
ID is generated, simply re-creating the e-file will generate a new Submission ID.
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Holding/Releasing State E-files
By default, ATX holds State e-files until the corresponding Federal e-file has been accepted for states that prefer prior
Federal acceptance. With this preference enabled, held State e-files will automatically be Released (meaning,
changed to a "created" status) upon Federal acceptance. The Held status of the state return is reverted to “created,” so
that the user can select and transmit the state e-file. The software will not transmit the state e-file automatically. See
Transmitting E-files and E-file Manager Preferences.

To manually Hold or Release State e-files upon creation:

Each time e-files are created, the E-file Creation Results Dialog Box is where the process is completed.

Assuming the e-file was created successfully:

= Held

= Released

Click the notification to toggle between Held and Released.

To manually Hold or Release State e-files in a batch:

1. In the E-file Manager, mark each E-file Return to be Held or Released.

Federal and State e-files are listed separately.

2. Do one of the following:
l ToHold all marked e-files, click the E-file menu; then, select Hold Marked E-files.
l ToRelease all marked e-files, click the E-file menu; then, select Release Marked E-files.

Displaying E-file Rejection Errors or Messages
If an e-file is rejected by a taxing agency, or if a return is accepted with messages from the taxing agency, messages are
displayed in the Rejection Errors pane at the bottom of the return.

This topic provides instructions for the following e-file events:

l When E-files are Rejected
l When E-files are Accepted with Messages

When E-files are Rejected

When an e-file is rejected, you need to display and correct the errors and re-transmit the revised e-file.
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To display and/or print e-file rejection errors:

From the E-file menu, press Ctrl+R (or select Display Selected Rejection Errors).

To print the rejection errors, click Print in the Rejection Errors pane.

A list of EFC Rejection codes can be found by searching for EFC Rejection Codes in the
ATX Knowledgebase. See Correcting E-file Rejection Errors.

Fields Associated with Errors/Messages

To view fields in the return that are associated with rejection errors (or messages):

1. Click the error/message number.
2. Click the arrow next to Fields commonly associated with this error.

A list of boxes appears.

3. Click the red box. The cursor moves to the associated field (highlighted in yellow).
4. Tomove to the next field associated with that error, click the Next button at the bottom right of the Rejection Error

pane.
5. To return to the previous field associated with the error, click Previous.

When E-files are Accepted with Messages

If your e-file displays an Accepted with Messages status, follow these steps to review themessage(s):

1. Do one of the following:
l From E-file Manager, highlight the return. Then, from the E-file menu, select Display E-file Action Required.
l From the open return, select the E-file menu; then, select Display E-file Actions Required.

2. In the E-file Actions pane, click amessage number that appears under the form name.
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Themessage appears in the panel to the right.

3. If the agency specified certain fields in their message, you'll be able to view those fields. Follow the same steps
used in Fields Associated with Errors/Messages, above.

4. To print themessages, click the Print button on the Rejection Errors pane.

Common IRSRejection Codes

Error Code Error Title Error Description

F1099R-002
FormW-2/W- 2G/1099-R – Missing or
Invalid Data

If Form 1099-R has a US Address in the Payers Address,
then Statemust have a value.

F1099R-003
FormW-2/W- 2G/1099-R – Missing or
Invalid Data

If Form 1099-R has a US Address in the Payers Address,
then ZIP codemust have a value.

F1099R-004
FormW-2/W- 2G/1099-R – Missing or
Invalid Data

If Form 1099-R has a US Address in the Payers Address,
then the first five digits of the payers ZIP codemust be
within the valid ranges of ZIP codes listed for the
corresponding State Abbreviation. See Publication 4164
on the IRS web site.

IND026
Self-Select PIN Taxpayer's Prior Year
AGI Missing Data

If PIN Type Code in the Return Header has the value
"Self-Select Practitioner", and Primary Date Of Birth has
a value, then Primary Prior Year AGI or Primary Prior
Year PIN or Primary Electronic Filing PIN must have a
value.

IND-028
Self-Select PIN Spouse's Prior Year
AGI Missing Data

If PIN Type Code in the Return Header has the value
"Self-Select Practitioner", and Spouse Date Of Birth has
a value, then Spouse Prior Year AGI or Spouse Prior Year
PIN or Spouse Electronic Filing PIN must have a value.

FD0372
Form 1040/1040A – Required
Information is Missing

If Form 1040, Line 51 Child Tax Credit or Line 65
Additional Child Tax Credit has a non-zero value, then the
sum of Line 51 and Line 65 cannot exceed an amount
equal to $1000 times the number of qualifying children.

Correcting E-file Rejection Errors
After an e-file is created and transmitted to the taxing agency, or if a return is accepted with messages from the taxing
agency, there is always the possibility that it may be rejected by the agency. If one of your Federal or state e-files is rejected,
youmust correct the errors, re-create the e-file, and re-transmit it. Failure to correct all errors will cause the return to be
rejected again.

To fix e-file rejection errors, re-create the e-file and re-transmit it:

1. Select E-file Manager.
2. Select the Rejected filter check box.
3. Select the rejected return you want to correct.
4. Click the E-file menu; then, select Display Rejection Errors.
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The return opens, and the E-file Rejection Errors pane displays the errors, number of errors, and fields in which
they are located.

5. Click a specific error (in red) to navigate to the field containing the error.
6. Correct the error.

If the error is in a field on a form, the form appears and the cursor is placed in that field.

7. After you have corrected the errors, re-create the e-file. See Creating E-files.

8. Transmit the re-created e-file to the EFC. See Transmitting E-files.

If you receive an error referring to a duplicate Submission ID, simply re-create the e-file to correct the error. The
system will generate a new Submission ID. See E-file ID.

Transmitting E-files
Once you've created an e-file, you can transmit the e-file via the Internet to the Electronic Filing Center (EFC). However, the
following conditions must exist to transmit e-files:

l Youmust be connected to the Internet to transmit e-files to the EFC.
l The return(s) that you're trying to e-file cannot be open.

To transmit (or send) e-files:

Youmust have already created an e-file in order to send e-files. See Creating E-files.

1. Click the E-file Manager tab.
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Use filters to control which E-file Returns are displayed.

2. Mark the e-file(s) you want to transmit.
3. Do one of the following:

l Click the Transmit button on the toolbar.
l Click the E-file menu; then, select Transmit Marked E-files.
l Press Ctrl+T.

Open returns cannot be transmitted. Only those returns that aremarked in this dialog box will be transmitted.

If you're transmitting a 1041 Fiduciary return with a NY State Fiduciary return, both returns are selected
automatically in the Transmit Marked E-files dialog box and will be transmitted simultaneously to the IRS.
The state return is then forwarded to the New York agency.

4. Click Transmit Marked E-files.
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5. Click Close.

After transmitting e-files, Receive Acknowledgements periodically to update the e-file status to Accepted or
Rejected. If Rejected, the e-file must be re-created and re-transmitted (after correcting any errors). See Common
IRS Rejection Codes and Correcting E-file Rejection Errors. For information on known delays in Acks, check the
ATX Blog.

Rules Regarding Transmission
l Once transmitted, an e-file cannot be recalled or resubmitted, unless it is rejected.
l If you're unsure about a return, you can place it on Hold until you're ready to file it. See Holding/Releasing State E-
files.

l Once transmitted, an e-file cannot be deleted from the E-file Manager.
l If you need tomake changes to returns with a Transmitted status, wait until the return is either Accepted or
Rejected. If the return is Accepted, file an amended return. If the return is Rejected, make the changes directly to
the return, recreate the e-file and re-transmit.

Deleting E-files
You can delete e-files with Created or Rejected statuses. However, e-files that have been Transmitted or Accepted
cannot be deleted.

To delete a selected e-file:

1. Open the E-file Manager.
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2. Click the row with the e-file you want to delete.
3. Click the E-file menu; then, select Delete Selected E-file.

4. Click the Delete E-file button.

DeletingMarked E-files
To deletemultiple e-files simultaneously, the check boxes for the returns must be selected.

1. Open the E-file Manager.
2. Select the check box next to each e-file you want to delete.
3. Click the E-file menu; then, select Delete Marked E-files.

4. Click Delete Marked E-files.

Creating State E-files
Many states employ a procedure in which the State e-file piggybacks on the Federal e-file. If this option is available for your
state, you will transmit both the Federal and State returns to the IRS. After the IRS has accepted and processed the Federal
e-file, the state e-file is forwarded to the appropriate state-taxing agency.

To create linked, unlinked, or direct state e-files:

1. Open the return.
2. Click the E-file button on the toolbar.
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3. Select the Federal check box and the check box for the state with which you want to file the return.

If you have errors, you will need to resolve them before you can create the e-file. Refer to the Create E-file
Dialog Box topic for specifics on e-file errors.

4. Resolve any errors that stand in the way of filing a state return.
5. Select the state jurisdiction for which you want to create an e-file.
6. If you selected a state that offers multiple types of State e-files, select the type of State e-file you want to create.
7. Click Create.

The E-file Creation Results Dialog Box appears.

8. Click OK.
9. If unsuccessful, make the necessary corrections; then, repeat the e-file creation process.

Managing Acknowledgements (Acks)
When the IRS receives an e-file, it acknowledges receipt of the e-file by sending an acknowledgement, or Ack, to the EFC,
which processes the Acks andmakes them available in the program.

Each time you transmit a return or request acknowledgements, the program automatically updates the status for all your e-
filed returns. If the IRS or a state rejects one of your returns, review and correct the errors, re-create the e-file, and then
transmit the return again.

After you transmit the e-file, you shouldmake it a best practice to Receive Acknowledgements periodically until you
get a positive acknowledgement that the return is accepted. If you don't periodically receive Acks, youmay miss an
important acknowledgement that requires a swift response (e.g. a reject). For information on any known delays in
Acks, check the ATX Blog.

Ack Timeliness
ATX tracks all e-files transmitted to the various IRS service centers and direct states. We ensure you receive Acks from
these agencies in a timely manner. IRS and direct state acknowledgements generally take 24 to 48 hours from the time of
transmission.

If returns are pending for more than 24 hours, we'll contact the appropriate IRS service center or state agency directly to
quickly resolve any issues that may be causing a delay and will tell you when to expect acknowledgements.
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If significant processing delays are encountered by a state or the IRS, information will be posted to the ATX support site.

State E-file Acks
If you have state returns pending for more than 5 days, we'll contact the appropriate state agency to quickly resolve any
issues and provide you with up-to-date information about when you should expect to receive your acknowledgements.

When we request a re-hang of acknowledgements from the IRS or state agencies, we expect to receive the
acknowledgements the same day. However, when there are additional problems requiring us to retransmit a batch of returns,
we expect to receive the acknowledgements the next day.

Acknowledgement History
Each time you transmit a return or request acknowledgements, the program automatically updates the status for all your e-file
returns.

You can view the Acknowledgement History of one or more e-files from either the E-file Manager or from the open return.

To review Ack histories for returns:

From the E-file Manager, do one of the following:

l Select (highlight) a return; then, click the E-file menu and select Display Selected E-file Acknowledgement
History.

l Mark (check) one or more returns; then, click the E-file menu and select Display Marked E-file Acknowledgement
Histories.
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Receiving Acknowledgements
Acknowledgements that your e-files have been received, approved, or rejected are not automatically sent to ATX users from
the taxing agencies. After you transmit your e-file(s), youmust do one of the following to get Acks from agencies:

l Transmit other e-files (see Transmitting E-files).
l Run the Receive Acknowledgements process, detailed below.

To Receive Acknowledgements:

1. Open E-file Manager.
2. Click Receive Acknowledgements.

4. Click Close.

Extensions, Estimated Payments, and Payments
The program allows you to create extensions and estimated payments as allowed by the taxing agency. If they are present in
a return, each of these items appear as a separate item in the Create E-file Dialog Box.

The following is a list of extensions, estimates and payments that are separate from the return's e-file:

Type Form Number/Title

Federal Extensions

l Form 4868, Individual Automatic Extension of Time To File
l Form 2350, Application for Extension of Time to File for US
Taxpayers Abroad

l Form 7004, Automatic Extension for Certain Business
Income/Information/Other

l Form 8868, pages 1&2, Application Extension for Exempt
Organizations & Additional Extension

State Extensions

Individual:

l AZ 204-E
l DC FR-127
l LA R-2868
l MAM-4868
l MD 502E
l NJ 630-V
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Type Form Number/Title

l NY IT-370
l NYC-EXT
l NYC-EXT (Spouse)

Business:

l FL F-7004
l IL 505-B
l LA CIFT-620EXT
l MA 355-7004
l MAM-8736
l MD 500E
l MD 510E
l NJ PART-200-T
l NY IT-370-PF
l NY CT-5
l NY CT-5.3
l NY CT-5.9
l NY CT-5.9E
l NYC-EXT.1
l PA REV-853R
l TX 05-164

State Estimated Payments/Other Payments

l FL F-1120ES
l KS K-120ES
l MD 500D
l MD 502D
l MD 510E
l NY IT-204-LL
l NY CT-400
l NY NYC-400
l NY NYC-5UB
l NY NYC-5UBTI
l NY NYC-5UBTI (Sp)
l UT TC-547
l WI 1-ES

Formore information, refer to the E-file Availability page on the Support site.

For the small number of states that allow them, the system also allows you to create and submit payments after the
return is e-filed.
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To create and e-file an extension, estimated payment, or payment:

1. Start the application.
2. In Return Manager, click the New button.

The Select Forms Dialog Box appears.

3. In the Find field, enter your search criteria, such as extension, estimated, or payment.
4. Press Enter.

A list of forms appear.

5. Highlight the desired form and press Enter.
6. Complete the form.
7. To name the extension, estimated payment, or payment, click Save.

The Return Name dialog box appears.

8. Enter a name for this extension, estimated payment, or payment; then, click Save.
9. Click the E-file button.

The following screen capture is an example of an estimated payment:

10. Follow themessage directions in the dialog box to add required forms; or, resolve any other problems indicated by
themessage.
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When every problem is resolved, the corresponding check box is enabled.

11. Select the check box for the item for which you want to create the e-file.
12. Click Create.

If your e-file is not created due to errors, you'll see the followingmessage:

13. If your e-file has errors:
l Open each error in the Check Return pane and correct it.
l After you've corrected each error, click the Re-Create E-file(s) button.

14. Repeat this until your Federal Extension e-file is created successfully.

15. Click OK.
16. To view the e-file, click E-file Manager.

17. Select the check box beside the item you want to e-file.
18. Click the Transmit button on the toolbar.

19. Click Transmit Marked E-files.
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20. Click Close.
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Tax Prep Utilities
ATX offers several planning and comparison utilities that may be used individually or in any combination. This section
discusses each of these utilities in more detail.

l Tax Summary/Carryover Worksheet
l Last Year Comparison
l Tax Planner
l Married Joint - Separate Comparison
l U.S. Averages Comparison

Tax Summary/Carryover Worksheet
The Tax Summary/Carryover worksheet is a two-part worksheet that can be added to a return via the Forms menu.
The Tax Summary gives you an "at-a-glance" view of the Federal and State information.

A quick way to add the Tax Summary/Carryover Worksheet to a return is to click the Refund Meter.

To add a Tax Summary/Carryover Worksheet to a return:

1. Open the return.
2. Do one of the following:

l Click the Refund Meter.
l Click the Forms menu, expand the Planning/Analysis fly-out menu, and then select Tax
Summary/Carryover Worksheet.
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3. To view the Carryover Summary, click the Carryover Summary worksheet tab at the bottom of the return.

You can also add the Tax Summary/Carryover worksheet to a return via the Add Forms function. In the Find field of
the Return Manager, enter Tax Summary. Select Tax Sum for the return type (such as Tax Sum 1120), and click
Open Forms. The worksheet is added to the return.

Last Year Comparison
The Last Year Comparison worksheet is a three-part worksheet that can be added to a return via the Forms menu. The Last
Year Comparison looks at this year's and last year's income and deductions, and provides the resulting percentage change.

To use the Last Year Comparison worksheet:

1. Open the return.
2. Click the Forms menu, expand the Planning/Analysis fly-out menu. and then select Last Year Comparison.

You can also add the Last Year Comparison worksheet to a return via the Add Forms function. In the Find
field of the Select Forms Dialog Box, enter the word Comparison. Select Comparison for the return type
(such as Comparison 1120), and click Open Forms. The worksheet is added to the return.

3. In the Prior Year column, enter amounts from the client's prior year tax return. (The Current Year amounts are
from this year's forms and schedules.)

In order for the Prior Year column to contain last year's amounts, youmust have included the Comparison
worksheet in last year's return and have used the Rollover function.

4. Be sure to review all pages of the worksheet.
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Tax Planner
The Tax Planner worksheet, which is part of the Planning and Analysis function, is a three-page worksheet that can be
added to a return via the Forms menu. The Tax Planner helps you calculate an inflation-adjusted, six-year projection of your
client's tax data. You can adjust amounts to grow or decrease at rates you specify.

To use the Tax Planner worksheet:

1. Open the return.
2. Click the Forms menu, expand the Planning/Analysis fly-out menu, and then select Tax Planner.

Tax Planner instructions appear at the top of Page 1.

3. Be sure to review all pages of the worksheet.

You can also add the Tax Planner worksheet to a return via the Add Forms function. In the Find field of the
Select Forms Dialog Box, enter Tax Planner. Select the Planner for the return type (such as 1120 Planner),
and click Open Forms. The worksheet is added to the return.

To show a downward trend in earnings or expenses, enter negative numbers in the Adj % column (outlined).

Married Joint - Separate Comparison
This worksheet is only available for 1040 returns.

Use theMarried Joint - Separate Comparison worksheet to see whether amarried couple will benefit more from filing
jointly or separately.

To use the Married Joint - Separate Comparison worksheet:

1. Open your clients' return.
2. Click the Forms menu, expand the Planning/Analysis fly-out menu, and then select Married Joint/Separate

Comparison.
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3. At the top of the columns, be sure the Filing Status and Exemptions are correct.
4. Review the amounts in each of the Joint, Filer, and Spouse columns. Make adjustments, if required.
5. Scroll to the bottom of the form to see the difference betweenMarried Filing Separate andMarried Filing Jointly:

6. Click the worksheet tabs at the bottom of the return to see the source for Social Security Benefits, Capital Gains
(Schedule D), and Credits.

You can also add this worksheet to a return from the Select Forms Dialog Box. See Adding Forms to a
Return.

U.S. Averages Comparison
This worksheet is only available for 1040 returns.

The U.S. Averages Comparison worksheet is a fully-calculated worksheet whereby the income and deductions in the tax
return are compared to other returns with adjusted gross incomewithin the same range. The comparative data is reported by
the Statistics of Income Bulletin published by the IRS.

To use the U.S. Averages Comparison worksheet:

1. Open your client's return.
2. Click the Forms menu, expand the Planning/Analysis fly-out menu, and then select U.S. Averages Comparison.
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3. To adjust for inflation, click the Avg Table worksheet.

4. Enter the appropriate inflation percentage.
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Standard Client Letters
There are two types of letters that may be attached to your customers' returns: Standard Letters and Custom
Letters.

This section includes the following topics regarding Standard Letters:

l Working with the Standard Client Letter
l Add Standard Letters to All Returns
l Add a Standard Letter to an Open Return
l Modifying Standard Letters
l Delete a Standard Letter from a Return

Standard Letters
Standard letters can be added globally to all returns upon creation (via Client Communication Preferences) or
individually added to one return at a time (via the Client Communication Manager).

The settings available in Client Communication Preferences offer the following controls for the Standard Letter:

l Which Letter or combination of Letters will be automatically attached to new returns
l The ability to combine the Client and Estimate Letters
l The ability to include a Privacy Notice on Client and Estimate Letters
l The ability to combine the Federal and State/Local Letters
l The ability to determine whether Client Letters should be written as if the return 'has been e-filed' or 'will be e-
filed'

l The ability to determine desired pronoun usage (I/me versus we/us)
l The ability to determine which paragraphs should be included or excluded and the order in which the paragraphs
will appear.
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These settings are unique for each letter type (Federal Client Letter, Federal Estimate Letter, State Client
Letter, and State Estimate Letter). Settings for each letter typemust bemade individually.

Custom Letters
Custom letters are only created in the Client Communication Manager. Using a series of templates, you can create totally
unique communications that meet the specific needs of your business. Twomaster templates and one blank template provide
you greater flexibility in communicating with your customer. The available Master Templates are listed below:

l Engagement Letter
l Individual Tax Due
l Individual Refund
l Cover Sheet
l Mailing Slip
l Blank

Custom letters function like standard letters in that they pull information from the return and plug it into a letter. However,
custom letters offer youmore variables that can be used in each letter to customize the content. Full word processing
capabilities (including the ability to add a graphic signature or logo) are also available to further customize your letters.

Custom Templates may be created and saved or even imported and used whenever and however you like. The template itself
may be edited, or each individual letter may be edited tomeet your needs.

Working with the Standard Client Letter
Standard Client Letters pull specific information from the return to which they're attached and plug it into letters for the
customer. Standard letters can be automatically attached to every return upon creation or added to returns individually after
the return has been created depending on your preference.

If you choose to automatically add standard letters to returns upon creation, they will only be added to returns created
after the selection was made.

You can select one or more of the following items (Federal and/or State/Local may be selected):

l Client Letter
l Estimate Letter
l Return Cover Sheet
l Estimate Letter Cover Sheet
l ReturnMailing Slip

Client and Estimate Letters may be combined to include Federal and State/Local in one.

Add Standard Letters to All Returns
To automatically add one or more Standard Letters to all returns:

1. Do one of the following:
l From Return Manager, click the Options menu, and then select Preferences.
l From an open return, click the Tools menu, and then select Preferences.
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2. Select the Client Communication tab.
3. Under Include the following when creating a new return, select the letter(s) you want added to every return

upon creation.
4. Do one of the following:

l Click OK to apply your changes and close the dialog box.
l Click Apply to apply your changes and leave the Preferences dialog box open.

Upon creation of a new return, Standard Letter(s) will be attached per your selections.

Some information in the Standard Letter is variable, meaning values will change dynamically according to the
information entered or calculated in the return at a given time.

Add a Standard Letter to anOpen Return
Standard letters may be automatically added to returns upon creation or manually added one at a time.

To add all Client Letters to a return at once, right-click the tab for the signature form (1040, 1065, 1120, etc.) and select Add
All Client Letters. To add all State Letters, right-click the tab for the state signature form, and select Add All Client Letters.

If a client letter is already attached to the open return, Add All Client Letters will not be available.

To manually add a single Standard Letter to an open return:

1. With the return open, click the Forms menu; then, select Client Letter.

2. Under Client Letters (in the left pane), select the letter you wish to add to the open return.
3. Do one of the following:

l Click the Open button on the toolbar.
l Double-click the selected letter.
l Click the Templates menu; then, select Open.

The selected letter will then appear in themiddle pane.

4. Edit the letter as desired.
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Edits made this way will be saved globally. This means that the edited template, when added to any future
returns, will contain the changes that were saved. Thus, it is strongly recommended to only make generic edits
that are not specific to any particular taxpayer. If you would like tomake changes to letters on a per return
basis, skip steps 4 and 5 and attach the template as is. SeeModifying Standard Letters for specific
instructions on editing letters locally (per return).

5. After editing, do one of the following:
l Click the Save button on the toolbar.
l Click the Templates menu; then, select Save.
l Press Ctrl+S.

6. Do one of the following:
l Click the Attach Template button on the toolbar.
l Click the Tools menu; then, select Attach Letter(s) to Return.

7. Select the check box(es) for the Client Letter(s) and/or Template(s) you would like to attach to the open return.
8. Click Attach.

The selected Letters/Templates are attached to the open return and the Client Communication Manager regains
focus.

9. Close the Client Communication Manager when finished.

Custom Letters may also be addedmanually instead of or in addition to Standard Client Letters. See Client
Letter Templates.

Modifying Standard Letters
Standard letters can bemodified in two ways. The dynamic content of the letter may be changed via the Options Sheet and
the formatting of the letter may be edited via the Edit Formatting button.

To set the text of letters to read "has been e-filed" or "will be e-filed" for all letters and all returns, make your selection
under Other Information: in Client Communication Preferences. Selections made under Letter Options will only
affect the open return.
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To modify a standard letter via the Options Sheet:

1. From the open return, click the tab for the letter you want to modify.
2. Click the Letter Options radio button above the letter.

3. Change your selections as needed to determine the desired output.
4. To preview the results of your selections, click the Preview Letter radio button.

If you would like this worksheet to be printed whenever the client letter is printed, select the Print this
worksheet radio button. This setting applies only to the selected letter within the open return.

To edit the content of a Standard Letter:

1. From the open return, click the tab for the letter you want to modify.
2. Click the Edit Mode button on the toolbar.
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3. Use the Client Communication Manager to add or edit graphics, text, and/or variables to the letter.
4. Save the changes after editing.

Upon saving, you will be given the option to save your changes locally (changes will only be applied to the
current letter attached to the open return) or globally (changes will be applied to the letter template itself and will
be included in any future use of the letter).

5. Close the Client Communication Manager when finished.

If at any time you would like to restore any Master Template to its default state:

1. Open the desired template.
2. Do one of the following:

l Click the Restore button on the toolbar.
l Click the Tools menu; then, select Restore.
l Right-click the selected template; then, select Restore.

Delete a Standard Letter from aReturn
To delete a standard letter from a return:

1. From the open return, do one of the following:
l Right-click the Client Letter tab to be deleted.
l Open the letter to be deleted; then, click the Forms menu.

2. Select Discard Form.

3. Click Discard to confirm.

410



Chapter

14
Fixed Asset Manager
You canmanage your client's assets using the Fixed Assets Manager. ATX adds the Fixed Assets form to the return
whenever you select a new Form 4562, Depreciation and Amortization from the Add Forms dialog box. ATX
displays the Fixed Asset tab in the forms list.

If you roll a prior year return that had Fixed Assets data, asset information rolls to the current year return with
updated depreciation data.

By using the asset entry features, you can:

l Select from pre-defined asset categories and subcategories for quicker data entry.
l Link depreciation results to at least sixteen business activity forms.
l Enable an automatic calculation of prior, current, and future depreciation.
l Compare actual expenses to the standardmileage deduction for listed vehicles (individual returns only).
l Create dispositions for sales, casualties, installments, like-kind exchanges.
l Create Bulk Dispositions for the sale of multiple assets.

If you would prefer to use Form 4562 only, please refer to Entering Assets Directly on Form 4562.
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Fixed Asset Manager And Enhanced Asset
Management
Fixed Asset Manager comes with every purchase of ATX. Enhanced Asset Management functionality is available as an add-
on to your existing ATX package. If you do not have Enhanced Asset Management functionality, click the Enhanced Asset
Management Trail link to enable a 30 day free trial.

Feature Fixed Asset
Manager

Enhanced
Asset
Management

Add or Delete: Allows you to add an additional asset or delete an asset.

Duplicate: Allows you to duplicate the asset information section for an asset,
saving you data entry time. See Duplicating Assets.

Reports: Helps youmanage and track your clients’ assets using standard or
customized reports.

Fixed Asset Manager includes three basic reports on Form 4562. The Enhanced
version has expanded reporting capability. See Reports Overview.

Split: Splits an asset into multiple assets based on units, cost/basis or
percentage. See Split Assets.

Multiple Asset Account: Allows you to report a single depreciation total on
Form 4562 for a group of related assets. SeeMultiple Asset Account (Mass
Asset).

Maximize 179: A quick way to populate several current year assets with a
section 179 deduction equal to the Cost (times bus %). SeeMaximize 179.

Move: Allows you to re-assign one asset at a time or re-assignmultiple assets
to a different business activity.

Bulk Sales: Links the assets together into one sale with one sale price.

Prior Year Deduction: Allows you to accept or modify system calculated prior
depreciation for assets (including listed assets).

Classifications: Allows you to identify and characterize similar assets,
gathering them into groups, locations, or any custom classification. See
Classifications.

Summary Information: Allows you to see a summary by group (based on what
is selected in the Group by: filter on the Navigation pane), 179 limit information,
andMQ summary. See Summary Information Pane.
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Feature Fixed Asset
Manager

Enhanced
Asset
Management

Book Deprecation: Allows you to calculate book depreciation using the Book
Depreciation column on the Depreciation and Section 179 tab. You can also
run reports related to book depreciation.

Fixed Asset Manager Interface

Asset Tabs
Asset Entry tabs include:

l Asset Entry - the default tab where you can enter asset information.
l Asset Global Settings - allows you to configure and view settings for assets.
l Reports - run reports for your assets. (Only available with Enhanced Asset Management).

Panes
The left and right panes are indicated by a red circle in the image above. These panes are displayed by default. To hide a pane
for a larger viewing area, click the red circle.

The left pane allows you to search, filter, and access a list of assets in a return.

The right pane includes Classification and Summary Information for assets. (Only available with the enhanced version of
Enhanced Asset Management).

Asset Information
The starting point for entering a new asset. For more information, see the Asset Information Pane.
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Asset Entry Toolbar

Icon Item Description

Add Adds a new asset.

Delete Deletes the displayed asset.

Duplicate
Duplicates the displayed asset.

This feature is only available in Enhanced Asset Management.

Reports

Launches the Reports tab, where you can choose from standard reports or use the
Customize Report Wizard to create a custom report.

This feature is only available in Enhanced Asset Management.

Split

Launches the Split Asset dialog box, where you can split an asset into multiple assets
based on either units, cost/basis or percentage.

This feature is only available in Enhanced Asset Management.

Edit Mass Asset
Allows you to tie additional assets to a parent asset for amultiple asset account.

This feature is only available in Enhanced Asset Management.

Maximize 179

Launches theMaximize 179 dialog box for current year assets with a section 179
deduction.

This feature is only available in Enhanced Asset Management.

Move
Launches theMove Asset dialog box, where you canmove assets from one activity to
another.

Bulk Sales
Launches the Bulk Dispositions dialog box, where you are able to enter the information
for bulk sales.

Prior Deprecation
Launches the Prior Depreciation/Business Use (for Listed Assets) dialog box, where
you can enter prior year business use percentages and/or business miles for luxury autos.

Search and Filter for Assets
The navigation pane is located on the Asset Entry tab and directly to the left of the Asset Information Pane. Within the
navigation pane you can Search assets and filter the results by Group, Location, and/or Activity.
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Item Description

Takes you to the first asset in the asset list.

Takes you back one asset.

Displays the current asset number you are viewing and the total number of
assets in the asset list.

Takes you to the next asset in the asset list.

Takes you to the last asset in the asset list.

Allows you to search for a group of assets or a particular asset.

TheMore link allows you to filter your search further, using options such
as Group, Location and Activity.

Allows you to filter your search by Activity, Year Placed in Services,
Groups, or Location.

Allows you sort your assets by Description or Date Placed in Service.
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Clear Your Search
To clear your search, do one of the following:

l To clear your search information you can delete the search text from the Search box, or if using theMore search
options, click Clear.

l To clear the Grouped by box, click the drop-down list and select All.
l To clear the Sort by box, click the drop-down list and select the blank area.

Display Calculations for Asset
ATX allows you to view the calculations of any selected asset.

To view calculations:

1. From the Asset Entry tab, select an asset.
2. Click a field on the Depreciation and 179 tab.
3. Press Shift+Ctrl+F12.
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Asset Information Pane

The Asset Information Pane is the starting point for entering a new asset. Your rolled over data is automatically entered in
this section. For all new assets, complete the Asset Information Pane, and then enter at least a cost or basis on the
Depreciation and Section 179 tab. Complete the Auto/Listed and Dispositions tabs as needed.

Asset Information Pane fields:

l Item#: A unique item number for the asset (created by the user to identify the assets).
l Description: A description of the asset.
l Date in service: The date the asset was placed in service.
l Activity: Any business activity form added to the return will show in the activity list. Select from the list to assign the
asset to a business activity form. Some business activities can have several copies andmay be appended with :01,
:02 and so forth.

l Category/Sub-Category: Select from a category and subcategory to enable defaults for recovery period, method,
and convention.

l New asset: Indicates if the asset meets original use requirements for bonus depreciation.
l Balance Sheet: Sends the depreciation to the balance sheet (Schedule L) of business forms.
l IRC Section: Internal Revenue Code Section for amortized assets for page 2 of Form 4562.
l AMT Adj. Type: For amortized assets, this affects the AMT column’s recovery period.
l Bus percent: Percentage the asset was used for business use. ATX defaults this to 100%.
l Serial #: Serial number of the item, if applicable.
l Multiple Asset Account: Check to designate this asset as the parent in amultiple asset account. (This check box is
only active and available in Enhanced Asset Management.

Depreciation and Section 179 Tab
After themain asset pane has been completed, this tab allows for entry of the asset’s Cost or Basis in order to calculate the
depreciation of the asset.

To enter depreciation:

1. Enter the Cost or Basis of the asset in the Federal column. Entering the cost or basis in the Federal column also
completes the cost in the Federal AMT and State columns.

2. The Fixed Assets form calculates the following based on this entry:
l The recovery period, method, and convention for the Federal, AMT, State, and Book columns if a
category/subcategory was selected

l Any qualified Bonus depreciation
l The Recovery Basis
l Prior depreciation (if this is a prior year asset)
l Current Year depreciation
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l Accumulated depreciation
l Next year depreciation

3. Enter any other applicable information in the space provided.

The calculated entries can be changed if necessary by selecting the field and entering the changes. The text of the
overridden fields will be red. To restore the calculated field, right-click in the field and select Restore.

Auto/Listed Tab
This tab allows for the calculation of depreciation on listed property and vehicles. If you use a vehicle for business purposes,
you ordinarily can deduct vehicle expenses. You generally can use one of the two followingmethods to figure the deductible
expenses:

l Standardmileage rate
l Actual vehicle expenses

The first year you place the listed vehicle in service, the program will show the standardmileage section and the actual
section so that you can determine which is the higher deduction. The sections that display after a rollover depend on which
deduction was taken in the first year.

If the standard deduction is selected in the first year, the program will begin to compute a depreciation component attributed to
the standardmileage deduction and will switch themethod and convention to SL/FM.

Only listed vehicle types will allow use of the Auto Listed tab – for example V5, 6, 7 and 9.

Business returns such as 1120, 1120S, 1065 do not report a standardmileage deduction, so the tab is not visible for
those return types.

Based on the destination form and the sub-category of the vehicle, certain sections of this tabmay not be visible.
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EvidenceQuestions

You need to complete the evidence questions for the first vehicle. After that, ATX completes the questions for you.

Current Mileage

Enter or verify the following information for the vehicle:

l Start and End Total miles. The Endmiles will roll to the next year.
l Total miles driven.
l Business miles, commutingmiles, and other miles as applicable.

Fixed Assets uses this information to compute the business use percentage. See Prior Business Use Percents
(Listed Assets).

4562 Vehicle Questions (Section B, C)

l Section B questions need to be answered for each vehicle unless the exception in Section C applies.
l Section C questions will be completed per business activity, if applicable.

Actual Expenses

If the taxpayer does not use the standardmileage rate, they may be able to deduct actual car expenses. If they have fully
depreciated a car that is still used in the business, the taxpayer can continue to claim their other actual car expenses.
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To add other expenses click Add; then, click within the Other Expenses dialog box to add a description and amounts
for each field added.

Dispositions Tab
Fixed Assets allows you to create these disposition types from the Dispositions tab: Sale/Abandonment, Installments,
Casualty/Theft, and Like-Kind Exchanges. Select the appropriate sale type from the drop-down list. Bulk Sale treatment is
available for the sale/abandonment and install sale types.

If for some reason you need to clear all the disposition data from a particular current year disposition, return the
disposition type to “Please Select”. This will remove any manually entered information and calculated data from the
disposition tab and forms.

By default, the Dispositions tab appears as pictured below:

The calculated disposition gain/loss is linked to the appropriate form in the return such as 4797, 6252, 4684 Section B, or
8824. ATX also provides non-calculating or non-flowing disposition types: Converted to Personal Use and Do Not
Calculate Gain/Loss. These types may be used when you do not want the disposition reported in the current year tax return.

When you roll to the next year, prior year disposed assets will not be visible by default. To view (but not edit) sold
assets, select the corresponding preference from the Rollover Manager tab of the Preferences dialog box.

If Sale/Abandonment is selected as the disposition type, the Dispositions tab appears as pictured below:
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The Sale of Personal Residence check box option allows you to split a sale between business and personal
based on business use percent, Portions of the sale are sent to Form 4797 or Form 8949 where any exclusion of
gain will be calculated.

If Installment Sale is selected as the disposition type, the Dispositions tab appears as below. Please be sure to
complete the current year payments field on the Install Sale Info tab for a correct calculation on Form 6252.

If Casualty/Theft is selected as the disposition type, the Dispositions tab appears as pictured below. Be sure to
complete the Casualty/Loss Info tab because it is data required by Form 4684, Part B.
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If a Like-Kind Exchange is selected as the disposition type, the Dispositions tab appears as below. Be sure to
complete all applicable fields on the Exchange Info tab for correct computation of the Like-Kind Exchange on Form
8824. When you create a like-kind exchange, the basis of the replacement asset will automatically be added to the
asset list.

The received asset is automatically added to the asset list.

Disposition of Single Assets

Fixed Assets allows several types of dispositions. If a bulk disposition (sale of multiple assets) is available, a Bulk
Disposition check box will be present under Disposition Information. Selecting that check box will prompt you to select or
create a bulk disposition event, then assign assets by activity.

To assign the disposition of a single asset:

1. In the Navigation pane select the affected asset.
2. Click the Dispositions tab.

3. Select the desired disposition for the asset in the Type of disposition drop-down list.
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Depending on the disposition type selected, required information will vary. Be sure to enter all requested
information on each tab to ensure proper calculation and data flow.

4. Enter a date for the disposition.
5. Enter all requested information on each tab.

Bulk Dispositions

If the sale of a group of assets is to be reported on Form 4797, Sales of Business Property or Form 6252, Installment Sale
Income, use the Bulk Sales feature to link the assets together into one sale with one sale price.

The Fixed Assets form will calculate the gain/loss for a group of assets tied together in one sale using the Bulk Sales feature.
On the Fixed Assets form, there are two types of Bulk Dispositions available: Sale/Abandonment (for Form 4797) and
Installment Sales (for Form 6252).

The Bulk Sales feature can be set up or edited in two ways:

l From the Fixed Asset toolbar.
l From the Disposition tab.

Be sure to review the IRS reporting requirements and explanation of how to treat different classes of assets if grouping
assets together in a sale. (Publication 544, Sales andOther Dispositions of Assets)

Assets grouped in a bulk sale should be of the same property type. For example, all the assets are Section 1245 property
(depreciable personal property, tangible or intangible) or Section 1250 property (real property).

Bulk Disposition Setup

To add a new Bulk Disposition:

1. In the navigation pane, select one of the assets to be included in the Bulk Disposition.
2. Click the Dispositions tab and select Sale/abandonment or Installment sale from the drop-down.
3. Select the Bulk Disposition check box, and then select Add New from the drop-down list.
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4. Enter a Description for the bulk disposition.
5. Enter the Date of disposition.
6. Select the Type of disposition from the drop-down list.
7. Enter the Date placed in service.

A valid date is required for e-filing.

8. Make a selection from the drop-down list for Force 4797 section.
9. Select the Activity from the drop-down list.
10. Select the Holding period from the drop-down list.
11. Enter the Selling price of the assets in the Bulk Sale.
12. Select the Type of property from the drop-down list.
13. Enter any incurred Expense of disposition.
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Assign Assets for a Bulk Disposition
Assets must be assigned to the bulk disposition. If no assets are assigned, the bulk disposition does not calculate.

1. Click Assign or edit assets for this Bulk Disposition from the Bulk Disposition Setup dialog box.

Assets already assigned to other dispositions will not be available for assignment to the Bulk Disposition.

Only assets assigned to the same activity as the current selected asset will be available for assignment to the
Bulk Disposition.

2. Highlight the desired asset in the Available Assets list and click > tomove it to Selected Assets list or >> tomove
all assets.

To select multiple assets at once, hold the Ctrl key and select the assets with your mouse.

3. Click Done.
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4. Click OK.
5. Select the name of the bulk disposition from the Please Select drop-down list.

The details of each asset's disposition and the totals for all assets in the bulk disposition are displayed in the Bulk
Dispositions dialog box. TheGain/Loss is calculated based on the total sale.

Click the Edit button to return to the Bulk Disposition Setup dialog box if you need to edit the details of the
disposition.

6. Click Save.

Editing Existing Bulk Disposition

To edit an existing Bulk Disposition:

1. In the Navigation pane, select one of the assets that currently belongs to the Bulk Disposition to be edited.
2. From the Dispositions tab, select the bulk disposition from the drop-down list, and then click View Bulk

Disposition.
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3. Click the Edit button on the toolbar.

4. Edit the details of the selected Bulk Disposition as desired.
5. Click OK to save your changes or click Cancel to exit without saving.
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Deleting Existing Bulk Disposition

To delete an existing bulk disposition:

1. In the Navigation pane, select one of the assets belonging to the desired Bulk Disposition.
2. From the Dispositions tab, select the bulk disposition from the drop-down list, and then click View Bulk

Disposition.

3. Click the Delete button on the toolbar.

4. Click Yes to delete or click No to cancel the operation and return to the Bulk Dispositions dialog box.

For any bulk disposition that includes the sale of a personal residence, the Sale of Principal Residence Input tab on
Form 8949 must also be completed.
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Asset History Tab
This feature is available in Enhanced Asset Management.

The Asset History tab displays the history and projection of the asset by the different depreciation treatments starting with
the first year placed in service through the last depreciable year. Each depreciation treatment is listed on a tab on the left.

Entering a New Asset
Fixed Assets calculates prior, current, and future depreciation for each depreciable or amortizable asset. This enables you to
have all of the client's asset information at your fingertips.

To add an asset:

1. From an open return, do one of the following:
l From the toolbar click Add Form, and add Form 4562, Depreciation and Amortization. ATX loads the Fixed
Assets in the Forms tab.

l Jump from a form field. Select Form 4562, Depreciation and Amortization, or the Fixed Asset Form. ATX loads
the Fixed Assets in the Forms tab.

2. To complete the Asset Information, enter the following information:
l A unique item number: This can be a number or combination of numbers and letters created by the user.
l A description of the asset. Required field inorder to save the asset.
l The date placed in service. Required field inorder to save the asset.
l Select the business activity from the Activity drop-down list to assign the asset. If you have only one business
activity it will already be selected by default.
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l Select a Category and Sub-category from the drop-downmenu. Selecting a Category and Sub-category will
automatically populate Method, Recovery, and Convention. You can leave these blank or override with
manual entries.

l Select No from the New asset drop-down list if the asset does not meet the original use requirement.
l Select the IRC section if applicable for amortized assets. (ATX defaults to the correct code if you chose the
category and subcategory)

l Select the AMT adjustment type for amortized assets, if applicable.
l Review the percentage of business use and adjust as necessary. If this is a listed vehicle, complete the
Auto/Listed tab to calculate the business use.

3. Click the tab related to the type of entry you aremaking and enter the pertinent information regarding the asset.
l Depreciation and Section 179 Tab
l Auto/Listed Tab
l Dispositions Tab
l Asset History Tab

To add additional assets, click the Add button on the Asset Entry toolbar.

Duplicating Assets
This feature is available in Enhanced Asset Management.

This feature allows you to duplicate assets in the event your client purchases multiple assets that are the same. After you
enter one asset, duplicating it will save you time entering the remaining assets. For example, if your client purchases 5
computers for their office, you can enter the asset information for one computer and duplicate the asset information for the
remaining computers.

The Item number and Serial number will not be included in the duplication.

To duplicate an asset, use the following steps:

1. Select the asset in the Navigation Pane.
2. Do one of the following:
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l Click the Asset menu and select Duplicate.
l Click the Duplicate button on the toolbar.

3. Enter the number of copies of the asset you will need.
4. Select the appropriate check box(es) indicating the tabs you want to include in the duplication.
5. Click Duplicate.

Move Assets
ATX allows you tomove a single asset or multiple assets at the same time.

Move an Asset
To move assets one at a time:

1. From the asset list, select the specific asset.
2. Click on the Activity list drop-down on the Asset Information Pane.

3. Select the desired business activity from the drop-down to link to the desired business activity.
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ATX only displays available forms within the return. Make sure you add the appropriate form to link the asset to
before you try to move the asset.

MoveMultiple Assets

Themove assets feature allows you tomove assets from one activity to another.

This feature is helpful if you havemultiple assets where the activity needs to be changed.

To move assets in bulk:

1. Click theMove button on the Asset toolbar.

2. Select an activity in the From: drop-down box. ATX displays all linked assets.
3. Select an activity in the To: drop-down box. ATX displays all available asset forms in the return.
4. Select the Assets in the Assets for box.
5. Use the arrows located in themiddle of the dialog box tomove the asset(s) from one pane to the other. Do one of

the following:
l Click the > button tomove the selected asset from the Assets for pane.
l Click the < button tomove the selected asset from theMove to pane.
l Click the >> button tomove all assets from the Assets for pane.
l Click the << button tomove all assets from theMove to pane.

6. Click Move.
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Split Assets
This feature is available in Enhanced Asset Management.

Use this feature to split an asset into multiple assets based on units, cost/basis or percentage. ATX creates new assets
based on the information you enter in the Split Asset dialog box andmodifies the original asset's information as required by
the split.

The split icon will be grayed out whenever the feature is not available. For example, you cannot split a disposed asset.

To split an asset:

1. From the asset list, select the specific asset.
2. Click the Split button on the toolbar.

By default, the asset will be split into two (2) assets.

3. If you need to split the asset into more than 2, enter the number in the Split into field.
4. To change the split calculation, click in the field you wish to change and enter the Item #, Description, Cost or

other Basis, or Allocated Percent.
5. Click Split.

Multiple Asset Account (Mass Asset)
This feature is available in Enhanced Asset Management.

A multiple asset account is made up of a group of assets that are similar. One depreciation total is sent to Form 4562 for the
entire group of assets. You can add to or remove assets from the group. The basis of the entire group will recalculate based
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on the individual assets (called units) in the group. To activate amultiple asset account, check the box that appears in the
Asset Information pane. TheMultiple Asset Account check box will not be active until certain minimal information has been
entered for that asset.

The asset with this check box selected becomes themain asset under which units reside.

To add a multiple asset account, use the following steps:

1. Complete all fields to activate theMultiple Asset Account check box.
2. Select theMultiple Asset Account check box.

3. Enter the number of units that need to be included in themultiple asset account.

In this dialog, the description and units are the only editable fields. Any other changes should bemade in the
asset information.
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Edit Units

1. Click the View/Edit Units link to make any changes to the cost and/or allocated percent of the units.

2. Tomake changes to the information in the grid, click in the field you wish to change and enter the information. You
are able to edit the Item #, Description, Cost or other Basis, or Allocate Percent fields.

3. If an asset needs to be removed from themultiple asset account, select the check box in the Remove Units
column next to the asset.

Select the check box next to the Remove Unit header to select all assets.

4. Click Save.
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Edit Mass Asset

Once amultiple asset account has been setup, use the following steps to view and/or edit themass asset.

1. Click theMass Asset icon on the toolbar.

2. From theMultiple Asset Account Setup you canmake your changes to themultiple asset account. See Edit
Units.

3. Click Save.

436



Chapter 14: Fixed Asset Manager

Maximize 179
This feature is available in Enhanced Asset Management.

TheMaximize 179 feature is a quick way to populate several current year assets with a section 179 deduction equal to the
Cost (times bus %). Certain options are provided to control the order in which the 179 deduction is applied to possibly provide
a tax advantage. The program will remember the options you selected on a client by client basis. If no options are selected,
the system will apply the section 179 deduction up to the Cost limit based on the asset list order. Some options will be
checked by default when you open the program.

Remember that available 179 deductions can be limited by business income that will be calculated only in the tax
return, so further edits may be needed in the tax return environment.

Features of theMaximize 179 Dialog

l TheMaximize 179 button allows you to populate all of the assets seen in the dialog's list with section 179 at the
same time.

l TheOptions button allows you to set preferences for the order in which the section 179 deduction is applied.
l The Clear All button removes all of the section 179 deduction entries.
l The asset list includes only current year assets that qualify for a section 179 deduction.
l You can sort the list by any column in the dialog.
l TheMax button on each asset allows you to set themaximum 179 deduction just for that asset.
l Cost/Basis Grand Total shows you the overall cost of the qualifying assets. If the cost threshold is exceeded, the
program calculates the reduced dollar limit.

l MQ summary shows the current-year asset total basis by quarter for mid-quarter determination.

Options/Calculation Options

Calculation Options help determine the calculations used for Section 179 amounts.

l If Mid-Quarter, apply to MQ4 first.
l In the determination of whether mid-quarter conventionmust be used, cost amounts expensed under Code Sec.
179 are disregarded (Reg. §1.168(d)-1(b)(4)). By applying section 179 to the assets that would otherwise need to
useMQ4 convention, you are reducing the basis of those assets to 0.

You can launch theMid-Quarter (MQ) Summary from the bottom right corner of theMaximize 179 dialog.
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l Apply to longer recovery periods first.

Assets with a shorter life aremore likely to be kept in service for the entire recovery period so deductions can
be recovered through normal depreciation.

l Apply from smallest to greatest cost.
l Apply from greatest to smallest cost.

These options are simply user preference:

l Exclude listed autos with limits....(V-5, V-7, A-19, A-21)

A section 179 deduction will not be applied to these asset types if either of these options is checked, but the
cost will still be considered in the cost limitation calculation because they qualify for a Section 179 deduction.

Maximum Amount of Section 179 to a Single Asset
To assign the maximum amount of Section 179 to a single asset, use the following steps:

1. Right-click in any field on the Depreciation and Section 179 tab, and select Maximize Section 179. The Section
179 field is automatically populated with themaximum allowed amount.

2. Click theMaximize Section 179 menu.
3. The program will insert themaximum section 179 amount for the individual asset.
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Multiple Assets with Section 179
To assign the maximum amount of Section 179 to multiple assets, use the following steps:

1. Click theMaximize 179 icon on the toolbar.

2. Click Maximize All on the toolbar. ATX sets the Federal Election column, calculations for all assets listed.

Clear All Section 179 Deduction Amounts
To clear all Section 179 Deduction amounts:

1. Click theMaximize 179 icon on the toolbar.

439



Chapter 14: Fixed Asset Manager

2. Click Clear All on the toolbar. ATX sets the Federal Election column to zero, clearing the Section 179 calculations
for all assets listed.

The current year 179 deductionmay be further limited by business income. To see the business income
calculation in the return, open Form 4562 and select the 179 Worksheet from the Pages and
Worksheets tab.

MQ Summary

To view your Mid Quarter Summary for an asset, click theMQ Summary button from theMaximize 179 dialog box. This
information is for display only. Click Close to close out of theMQ Summary.
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Classifications
This feature is available in Enhanced Asset Management.

Asset classifications identify and characterize similar assets, gathering them into groups, locations, or any custom
classification.

The Classifications pane (in Fixed Asset Manager) allows you to assign the Asset Classifications that you have already set
up to the new and/or existing assets in the tax return.

To rollover asset classifications from Fixed Asset Manager:

You can rollover Group, Location, or Custom classifications from Fixed Asset Manager 2016 into ATX and into your Form
4562:

1. In Rollover Manager, under Other Data, select the Asset Classifications check box. (The number of asset
classifications should appear in parentheses.)

2. Click the Rollover icon.

To verify, open a Form 4562 in any return. The Classifications pane should contain any Group, Location, or custom
classifications that you created in Fixed Asset Manager 2016.

Global vs. Local Classifications
By default, any asset classifications you create are saved locally to the computer where they are created.

Tomake classifications globally available to all ATX users on a network, select the Save Globally check box on the Asset
Classification dialog box.

Custom Classification
To add a custom asset classification:

1. From an open return with the Fixed Assets tab open, click the (Edit) button in the Classifications pane.
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2. Click New and enter the name of the Classification.
3. Once you have completed entering all your classifications, click Save.

When you add a new asset classification, the classification remains specific to the local user and is not seen
globally (by other users) unless you select the Save Globally button in the Classifications pane.

Add Items to a Classification
To add items to a classification:

1. From an open return with the Fixed Assets tab open, click the (Edit) button in the Classifications pane.
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2. Select classification in the Classification column.
3. Click New in the Items column and enter the name of the item.
4. Once you have completed entering all your items for each Classification, click Save.
5. Click Save at the bottom of the dialog box.

Assigning Classifications to Assets
To assign classifications to an asset:

1. Open the asset.
2. In the Classifications pane, click the drop-down for Groups, Locations or Custom Class.
3. Select the item you want to assign.

Delete Classifications and Items
To delete a classification or item from a classification:

1. In the Classification column, select the classification, or item you wish to delete.
2. Click the red x, to delete the items or custom classification.

The default classifications Groups or Locations can not be deleted. Deleting a custom classification deletes
all items within the custom classification.
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Summary Information Pane
This feature is available in Enhanced Asset Management.

The Summary Information pane allows you to see a summary by group (based on what is selected in the Group by: filter on
the Navigation pane), 179 limit information, andMQ summary.

When you click on an asset assigned to a certain business activity, the fist tab gives you the following information:

l The number of assets assigned to that activity.
l The cost or basis for the activity.
l The total depreciation for the activity.
l Section 179 deductions elected for that activity.

The 179 (All) tab reports on all of the section 179 for all business activities and reports any excess taken.

TheMQ tab calculates the basis of assets placed in service each quarter for mid-quarter convention determination.

Asset Global Settings
The Fixed Assets form allows you to configure certain settings to be persistent for all the assets in the return on the Asset
Global Settings tab.

Any changes made in the Asset Global Settings tab will only be applied to the return you are working in, with one
exception: any changemade to Section 179 limits will apply to all future returns.
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Input Defaults
The Input Defaults tab (under Asset Global Settings) allows you to setup defaults on a client by client basis.

Display

Select the check box to disable the automatic prompt regarding prior year business % when entering prior year listed assets.

Calculations

Default Book to Federal Treatment- select the check box to have book depreciation default to Federal treatment.

Select the check box to suppress the calculation of state depreciation (for example if the state is a non-tax state). Themid-
quarter convention box is non-editable and will be checked if mid-quarter convention applies.

MACRS Federal Elections

The Federal Section 179 dollar limit and cost threshold: Program updates will automatically keep these limits
current with Federal legislation but you can override the system defaults on a per return basis as desired.

MACRS Elections for 150%, SL or ADS: Select from one of these elections per recovery period or class to default all
new assets with the selectedmethod.

Prior Business Use Percents (Listed Assets)

When directly entering a prior year listed vehicle or other listed property such as a computer, you will be prompted to enter
prior year business use percentages. This allows the program to accurately calculate prior year depreciation and arrive at the
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correct remaining basis for the listed asset. If the asset is rolled, this dialog will automatically be completed.

To launch the full version of this dialog, click the Prior Depreciation icon on the Fixed Assets toolbar.

To turn this prompt off, select the Don't prompt me to enter prior year business % for prior year listed assets
check box located on the Input Defaults tab in the Asset Global Settings.

Entering Business Miles History
Clicking the Enter business miles link from the Prior Depreciation/Business Use dialog box displays the Business
Mileage History dialog box. The Business Mileage History dialog box carries mileage information entered on the
Auto/Listed tab to this dialog. This information is retained for rollover, or you can directly enter historical mileage by year.
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Bonus Elections
ATX inserts a Special Allowance Deduction on the Depreciation and Section 179 Tab for any class of asset to which
bonus depreciation applies currently, or did apply in prior years. You can use Bonus Elections to override the default setting
by electing out.

A formal elect out statement for the IRS is only required if you are opting out of bonus depreciation for the current year.

If an election statement is required, ATX adds the election statement for you.

Check selections in the Bonus Elections tab to indicate an election out of bonus depreciation for any year and class of
property for which the election was made. This allows ATX to remove the default Special Allowance Deduction from
qualifying assets.

If you need to override the system defaults to either force bonus election or remove the election for individual
assets:

1. Click the Asset Entry tab.
2. Click the Depreciation and Section 179 Tab.
3. From theQualified Special Allowance drop-down list, click Custom.
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To make bonus elections:

1. Select Bonus Elections under the Asset Global Settings tab.
2. Select eachMACRS Class that you wish to elect out of for bonus depreciation for each year.

To elect out of all the classes, click the Elect All button located at the bottom of each column.

3. Click OK.

State Calcs Tab
State Calcs can be found under the Asset Global Settings tab. If youmake changes to the Section 179 Defaults or State
Bonus Defaults in either location, it will modify the calculations for all clients using that state.

Within the State Calcs tab, there are tabs for 1040, 1041, 1065, 1120, 1120S, and 990 entity types. Each tab contains
information about the selected state’s compliance with sections 168(k) and 1400L as well as other pertinent information
regarding state 179 limits, or whether or not additional Go Zone or disaster area Section 179 is allowable. Information is preset
for each state and will be updated to reflect changes in future years.

Program updates will automatically keep the state Section 179 limits and Bonus defaults up to date with current
legislation. You can override the state Section 179 limits if needed.
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State 179 Defaults

1. Select the year for which you wish tomodify the section 179 limitations from the drop-down list.
2. Select the appropriate check box for additional GO Zone Section 179 or additional disaster area Section 179 if they

are allowed for the state.
3. If the state has a section 179 limit other than the program default limit, enter the correct amount in the State 179

Limit field.
4. If the state has a threshold other than the program default, enter the correct amount in the State threshold field.

State Bonus Defaults

This section is for display purposes only. Changes made to this section do not affect your assets.

Tax Year Information
Tax Year Information can be found under the Asset Global Settings tab. Tax year and short year information is used to
determine what year of the recovery period a particular asset is in.

The Tax Year Information Table on the Tax Year Information tab will be visible for any return type that supports a short
year.

If you are creating a new business return, Fixed Assets will try to set up your short year based on the begin and end dates
entered on amain form such as the 1120, 1120S, 1065, 990, or 1041.

Whether starting a new business return or rolling a prior year return, review the Tax Year Information Table tomake sure it
accurately represents short, fiscal, or calendar years since these determine depreciation calculations.

Prior Year Short
To establish a short year for a new return:

1. Click the Asset Global Settings tab.
2. Click the Tax Year Information tab, and click Prior Short Years.
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3. Enter prior short year information.

Up to three prior short years may be entered.

4. Click Save to complete the process.

Tax Year Information

Tax Year Information can be found under the Asset Global Settings tab. Tax year and short year information is used to
determine what year of the recovery period a particular asset is in.

The Tax Year Information Table on the Tax Year Information tab will be visible for any return type that supports a short
year.

If you are creating a new business return, Fixed Assets will try to set up your short year based on the begin and end dates
entered on amain form such as the 1120, 1120S, 1065, 990, or 1041.

Whether starting a new business return or rolling a prior year return, review the Tax Year Information Table tomake sure it
accurately represents short, fiscal, or calendar years since these determine depreciation calculations.
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Prior Year Short

To establish a short year for a new return:

1. Click the Asset Global Settings tab.
2. Click the Tax Year Information tab, and click Prior Short Years.

3. Enter prior short year information.

Up to three prior short years may be entered.

4. Click Save to complete the process.

Reports Overview
This feature is available in Enhanced Asset Management.

Enhanced Asset Management provides a variety of reports to help youmanage and track your clients’ assets. Using the
Reports features, you can choose from the Standard Reports list or create Custom Reports. 
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If you receive themessage "An additional component (Crystal Reports) is required to use this feature", click the Install
Crystal Reports link located in the report viewing area. When the installation completes, the Reports List displays all
available reports.

Edit Mode for Reports
When you view a report, ATX displays the report in Edit Mode by default. The Edit Mode allows you to edit an existing report
and edit your Print Setup.

Edit Mode Toolbar

Toolbar Button Description

Column Options : Gives you the option to add and/or remove columns, create
new columns, select which columns should be shown, etc.

Sorting Options: Gives you the option to set up how the report is sorted.

Grouping Options: Gives you the option to set up how the report is grouped.

Filtering Options: Gives you the option to set up how the report is filtered.
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ColumnOptions

The Show these types of fields drop-downmenu allows you to select the type of fields you wish to choose from for your
report. The default is ALL, but you have the option to select Common, General Asset Info, Depreciation and Section
179, Auto/Listed, and Dispositions and Bulk Dispositions.

After selecting the type of fields, do the following:

1. Select each column and use the arrow keys located in themiddle of the dialog tomove the desired columns to the
Selected Columns pane.

To create a custom field, click the Create Custom Field button. See the Create Custom Calculation section
for more information.

2. To change the position in which a column appears, highlight the column in the Selected Columns pane, and click
the arrow located on the right of the dialog tomove the column up or down to the desired position in the report.

3. To edit an existing custom calculation, click the Edit button for the custom calculation.
4. Select the check box in the Calculate Column Total to have the report calculate the total for that column.
5. The print width of the report depends on whether you have the Paper Orientation set to Landscape or Portrait.

The progress bar will indicate how much space is remaining. If needed, you can change the font size of the report.

The Show check box is selected by default when creating a custom report. If for some reason you do not want the
column to show in the report you can deselect the check box.

Sorting Options

You have the option to set up how the report is sorted. You are able to set the column name and whether you want the column
to sort ascending or descending. The buttons on the right side of the dialog allow you to add, delete and set the sort type.

To create a custom sort for your report, click under each column heading to display the drop-down list andmake your
selections. When you are finished, click Save.
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Button Description

Moves the selected row up in the list.

Moves the selected row down in the list.

Adds an additional row for sorting your information.

Removes the selected row.

Changes the Sort Type column to sort in ascending order for the selected row.

Changes the Sort Type column to sort in descending order for the selected row.

GroupingOptions

Allows you to group items together by column name. The buttons on the right side of the dialog allow you to add and/or delete
the grouping.

To create a custom group for your report, click under Column Name to display the drop-down list andmake your selection.
When you are finished, click Save.
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Button Description

Moves the selected row up in the list.

Moves the selected row down in the list.

Adds an additional row.

Removes the selected row.

Filtering Options

Allows you to filter columns by adding conditional filters. You need to select the condition, column name, operation and enter
a value if necessary. The buttons on the right side of the dialog allow you to add and/or delete the filtering.

To create a custom filter for your report, click under each column heading to display the drop-down list andmake your
selections. When you are finished, click Save.

455



Chapter 14: Fixed Asset Manager

Button Description

Moves the selected row up in the list.

Moves the selected row down in the list.

Adds an additional row.

Removes the selected row.

Print Setup
Allows you change the paper orientation or font size for the report.

PreviewMode for Reports
When viewing the report in Preview Mode you will see the report as it will print.
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PreviewMode Toolbar

Toolbar Button Description

The Refresh icon will refresh the information in a report. This is
useful if you have gone back and added or removed an asset
while the report is open.

The Zoom icon increases or decreases the size of the report
displayed on screen, depending on the choice youmake.

The left facing arrow with a line will take you back to the first
page of amulti-page report.

The left facing arrow will take you back one page in amulti-page
report.

The right facing arrow will take you forward one page in amulti-
page report.

The right facing arrow with a line will take you to the last page in
amulti-page report.

The jump to page field allows you to select the page number you
want to view from the drop-down list.

The Search icon allows you to search the report.

The Print Report icon allows you to print the report to the printer
of your choice.

The Export Report icon allows you to save the report as a PDF.

If you have PaperlessPLUS installed on your computer, you
have the option to send your reports directly to PaperlessPLUS
to be stored.

Standard Reports
This feature is available in Enhanced Asset Management.

There aremultiple standard reports available in the Enhanced Asset Management feature. The standard reports are grouped
by the tax treatment.

To view a report, use the following steps:

1. From the Fixed Assets tab, click the Reports tab.
2. The list of Federal reports will automatically be expanded when you open the Reports tab. If you want to view any

other type of tax treatment report, click on the treatment and the list will expand.
3. Double-click the report you wish to view.
4. By default, the report opens in the Edit Mode for Reports.
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Custom Reports
This feature is available in Enhanced Asset Management.

The Custom Reports Wizard allows you to create reports that meet a variety of needs. In addition, you canmodify the
standard reports to accommodate any reporting needs that you have.

Custom reports from 2016 can be rolled from the Rollover Manager. Click the Rollover Manager tab and select the
Custom Reports check box in the Other Data section.

To create a custom report, use the following steps:

1. Click the Reports tab within an open return.
2. Click the Custom Reports Wizard link.

Enhanced Asset Management displays the New Report dialog:

3. Enter the name of the report.
4. If you wish to use one of the reports provided or one of your custom reports as a template, select the report from the

drop-down list.
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5. Complete the Columns, Sorting, Grouping, and/or Filtering tabs. The options on these tabs are explained below.
6. After saving the report, it will be saved under Custom Reports for use in the future.

The Custom Reports functionality in ATX does not include the following fields/functions: book or ACE
depreciation, multi-state reporting, calculation periods, GL accounts, cents, journal entries, and period detail.

Columns

The Show these types of fields drop-downmenu allows you to select the type of fields you wish to choose from for your
report. The default is ALL, but you have the option to select Common, General Asset Info, Depreciation and Section
179, Auto/Listed, and Dispositions and Bulk Dispositions.

After selecting the type of fields, do the following:

1. Select each column and use the arrow keys located in themiddle of the dialog tomove the desired columns to the
Selected Columns pane.

To create a custom field, click the Create Custom Field button. See the Create Custom Calculation section
for more information.

2. To change the position in which a column appears, highlight the column in the Selected Columns pane, and click
the arrow located on the right of the dialog tomove the column up or down to the desired position in the report.

3. Select the check box in the Calculate Column Total to have the report calculate the total for that column.
4. The print width of the report depends on whether you have the Paper Orientation set to Landscape or Portrait.

The progress bar will indicate how much space is remaining. If needed, you can change the font size of the report.

The Show check box is selected by default when creating a custom report. If for some reason you do not want
the column to show in the report you, can de-select the check box.

Sorting

On the Sorting tab you have the option to set up how the custom report is sorted. You are able to set the column name and
whether you want the column to sort ascending or descending. The buttons on the right side of the dialog allow you to add,
delete and set the sort type.

Grouping

TheGrouping tab allows you to group items together by column name. The buttons on the right side of the dialog allow you
to add, and/or delete the grouping.

Filtering

The Filtering tab allows you to filter columns by adding conditional filters. You need to select the condition, column name,
operation, and enter a value if necessary. The buttons on the right side of the dialog allow you to add and/or delete the
filtering.

Create Custom Calculation

A custom formula can be created between two or more numerically based fields and saved as a custom column.
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To create a custom field to be used in reports, use the following steps:

1. Click the Create Custom Calculation button located on the New Report dialog.

When you select from the Field Name list, only select fields that are numerical. Non-numerical fields do not
calculate. Example: if you add Description as part of your custom calculation ATX does not perform the
calculation. However, if you select Federal Cost or Basis - Federal Sec. 179, ATX performs the custom
calculation.

2. Double click to Select Field names that are numerically based to put into the custom formula. The fields selected
will move into the operation window. Select an operator (i.e. /,*,-,+) in between the fields to create the formula.

3. Enter a description.
4. Modify the length of the column as needed.
5. Click Create.
6. Your custom column appears in the Column Options dialog as one of the columns in the report.

To modify an existing custom formula:

1. From an open report, select the Column Options button in Edit mode.
2. On the right side of the dialog, locate and click on the special custom column you created.

3. Click the Edit button .

The custom formula created earlier can be seen and edited on the Create Custom Calculation dialog as needed.
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Printing an Asset
To print a single asset within ATX:

1. From the Asset Entry tab select the asset from the list.
2. On the ATX toolbar, click Page.

3. Select the check box next to the items you want to print.
4. Click Print.

The printer that appears by default is the printer that you've selected as the default on your computer system.
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5. Click OK to print the asset. See Setting Global Print Options.

Entering Assets Directly on Form 4562
You can enter asset and depreciation information directly on Form 4562 and file it electronically.

If you use another depreciation program, we recommend that you generate a report from the program that groups
acquisitions by type, class life, and depreciationmethod.

To enter depreciation data directly on Form 4562:

1. AT the top of Form 4562, click the Discard Fixed Assets for Direct Input button.

2. Click Discard.

When you use the direct input method for Form 4562, the program discards the Fixed Assets form and
maintains no historical information for assets.
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3. Follow the instructions at the top of Form 4562.

Form 4562 Pages andWorksheets
Although the program completes most of Form 4562 automatically, be sure to review the following form pages and enter any
additional data in the blue input fields on each page:

l Form 4562, Page 1
l Form 4562, Page 2
l 179 Bus Inc Limit
l 179 Summary

If your client has section 179 carryover from a prior year, or adjustments to business income that are not reflected on
the activity schedules in the return, youmay need tomake entries on the Form 4562 worksheets.
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The following table lists and describes the tabs included in Form 4562. The reports can be printed with the return by selecting
the appropriate options on the Print Options tab of Form 4562.

Tab Description

Form 4562, Pages 1 and 2
If the Asset Entry form is used, Pages 1 and 2 of Form 4562 derive information from
the Input and Vehicle Info worksheets.

179 Summary
If more than one of the return's business activities elects Section 179, this sheet will
be populated with the summary totals on lines 1-13.

Print Options Allows you tomodify the selections to override the program defaults for printing.

Part 1 Summary
Calculates the business income for section 179 limitation. In most cases there is
little to nomodification needed.

179 Worksheet
Shows the allocation of Section 179 between business activities and any carryover
amount. Can bemodified if you want to change the allocation percentages.

179 Statement Reports the Section 179 deduction elected per activity.

Use of Vehicles Reports vehicle data from Part V, Section B on Form 4562.

4562 Statement
Reports detail of assets reported on Form 4562, in reconciliation format. Not printed
by default.

Section 280F Recapture

Reports amounts recaptured as income from the Asset Entry Input sheet if an
acceleratedmethod/convention was used, if Section 179 or Bonus was taken in the
prior year, and if the business use percent drops below 51% in the current year. The
amount recaptured is sent to the appropriate line of Form 4797 as well as to the
business activity form to which the asset is assigned.

Tax Classification Report
Similar to the 4562 Statement, but compiled by asset classification and without a
reconciliation.

Detail Report
Customizable report providing the ability to sort assets and to show and hide
columns.

Customizable Report
Provides information for states that do not use Federal Form 4562 and require a
separate depreciation schedule.

Viewing Calculated Depreciation on Form 4562
At any time during data entry, you can view the assets and their corresponding depreciation on Form 4562.

To view calculated depreciation on Form 4562 (after entering assets on the Asset Entry form):

1. Click the 4562 tab.

2. Use the toolbar at the top left of the 4562 to view more than one activity.

A separate 4562 is created for each activity.

3. Select from the Treatment Type list to view AMT and State depreciation results.
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Print
The Print feature in ATX lets you be in control of printing your clients’ returns.

l Set global print options. Select a default printer, paper size, print orientation (Portrait or Landscape).
l Set print specs for a particular copy type (Filing, Client, Preparer, Custom) on the Print Return Dialog
Box. These selections aremade per return.

l Print Packets. To set print specs per copy type to be applied to every return printed, use the Print Packets
feature. If desired, these specs can still be changed per return in the Print Return Dialog Box.

l Preview what you're printing. Preview the pages you selected in the open return.
l Print the entire return, or just a selection. Print all forms, schedules, and worksheets associated with a
return, or only the ones you select.

l Print to paper or to electronic file. Print to a traditional printer or to PDF or XPS outputs (if these printers are
set up on your computer).

l Print Reports. Print a list of errors, overrides and estimates associated with the open return.

Print Preferences

Print Preferences offer several settings that enable you to fine tune your control over what is printed and how it is
printed.

Default Print Orders

All Federal forms appear in the print list in the order defined by the IRS. The pages that you need for filing are
automatically selected. To print other pages, select them from the Print Return Dialog Box. If desired, the print order
may be changed via the Editing Print Packets feature.
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Print Packets
A Print Packet is a group of forms to be printed by copy type. ATX™ 2017 provides four print packets: Filing Copy, Preparer
Copy, Client Copy, and Custom Copy. Each packet can be customized and customizations can be saved. The Custom
Copy packet allows users to fully customize one packet.

To access the Print Packets dialog box, do one of the following:

l From the Return Manager, click the Returns menu; then, select Print Packets.
l From an open return, open the Print Return Dialog Box by clicking the Returns menu and selecting Print Return.
From the Print Return Dialog Box, click the Print Packets link (bottom right of dialog box).

To edit Print Packets:

Print Packets settings for each copy type will be used as the default settings for each copy type when printing a return.
If you are printing an open return, these settings may be changed in the Print Return Dialog Box without affecting Print
Packets settings. See Printing Returns.

1. Select the desired package in the Package drop-down list (default is Individual).
2. Select which print packet you wish to edit in the Print Packet drop-down list (default is Filing Copy).
3. Select which printer to use as default (for each copy type) under Default Printer.
4. Select the Upload to Client Portal check box for a particular copy type if you want that copy type to always be

uploaded to Client Portal.

By default, your computer's default printer will be selected. This can be changed for any or all copy types
desired.

5. Select the number of copies you wish to print (for the specified copy type) in the Number of Copies drop-down list
(default is 1).
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6. Select Watermark and enter the desired text to print a custom watermark on all forms (default watermark is
CLIENT COPY).

TheWatermark feature is disabled for Filing Copy.

Watermarks will not be printed on client documents such as billing invoice and client letter.

7. Under This Print Packet, select which forms to show (default is ALL).

To search for a particular form by name, enter the form name in the Search by form name box. Results will be
narrowed by the text entered and each header label that contains forms that correspond with the criteria
entered will be expanded to show the forms matching the entered criteria.

8. To expand all header labels, click the Expand All link. Conversely, to collapse all header labels, click the Collapse
All link.

To expand individual header labels, click the to the immediate left of the desired label.

9. When the header label(s) are expanded, the setting for each listed form is shown underWhen to Print. To change
the setting, select the desired form and then select the desired setting in the drop-down list. Available selections
are Default, Always, and Never.

These settings are specific to each copy type.

10. Do one of the following:
l Click Save and Close to save settings and close the Print Packets dialog box.
l Click Save to save settings and leave the Print Packets dialog box open.
l Click Cancel to abort.

The Save and Close and Save buttons will remain unavailable until changes aremade.

To change the print order for the selected copy type:

By default, forms will print in the order shown in the Print Packets dialog box. Only forms used in the return will be
printed.

1. Expand the desired header label and select the form you wish to reorder.

Header labels may also be reordered by selecting the desired header label rather than expanding it.

2. Do one of the following:
l Click the appropriate arrow button tomove the form up or down in the print order.
l Right-click the selected form (or header label) and select Move up, Move down, Move to top, or Move to
bottom.

l Use the appropriate shortcut key combination tomove the form to the desired location.

See the table below for clarification on buttons, functions, and shortcut keys.

3. Repeat as necessary for each form (or header label) and each copy type.
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Button Function/Right-click Selection Shortcut Keys

Move to top Ctrl+Shift+Up

Move up Ctrl+Up

Move down Ctrl+Down

Move to bottom Ctrl+Shift+Down

To reset print packets to program defaults, do one of the following:

l Click Reset Current to reset the current selected Print Packet to default settings.
l Click Reset All to reset all Print Packets to default settings.

To import custom print packet settings from another user:

1. Select a user from the Choose a user drop-down list.

The Choose a User drop-down list only contains users who have customized print packet settings.

2. Click Import.

When you click Import, ATX overwrites the current settings.

3. Click Save and Close.

ATX does not save the imported packet until you click Save or Save and Close. If you do not wish to save the
imported print packet, click Cancel.

Setting Global Print Options
Basic print options can be set up on the Print Setup dialog box. Basic options include:

l Changing the printer
l Changing paper size, source, and orientation for all printed output

Printer Selection
The default printer will be the printer selected as your default for your workstation.

To change the default printer:

1. From either an open return or from the Return Manager, click the Returns menu; then, select Change Printer.
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The printer that appears by default is the printer that you've selected as the default on your computer.

2. Under the Printer section, in the Name field, click the drop-down arrow and select another printer.
3. Click OK to save your printer settings.

Paper Size (Letter, Legal, etc.)
The default paper size is Letter. To change the paper size, make sure that the corresponding paper is loaded in the
selected printer.

To change the paper size:

1. In the Print Setup dialog box, click the drop-down.
2. Select a new paper size.
3. Click OK.

Paper Source (Tray 1, Tray 2, etc.)
Youmay need to specify a particular source tray for your printed output.

The default paper source is Automatically Select.

To change the paper source:

1. On the Print Setup dialog box, in the Source field, click the drop-down arrow.
2. Select the new source.
3. Click OK.
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Print Orientation (Portrait or Landscape)
The default print orientation is Portrait.

To change the orientation of all printed output:

1. In the Print Setup dialog box, click the Portrait or Landscape radio button, as desired.
2. Click OK to save this global print change.

Printing Returns
The Print feature discussed in this topic only pertains to an open return.

If you want to print multiple returns simultaneously, see Batch Printing Returns.

Print functionality in ATX gives you the following options:

l Print Filing, Client, Preparer, and/or Custom copies
l Print the current return to a traditional printer
l Print the current return as a PDF
l Print only specific forms or documents within the return
l Upload the return to Client Portal
l Print the return to PaperlessPLUS (if you have PaperlessPLUS installed on the same computer as ATX)
l Use both sides of your paper for printing (Duplex)
l Use standard or customWatermarks
l Any combination of the above

Duplex Printing andWatermarks are not available for the Filing copy.

To print a copy of the open return:

If a required form is missing from the return, the application automatically adds it when you print the return.

1. From an open return, do one of the following:
l Click the Print button on the toolbar.
l Click the Returns menu; then, select Print Return.
l Press Ctrl+P.
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If you have edited and saved Print Packets for the selected copy type, the default print selections and print
order in the Print Return Dialog Box will reflect your Print Packets settings. Print selections/order may be
changed within the Print Return Dialog Box (for the current open return) without affecting your Print Packets
settings.

Steps 2 through 10 must be completed for each copy type desired.

2. If you would like to print a hard copy of the open return, select the Print to Printer check box.
3. To select a printer other than the default printer, select the desired printer in the drop-down list under the Print to

Printer check box.

In order for a printer to be listed, it must be installed on the computer from which you are working.

4. If you would like to print the open return to PDF, select the Print to PDF check box.
5. If you would like to upload the open return to Client Portal, select the Upload to Client Portal check box.
6. Select Duplex to print on both sides of your printer paper (if the form permits and your printer is capable of Duplex

Printing).

The Duplex option is not available for the Filing copy.

7. If you would like to print the open return to PaperlessPLUS, select the Print to PaperlessPLUS check box.

If you do not have PaperlessPLUS installed on the same computer as ATX, you will not see this option.
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8. If you would like to print more than one copy of the open return, select the desired number of copies in the Copies:
drop-down list.

9. To designate a custom watermark, select theWatermark check box; then, enter the desired watermark text in the
field provided.

TheWatermark option is not available for the Filing copy.

If you have set up watermarks for any copy type(s) in the Print Packets dialog box, the Print Return Dialog
Box will reflect those settings and/or text. You can change the selection and/or text in the Print Return Dialog
Box without affecting your Print Packets settings.

10. Select which form(s) you would like to print by selecting the corresponding check box(es) in the tree.

Exactly which forms print by default for each copy typemay be edited globally via the Print Packets dialog
box.

Select the Check All check box to select all forms. Otherwise, expand and select Documents, Forms,
Statements, andWorksheets as desired.

Click Expand All to expand all nodes or click Collapse All to collapse all nodes.

11. Repeat steps 2 through 10 for any other copy type(s) desired by clicking the corresponding tab(s) andmaking the
desired selection(s).

12. To save your print choices, select the Remember selections check box.

The Remember selections setting is only applied to the current open return. Use the Print Packets feature to
make global selections. Global selections will be applied to every return you print.

13. Click Print Preview to see what will be printed before actually printing the return.

Print Preview will show the selected tab only. For example, if the Preparer tab is selected, the Preparer
copy will be shownwhen you click Print Preview.

14. Click Print.

By default, none of the print options are selected. The Print button will remain disabled until at least one print
option has been selected.

The Print Progress dialog box appears, followed by the Print Results dialog box.

15. If there are any issues reported in the Print Results dialog box, make any necessary corrections, then try again.
16. Click Close.

Printing the Return as a PDF File
If you select Print to PDF in the Print Return Dialog Box, the return will be saved as a PDF file which can be easily stored
electronically. If Print to PDF is your only selection, there will be no paper output.

To print the return to PDF:

1. Complete steps 1 and 2 above.
2. Select the Print to PDF check box (either instead of or in addition to any other selections).
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3. Select the desired form(s) in the tree.
4. Click Print.

A Save As window opens to your C:/Documents folder. The name of the return appears in the File name field.
The Save as type field is set to PDF files (*.pdf).

5. Navigate to the location where you want to store the PDF copy of the return.
6. Click Save.

If you print all copy types in a single print job to PDF, they will all be printed to one file. To distinguish between
copy types within a single PDF file, we suggest that you use Print Separators. See Print Preferences. As
an alternative, you could apply a distinctive watermark to each copy type. See Print Packets.

Printing the Current PageOnly
To print only the current page of the open return:

Click the Page button on theOpen Return toolbar.

The page will be printed to the default printer designated for the computer from which you are printing.

Print Return Dialog Box

Print Return dialog box
section Print Return dialog box item Description

Copy Types (tabs) Filing, Client, Preparer, Custom
Click the tab that corresponds to the desired copy
type to see printing options for that type. See
Print Packets.
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Print Return dialog box
section Print Return dialog box item Description

Forms Tree Client Documents/Federal/State

Displays an expandable list of items that may be
printed. Select the forms to be included.
Selections must bemade for each copy type
selected.

Check all
Check this box if you want to print all items listed
in the tree.

Collapse All
Click this to reduce the expanded tree view to
only its top level nodes (not showing individual
items).

Expand All
Click this to expand all nodes of the tree (show all
individual items).

Print Settings Print to Printer Print to selected printer.

Print to PDF
Prints the open return to a PDF file to be stored on
your computer.

Upload to Client Portal
Uploads return to Client Portal. See CCH iFirm
Client Portal.

Print to PaperlessPLUS

Prints the return to PaperlessPLUS.

If you do not have PaperlessPLUS installed,
this item will not be available.

Duplex

Use both sides of printer paper for printing.

This feature is only available for Client,
Preparer, and Custom copies. Scannable
state forms will not print in duplex. If your
printer is incapable of Duplex Printing, only
one side of printer paper will be used.

Copies Select the number of copies you want to print.

Watermark

Select theWatermark check box, then enter the
desired watermark text in the field provided.

Watermark functionality is only available for
Client, Preparer, and Custom copy types.

Print Preview
Allows you to preview what the return will look like
when printed.

Remember selections
Remembers print order and print settings for the
open return only.
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Print Return dialog box
section Print Return dialog box item Description

Help
Opens Help specific to the Print Return dialog
box.

Print Preferences
Opens the Print Preferences of the
Preferences dialog box.

Print Packets Opens the Print Packets dialog box.

Restore

Restores all Print Return dialog box settings to
default.

If there are any Print Packets settings, they
will be considered default.

Print Prints the open return based on your settings.

Cancel
Closes the Print Return dialog box and cancels
the print job.

All Print Settings must bemade for each copy type to be included in the print job.

Batch Printing Returns
As an alternative to printing individual returns, multiple returns may bemarked and batch printed.

When you use the Batch Print Marked Returns function, all copies will be sent to your default printer. To change your
default printer, click the Printer Setup link in the Returns Marked for Printing dialog box. If you use a PDF Printer as
default, your copies will be sent to the location selected in the Browse For Folder dialog box upon clicking Print.

To batch print returns:

1. In the Return Manager, select the check boxes for the returns you want to print.
2. Do one of the following:

l Click the Returns menu; then, select Batch Print Marked Returns.
l Press Ctrl+P.
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If you're working on a network and a return in the batch is open on another workstation, that return will appear in
the list but will not be printed. The Details columnwill indicate that it is Open and the workstation ID will be
displayed.

3. Clear the check box for any returns you would not like to include in the batch.
4. Click Batch Print Marked Returns to continue.

To check your selected Print Preferences, click the Adjust print settings link.

To change your default printer, click Printer Setup.

5. Under Printing Order, select the order by which you want to print the returns.
6. Under the Copies to print section, select one or more copy types to print for all the returns.

See Setting Global Print Options.

7. Click Print.

Printing Checks
Checks are printed via a web-basedOnline Check Printing center that is part of the CCH SFSWeb site. When you go to print
checks from the product, you are sent to the login page for the Online Check Printing Center.

Any check with the status of Authorized can be printed. A check is authorized if it has an Authorization number on the Bank
Products tab in the Bank Manager.

Youmust be authorized to useOnline Check Printing. If you are not authorized to useOnline Check Printing, please
contact your sales representative.

Internet Explorer is the only supported browser for Online Check Printing. ATX automatically launches Internet Explorer
regardless of your default browser.
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To print checks:

Youmust be connected to the Internet to print checks.

1. Do one of the following:
l Go to https://ocp.cchsfs.com.
l From the Bank Manager, click the Print Checks button.
l From the Bank Manager, click the Disbursements menu; then, select Print Checks.
l Press Ctrl+H.

The Client Login screen appears.

2. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
3. Enter your User Name in the User Name box and press the Tab key.
4. Enter your Password in the Password box.
5. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
6. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
7. Click Log In.

8. For step-by-step instructions on check printing, click the Help tab on the left of the page. (This opens Online
Check Printing help.)

9. Review theOverview and Print Checks topics.

Configuring Printer for Check Printing
The Check Printer Setup feature enables you to select and set up a specific printer to be used when printing checks. The
program stores and applies these settings separately from those used when printing returns and reports, and it will remember
the paper location, paper size, and orientation settings.

Internet Explorer is the only supported browser for Online Check Printing. ATX automatically launches Internet Explorer
regardless of your default browser.

To set up your check printer and align checks:

1. Visit https://ocp.cchsfs.com.
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The Client Login screen appears.

2. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
3. Enter your User Name in the User Name box and press the Tab key.
4. Enter your Password in the Password box.
5. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
6. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
7. Click Log In.

8. For step-by-step instructions on check printing, click the Help tab on the left of the page. (This opens Online
Check Printing help.)

9. Review theOverview and Configure Printer topics.

Reprinting Checks
Typically, preparers reprint checks only if a check becomes damaged or did not print correctly in the first place. In general,
you only reprint in a situation where you have possession of the original check.

In this scenario, you can reprint the check, write "Void" on the original check, and return the voided check to the bank.

Reprinting a check is different from reissuing a check. A typical "reissue" scenario is where the taxpayer's check was
lost or stolen. In this situation, the preparer does not have possession of the check. Contact the bank for specific
instructions on reissuing a check.

Internet Explorer is the only supported browser for Online Check Printing. ATX automatically launches Internet Explorer
regardless of your default browser.

To reprint a check:

Be sure to write VOID on the original check and forward it to the bank. Internet Explorer is required for Online Check
Printing.

1. Do one of the following:
l From the Bank Manager, click the Print Checks button.
l From the Bank Manager, click the Disbursements menu; then, select Print Checks.
l Press Ctrl+H.
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You can also visit https://ocp.cchsfs.com.

The Client Login screen appears.

2. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
3. Enter your User Name in the User Name box and press the Tab key.
4. Enter your Password in the Password box.
5. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
6. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
7. Click Log In.

TheOnline Check Printing page appears.

8. Select Reprint Check from themenu on the left side of the screen.

9. For step-by-step instructions on check printing, click the Help tab on the left of the page. (This opens Online
Check Printing help.)

10. Review the Reprint Check/Search for Check topic.

Aligning Checks
To align checks properly in the printer:

1. Visit: https://ocp.cchsfs.com.

The Client Login screen appears.

2. If you are not logged in, enter our Client ID in the Client ID box and press the Tab key
3. Enter your User Name in the User Name box and press the Tab key.
4. Enter your Password in the Password box.
5. Select the Remember me check box if you want the Solution Center to remember your information the next time

you log in.
6. Select the I'm not a robot check box and select the images based on the instructions shown on-screen, then click

the Verify button.
7. Click Log In.
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8. For step-by-step instructions on aligning checks properly in the printer, click the Help tab on the left of the page.
(This opens Online Check Printing help.)

9. From the Help Table of contents, select the Configure Printer topic, and refer to Adjusting the Starting Print
Position.

Printing Reports
ATX provides the following reports on your open return:

l Error Report - lists errors, warnings, information, and e-filing issues for the open return
l Override & Estimate Report - lists all overridden and estimated fields in the return
l Notes Report - lists fields in the return to which notes are attached

To print any of these reports:

1. From the open return, click the Print button on the toolbar.

480



Chapter 15: Print

2. In the tree, select the check box(es) for the reports you'd like to generate for the open return.
3. Click Print.

Print Preview
The Print Preview function will preview the portions of the return you've selected in the Print Return Dialog Box.

To see a preview of the pages you've selected to print:

1. From the open return, click the Print button on the toolbar.

The Print Return Dialog Box appears.

2. Once you're satisfied with your selections, click the Print Preview link.

In the Print Preview, pages will appear in the order in which they are listed in the tree. To change the order of
forms for the open return only, see the Reordering Print Sheets in a Return topic. To change the order of
forms for all returns, see Print Packets.

3. Use the arrow buttons at the top of the screen to scroll through the selection.
4. Click the Printer button to print the preview.
5. Click Close to close the Preview dialog box and return to the Print Return Dialog Box.

Reordering Print Sheets in a Return
All Federal forms appear in the tree in the order defined by the IRS. The pages that you need for filing are automatically
selected. To print other pages, select them from the Print Return Dialog Box.
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You can change the order in which selected forms are printed. You can reorder the top level items (Client Documents,
Federal Forms, Federal Statements, etc.) or you can reorder the items within each top-level item.

Print sheets reordered in the Print Return Dialog Box will only apply to the current open return. To reorder print sheets
for every return you print, use Print Packets.

To reorder items in the printed output:

From an open return, click the Print toolbar button; then, do one of the following:

l Right-click the desired item, then click a selection from the context menu (move up, move down, move to top, move
to bottom).

l Select the item and use the keyboard shortcuts below tomove the item.

Keyboard Shortcuts

Shortcut Description

Ctrl+Up Moves the item up in the list.

Ctrl+Down Moves the item down in the list.

Ctrl+Shift+Up Moves the item to the top of list.

Ctrl+Shift+Down Moves the item to the bottom of the list.

Printed Mailing Slip Orientation
TheMailing Slip Orientation section of Print Preferences enables you to designate themailing slip print orientation as
Portrait or Landscape.

To set the orientation of your mailing slips:

1. Do one of the following:
l From the Return Manager or E-file Manager, click the Preferences button on the toolbar.
l From the Return Manager or E-file Manager, click the Options menu; then, select Preferences.
l From an open return, click the Tools menu; then, select Preferences.

The Preferences dialog box appears.

2. Select the Print tab.
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3. Use the scroll bar on the right and scroll down to theMailing Slip Orientation section.
4. Do one or both of the following as desired:

l Portrait is the default orientation. Select Landscape to change your mailing slip orientation.
l Left is the default alignment. Select Center to change the alignment.

5. Do one of the following:
l Click OK to save your changes and close the Preferences dialog box.
l Click Apply to save your changes and leave the Preferences dialog box open.
l Click Cancel to exit without saving your changes.

Printing Marked Client List
A Client List may be printed whenever you need it with just a few clicks. The Client List lists your clients' pertinent
information including Name or Company Name, Return Type, Address, Telephone Number, e-Mail, andmore.

To print the Marked Client List:

1. Mark the returns for the clients' whose information you wish to appear in the Client List.

Click Mark All on the toolbar to mark all returns and include all clients.

2. From the Return Manager, click the Reports menu; then, select Print Marked Client List.
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3. Clear the check box for any returns you do not want to include in the batch.
4. Click Continue when ready to proceed.

To change your default printer, click Printer Setup.

5. Adjust Orientation, Options, and Sorting Order settings as desired.
6. Click Print.

Printing Marked Client Labels
To print client address labels:

1. In Return Manager, mark the returns of clients for whom you would like to print labels, or click Mark All on the
toolbar to mark all returns.

2. Click the Reports menu; then, select Print Marked Client Labels.
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3. Set the desired Font, Font Size, Margins, Style (Bold, Italic, or neither), Copies, and Sorting Order.
4. Insert labels into your printer.
5. Click Print.

Before printing on actual labels, it is recommended you print the labels on a blank sheet of paper, and then
compare the alignment with your label stock.

Labels print on standard 8.5 inch x 11 inch (3 across, 10 down, 1" x 2.63") sheets. The following
brands/products are compatible:
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CCH iFirm
CCH iFirm is a cloud-based solution that simplifies and automates the running of your accounting firm. By completing
the following setup, you'll enjoy increased visibility across workflow, resources and performance, ultimately freeing your
firm up to spendmore time adding value to your clients.

CCH iFirm Setup:

l Sign In To CCH iFirm: Opens the line of communication between the CCH iFirm and ATX applications and
enables data to be shared.

l Export Existing Contacts to CCH iFirm: Allows you to export contact information from ATX returns to CCH
iFirm, so you don't have to set up contact data twice.

l Setup Jobs for Job Status: Open the line of communication for jobs status and job details by assigning tax
return types to a job type in CCH iFirm.

How to Topics:

l Sign In To CCH iFirm
l Export Existing Contacts to CCH iFirm
l Import CCH iFirm Contact Data into a New Return
l Sync New ATX Contacts with CCH iFirm
l Sync Contact Data on Open and Close
l View CCH iFirm Job Status in Return Manager
l View Job Details
l Send CCH iFirm Invoice
l Tracking Time in ATX

Sign In To CCH iFirm
The CCH iFirm preference section on the Return Manager Preferences tab, opens the line of communication
between the CCH iFirm and ATX applications and enables data to be shared.

To set up ATX to share data with CCH iFirm, do the following:

1. Click the Preferences button on the toolbar; then, click the Return Manager Preferences tab.
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2. In the CCH iFirm section enter your CCH iFirmWebsite Address; then, press Enter or Tab off the box to enable
the Sign Into iFirm button.

3. Click Sign Into iFirm. The Sign in with iFirm dialog box displays.

4. Enter your username and password; then, click Login. The Sign in with iFirm dialog box displays an
acknowledgement asking if you want to allow access to CCH iFirm from ATX.
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5. Click Yes to allow your CCH iFirm user account to sync with ATX.

6. Click Apply to save the change; then, OK to close the Preferences dialog box.

CCH iFirm Menu
From the Return Manager or an open return, you can access the CCH iFirm menu.

Menu Item Description

My Dashboard
Launches your CCH iFirm dashboard, which is an overview of your business’ efficiency,
annual review, resource allocation, work in progress, andmore.

My Jobs Launches your CCH iFirm jobs, where you can view jobs in CCH iFirm.

My Invoice Launches your CCH iFirm invoices, where you can view and create invoices in CCH iFirm.

My Reports
Launches your CCH iFirm PracticeManagement reports, where you canmeasure the
performance of teammembers and see how your firm is performing.

My Timesheet Launches your CCH iFirm timesheet, where you can track your personal time by job.

View Job Details* Opens job details for the job associated with the open return.

Contact Details*
Launches CCH iFirm Contact Details for the taxpayer in the open return, where you can
view and edit their information.

Client Portal
Launches CCH iFirm Client Portal, where you can organize and share important
documents with clients.

*View Job Details and Contact Details menu items are only available while inside an open return.
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Export Existing Contacts to CCH iFirm
The Export Contacts to iFirm feature allows you to export contact information from ATX returns to CCH iFirm so you don't
have to set up contact data twice.

To export your contact information to CCH iFirm:

1. Click the Rollover Manager tab.
2. Click the CCH iFirm menu, and click Export Contact to iFirm.

3. Click Export to iFirm.

If the SSN or EIN already exists in CCH iFirm, ATX skips the return and proceeds to the next return.

What's IncludedWhen you Export Contacts to CCH iFirm
When you export your contacts using Rollover Manager, ATX exports the following information to CCH iFirm:

l SSN or EIN
l Taxpayer name or business name
l Address, city, state, and ZIP Code
l E-mail address
l Date of birth

Import CCH iFirm Contact Data into a New Return
You can reduce your tax return preparation time by importing contact information from CCH iFirm into new returns.

ATX requires an SSN or EIN to sync with CCH iFirm’s contact database. If you create contacts in CCH iFirm, be sure
to enter the SSN or EIN before importing into ATX. If you create an ATX return for a CCH iFirm contact that does not
have an assigned SSN or EIN, the system assumes that this is a "new contact" and a duplicate contact is created in
CCH iFirm.
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To import contact information from CCH iFirm:

1. In Return Manager, click New to create a return.
2. After selecting forms, the Import CCH iFirm Contact Data dialog displays.
3. In the Search iFirm Contacts box, type all or part of the information to display a list of contacts from CCH iFirm.

You can search on any of the column heading types (SSN/EIN, First Name, Last Name, or Company Name).
ATX displays a list of results.

If there are nomatching contacts, ATX displays amessage, Nomatching contacts found. Verify the
information and retype or click Skip.

4. Select the contact from the list and click the Import related contact check box, then click Import.

By checking the Import related contacts check box, ATX imports spouse and/or dependent information from
CCH iFirm for individual returns. For business returns ATX imports partner, beneficiary, and/or shareholder
contact data.

5. The Import dialog closes and the selected contact data is entered in your new return.

Sync New ATX Contacts with CCH iFirm
When you create a new return, if the contact does not yet exist in CCH iFirm, ATX allows you to sync the contact information
to CCH iFirm.
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ATX requires an SSN or EIN to sync with CCH iFirm’s contact database. If you create contacts in CCH iFirm, be sure
to enter the SSN or EIN before importing into ATX. If you create an ATX return for a CCH iFirm contact that does not
have an assigned SSN or EIN, the system assumes that this is a "new contact" and a duplicate contact is created in
CCH iFirm.

To sync new ATX contact information to CCH iFirm:

1. When you close the new return in ATX the iFirm Contact Sync dialog displays.

2. Select the contact(s) you want to sync to iFirm. Click Sync Changes. ATX exports your client's contact
information to CCH iFirm. See Sync Contact Data on Open and Close for information what type of data is shared
with CCH iFirm.

If you choose to Skip, you will not be prompted to sync again unless you have edited the information in the
return.

Sync Contact Data on Open and Close
When you open or close a tax return, ATX syncs with CCH iFirm, recognizing changes to contact data. The following data is
exchanged between ATX and CCH iFirm:

l Taxpayer name/Business name
l Address, city, state, and ZIP Code
l Work, cell and home phone numbers
l Email address
l Date of birth
l Date of death
l Related contacts:

l Spouse
l Dependent
l Beneficiary *
l Partner *
l Shareholder *
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*Syncing Partner, Shareholder, and Beneficiary Contact Data: Entity Type must be specified on Schedule K-1
forms for Partners, Shareholders and Beneficiaries to sync properly between ATX and CCH iFirm.

ATX requires an SSN or EIN to sync with CCH iFirm’s contact database. If you create contacts in CCH iFirm, be sure
to enter the SSN or EIN before importing into ATX. If you create an ATX return for a CCH iFirm contact that does not
have an assigned SSN or EIN, the system assumes that this is a "new contact" and a duplicate contact is created in
CCH iFirm.

Sync onOpen
When opening a return, if there are changes from CCH iFirm, ATX recognizes these changes and asks if you would like to
sync them.

To sync updated contact information from CCH iFirm when opening a return:

1. Open your return. For more information, seeOpening Returns. When changes have beenmade to the contact in
CCH iFirm, a dialog appears asking if you want to sync:

2. Select the check box for the contact(s) you want to sync.
3. Click Sync Changes.

If you want to keep the current information in ATX, click Skip.

Sync on Close
When you close a return, if there are supported field changes, ATX asks you if you want to sync the changes to CCH iFirm.

To sync updated contact information from ATX to CCH iFirm when closing a return:

1. If changes have beenmade to the contact in ATX, a dialog appears asking if you want to sync:
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2. Select the check box for the contact(s) you want to sync.
3. Click Sync Changes.

If you want to keep the current information in CCH iFirm, click Skip.

View CCH iFirm Job Status in Return Manager
In CCH iFirm, job statuses track the progress of a job for a particular contact, which helps youmanage your firm's workflow.
The CCH iFirm job status for that contact is listed with the return. This helps tie tax preparation tasks to other work done in
your firm for that contact.

To view the job status associated with an ATX return:

1. Click the Return Manager tab.
2. From the Return Manager tab, click the Returns tab.
3. Locate the Job Status column.

The Job Status column only displays CCH iFirm job statuses.

View Job Details
View Job Details opens job details for the job associated with the open return.

To open View Job Details, click the CCH iFirm menu, and select View Job Details.
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ATX and CCH iFirm will smartly assign jobs to tax returns whenever that return is being prepared for a contact existing
in iFirm. For returns being prepared using SSN/EIN information that has not yet been sync'd with iFirm, clicking View
Job Details will take you to the generic Jobs list in CCH iFirm.

Send CCH iFirm Invoice
The Send CCH iFirm Invoice feature allows you to send an ATX Billing Invoice from ATX to CCH iFirm without interrupting
your tax preparation workflow. When you send the invoice to CCH iFirm you can track the status of sent invoices using the
Finalized Invoice tab within PracticeManagement. To track invoice payments use Accounts Receivable within CCH
iFirm.

To send a Billing Invoice to CCH iFirm:

1. From the open return, click the Forms menu; then, select Send CCH iFirm Invoice.
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If you don’t have a Billing Invoice in the return when you select Send CCH iFirm Invoice, ATX prompts you to
add the form to the return. Click Continue to add the Billing Invoice to the return. See Billing Manager.

If you already added the information from the Add Billing Invoice dialog box, repeat the first step.

2. Review the information on the Send CCH iFirm Invoice dialog box and click Send Invoice.

If changes are needed, click Cancel.

3. ATX displays the Send Invoice Results dialog box. Click the Finalized Invoices link to track the status of the
invoice or click Close to finish preparing the tax return for electronic filing.
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For help on printing and sending invoices in CCH iFirm see Print and send invoices.

Tracking Time in ATX
Once you've signed into CCH iFirm in Preferences, you can track the time you spend in all your active returns and in other
areas of ATX. As part of our integration with CCH iFirm, time spent in ATX can be sent to CCH so it can be rolled into the
CCH iFirm Timesheet.

Timer

When you are doing anything in ATX that is outside an open return, one timer tracks this time. For example, if you start the
timer in ReturnManager and then open Bank Manager, the timer will continue to run.

You need to click Start/Stop when using the timer.

When you're working in a return and you navigate away from it, the timer pauses. When youmove back to the return, time
tracking resumes where it left off.

ATX auto starts the timer for each open return when the Auto-start timers in returns preference is enabled. To change
the Preference setting, go to the Return Manager Preferences.

Icon Feature Description

/ Stop/Start

Timers can be paused and re-started as often as needed throughout the

day. To pause a timer, click the Stop button . When the timer is

paused, the Start button allows you to resume the timer.

Reset

Discards the existing time and sets the timer back to 0:00. Once the
timer is reset, click Start to start the timer.

The timer does not auto start once you reset the time.
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Icon Feature Description

Timesheet Entry Allows you to create a timesheet entry.

Sending Time from ATX to CCH iFirm

When you are ready to send time to CCH iFirm, click the Timesheet Entry button . The Send Timesheet Entry to
iFirm dialog box displays.

Feature Description

Entry Type Billable is selected by default.

Job
(Required) Name of the iFirm job, if already assigned. If not assigned, begin typing job and
the job list will appear.

Time Elapsed
(Populated based on your time) The amount of time on the ATX timer. Appears in Hours or
Units, depending on how it is set up in CCH iFirm.

Activity Code
(Required) Select an activity code. Like the Job list, when you begin typing, a list will
appear.

Comment (Optional) Enter comments that might explain something on the timesheet entry.

If you're signed into CCH iFirm, ATX, always reminds you to submit time before you close a return or the application.
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Clicking Continue and Close discards time on all timers and closes the return and/or application. Clicking Cancel allows
you to cancel the closing process and go back to any timers to submit your timesheet entries.

Viewing Timesheet Entries
To view ormake adjustments to your ATX timesheet entries, click the CCH iFirm menu, and select My Timesheet.
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Chapter

17
CCH iFirm Client Portal
CCH iFirm Client Portal allows you to securely share files with your clients. ATX and CCH iFirm work together to simplify
your office workflow. As a Client Portal subscriber, you have the ability to upload tax return PDFs from ATX to Client Portal.
Some of themost-loved features of Client Portal are:

l Sharing documents with your clients
l Automatic notifications when clients upload documents to you
l Integration between ATX and Client Portal

How to Topics:

l Sign In To CCH iFirm: Opens the line of communication between the CCH iFirm and ATX applications and enables
data to be shared.

l Upload to Client Portal

For information on how to set up your Client Portal within CCH iFirm, see Set up Client Portal.

Upload to Client Portal
You can upload returns to Client Portal so your customers can review their returns. In order for Client Portal to automatically
send portal invitation e-mails to your clients, an e-mail address must be present in the tax return on the Filers Info page and
the Automatically Send Client Portal invitation emails preferencemust be enabled on the Return Manager Preferences
tab.

Review the following scenarios before uploading returns to Client Portal:

Scenario 1: When a contact does not exist in CCH iFirm

When a contact does not exist in CCH iFirm, the contact and portal are created for you when uploading returns to
Client Portal. When an e-mail address is present on the Filers Info page in ATX and the Automatically Send
Client Portal invitation e-mails check box is enabled on the Return Manager Preferences tab, Client Portal
automatically sends an invitation e-mail when the PDF is uploaded to Client Portal. If no e-mail address is present
on the Filers Info page in ATX, you will need to add an e-mail address for the contact in order to send an e-mail
invite. See Invite people to a portal and manage invitations.

Scenario 2: When the contact exist in CCH iFirm
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When the contact does exist in CCH iFirm, the portal will be created for you when printing the return to Client
Portal. When an e-mail address is present on the Filers Info page in ATX and the Automatically Send Client
Portal invitation e-mails check box is enabled on the Return Manager Preferences tab, Client Portal
automatically sends an invitation e-mail when the PDF is uploaded to Client Portal.

Scenario 3: When the contact and portal exist in CCH iFirm

When the contact and portal exist in CCH iFirm and the Automatically Send Client Portal invitation e-mails
check box is enabled on the Return Manager Preferences tab, Client Portal automatically sends an invitation e-
mail when the PDF is uploaded to Client Portal.

To upload returns to Client Portal:

1. Open the return.
2. Do one of the following:

l Click the Print toolbar button.
l From the Returns menu, select Print Return.
l Press Ctrl+P.

3. Select the copies you wish to print in the tree.
4. Check the Upload to Client Portal check box (either instead of or in addition to any other Print selections).
5. Click Print, and ATX uploads the document to the client's portal.

You can set up your Print Packets to always upload specific copies to Client Portal.
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Tax Research and the Master
Tax Guide
Your ATX software includes a Tax Research subscription of CCH® AnswerConnect or CCH® IntelliConnect®. Your
subscription content varies based on your tax package, and you can access these features through the Tax Research
menu in ATX.

If you would like to add any of these tools to your package, call your Account Manager at 800-495-4626.

ATX saves your credentials in Return Manager Preferences, allowing you to bypass the login routine and access
Tax Research, IRS Publications, and/or theMaster Tax Guide quickly from an open return or any of theMain
Managers.

A red Tax Research button on the toolbar indicates you need to enter your Tax Research credentials on the
Return Manager tab of the Preferences dialog box.

To enter your Tax Research credentials:

1. From an open return, do one of the following:
l Click the Tax Research button on the toolbar.
l Click the Tax Research menu and select any of the options.
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2. Click Preferences.

3. Under the Tax Research Login Credentials section, enter your User Name and Password.

504



Chapter 18: Tax Research and the Master Tax Guide

If you do not know your login, use the registration email link to retrieve your information.

4. Click OK to apply your changes and close the dialog box or click Apply to save changes and leave the dialog box
open.

5. From and open return, do one of the following:
l Click the Tax Research button on the toolbar.
l Click the Tax Research menu and select any of the options.

Tax Line Research Tooltips and Indicators
Tax research tooltips provide a quick preview of associated tax line research content from CCH Tax Prep Partner. Tooltips
are available onmany tax lines across Federal signature forms and display automatically when you hover over an indicator or
click a field with an indicator.

Tax line research indicators provide visual cues for tax lines that are integrated with CCH Tax Prep Partner. ATX displays a
blue indicator in the field to show you that Tax Research is available for the specific line. See Accessing Line-Specific
Research From Open Returns below for additional information.

Tax line research indicators and tooltips are enabled by default on the Open Return Preferences tab.

Accessing Line-Specific Research From Open Returns
To access Tax Line Research from an open return, do one of the following:

l Right-click a field in a form; then, select Tax Line Research.
l With the desired field highlighted, click the Tax Research menu; then, select Tax Line Research.

Tax Line Research information is not available for every line of every form.

Practice Aids
There are over 200 practice tools available in CCH Tax Prep Partner; your subscription determines the availability of practice
tools. Practice Aids are available for the following packages:

l 1040
l 1041
l 1065
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l 1120
l 1120S

Practice Aids allow you to select from elections, flowcharts, worksheets, checklists, tables, tools and client letters, that
aid in tax preparation.

To access Practice Aids from an open return, do the following:

1. Click the Tax Research menu, then point to Practice Aids.
2. Do one of the following:

l Click 1040 Practice Aids
l Click 1041 Practice Aids
l Click 1065 Practice Aids
l Click 1120 Practice Aids
l Click 1120S Practice Aids

When you click the Practice Aids button on the toolbar ATX takes you to the corresponding Practice Aids for the open
signature form. If you do not have a signature form open ATX takes you to the 1040 Practice Aids.

Client Letter Toolkit
To access the Client Letter Toolkit from an open return, click the Tax Research menu; then, click Client Letter
Toolkit.
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SearchOnline
The Search Online feature allows you to search online for an answer to your question. You can also use your CCH Browser
plug-in to search the Internet for answers to your questions. This way, you do not have to navigate to CCH IntelliConnect
every time you need to search for an answer. Use the plug-in to get access to CCH IntelliConnect answers directly on the
results page of your favorite search engine.

To use the Search Online feature:

1. From an open return do one of the following:
l From the toolbar, click the Search Online button. ATX displays a search box, type your search criteria in the
box and click Search.

To turn off the search box click the Search Online button.

l Click the Tax Research menu; then, click Search Online.
2. ATX opens your internet browser where you can browse through your search results. See Searching with Internet

Explorer or Searching with Chrome.

To download the CCH Browser Search plug-in for Internet Explore:

Use these steps if you did not install the plug-in during the ATX installation process.

1. Navigate to http://cchconnect.cch.com/ICSearchSSO/InstallCrm.aspx.
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2. Click Install Now.
l For information on installation, see CCH Browser Search Plug-in Installation.
l For information on Internet Explorer setup, see CCH Browser Search Plug-in For Internet Explorer.

To download the CCH Browser Search plug-in for Google Chrome:

1. Navigate to http://cchconnect.cch.com/ICSearchSSO/InstallCrm.aspx.
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2. Click Install only to Chrome™.

l For information onGoogle Chrome setup, see CCH Browser Search Plug-in For Google Chrome.

509



Chapter 18: Tax Research and the Master Tax Guide

CCH Browser Search Plug-in Installation
To continue the installation process of your CCH Browser plug-in:

1. Click Next.

2. Read the License Agreement and click I Agree to continue.
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3. Verify the location, then click Install.

4. Click Next.
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5. Click Next.

6. Click Next.
7. CCH® Browser Search displays your default Internet Browser.

For information on Internet Explorer setup, see CCH Browser Search Plug-in For Internet Explorer.

For Information onGoogle Chrome setup, see CCH Browser Search Plug-in For Google Chrome.

CCH Browser Search Plug-in For Internet Explorer
To setup your CCH Browser plug-in with Internet Explorer:

1. Do one of the following:
l Click Manage add-ons.
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l Click the Tools menu, thenManage add-ons.

2. Select CCH Browser Search underWolters Kluwer U.S. Corporation, then click Enable.
3. Click Close.

4. Click CCH Browser Search icon.

5. Click Enter Log In Credentials.
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6. Enter your User ID in the User ID box.
7. Enter your password in the Password box and click LOGIN.

Searching with Internet Explorer
If you used the Search Online toolbar button, skip to step 3.

1. Type your search phrase (example alternativeminimum tax) in the search box.
2. Do one of the following:

l Click the Search button.
l Press Enter.
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3. Click Display CCH® IntelliConnect® search results.
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You can either select search results from the CCH Browser Search plug-in or results from another source.

If you select results from the CCH Browser Search plug-in, CCH Browser Search opens to the link location within
CCH® IntelliConnect® or CCH® AnswerConnect.
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CCH Browser Search Plug-in For Google Chrome
To setup your CCH® Browser plug-in with Google Chrome:

1. Click Add to Chrome.

2. Click Add extension.

517



Chapter 18: Tax Research and the Master Tax Guide

3. Click Enter Log In Credentials.

4. Enter your User ID in the User ID box.
5. Enter your password in the Password box and click LOGIN.
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Searching with Chrome
If you used the Search Online toolbar button skip to step 3.

1. Type your search phrase (example alternativeminimum tax) in the search box.
2. Do one of the following:

l Click the Search button
l Press Enter.
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3. Click Display CCH® IntelliConnect® search results.

You can either select search results from the CCH Browser Search plug-in or results from another source.

If you select results from the CCH Browser Search plug-in,CCH Browser Search opens to the link location within
CCH® IntelliConnect® or CCH® AnswerConnect.
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Backup and Restore
The Backup feature in ATX saves your tax return and associated data in an archive so youmay access it if you have a
computer failure or other loss of data. The Restore feature enables you to replace the lost data on your system,
assuming the data was backed up.

It's important to know the differences between Backup/Restore and Export/Import. See Backup vs. Export.

How to Topics:

l Backup and Files Preferences
l Automatic Backup
l Changing File Storage Location in Preferences
l Changing Backup Location in Preferences
l Manually Moving Files to a New Location
l Manual Backup
l Setup Data*(must be backed upmanually)
l Restoring Returns
l Restoring Other Data
l Restoring Returns with E-files and Bank Products

Third Party Backup Products
Using a third party back product such as (Carbonite, Mozy, Backblaze, or AmazonGlacier) may require you to change
your backup location to a location the third party product can access. See Changing Your Backup Location.

Backup and Files Preferences
The Backup and Files Preference tab is where you can identify or change the location where your returns and data is
backed up or stored. ATX has an Automatic Backup Preference that is enabled by default when ATX is installed.
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Automatic Backup
All your returns are automatically backed up whenever they are closed. With each return, ATX also backs up e-files, bank
product information, asset data, and any PDF attachments. In addition, ATX backs up data in the Company Manager,
Payer Manager, Preparer/ERO Manager, and Billing Manager twominutes after the last change is made or when the
manager is closed. See Automatic Backup.

Any changes to the Backup and Files Preferences tab affects all users.

Where are backups stored?

By default, your backup data is stored on the C:\ drive of either your stand-alonemachine or your network server, depending
on your installation type.

ATX backs up data automatically when the Automatic Backup check box is selected. If the Automatic Backup is not
selected, aManual Backup is required. The Automatic Backup process includes all data except Setup Data. To backup
your Setup Data aManual Backup is required.

Important Tips About Backup Locations: We strongly recommend that all Admin users change the default backup
location to a permanent location (e.g. another drive) that is not on the stand-alone computer or network. This will
protect backup information from being lost if you have a computer or server failure. While you should never use a flash
drive as your primary backup device, you can use an external hard drive for your backups if you leave it permanently
attached to your stand-alone system or network server.

Youmay need to change your Backup Location if you want to use a different location on your network or if using a third party
backup product. If you need to change your Backup Location, see Changing Backup Location in Preferences.

Using a third party back product such as (Carbonite, Mozy, Backblaze, and AmazonGlacier) may require you to
change your backup location to a location the third party product can access.
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File Storage Location
The File Storage Location is where your actual returns and associated data will be stored and accessed by the
workstations. This is not where backups of your returns are stored. For more information on File Storage Location, see
Changing File Storage Location in Preferences.

Reset to the Default Location
Reset Defaults is located on the Backup and Files tab.

To reset to the default Backup Location, browse to: X:\ProgramData\CCH Small Firm Services\ATX 2017 Server\ATX
2017 Backup

To reset to the default File Storage Location, browse to: X:\ProgramData\CCH Small Firm Services\ATX 2017
Server\ATX 2017 Files

X = the drive where ATX is installed.

Saving Selected Returns to a Specific Location
To save specific returns to a specific location, use the Export feature. See Exporting Returns.

Automatic Backup
The Automatic Backup feature is enabled by default when you install ATX, so you don’t have to worry about turning it on.
This preference is found on the Backup and Files tab of the Preferences dialog box.

We strongly recommend that you allow the program to back up automatically so you can be assured your files are
backed up regularly.

Setup Data is not backed up automatically. To backup your Setup Data, see Backing up Setup Data.

What Data is backed up as part of Automatic Backup?
The Automatic Backup feature includes the following in the backup:

What is backed up? How often? (if Automatic Backup
preference remains selected)

Where is it Backed Up?

Returns
(includes forms, related e-files,
acks, bank apps, bank
disbursements, asset data, PDF
attachments, and return-specific
print settings)

When the return is closed. In the system ATX 2017 Backup folder

Companies
Twominutes after the last change is
made in the Company Manager; or,
when themanager is closed.

Companies file created in the ATX
2017 Backup folder.
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What is backed up? How often? (if Automatic Backup
preference remains selected)

Where is it Backed Up?

Payers
Twominutes after the last change is
made in the Payer Manager; or, when
themanager is closed.

Payers file created in the ATX 2017
Backup folder.

Preparer/EROs
Twominutes after the last change is
made in the Preparer/ERO Manager;
or, when themanager is closed.

Preparers file created in the ATX 2017
Backup folder.

Billing Information
(Hourly and Form Rates)

Twominutes after the last change is
made in Billing Manager; or, when the
manager is closed.

ATXFormRates and HourlyRates file in
the ATX 2017 Backup folder.

Backed up return data can be restored to your system using the Restore Returns function. See Restoring Returns.

Changing Backup Location in Preferences
You can change the default backup location for your entire system database, including your returns. The new location will
only be used for backups created after the change was applied.

Existing backups will not bemoved to the new location automatically. If you want existing backups to be stored in the
new location, the files must bemovedmanually. SeeManually Moving Files to a New Location.

External Hard Drives: If you are using an external hard drive as your new backup location, the external drivemust be
physically connected to the server.

To change backup locations:

1. Do one of the following:
l Click the Preferences button on the toolbar.
l From the Return Manager, E-file Manager, or Bank Manager, click the Options menu; then, select
Preferences.

l From Rollover Manager, click the Tools menu; then, select Preferences.
2. Click the Backup and Files tab.
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3. Click the Browse button under Backup Location to navigate to and select a new backup location.

The storage locations can only be changed fromWorkstation/Server or Server Only (using Admin Console)
for Network installs.

The new backup pathmust be a physical drive on the server or a fully-qualified universal naming convention
(UNC) path to another location on the network. If you use amapped drive for backups, it must be converted to
a fully-qualified UNC path. For detailed information, see theMicrosoft article on Naming Files, Paths and
Namespaces.

4. Click Apply andOK to close.

These locations can also be changed on the File Settings tab of the Admin Console dialog box.

Changing File Storage Location in Preferences
The file storage location is where your actual returns and associated data will be stored and accessed by the workstations.
This is not where backups of your returns are stored. Backups are stored separately under an ATX 2016 Backup folder on
your ATX server. To change your backup location see Changing Your Backup Location.

The Admin user typically changes the file storage location, if required. The storage locations can only be changed from
Workstation/Server or Server Only (using Admin Console) for Network installs.

The new location will only be used for data created after the change was applied. Existing data will not bemoved to the
new location automatically. If you want existing data to be stored in the new location, the files must bemoved
manually. SeeManually Moving Files to a New Location.

While you cannot change the location where ATX installs, you can change where your data is stored, if desired.

For example, if you have an extremely large number of returns, companies, payers, or billing rates, youmay want to use a
larger hard drive or faster computer.
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To change your file storage location:

1. Do one of the following:
l Click the Preferences button on the toolbar.
l From the Return Manager, E-file Manager, or Bank Manager, click the Options menu; then, select
Preferences.

l From Rollover Manager, click the Tools menu; then, select Preferences.
2. Click the Backup and Files tab.

3. Under the File Server section, click the Browse button to select a new path for the Storage Location field.
4. Click Apply andOK to close.

These locations can also be changed on the File Settings tab of the Admin Console dialog box.

Manually Moving Files to a New Location
Backups and files created prior to changing a backup or file storage location will not bemoved to the new location
automatically. If Backup and/or File Storage locations are changed, any files previously stored in the default locations must
bemovedmanually.

To manually move your existing backups and files to a newly designated location:

1. After the Backup and/or File locations have been changed, close ATX.
2. Navigate to the ATX 2017 Server. Existing Backup files are stored in the ATX 2017 Backup folder and Data files

are located in the ATX 2017 Files folder.

The default location is \ProgramData\CCH Small Firm Services\ATX 2017 Server.

3. Open the ATX 2017 Backup folder or the ATX 2017 Files folder, depending on which files are beingmoved.

Do not copy/move the entire folder.
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4. Press Ctrl+A to select all files within the open folder, and then press Ctrl+C to copy all selected files.
5. Browse to the newly designated location and open the ATX 2017 Backup folder or the ATX 2017 Files folder,

depending on which files are beingmoved.
6. Press Ctrl+V to paste the copied files into the open folder.

Do not copy or remove the DataStore folder from the ATX 2017 Server folder. Doing so will result in
undesirable conditions/behavior in ATX.

Manual Backup
Although we strongly recommend that you use Automatic Backup, aManual Backup feature is available if you prefer make
additional backup copies in alternate locations.

By default, manual backups are saved to the location shown on the Backup and Files tab of the Preferences dialog box.

To change the default location for a manual backup:

1. Do one of the following:
l Click the Preferences button on the toolbar.
l From the Return Manager, E-file Manager, or Bank Manager, click the Options menu; then, select
Preferences.

l From Rollover Manager, click the Tools menu; then, select Preferences.
2. Click the Backup and Files tab.

3. Click the Browse button under Backup Location to navigate to and select a new backup location.
4. Click Apply andOK to close.

To manually backup returns and other data:

1. Disable the Automatic Backup on the Backup and Files Preferences before running amanual backup.
2. From Return Manager, click the Returns menu; then, click Backup Returns.
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3. Select the check box(es) for return(s) to be backed up or select the Name check box to select all files.

Selecting the Name check box will select all rows shown on the page. Increase the number of rows shown per
page in the drop-down list at the lower left of the Backup dialog box to select more returns at once.

Enter text into the Search by name... to show only those returns matching the criteria entered.

4. Under Other data:, select the check box for Companies, Payers, Preparers, Form Rates, Hourly Rates,
Setup Data and Asset Classifications as desired to be included in the backup.

5. Click Browse to navigate to and select another backup location if desired.

Selecting another location from the Backup dialog box will not change your default backup location. If you
want to change your default backup location, you can do so via the Backup and Files tab of the Preferences
dialog box or from the Admin Console.

6. Click Backup.
7. Click Close.

Setup Data
Setup Data is a consolidated group of data that includes the following types of information that you use regularly in ATX:

l Preferences - all the preferences you've selected for your system
l Security Manager information that you've set up
l Print Packet settings
l Custom Client Letters
l CustomizedMaster Forms
l EFIN Enrollment Data
l Unpostable Funds records
l Enhanced Asset Management settings
l PRS purchases
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Backing up Setup Data
Setup Data is not backed up automatically. Setup Data can bemanually backed up by selecting the Setup Data check
box from the Backup dialog box. When needed, Setup Data can be restored using the Restore function.

To back up your Setup Data, use the following steps:

1. From Return Manager, click the Returns menu; then, click Backup.

2. Under Other data, select the check box for Setup Data to be included in the backup.
3. Click Browse to navigate to and select another backup location if desired.

Selecting another location from the Backup dialog box will not change your default backup location. If you
want to change your default backup location, you can do so via the Backup and Files tab of the Preferences
dialog box or from the Admin Console.

4. Click Backup.
5. Click Close.

Restoring Setup Data
To restore Setup Data:

1. Click the Returns menu; then, select Restore Returns.
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2. Under Other data, select the Setup Data check box.
3. Click Restore.
4. Click Close.

Restoring Returns
ATX’s Backup and Restore functions work in tandem. Only data that has been backed up by ATX may be restored using the
Restore function.

To restore backed up returns and related data:

1. Click the Returns menu; then, select Restore Returns.
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Returns that aremarked as Open may be open on another network user's computer. Open returns will not be
restored.

2. Do one of the following:
l Select the check box(es) for the return(s) to be restored or select the Name check box.

Enter text into the Search by name... to show only those returns matching the criteria entered.

l To restore all returns, click the Restore All Returns link.

3. Note the information listed under the Last Modified and Backup Version columns and either select which backup
version to restore or leave the default setting to restore themost recent version.

If there aremultiple backup versions of a particular return, the versions are listed in the drop-down list in the
Backup Version column.

4. Click Browse to navigate to and select another backup location if desired.
5. Under Other data:, select the check box(es) for Companies, Payers, Preparers, Form Rates, Hourly Rates, or

Setup Data as desired to be restored.
6. Click Restore.

Returns of the same name on your systemmust be replaced. Existing returns can be renamed if you would
prefer to keep both the old and new versions. See Renaming Returns.

7. Do one of the following:
l Click Replace to replace only the return named in themessage.

You will be asked again for each return that has amatch on your system.

l Click Replace All to replace all returns being restored without being asked about any other returns in the batch.
l Click Skip to skip the return named in themessage.

Skipped returns will not be restored.

l Click Cancel to abort the action.

8. Click Close.
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Restoring Other Data
ATX’s Backup and Restore functions working in tandem: only data that has been backed up by ATX may be restored using
the Restore function. While restoring backed up returns, you can also restore “other data,” such as Companies, Payers,
Preparers, Form Rates, Hourly Rates, Setup Data, Asset Classifications, and Custom Reports.

To restore Other Data:

1. Click the Returns menu; then, select Restore Returns.

2. Under Other data:, select the check box(es) as needed to restore the desired information.
3. Click Restore.
4. Click Close.

Backup vs. Export
Although both Backup and Export can be used to archive returns, each function stores different types of data and stores the
files in different formats. The following differences between the features may help you decide the appropriate feature based
on the task at hand:

The Backup feature:

l Has an Automatic Backup option.
l Saves multiple versions of the return.
l Saves PRS Authorization information (Manual Backup with Setup Data included is required).
l Is intended to be used as part of your office’s overall data storage/backup plan.
l Stores data in an *.atx[taxyear]backupt file format (such as *.atx17bakcup).
l E-File information is included with the backup.
l Should be used in conjunction with the Restore feature to get data back into ATX.
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The Export feature:

l Must be performedmanually.
l Saves only themost recent copy of a return.
l Stores data in an *.atx[taxyear]Export file format (such as *.atx17Export).
l Does not save PRS Authorizations information.
l Requires you to synchronize E-file information with EFC after import.
l Should be used in conjunction with the Import feature to get data back into ATX.
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Organizers
AnOrganizer is a pre-assembled packet of worksheets that can help you and your clients organize tax information for
the upcoming tax season. When you add an organizer to the client's return, information from the client's previous tax
year return is populated in the organizer worksheets.

Organizers can be added to any 1040 return. Choose between the 1040 Comprehensive Organizer and the shorter
version—the 1040 Standard Organizer.

When theOrganizers become available this fall, youmust have version 16.6 of ATX 2016, in order to print the
2017Organizers.

Organizer Types
1040 Comprehensive Organizer
By default, a customizable 1040 Comprehensive Organizercan be added to any 1040 return. It includes detailed
worksheets for items such as income, deductions, contributions, and Schedules K-1 received by your clients.

1040 Standard Organizer (Condensed)
The 1040 Standard Organizer is amore condensed organizer in which Organizer Sheets cannot be added or removed.
To use the Standard Organizer, youmust disable the default Comprehensive Organizer in Select Forms
Preferences.

Organizer Preferences
Organizers allow you to select from the following Preferences:
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l Suppress SSNs when printing Organizer: This preference hides Social Security numbers on printed Organizer
worksheets. With this preference enabled, printed Social Security Numbers will appear as XXX-XX-XXXX, enabling
you to protect your client's privacy. This preference is enabled by default. See Print Preferences.

l Use Comprehensive Organizer: This preference sets the Comprehensive Organizer as the default organizer.
Disabling this option sets the Standard Organizer as default.

l Include Organizer Letter and/or Engagement Letter with the Organizer Packet: These preference options are
enabled by default. With these preferences enabled, the Organizer Letter and Engagement Letter automatically
load when an organizer is added to a return.

When you use the Create Organizer for Marked Returns feature or the Print Organizers for Marked Returns
feature, ATX adds or prints the Organizer according to your preference selections on the Select Forms Preferences
tab. Check your preference settings before using these options to ensure the appropriate organizer and/or organizer
letters are added to the returns.

Organizer Types
There are two types of organizers, the Comprehensive Organizer and the Standard Organizer. By default, the
Comprehensive Organizer is added to returns.

To change to the Standard Organizer:

1. From Return Manager, click the Preferences toolbar button.

The Preferences dialog box appears.

2. Click the Select Forms tab.
3. Clear the Use Comprehensive Organizer check box.
4. Click OK to apply your changes and close the Preferences dialog box.
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Comprehensive Organizer
Unlike the Standard Organizer, the Comprehensive Organizer is a customizable set of forms that can be included in a
copy of last year's return.

The Comprehensive Organizer contains the following sheets by default:

Default Comprehensive Organizer
Forms & Worksheets Information found on these pages

Organizer Letter Cover letter form that explains the purpose and contents of the Organizer.

Organizer Engagement Letter
A client letter form that spells out the business agreement between your
firm and your client.

Mailing Slip - Portrait
Customer's name, address andmailing barcode. Page can be slipped into
a standard 9x12 envelope with a window.

General
General information, such as Name, SSN, Phone, E-mail, Filing status,
and Address.

Organizer Options
Select the detail sheets that you want to include in this customer's
Organizer packet, such as Dependent Information, Wage Information (W-
2), and Interest Income.

Questions
Select the questions that you want included in this customer's Organizer
packet, such as "Did your marital status change since last year?" or "Are
there any changes in your dependents?"

Comments A page for customer comments.

Employee and Other Misc
The following types of itemized deductions: Unreimbursed Employee
Expenses, Certain Miscellaneous Deductions (tax or attorney fees, IRA
custodial fees), Other Miscellaneous Deductions.

Standard Organizer
In contrast to the Comprehensive Organizer, the Standard Organizer is a condensed, non-customizable group of forms
that can be printed with a return for your customers. With the exception of the Organizer Engagement Letter, nothing can
be added to or removed from Standard Organizers.

The Standard Organizer contains the following forms:

Standard Organizer Forms &
Worksheets Information found on these pages

Organizer Letter
Cover letter form that explains the purpose and contents of the
Organizer.
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Standard Organizer Forms &
Worksheets Information found on these pages

Organizer Options

Specify an appointment time on theOrganizer Letter; also, select the
detail sheets that you want to include in this customer's Organizer
packet, such as Dependent Information, Wage Information (W-2), and
Interest Income.

Mailing Slip - Portrait
Customer's name, address andmailing bar code. Page can be slipped
into a standard 9x12 envelope with a window.

Page 1
Basic taxpayer, dependent, wage, salary, pension, and IRA
information.

Page 2 General, business and investment questions.

Page 3
Interest and dividend income, income or loss from partnerships, S
corporations, and trusts.

Page 4
Gains or losses from sales of stocks, securities or other assets, other
income and adjustments to income.

Page 5
Itemized deductions, education and childcare or dependent care
expenses.

Page 6 Federal, state and local or other estimated taxes paid.

Page 7
Vehicle information and expenses, automileage documentation and
business use of home.

Page 8 Comments page.

Custom (Blank)

Changing the Organizer Type
To change from the default Comprehensive Organizer to the Standard Organizer:

1. From either the open return or from Return Manager, click the Preferences button on the toolbar.

The Preferences dialog box opens.

2. Click the Select Forms tab.
3. Clear the Use Comprehensive Organizer check box.
4. Click OK to apply your changes and close the Preferences dialog box.
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Adding Organizers to Returns
Organizers can only be added to 1040 returns.

You can add anOrganizer to:

l An open return
l A single return in Return Manager
l A batch of returns in Return Manager

The Comprehensive Organizer is the default organizer type added to 1040 returns. To change the organizer type, see
Changing the Organizer Type.

AddingOrganizers to Open Returns
To add an Organizer to an open return:

From the open return, click the Forms menu; then, expand theOrganizer fly-out menu and select Add Organizer.

TheOrganizer and anOrganizer Letter are added to the return. They appear as form tabs. TheOrganizer Letter opens
immediately. To addOrganizer Sheets:

1. Open the return to which you wish to addOrganizer Sheets.
2. Click the Organizer tab so that the Organizer Options is displayed.
3. Select the check boxes for additional forms to be included in the Client Organizer.

You can also add anOrganizer from the Select Forms Dialog Box. See Adding Forms to a Return.
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AddingOrganizers to a Batch of Returns
In most cases, you can add organizers to a batch of 1040 returns in the Return Manager. The only exceptions are returns
that are password-protected, and returns that are currently open. In these cases, youmust add theOrganizer from inside the
return. See Adding Organizers to Open Returns.

To add organizers to a batch of returns:

1. In Return Manager, mark the returns to which you want to add anOrganizer.
2. Click the Returns menu; then, select Organizers.
3. Select Create Organizer for Marked Return.

Open and password-protected returns will appear as locked. Organizers can only be added to these from
within the open return.

4. Click Create Organizers.
5. Open any of themarked returns to see the Organizers.

Creating a Blank Organizer for a NewReturn
The simplest way to generate an organizer for a new customer is to create a new 1040 return with a blank Organizer attached.

To create a blank organizer for a new 1040 return:

From Return Manager, click the Returns menu; then, expand theOrganizers fly-out menu and select Create Blank
Organizer for New Return.

The new return opens with the Organizer attached.
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Use theOrganizer Letter for Scheduling
To add or change the appointment time for an Organizer Letter:

1. In the open return, click the Organizer form tab. (If you haven't added anOrganizer, see Adding Organizers to
Returns.)

2. On theOrganizer Options worksheet, enter/modify the Date and Time of the appointment (the day is
automatically entered by the system).

3. To confirm that the data is in the Organizer letter, click the Organizer Letter tab.
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AddingOrganizer Sheets
Organizer Sheets may be added to a Comprehensive Organizer to allow for customization.

Sheets cannot be added to or removed from a Standard Organizer.

To add Organizer Sheets:

1. Open the return to which you wish to addOrganizer Sheets.
2. Click the Organizer tab so that the Organizer Options are displayed.
3. Select the check boxes for additional sheets to be included in the Organizer.

Deleting Organizer Sheets
Organizer Sheets may be deleted from the Comprehensive Organizer to allow for customization.

Sheets cannot be deleted from the Standard Organizer.

To delete an Organizer Sheet:

1. Open the return from which you wish to delete anOrganizer Sheet.
2. Click the Organizer tab so that the Organizer Options display.
3. Remove the "x" from the check box, for sheets you do not want included in the Organizer.
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Organizer Engagement Letter
AnOrganizer Engagement Letter is a client letter that spells out the business agreement between your firm and your
client. By default, the Organizer Engagement Letter is automatically added to all 1040 returns via a preference on the Select
Forms Preferences.

TheOrganizer Engagement Letter is added with either the Comprehensive Organizer or the Standard Organizer.

AddingOrganizer Engagement Letters to Returns

You can addOrganizer Engagement Letters to returns by:

l Adding Organizers to Returns (the Organizer Engagement Letter will automatically be included); or.
l Adding anOrganizer Engagement Letter to the return from the Client Communication Manager.

To add the Organizer Engagement Letter from the Client Communication Manager:

1. Open the return.
2. Click the Forms menu; then, select Client Letter.
3. Under Templates, scroll down and select Organizer Engagement Letter.
4. Do one of the following:

l Right-click and select Attach letter(s) to return.
l Click the Attach toolbar button; in the Attach to Return dialog box click the Attach button.

Disabling the Organizer Engagement Letter
To disable the preference that automatically adds the Organizer Engagement Letter to returns:

1. Select the Preferences toolbar button.
2. Click the Select Forms tab.
3. Clear the Organizer Engagement Letter check box.
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Printing Organizers
You can print organizers in two ways:

l From an open return, print organizers one at a time.
l From Return Manager, print a batch of organizers.

Printing anOpen Return's Organizer
1. Open the return.
2. Do one of the following:

l Click the Print toolbar button.
l Click the Returns menu; then, select Print Returns.
l Press Ctrl+P.

Printing Organizers for Marked Returns
In most cases, you can print a batch of 1040 returns from the Return Manager. The only exceptions are returns that are
password-protected, or returns that are currently open. In both of these cases, youmust add theOrganizer from inside the
return.

The Print Organizer for Marked 1040 Returns prints according to your settings on the Select Forms Preferences
tab. Check your preference settings before using these features to ensure the appropriate organizer and/or organizer
letters are added to the returns.

1. In Return Manager, mark the returns for which you want to print an Organizer.
2. Click the Returns menu; then, select Organizers.
3. Select Print Organizers for Marked Return.

The Print Organizers for Marked Returns dialog box appears:

4. Click Print Organizers.
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The Returns Marked for Printing dialog box appears:

5. Make adjustments to the printing order if desired.

The Copies to print options are set in your Print Preferences.

6. Click Print.

The Print Progress dialog box appears.

7. Click Close when you're finished.

545



546



Chapter 21: Keyboard Shortcuts

Keyboard Shortcuts
Many of the program's commands and features are accessible through keyboard shortcuts.

To perform these keyboard shortcuts, press and hold the two (or more) keys shown. For example, to start a new
return (Ctrl+N), press and hold the Ctrl key, and then press and hold the N key.

Global Shortcuts
The shortcuts in the following table are valid in every program view (all main and secondary managers):

Shortcut Description

F1 Opens Program Help.

F2
Alternately positions cursor at the end of the active field and highlights text in the same field. Can be used
to edit the active field.

ReturnManager Shortcuts
The shortcuts in the following table are valid only when you are in the Return Manager:

Shortcut Description

Ctrl+D Opens the Duplicate Selected Return dialog box, enabling you to duplicate the selected return.

Ctrl+F Places cursor in the Find field of any main or secondary manager.

Ctrl+N Opens the Select Forms Dialog Box, which is the first step in creating a new return.

Ctrl+O Opens the selected return.

Ctrl+P
Opens the Returns Marked for Printing dialog box, which allows you to specify print settings for
selected returns. Allows you to print one or more returns.

Ctrl+Delete Deletes the selected return.

F8 Opens the Calculator.
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Rollover Shortcuts
The following shortcuts are valid when you are in the Rollover Manager:

Shortcut Description

Ctrl+F Places cursor in the Find field of any main or secondary manager.

Ctrl+N Opens the Select Forms Dialog Box, which is the first step in creating a new return.

Ctrl+R Begins the Rollover Managerprocess for returns that have been selected.

F8 Opens the Calculator.

E-file Manager Shortcuts
The following shortcuts are valid when you are in the E-file Manager:

Shortcut Description

Ctrl+F Places the cursor in the Find field of any main or secondary manager.

Ctrl+K Downloads e-file acknowledgements (Receive Acks).

Ctrl+O Opens related return.

Ctrl+R Displays e-file rejection errors.

Ctrl+T Transmits marked e-files.

Ctrl+Delete Deletes the selected e-file.

Bank Manager Shortcuts
The following shortcuts are valid when you are in the Bank Manager:

Shortcut Description

Ctrl+F Places the cursor in the Find field of any main or secondary manager.

Ctrl+N Opens the Select Forms Dialog Box, which is the first step in creating a new return.

Ctrl+O Opens the selected return.

Preparer/EROManager Shortcuts
The following shortcuts are valid when you are in the Preparer/ERO Manager:
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Shortcut Description

Ctrl+F Places the cursor in the Find field of any main or secondary manager.

Ctrl+Delete Delete the selected preparer/ERO.

Company Manager Shortcuts
The following shortcuts are valid when you are in the Company Manager:

Shortcut Description

Ctrl+F Places the cursor in the Find field of any main or secondary manager.

Ctrl+Delete Delete the selected company.

Payer Manager Shortcuts
The following shortcuts are valid when you are in the Payer Manager:

Shortcut Description

Ctrl+F Places the cursor in the Find field of any main or secondary manager.

Ctrl+Delete Delete the selected payer.

BillingManager Shortcuts
The following shortcuts are valid when you are in the Billing Manager:

Shortcut Description

Ctrl+F Places the cursor in the Find field of any main or secondary manager.

Ctrl+Delete (Only on Hourly Rates tab) Clears the selected field.

OpenReturn Shortcuts
The shortcuts in the following table are valid when working in an open return.

Shortcut Description

Ctrl+1 Deletes the current form from the open return.

Ctrl+Shift+1
Opens the Discard Multiple Forms Dialog Box which allows you to delete multiple forms from the open
return.

Ctrl+A Add a new record (Input Sheets).
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Shortcut Description

Ctrl+B Go back to the previous page or form.

Ctrl+C Copy the contents of a field or cell to clipboard.

Ctrl+D Delete the current record (input sheets).

Ctrl+E Check the return for errors (opens the Diagnostics pane).

Ctrl+F Add a form (opens the Select Forms Dialog Box).

Ctrl+I Create an itemized list for the current field.

Ctrl+N
Opens the Select Forms Dialog Box, enabling you to create a new return. If you have less than 3 returns
open, you are taken back to Return Manager and the Select Forms Dialog Box opens. If you have 3
returns open, you'll receive aMaximum Returns Allowed message.

Ctrl+O Opens the Forms in Return dialog box that lists all forms in the return.

Ctrl+P Opens the Print Return Dialog Box, enabling you to print the entire return or a portion of it.

Ctrl+R
Restore the field (when it has been overridden or removes a custom link to another worksheet or schedule,
such as an itemized list).

Ctrl+S Save the return.

Ctrl+T Insert or edit a note.

Ctrl+V Paste the contents of the clipboard into the current field.

Ctrl+X Cut the content from the current field and place it on a clipboard.

Ctrl+Z Undo (Cancel themost recent Cut, Copy, Paste or Restore operation).

Ctrl+(+) Enlarge the page (zoom in).

Ctrl+(-) Reduce the page (zoom out).

Ctrl+Page
Up /
Ctrl+Page
Down

Allows you to toggle from one page/worksheet to the next (Ctrl+Page Up) or to the previous (Ctrl+Page
Down) page/worksheet.

F3
Gives you access to the Government Instructions for the form. When you press F3, the Select Forms
Dialog Box opens; scroll to the form, and click the View Instr link. If instructions are not yet installed, you
can check for updates.

F4 Marks an amount as an estimate.

F6 JumpTo.

F7 Cross Reference.

F8 Opens the Calculator.
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Shortcut Description

F11 If the Calculator is open, captures the current field contents.

Client CommunicationManager Shortcuts
The shortcuts in the following table are valid only when you are in the Client Communication Manager:

Shortcut Description

F2 Rename selected template (only for user created templates).

ESC key Close or open the Client Communication Manager.

Ctrl+A Select all text inside a paragraph.

Ctrl+B Bold the selected text.

Ctrl+C Copy the selected text.

Ctrl+E Center text.

Ctrl+F Find/Replace.

Ctrl+I Italicize the selected text.

Ctrl+J Justify text.

Ctrl+L Align text to the left.

Ctrl+N Start a new template.

Ctrl+O Open the selected template.

Ctrl+R Align text to the right.

Ctrl+S Save the current template or letter.

Ctrl+U Underline the selected text.

Ctrl+V Paste the item.

Ctrl+X Cut the selected item.

Ctrl+Y Redo.

Ctrl+Z Undo (cancel themost recent Cut, Copy, Paste, or Restore operation).

Calculator Shortcuts
The following shortcuts are valid when you are working with the Calculator:
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Shortcut Description

F8 Open the Calculator.

Ctrl+F8 Close the Calculator.

Ctrl+L Clear memory.

Ctrl+R Recall the item that is stored inmemory.

Ctrl+M Store the item inmemory.

Ctrl+A
Add the current value to the value stored inmemory. If a value is stored inmemory, anM appears to
the left of the screen.

Ctrl+S Subtract the current value from the value stored inmemory.

Delete Clear the current entry.

Ctrl+Delete Clear all calculator entries.

F9 Plus/Minus.

Enter Equals.

F11
Capture the number from any field on any form, schedule, or worksheet so youmay use it in a
calculation.

Insert Insert value into the current cell on the form.
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